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Value-Added Reseller (VAR) Language 

Oracle Retail VAR Applications 
The following restrictions and provisions only apply to the programs referred to in this section and 
licensed to you. You acknowledge that the programs may contain third party software (VAR 
applications) licensed to Oracle. Depending upon your product and its version number, the VAR 
applications may include: 

(i) the MicroStrategy Components developed and licensed by MicroStrategy Services Corporation 
(MicroStrategy) of McLean, Virginia to Oracle and imbedded in the MicroStrategy for Oracle Retail 
Data Warehouse and MicroStrategy for Oracle Retail Planning & Optimization applications. 

(ii) the Wavelink component developed and licensed by Wavelink Corporation (Wavelink) of 
Kirkland, Washington, to Oracle and imbedded in Oracle Retail Mobile Store Inventory 
Management. 

(iii) the software component known as Access Via™ licensed by Access Via of Seattle, Washington, 
and imbedded in Oracle Retail Signs and Oracle Retail Labels and Tags. 

(iv) the software component known as Adobe Flex™ licensed by Adobe Systems Incorporated of 
San Jose, California, and imbedded in Oracle Retail Promotion Planning & Optimization 
application. 

You acknowledge and confirm that Oracle grants you use of only the object code of the VAR 
Applications. Oracle will not deliver source code to the VAR Applications to you. Notwithstanding 
any other term or condition of the agreement and this ordering document, you shall not cause or 
permit alteration of any VAR Applications. For purposes of this section, "alteration" refers to all 
alterations, translations, upgrades, enhancements, customizations or modifications of all or any 
portion of the VAR Applications including all reconfigurations, reassembly or reverse assembly, re-
engineering or reverse engineering and recompilations or reverse compilations of the VAR 
Applications or any derivatives of the VAR Applications. You acknowledge that it shall be a breach 
of the agreement to utilize the relationship, and/or confidential information of the VAR 
Applications for purposes of competitive discovery. 

The VAR Applications contain trade secrets of Oracle and Oracle's licensors and Customer shall 
not attempt, cause, or permit the alteration, decompilation, reverse engineering, disassembly or 
other reduction of the VAR Applications to a human perceivable form. Oracle reserves the right to 
replace, with functional equivalent software, any of the VAR Applications in future releases of the 
applicable program. 
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Send Us Your Comments 
Oracle Retail Macro Space Management, Administration Module User Guide, Release 
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Oracle welcomes customers' comments and suggestions on the quality and usefulness of 
this document. 

Your feedback is important, and helps us to best meet your needs as a user of our 
products. For example: 

 Are the implementation steps correct and complete? 

 Did you understand the context of the procedures? 

 Did you find any errors in the information? 

 Does the structure of the information help you with your tasks? 

 Do you need different information or graphics? If so, where, and in what format? 

 Are the examples correct? Do you need more examples? 

If you find any errors or have any other suggestions for improvement, then please tell us 
your name, the name of the company who has licensed our products, the title and part 
number of the documentation and the chapter, section, and page number (if available). 

Note: Before sending us your comments, you might like to 
check that you have the latest version of the document and if 
any concerns are already addressed. To do this, access the 
Online Documentation available on the Oracle Technology 
Network Web site. It contains the most current 
Documentation Library plus all documents revised or 
released recently. 

Send your comments to us using the electronic mail address: retail-doc_us@oracle.com 

Please give your name, address, electronic mail address, and telephone number 
(optional). 

If you need assistance with Oracle software, then please contact your support 
representative or Oracle Support Services.  

If you require training or instruction in using Oracle software, then please contact your 
Oracle local office and inquire about our Oracle University offerings. A list of Oracle 
offices is available on our Web site at www.oracle.com. 
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Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 

https://support.oracle.com 

When contacting Customer Support, please provide the following: 

 Product version and program/module name 

 Functional and technical description of the problem (include business impact) 

 Detailed step-by-step instructions to re-create 

 Exact error message received 

 Screen shots of each step you take 

Review Patch Documentation 
When you install the application for the first time, you install either a base release (for 
example, 14.1) or a later patch release (for example, 14.1.1). If you are installing the base 
release or additional patch releases, read the documentation for all releases that have 
occurred since the base release before you begin installation. Documentation for patch 
releases can contain critical information related to the base release, as well as information 
about code changes since the base release. 
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Conventions 
Navigate: This is a navigate statement. It tells you how to get to the start of the procedure 
and ends with a screen shot of the starting point and the statement “the Window Name 
window opens.”  
This is a code sample 
 It is used to display examples of code 
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1 
Administration Basics 

Logging in to the Administration Module 

How Passwords and Privileges are Configured 
Passwords and privileges are configured in Macro Space Management's Administration 
module. 

Note: Access to the Administration Module is normally 
restricted to a limited number of users. This is because the 
Administration Module can be used to set a wide variety of 
parameters affecting how Macro Space Planning operates.   

Access rights to the Macro Space Management modules are set using the Functional 
Security option. 

 

Users are assigned to User Groups in the User Groups Tab. Which modules a User Group 
can access is specified in the Group Relationships tab. A user's privileges thus depend on 
what user groups they are assigned to. 
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In the above example, User 1 is only a member of the Equipment Planner user group. 
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2 
is a member of the Equipment Planner and Merchandiser Planner user groups. They 
have wider access and can use the Fixture Studio, Planner, Product Studio and 
Merchandiser modules. 

Logging in to Macro Space Management Modules 
When a user first attempts to access a Macro Space Management module, the Log In 
dialog box will appear. 

 

This requires the user to enter a User Name and Password. If these are correct, the user 
will be able to access the desired module. After the initial log in, information will be held 
in Security Server. Users will therefore be able to access all other Macro Space 
Management modules they have permissions for without the need to log in again. If the 
user enters an incorrect user name or password, a warning will result. 

 

If the user attempts to log into a module for which they do not have permissions for, a 
warning will appear and the log in attempt will be terminated. 
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Note: The permissions for which modules can be accessed 
are configured in the Administration module. 

Password Changes 
Macro Space Management can be configured to require password changes at specified 
intervals. If one of these intervals has been exceeded, the user will be asked to change 
their password the next time they log in. This can be done by means of the Change 
Password >>> option on the Log In dialog box. This will reveal another part of the 
dialog box where the changed password can be entered and confirmed. 

 

Security Server 
Security Server is a Macro Space Management process that runs in the background and 
is normally not visible to users. When running, it can be seen in the Processes tab of 
Windows Task Manager as the AVT5SecurityServer.exe *32 process. 
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How Security Server operates is shown in the following flowchart. 

 

 

1. The user opens a Macro Space Management module from a shortcut or the Windows 
start menu. 

2. Security server starts but remains in the background. 

3. The Log In dialog box appears. 

4. The user types their user name and password into the Log In dialog box. 

5. Security Server validates the user name and password against the information held 
in the database. If they are correct and the user has sufficient privileges, the Macro 
Space Management module opens. 

6. Security Server holds information on what other privileges the user has in Macro 
Space Management. 

7. If the user attempts to access other modules, Security Server will check the 
information it holds and allow or deny access as required. This means that a user 
only has to log into Macro Space Management once per session. 

8. When the user exits the last Macro Space Management module, Security Server also 
closes. 

  

 



Overview of the Administration Module 

 

Administration Basics 5 

Security Server and Application Errors 
On occasion a Macro Space Management module might encounter a significant error and 
automatically close. Because the closure was not user initiated, Security Server does not 
close but remains open in the background. If the module that unexpectedly closed is 
reopened, Security Server will contain information incompatible with the restart and 
further application errors will result. 

In the event of a Macro Space Management module failing unexpectedly, carry out the 
following actions: 

1. Save the information in any other Macro Space Management modules that are open 
and close those modules. 

2. Open Windows Task Manager, select the Processes tab, highlight the 
AVT5SecurityServer.exe *32 process and click End Task. 

3. When Security Server has closed, the required Macro Space Management modules 
can be restarted. 

Overview of the Administration Module 

The File Menu 
The File menu has four options: Configure, Configure Floor Plan Publishing, Configure 
Planogram Publishing and Exit. 

 

Configure brings up the Configuration Module, where a series of basic settings affecting 
the local operation of Macro Space Management can be changed. 

Note: All tabs in the Configuration module will be visible if 
opened via the Administration module. If opened in other 
modules, a more restricted selection of tabs will be available. 

 



Overview of the Administration Module 

6 Oracle Retail Macro Space Management 

 

Configure Floor Plan Publishing brings up the Floor Plan Publishing dialog box, 
allowing users to publish floor plans to a specified directory for onward distribution with 
a retail organization. 



Overview of the Administration Module 

 

Administration Basics 7 

 

Configure Planogram Publishing brings up the Planogram Publishing dialog box, 
allowing users to publish planogram designs to a specified directory for onward 
distribution with a retail organization. 
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Exit allows the user to close the Administration Module 

The General Menu 
The General menu gives access to options used for overall planning within Macro Space 
Management. 

 

Option Comment 

Calendars Configure the calendars used for financial planning. 
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Option Comment 

Color Themes Configure the legend for Key Performance Indicators (KPIs). 

Custom Query This option allows users to set up customized queries for the Find dialog 
box using Custom SQL. 

Key Performance 
Indicators 

Configure Key Performance Indicators (KPIs). 

Manufacturers Configure the list of manufacturers used for fixtures and for 
merchandise. 

Status Configure the statuses used for Store, Floors, Revisions, Files, Fixtures, 
Products and Planograms. 

Status Levels Configure the sequence statuses will be used in. 

System Variables Change the values of the system variables used by Macro Space 
Management and In-Store Space Collaboration. 

Tax Codes Set the values of the tax bands used for merchandise. 

Units Set the units used for information. 

User Defined 
Attributes 

Set the options for information associated with Users, Stores, Files, 
Fixtures, Products and Planograms. 

The Planning Menu 
The Planning pull down menu gives access to options used for laying out drawings 
within Macro Space Management. 

 

Option Comment 

Hatch Styles Hatch styles allow the user to configure the patterns used to color in Zones.   

Scales Scales allows the user to specify the scales used in Paper Space in AutoCAD 
(Planner Module). 

Text Styles Text Styles are the parameters used for annotation within the drawing. 

Title Blocks Title Blocks are used in Paper Space in AutoCAD (Planner Module) to display 
information about the store plan. 

Zone Types Zone Types are the broad classes Zone Definitions fall into. 

Zone 
Definitions 

Zone Definitions are areas of a store plan used for a specific retailing purpose. 
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The Merchandising Menu 
The Merchandising menu gives access to options used for Products and Planograms. 

 

Option Comment 

Adjacency Rules Allows the user to specify rules on which products should or should not 
be adjacent to each other. 

Severity Types Allows the use to specify the comments associated with the adjacency 
rules. 

Category Rules Allows the user to configure a list of Category Roles used in Category 
Management. 

Planogram Financial 
Weighting 

This option allows the user to specify the methods used to rank the 
financial performance of planograms. 

Planogram Import 
Styles 

This option allows the user to map import styles in third party 
planogram tools to those used in Macro Space Planning. 

Planogram 
Substitution 

Allows the user to specify which planograms to change in a floor plan. 

Product Code Types This option allows the user to specify the masks used for Product Codes. 

Ranges Specifies temperature or weight options for products. 

Seasons Allows the user to specify the seasons specifying whether time sensitive 
merchandise is valid to place. 

Strategies Allows the user to configure a list of Strategies used in Category 
Management. 

Styles This option allows users to configure Styles and Style Relationships. 

The Logs menu 
The Logs menu gives access the logs used to record user activities. 
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Options on the Logs pull down menu allow users to call dialogue boxes displaying the 
varying logs available. Only the Command Log option is active at present. 

The Security Menu 
The Security menu  gives access to options used for assigning access. 

 

Option Comment 

Security Options Security Options allows the users to specify options about passwords. 

Functional 
Security 

Functional Security allows Administrators to create users and to define the 
access allowed to those users. 

Data Security  Data Security allows Administrators to specify access to stores, products and 
statuses. 

The Tools Menu 
The Tools menu gives access to varying administrative options. 

 

Option Comment 

Purge Purge allows administrators to permanently delete items marked for deletion. 

Update 
ID Table  

This option causes the Next ID table to be manually updated. This table holds a list 
of the next primary keys to be used for specific tables in the database. If not fully up 
to date, errors can result when trying to add fixtures, planograms and so on to floor 
plans. 

Unlock 
Tables 

This option allows Administrators to check back in information in tables that might 
have been checked out for some reason - for example a software failure. 

Note: For more information on Next ID  table see the Oracle 
Retail Macro Space Planning Data Model. 
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The Window Menu 
The Window menu allows the user to arrange the windows open in the Admin module. 

 

The Cascade function arranges open drawing windows so that they overlap. 

The Minimize All function allows the user to minimize all open dialog interfaces. 

The Maximize All function allows the user to open for view all minimized dialog 
interfaces. 

The Help Menu 
The Help menu  calls this Help File. 

 

The About option displays information on the version of Macro Space Management 
currently in use. 
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2 
Master Planograms 

Master Planogram Concepts 
Master planograms provide a way of reducing the labour involved in store planning and 
the frequency with which floor plans need to be distributed. Selecting the right 
planogram to place in a floor plan has been simplified, while the frequency with which 
modified floor plans (as opposed to changed planogram designs) has been reduced. 
Master planograms act as placeholders - once placed they allow the software to 
determine what actual planogram is the best fit for the store. The basic concept is as 
follows. 

 

The master planogram acts as a placeholder.  For example it might represent the 
Chicken, Duck and Game segment of the meat category. The placeholder only contains 
header information - i t does not contain any information on equipment, merchandise or 
signage. As such the master planogram cannot be used for activities such as 
replenishment scheduling. Instead it is linked to a significant number of individual, fully 
detailed planogram designs. Functionality within Macro Space Planning allows the 
pertinent planogram to be selected for individual stores. As an example: 

Store Planogram 
Selected Details 

Convenience Planogram 1 4 feet, single bay planogram with basic selection of chicken, duck 
and game. 

Supermarket Planogram 2 8 feet, two bay planogram with larger selection of chicken, duck 
and game. 

Superstore Planogram 3 12 feet, three bay planogram with full selection of chicken, duck 
and game. 

How the business process works can be seen in the flowchart below. 
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The stages in the above diagram are as follows: 

Stage Description 

Initial 
Stage A floor plan has been created. This contains master planograms. 

7th 
June 

The retailer's batch processes are set to run every seven days. The batch process executes 
and determines it needs to publish the floor plan. It also calls the stored procedure and 
publishes all the individual planograms associated with the master planograms.  

14th 
June 

The batch process executes again. The floor plan has not been changed so it is not 
republished. The batch process calls the stored procedure that results in any necessary 
updated versions of individual planograms being published.  

21st 
June 

As on the 14th June the batch process executes again. The floor plan has not been changed 
so it is not republished. The batch process calls the stored procedure that results in any 
necessary updated versions of individual planograms being published.  

28th 
June 

The floor plan has now been updated with some different master planograms. The batch 
process executes and determines it needs to publish the floor plan. It also calls the stored 
procedure and publishes the planograms associated with the master planograms. 
Depending on settings in the Planogram Publishing configuration dialog box all 
planograms will be published or only changed planograms will be published. 

Overview of Master Planograms 
Master planograms provide a way of reducing the labour involved in store planning and 
the frequency with which floor plans need to be distributed. Selecting the right 
planogram to place in a floor plan has been simplified, while the frequency with which 
modified floor plans (as opposed to changed planogram designs) has been reduced. 
Master planograms act as placeholders - once placed they allow the software to 
determine what actual planogram is the best fit for the store. The basic concept is as 
follows. 
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A master planogram is placeholder that can be translated into a specific planogram 
revision in a floor plan. The master planogram is placed in the floor plan. At periodic 
intervals a stored procedure is run. Invoking the store procedure goes through the 
following stages: 

Stage Description 

Find Family 

All planograms that are children of the master planogram are assigned an 
identification code called a lineage. The first stage of the process is to find the 
family of planograms that share a common lineage. An example would be all 
planograms in the value range. 

Find Product 
Category 

The next stage is to find all planograms in the same category that the master 
planogram has been assigned. Ann example would be a meat planogram 

Find 
Assortment 

The next stage is to find the planogram with the assortment appropriate to the 
store cluster the store has been associated with. One planogram variant might be 
designed for an affluent area, one for a deprived one. 

Find 
Dimensions 

The overall dimensions of the planogram are determined from the fixtures within 
the floor plan that the master planogram has been placed on. 

Number of Bays 
The number of bays is determined by the number of fixtures that the master 
planogram has been assigned to. The stored procedure will look for a planogram 
of the identified length with the required number of bays. 

Revision The date of the floor plan will come into service is used to find the revision of the 
planogram that is appropriate for that date. 
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Stage Description 

Specific 
Planogram 
Identified 

After all these steps, a specific planogram will have been identified. This will be 
published for implementation at the store. If no specific planogram can be 
identified, the planogram will revert to the master planogram, requiring remedial 
action by the retailer. 

A worked example is as follows: 
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Stage Description 

Master 
Planogram 

Before the stored procedure is run the master planogram will reference a number 
of planograms. 

Find Family and 
Category 

The first stage is to identify the planograms that match both the Family and 
Category requirements. In the example above, this can be visualized as a grid 
with the planograms matching the requirements at an intersection on the grid. In 
this event we are looking for planograms in the Standard Family and the Poultry 
category. This will reduce the poll of planograms to a smaller subset. 

Find 
Assortment 

The next stage is to identify if any of the remaining subset of subset of the 
planograms  has been assigned a product assortment that is optimized for the 
store cluster the store is in. If so, those planograms will be selected, further 
reducing the size of the selected subset. 

Find 
Dimensions and 
Number of Bays 

The next stage is to establish the overall dimensions of the planograms. This is 
done by determining the cumulative dimensions of the fixtures the master 
planogram has been placed on. The number of fixtures selected is equivalent to 
the number of bays. This information on overall size and number of bays is used 
to further reduce the size of the subset of selected planograms. 

Revision 

The final stage is to look at the date any of the planograms in the selected subset 
become available from. The date selected is the closest one before the date the 
floor plan is scheduled to go into service. This should result in a single planogram 
being selected from those referenced by the master planogram. 

Specific 
Planogram 
Identified 

At the end of this process the most appropriate planogram should have been 
selected from the list of those referenced by the master planogram. If a pertinent 
planogram cannot be identified, the application will default back to the master 
planogram.  

Configuring the Use of Master Planograms 
This section gives and overview of the actions required to implement Master 
Planograms. This requires a number of actions outside of the Macro Space Planning 
application. The flowchart below shows the main considerations but should not be 
considered exhaustive. Actions in solid outlines are carried out within Macro space 
Planning (MSP). Actions in dotted outlines are carried out in other parts of the retailer's 
systems. 
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Planogram Design 
Planogram design is done externally to Macro Space Planning (MSP). There are two ways 
that planogram design can be executed. 

Store Specific Planograms 
If the planogram design program is generating (for example) store specific planograms 
then there will be a relationship between the master planogram design and its store 
specific variants. This information can be used during the import process to bring in an 
already defined relationship between planograms. 

Individually Designed Planograms  
If planograms are being created on a case by case basis these can be imported into MSP 
as individual planograms. In  this event the link between master planogram and 
individual planograms has to be created within MSP. 

Planogram Import 
As planograms are created externally to MSP, they have to be imported into the 
application. This is done via the MSP XML Planogram Importer. It is the responsibility 
of the implementer to create a suitable XML file for import. 

Store Clustering 
Many retailers cluster stores into groupings that share similar characteristics for example 
size and customer demographic.  This information has to be imported into MSP and 
associated with the pertinent store. It will later be used to identify and cluster specific 
assortments. 

Note: Store clustering should not be confused with the store 
clusters in the Store Manager hierarchy. One is a clustering 
of stores defined by statistical analysis, the other an arbitrary 
grouping of stores to assist store planner navigating through 
the hierarchy.  
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Category Management and Assortment Planning 
The category management process is external to MSP. Some category management 
processes generate assortments tailored to specific store clusterings. This information can 
be imported into MSP. 

Implementation 
The Master Planogram process is run via a stored procedure. This stored procedure can 
be edited to customise it for a specific retailer's business processes.  

Macro Space Planning 
Once planograms and master planograms have been brought into Macro Space Planning, 
they can be used in floor planning, Master planograms act as placeholders. When 
planograms are published, functionality within the software will check if master 
planograms are present in a floor plan. If they are, the functionality will find the 
individual planograms that are mapped to master planograms and publish those 
individual planograms. This is a way of reducing the number of times individual floor 
plans have to be published because as long as the position of the master planograms is 
unchanged, the floor plan will remain unchanged. 

Store Operations 
Two Oracle applications in the Macro Space Planning application suite impact on store 
operations. The first is In-Store Space Collaboration (ISSC).  This is web enabled 
application that allows store planners to see the floor plan, run KPIs and carry out tasks 
like printing planograms. The second is ISSC mobile.  This is a hand portable device that 
allows floor plans, KPIs and so to be viewed.  

Retailer Systems 
Information on planograms is used by other retailer systems. An example is the 
replenishment systems need to ensure that merchandise arrives in the stores in time for 
the planograms to be executed on the desired dates.  If a master planogram in a floor 
plan has no individual planograms associated with it, then a number of remedial actions 
will be required: 

 Planograms pertinent to the master planogram must be created 

 Replenishment will not execute correctly because there is on information on the 
associated merchandise. A method of mitigation will be required. 

 Depending on the retailer's systems, other corrective actions may be required if a 
master planogram does not have a defined individual planogram associated with 
it. 

Compliance and Replenishment 
Master Planograms give the option of improving compliance. Consider the flowchart 
below: 
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A batch process executes at regular intervals. If it finds that both the floor plan and 
planograms have changed, it publishes the updated versions of both. If just the 
planograms have changed, it only publishes planograms.  

Use of Master Planograms 
 Master planograms provide a way of reducing the effort involved in store planning. 
However, there are two factors that should be considered carefully: compliance and 
replenishment. 

Compliance 
Master planograms present a useful way of verifying compliance in store.  For master 
planograms to work, each master planogram must have an individual planogram 
pertinent to the floor plan associated with it.  With master planograms present in a floor 
plan, running a test publish exercise will highlight any master planograms that do not 
have real life equivalents.  

Replenishment 
Master Planograms should be operated such that each master planograms has an specific 
individual planogram mapped to it that meets the criteria for being published when 
planogram publishing is executed. If no such mapping exists, then when Planogram 
Publishing is executed, the master planogram will be published in place of the individual 
planogram.  This will have two consequences: 

 The master planogram report will be sent to the store. This planogram design is 
not capable of being executed by the store. 

 The master planogram does not contain the information required by the 
replenishment system to start ordering products for planogram execution in a 
timely manner. 

Accordingly, the KPIs and reports in Macro space Planning must be able to identify all 
master planograms in floor plans that do not map to specific individual planograms. 

Stored Procedure 
Master planogram functionality is dependent on a stored procedure called Get Specific 
POG. This stored procedure is referenced by the code and must be present in the 
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database. It can be customized by editing it, but the same inputs and outputs must be 
present. The following functionality in Marco Space Planning is dependent on this stored 
procedure: 

Macro Space Planning 
 Planogram Publishing in the Planner module. 

 Planogram Publishing in the  Merchandiser module. 

 Planogram Publishing when run as a batch process. 

In-Store Space Collaboration 
 Planogram Publishing 

 Planogram View 

ISSC Mobile 
 Floor Plan Changes KPI 

 Planogram Changes KPI 

Creating Master Planograms 
If a retailer is not creating store specific planograms, it is possible to create master 
planograms within Macro Space Planning. The basic logic is covered in the flowchart 
below.  

 

Import of Information 
The majority of the required information comes from the retailer's category management 
system. 

Information Description 

Categories and 
Sub-Categories 

Product categories are divided into sub-categories. Many retailers have 
planogram design policies where each sub-category has a specific sub-set of 
planograms associated with it. These planograms way vary in (for example) 
length or the specific product assortment associated with it. If this is the case a 
master planogram can be designed for each sub-category.   
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Information Description 

Store Clustering 
and Cluster 
Specific 
Assortments 

Most large retail chains cluster their stores based in shared characteristics. 
 Examples would include the customer demographic and the size of the store. 
A specific product assortment is then calculated for each store cluster. 

Information associated with the master planogram can then be used to identify the child 
planograms. 

Creating the Master Planogram 
The master planogram is essentially a set of header information with no information on 
equipment, merchandise or signage. This information includes: 

Note: See the Oracle Retail Macro Space Planning Data Model 
for full information on all mandatory fields to populate in 
the database. 

Information Description 

Primary Key 
[Mandatory] Unique identifier for master planogram. 

Planogram name 
[Mandatory] Pertinent description for master planogram 

Sub-Category 
[Mandatory] Which segment of the category the planogram caters for 

Assortment Code 
{Mandatory] 

Which store specific cluster the assortment of products in the planogram is 
designed for. This data can also be used to infer the cluster the store belongs to. 

Family [Optional] Which family the planogram belongs to. This is the Family Code in the 
Planogram definition. 

Lineage 
 [Optional] 

Which generic collection of planograms the planogram belongs to. This is the 
Planogram Client Code in the planogram description. 

Effective Date 
[Mandatory] 

This is the date the master planogram has become effective. This will normally 
be set to the date the master planogram is created so it can be used immediately. 

Expiry Date 
[Mandatory] 

This is the date that the planogram will be removed from service. It will 
generally be set to an indefinite date in the future as the master planogram will 
only be changes if there is a substantial revision to the category it belongs to. 

 

As several hundred master planograms will be required, it will often be easier to create 
them with a script or stored procedure. 
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3 
BatchRunner, Automated Calculations and 

Batch Processes 
Overview of BatchRunner 

BatchRunner is a small .exe used to execute batch operations. Although BatchRunner 
cannot be accessed from the Administration Module, many of the batch operations 
configured in the module require BatchRunner to execute them. The following brief 
section has been included in this user guide for the benefit of Administrators and System 
Analysts. 

Accessing BatchRunner 
BatchRunner is installed on the local drive of every computer Macro Space Management 
is installed on. It can be found in the C:\Program Files\Oracle 
Retail\MSM\Common.Net folder. Access to BatchRunner functionality is controlled via 
the Automation options in the Group Relationships tab of the Functional Security dialog 
box accessed from the Security menu. Any Macro Space Planning user can access 
BatchRunner, but permission to run floor plan processing, floor plan publishing, 
planogram publishing and planogram substitution has to be explicitly granted. Users 
trying to run those functions without the appropriate permissions will receive an error 
message.   

Running BatchRunner 
BatchRunner is run from the command line. Although BatchRunner can be run manually 
from the command line, it is more often done through a scheduling tool. More 
sophisticated scheduling tools can enter the switch parameters directly into the 
command line. Alternatively, the scheduler can be used to invoke small DOS batch files 
containing the switch details. 

 

The user accessing BatchRunner will need to enter the username and password they have 
been assigned to give them access to MSM. They will also need to have been assigned 
permissions in the Functional Security dialog box (Security menu) to use the 
functionality they are invoking. 

BatchRunner Options 
BatchRunner can run the following batch processes: 
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Note: See following section for details of command line 
switches. 

Floor Plan Processing 
Batch floor plan processing is used to ensure that each AutoCAD floor plan is contains 
the same information as the database without the need to manually open each floor plan 
in turn. The options are: 

 Synchronizing the floor plan 

 Refreshing the annotation 

 Updating calculations such as Allocated Areas and Fixture Adjacencies (required 
for accurate reporting). 

Details of how these options execute are determined either by command line switches or 
by settings in the Floor Plan Publishing Configuration dialog box. 

Floor Plan Publishing 
This allows floor plans to be published to specified Windows directories at specified 
dates. Floor plans may be published as DWG, DWF and PDF files. Alternatively, they 
may be printed in hard copy form at a specified printer. How floor plans are published is 
configured in the Floor Plan Publishing Configuration dialog box accessed from the 
File menu. Batch floor plan publishing is run via the command line. There are only a 
limited number of command line options available, so the required settings must be 
configured in the dialog box. 

Planogram Publishing 
This allows planograms to be published to specified Windows directories at specified 
dates. Planogram designs may be published as PDF files. Alternatively, they may be 
printed in hard copy form. How planograms are published is configured in the 
Planogram Publishing Configuration dialog box accessed from the File menu. 
Planogram publishing is run via the command line. There are only a limited number of 
command line options available, so the required settings must be configured in the 
dialog box. 

Planogram Substitution 
This allows one or more planograms to be substituted for one or more planograms across 
multiple floor plans. The planogram substitutions must first be defined in the planogram 
substitution dialog box (accessed from the Merchandising menu). Planogram 
substitution can then be run as a batch process using command line switches. 

BatchRunner Command Line Options 
Detailed descriptions of the BatchRunner command line options are given in the 
pertinent sections of this help file. A summary is given below. 

Note: Switches are not case sensitive: /t and /T will have the 
same effect. Also note that only the /t (terminate) switch is 
available for floor plan processing, floor plan publishing and 
planogram publishing. 

Floor Plan Processing 
The Syntax for Batch Operations will be of the format: 
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BatchRunner /processplans username/password /t 

/substitution 
This tells BatchRunner this set of commands is for floor plan processing. 

username/password 
The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run floor plan processing in the Functional Security dialog box). 

The /t Switch 
The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running floor plan processing operations. 

Floor Plan Publishing 
The Syntax for Batch Operations will be of the format: 
BatchRunner /publishplans username/password /t 

/publishplans 
This tells BatchRunner this set of commands is for floor plan publishing. 

username/password 
The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run floor plan publishing in the Functional Security dialog box). 

The /c Switch 
The /c switch is an optional switch. This identifies the stores filter that is to be applied to 
the Process Plans process. The stores will be identified by a comma separated list of store 
codes.  If the /c switch is included only floor plans that belong to a store listed will be 
processed. The syntax will be of the form:  
BatchRunner /processplans username/password /c 0001, 0010, “1,2”  

Note: If a store code includes a comma, it must be enclosed 
in double quotes. 

The /t Switch 
The /t switch allows the external program invoking floor plan publishing to terminate 
execution of any running floor plan publishing operations. 

Combinations of Filtering Switches 
There are three filtering switches: \c, \s and OUTOFSYNC). A floor plan must meet the 
criteria of all of the switches in order to be processed. 

Planogram Publishing 
The Syntax for Batch Operations will be of the format: 
BatchRunner /publishpogs username/password /t 

/publishpogs 
This tells BatchRunner this set of commands is for planogram publishing. 
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username/password 
The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run planogram publishing in the Functional Security dialog box). 

The /t Switch 
The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running planogram publishing operations. 

Planogram Substitution 
The Syntax for Batch Operations will be of the format: 
BatchRunner /substitution user name/password [/t] [/p] [/e definition_name_1, 
definition_name_2, …, definition_name_n] [/c code_1,code_2, …,code_n] [/s id_1, 
id_2, …, id_n] 

/substitution 
This tells BatchRunner this set of commands is for planogram substitution. 

username/password 
The user name/password is mandatory. (The user must also have been assigned the 
right to run planogram substitutions in the Functional Security dialog box). 

The /t Switch 
The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running planogram substitution definitions. 

The /p Switch 
The /p switch allows the external program invoking planogram substitution to pause 
execution of any running planogram substitution definitions. 

The /e Switch 
The /e switch is optional. It can be used to specify a list of planogram substitutions to 
run. 

The /c Switch 
The /c switch is an optional switch. This identifies the stores filter that is to be applied to 
the Publish Planograms process. The stores will be identified by a comma separated list 
of store codes.  If the /c switch is included only planograms that belong to a listed store 
will be processed. The syntax will be of the form:  
BatchRunner /processplans username/password /c 0001, 0010, “1,2”  

Note: If a store code includes a comma, it must be enclosed 
in double quotes. 

The /s Switch 
The /s switch is optional. It can be used to specify the list of file statuses against which 
planogram substitutions should be run. 

Note: for more detail on these switches, see the section on 
configuring planogram substitutions. 
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Automated Calculations 
Automated Calculations are used to ensure the information held in the database has 
been updated for reporting purposes. It provides an alternative to some of the options in 
batch floor plan processing or the options in the pre-processing tab of the Floor Plan 
Publishing Configuration dialog box in the Administration module. 

 

Automated Calculations can be run manually from the dialog box accessed from the 
provided shortcuts or run directly from the C:\Program Files\Oracle 
Retail\MSM\Common folder. They can also be run from the command lobe using the 
following syntax: 
Path\AVT5AutomatedCalcs.exe /Silent /Options /Status /Files 
An example would be: 
C:\Program Files\Oracle Retail\MSM\Common\AVT5AutomatedCalcs.exe /Silent /Options 
25 /Status 23|25|27 

Command Line Options 

Path and File Name 
The path is the location where the AVT5AutomatedCalcs.exe file is located. 

/Silent 
This option is used to suppress confirmatory dialog boxes when automated calculations 
are being run in batch mode. 

/Options 
This is a bitwise value specifying the selected options. 

Value Calculation 

0 No selection 

1 Aisle Adjacency 

2 Allocated Areas 

4 Face Planes 

8 Fixture Adjacencies 
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Value Calculation 

16 Product Adjacencies 

32 Space Measurements 

/Status 
The statuses for files to process are specified as pipe delimited STA_ID's from the Status 
table: for example 23|25|27. 

/Files 
The IDs of specific files to process are specified as a comma separated list of FIL_IDs 
from the File table: for example 235, 483, 679. 

Note: For more information on the Status  and File tables see 
the Oracle Retail Macro Space Planning Data Model. 
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4 
Business Processes for Floor Plan and 

Planogram Tools 
Information in Planner Floor Plans and the Database 

When considering batch processes, it is useful to understand how Macro Space Planning 
stores and processes data. 

The Macro Space Planning Database 
All information is held in the Macro Space Planning database. This information can be 
viewed and edited manually in one of three ways: 

 Via an AutoCAD based floor plan in the Planner module. 

 Via the Virtual Reality representation in the Merchandiser Module 

 Via the simple graphic interface in the In-Store Space Collaboration application. 

Data may also be modified directly in the database by means of batch processes. An 
example of this is running planogram substitutions. 

 

Reading and Writing Data in the Database 
If a floor plan is viewed or edited in the Merchandiser module or in the In-Store Space 
Collaboration application, data is written directly to and from the database. Any changes 
made in one application are immediately visible in the other. Changes made by a batch 
process are written directly to the database and are also visible immediately in the 
Merchandiser module or in the In-Store Space Collaboration application. The situation is 
more complex for the AutoCAD floor plan in Planner. 

Changes made Manually in Planner 
What is read from or written back to the database during manual editing varies 
considerably depending on whether Auto-Synchronization or Dynamic Synchronization 
is turned on. 

 If Auto-Synchronization is on, changes made in the database are automatically 
applied to the AutoCAD floor plan when it is opened. This includes changes 
made manually in the Merchandiser module or in the In-Store Space 
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Collaboration application and by batch processes. If Auto-Synchronization is Off, 
any changes that exist purely in the database will not be reflected in the 
AutoCAD floor plan and such changes must be included by manual 
synchronization. 

 If Dynamic Synchronization is on, changes made to the majority of (but not all) 
changes made to objects in the floor plan using AutoCAD (rather than Planner) 
functionality are written to the database at the time. If Dynamic Synchronization 
is Off, any changes that exist purely in the AutoCAD floor plan may not be 
reflected in the database and such changes must be included by manual 
synchronization. 

This means that changes made in the Merchandiser module or in the In-Store Space 
Collaboration application, made by batch processes or made by AutoCAD tools may 
result in differences in the data held in the database and in the AutoCAD version of the 
floor plan. Store planners working in Planner thus need to follow a clear business process 
to ensure that the information in the database and AutoCAD floor plan remain consistent 
with each other. 

Changes Made by Batch Processes Prior to  Publishing Floor Plans 
The differences between the database and the information held in the Planner AutoCAD 
floor plan achieve their greatest significance when considering floor plan publishing. The 
floor plan that is published is the copy held in the Windows folder on the Macro Space 
Planning file server. If changes have been made to the database by a batch process (for 
example planogram substitution) immediately prior to publishing the floor plan, those 
changes will not yet be reflected in those Planner AutoCAD floor plan. Those floor plans 
need to be processed prior to publishing to update the products, annotation and any 
associated calculations. This can be done as a discrete Floor Plan Processing operation 
run via BatchRunner and the command line. Alternatively, it can be done by using the 
Floor Plan Processing built into the Floor Plan Publishing process. 

Overview of Automated Floor Plan and Planogram Publishing 

Introduction 
Macro Space Planning is a store planning tool that allows store plans to be created with 
the aid of imported planograms. After the floor plans have been created, the information 
needs to be transmitted to the store and executed there. This process is normally 
executed by administrators, but a brief explanation has been included in the store 
planning help for the benefit of store planners. 

How the Process is Configured and Operated 
The process is configured in the Administration module using the Configure Floor Plan 
Publishing and Configure Planogram Publishing options accessed from the File menu. 
The process can then run by invoking a small Macro Space Planning tool called 
BatchRunner. The precise way BatchRunner operates is controlled by command line 
switches. BatchRunner is normally initiated by a scheduling tool. More sophisticated 
scheduling tools can automatically pass the command line switches to BatchRunner. The 
scheduling tool can also operate a small utility called UpdateStatus.exe.  This is used to 
change the status of the floor plan from Published to Current. 

BatchRunner and UpdateStatus.exe 
BatchRunner can be found in the C:\Program Files\Oracle Retail\MSM\Common.Net 
folder on each MSM installation. Access to the functionality is controlled in the 
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Functional Security dialog box in the Administration Module. BatchRunner is controlled 
via the command line and can run the following operations: 

 Processing Floor Plans (running operations such as calculations and restructure 
drawing). 

 Publishing Floor Plans. 

 Publishing Planograms. 

 Executing Planogram Substitution and Revision Changes. 

UpdateStatus.exe can be found in the C:\Program Files\Oracle Retail\MSM\Common 
folder in each MSM installation. Access to the functionality is controlled in the Functional 
Security dialog box in the Administration Module. When executed, UpdateStatus.exe 
changes the status of files from Published to Current when the Effective Date is reached 
or exceeded. 

Other Business Processes 
Retailers will also have business processes for carrying out actions associated with 
implementing those floor plans and planograms that are outside of the scope of Macro 
Space Planning. These include giving the stores access to the published floor plans and 
planograms and putting the necessary orders into the supply chain. 

Reports 
As installed, Macro Space Planning does not provide any reports for monitoring the 
results of batch process controlled floor plan processing, floor plan publishing, 
planogram publishing or planogram substitution. It is the retailer's responsibility to 
provide these. 

Automated Floor Plan and Planogram Publishing 
The basic process is described in the flow chart below. Conceptually, it can be viewed as 
taking place in the following general stages: 

1. A store plan is created and set to Authorized status. At the same time the Publish 
and Effective Dates are set. 

2. BatchRunner will initiate the publishing of both floor plans and planograms to 
specified directories or printers when the Publish Dates are reached or exceeded. 

3. Reaching the Publish date is also the trigger for the retail chain to notify the store that 
the floor plans and planograms are available in specified locations. The retail chain 
will also initiate ordering the required equipment and merchandise. 

4. When the Current Date is reached, Update Status will change the status of the floor 
plan to Current. This is the signal to put it into service in the store. 

 



Overview of Automated Floor Plan and Planogram Publishing 

32 Oracle Retail Macro Space Management 

 

This may be seen in slightly simplified form in this process flowchart: 
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Details of Process 

Note: floor plans and planogram designs can either be 
published in electronic form or printed as a hard copy. This 
example assumes electronic form: it is equally applicable for 
printed documentation. 

Generating Floor Plans 
For floor plans to be published they must first be at Authorized status with  Publish Date 
and Effective Date set. These dates act as triggers for successive action. 

Generating Planogram Designs 
Planogram designs are normally imported into Macro Space Planning. There is a chain of 
logic determining when the planogram design is published. 

 When the Publish Date is met or exceeded the planogram will be published. This 
will set the Last Published Date. 

 If the Last Modified Date exceeds the Last Published Date, the planogram will 
also be published - this indicates that a modification has been made to the 
planogram. 

Floor Plan Publishing 
The first stage of the process is to publish the floor plan. For an automated process, this is 
done via the BatchRunner utility. This will be run by a scheduling tool at regular 
intervals. When BatchRunner identifies that a Publish Date has been met or exceeded it 
changes the status of the floor plan from Authorised to Published. Simultaneously, the 
Floor Plan Publishing tool sends a copy of the floor plan to a Windows folder structure 
under the Floor Plan Publishing root specified in the Directories Tab of the Configuration 
Module. (This tab can only be accessed by opening the Configuration Module in the 
Administration Module). 

Floor Plan Publishing and Floor Plan Processing 
Floor plan processing allows the AutoCAD drawing representing the floor plan to be 
refreshed with the latest changes. For example, if planogram substitution has been 
carried out, the AutoCAD drawing will have to be synchronized relative to the database, 
have annotation refresh and have the calculations refreshed prior to publishing the floor 
plan. This can be done as a separate option via the command line or it can be done 
during the floor plan publishing process using options specified in the Floor Plan 
Publishing Configuration dialog box. 

Another use of floor plan processing is to run calculations prior to running reports to 
ensure the data used for the reports is fully up to date. 

Note: The flowchart above assumes floor plan processing is 
carried out as part of the floor plan publishing process.   

Planogram Publishing 
In parallel with publishing the floor plan, a set of planogram designs need to be sent to 
the store. For a routine update, this will just be the planograms that are being changed. 
For a remodel, a full set of planogram designs will be required. For an automated 
process, this is done via the BatchRunner utility. This will be run by a scheduling tool at 
regular intervals. When BatchRunner identifies that the planogram needs to be published 
by comparing Publish Date, Last Published Date and Last Modified Date, it will cause 
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that planogram to be published to a Windows folder structure under the Planogram 
Publishing root specified in the Directories Tab of the Configuration Module. (This tab 
can only be accessed by opening the Configuration Module in the Administration 
Module). 

Note: Depending in settings in the Planogram Publishing 
Configuration dialog box in the Administration module, the 
planogram designs sent to the windows folder will either be 
a complete set of planograms for the store or just the 
planograms that have been recently updated or revised. 

Notification that Information has been Published 
The Floor Plan and Planogram Publishing functionality will send copies of the floor plans 
and planograms to specified Windows folders. Notifying the store that new floor plans 
and planograms are available and ensuring that the store can access that information is 
the responsibility of the retailer. 

Implementation Actions by Retailer 
After the floor plans and planogram designs have been published, preparations need to 
be made for executing them in store. This is a retailer responsibility - Macro Space 
Planning can provide the data to orchestrate those actions. 

Executing the Changes 
The floor plan also has an Effective Date. UpdateStatus.exe (run at intervals by a 
scheduling tool) will identify when the Effective Date is met or exceeded and then 
change the floor plan status to Current. When a floor plan reaches Current status, this is a 
signal to the store that all planned changes should have been executed on that date and 
the floor plan put into service. 

At the same time as the floor plan is changed to current, its properties are changed to 
read only to prevent further changes being made in it. The floor plan being changes to 
current also causes the floor plan it replaces to be changed to Historical status. 

Overview of Automated Planogram Substitution 

Introduction 
Macro Space Planning allows users with the appropriate privileges to first define 
planogram substitutions and then to execute those substitutions in selected stores. This 
section has been included to show how a floor plan can be updated with a different suite 
of planograms using batch processes. The updated floor plans (and new planogram 
designs) can then be published by batch processes in turn. 

There are several ways of accomplishing this: the diagram below shows how a Current 
floor plan can be used to generate a duplicated file incorporating the required planogram 
substitutions. 

Note: This example assumes the 
PLANOGRAM_SUBSTITUTION_COPY_FILE system 
variable is set to On (allowing floor plans of Current Status 
to be modified by Planogram Substitution) and that 
planogram substitution definitions have been set up 
accordingly. 



Overview of Automated Planogram Substitution 

 

Business Processes for Floor Plan and Planogram Tools 35 

How the Process is Configured and Operated 
Planogram Substitutions are configured in the Planogram Substitution dialog box. This 
can be accessed from the Administration Module, the Planner Module, the Merchandiser 
Module and directly from the provided shortcut. BatchRunner is capable of running 
those planogram substitutions against a specified floor plan - in this case a floor plan at 
Current status in a specific store. 

 

 

As a result of running the planogram substitution a duplicate floor plan will be created in 
the same revision at Authorized status. This floor plan will have the Publish Date set to 
the Effective Start Date of the Planogram Substitution. The Effective Date of the floor 
plan will be set based on the Publish Data of the floor plan and the time interval specified 
in the EFFECTIVE_DATE_LEAD_PERIOD system variable. The AutoCAD version of this 
floor plan will be an exact copy of the floor plan it was cloned from as the planogram 
substitutions were executed purely in the database. 

The next stage is therefore to use floor plan processing to update the AutoCAD version of 
the floor plan so it reflects the revised information in the database. This is done by means 
of the Floor Plan Processing option. BatchRunner can run varying options depending on 
the switches used in the command line.  The options required are: 

 Synchronization: 'Match the Database' will bring in the planogram substitutions 
held in the database. (An alternative is to use the Auto-Sync option). 

 Annotation: The new planograms will require the annotation refreshed to reflect 
the changes. 

 Calculations: These require updating so that any subsequent reporting will be 
accurate. 

Note: Floor Plan Publishing has the option to carry out floor 
plan processing as part of the publishing process. This 
example shows how floor plan processing can be run as a 
separate operation. One reason for doing this would be a 
store planner briefly looking at the duplicated store plan 
before submitting it for the floor plan publishing operation.   
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Note: If the duplicated floor plan is opened in the 
Merchandiser Module or in In-Store Space Collaboration, the 
information is read directly from the database and no 
synchronization is needed. However, it is the AutoCAD 
version of the floor plan that is published; this needs to be 
updated before Floor Plan Publishing is carried out. 

Once the AutoCAD version of the floor plan has been processed, it will be identical to the 
information held in the database. As it is at Authorized status with the Publish Date and 
Effective Date set, the floor plan will be published by any automated floor plan 
publishing process when the Publish Date is reached of exceeded. 

Reports 
As installed, Macro Space Planning does not provide any reports for monitoring the 
results of batch process controlled planogram substitution. These would normally be 
configured during the implementation process to requirements specified by the retailer. 

Immediate Publishing of Planograms 

Overview of Immediate Publishing 
The majority of retail organizations will publish floor plans and planograms as part of an 
overnight batch process. This process can be scheduled on different frequencies varying 
from daily to weekly. Occasions will inevitably occur when there is a need to publish 
information before the next scheduled batch run. Merchandiser has two tools to assist in 
this process. 

 Immediate Planogram Publishing: Publish selected planograms. Depending on a 
setting in the Administration module this can be either be planograms that have 
met or exceeded their Publish date or all planograms. 

 Print Planograms: This allows a store planner to print off a copy of selected 
planograms in the currently active floor plan. 

Access to Immediate Planogram Publishing is controlled by settings in the Functional 
Security dialog box in the Administration module. Planograms can be printed from the 
currently active store plan by any users with access rights. 

Note: The option to Immediately Publish floor Plans is 
available from the File menu in the Planner module. 

Immediate Publishing of Planograms 
This option is for urgent publishing of planograms. An example of this would be if 
planograms are being published and transmitted to store by a weekly batch process. If 
this batch process ran every weekend, there might be a need to publish selected 
planograms in mid-week so as to avoid waiting for the next scheduled batch run. 

Permission to Access the Immediate Planogram Publishing Functionality 
Because the Immediate Planogram Publishing option could result in large numbers of 
planograms being published during working hours (with the corresponding load on the 
system), users require permission to access to the functionality. This is done in the Group 
Relationships tab of the Functional Security dialog box in the Administration Module. 
Users without this permission will not be able to open the dialog box. 
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The Immediate Planogram Publishing Dialog Box 
The Immediate Planogram Publishing dialog box is accessed from the File menu. It opens 
with the same settings as those for batch processing - these are configured using the 
Configure Planogram Publishing dialog box in the Administration Module. Planograms 
can be selected for publishing by ticking the check boxes and then clicking OK. 

 

The quantity of planograms that appear in this dialog box depends on a setting in the 
Output tab of the Planogram Publishing Configuration dialog box in the 
Administration module. 

 If the Re-publish planogram if files are missing option is checked, all planograms 
(irrespective of whether they have been published or not) will be available for 
selection. 

 If the Re-publish planogram if files are missing option is not checked, only 
planograms that have not been published or planograms that have been 
modified since they were last published (revision changes) will be available for 
publishing. 



Immediate Publishing of Planograms 

38 Oracle Retail Macro Space Management 

Note: Care should be taken when selecting planograms for 
Immediate Planogram Publishing if the Republish 
planogram if files are missing option is checked. Planograms 
will be published for all stores that have that planogram 
placed. If a large number of planograms are selected for 
publishing, this will means a substantial amount of 
processing and significant amounts of data passed over the 
network. Running Immediate Planogram Publishing during 
the day with large amounts of planograms selected may 
slow the response for other users. 

Where Planograms Will Be Published To 
Immediate publishing of planograms will result in the files being sent to the same folders 
as used for the batch process. The root folder for this is specified in the Directory Tab of 
the Configuration Module. (This tab can only be accessed if the Configuration Module is 
opened from the Administration Module). The file structure below the root folder and 
the form of the file name are specified in the Output tab of the Planogram Publishing 
Configuration dialog box in the Administration module. 

Other Planogram Publishing Tabs 
 Templates: The Templates tab allows the user to select the form the planogram 

definition will be output in. 

 Collation: The Collation tab determines the way planograms will be published 
below the Planogram Publishing root. 

 Validation: These are the checks that are performed before the floor plan is 
published. Any individual floor plan that fails validation will not be published, 
while an entry will be written to the pertinent log table. 

Printing Planograms 
The Planogram Printing option is called from the File menu and allows planograms from 
the currently active floor plan to be printed. The selected planograms will be sent to the 
default printer for the computer Macro Space Management is running on. Planograms 
can be selected for printing by ticking the check boxes and then clicking OK. 



Immediate Publishing of Planograms 
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Planograms are selected in the Filtering tab, with the type of report required selected in 
the Templates tab. (These templates are configured in the report designer module). The 
sequence the planograms are printed in is specified in the Collation tab. This is useful if 
large numbers of planograms are being printed
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5 
File Options 

Configuration Module 

Overview of the Configuration Module 
The Configuration module allows users to configure local aspects of their installation of 
Macro Space Management. If opened via the Admin module, the full range of 
configuration options is available. If opened from any other Macro Space Planning 
modules, a more restricted range of tabs will be available. 

 

Note: for more information see the help file for the 
Configuration module. 
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Overview of Floor Plan and Planogram Publishing 

Structure of Floor Plan and Planogram Publishing 
This section of help is intended to give a top level view of Printing and Publishing Floor 
Plans and Planograms. (The next section will discuss it in more detail). It is important 
that Administrators understand how the functionality in different modules interconnects 
as this will allow the functionality to be correctly configured and used. 

 

Administration Module 
This module is used to configure access to the different parts of the functionality. It is 
also used to assign permissions to print or publish specific floor plans and planograms. 
Finally, it is used to configure how the batch processes for publishing floor plans and 
planograms operate. 

Batch Processes 
Batch processes can be used to run Floor Plan Pre-processing, Floor Plan Publishing and 
Planogram Publishing. These batch processes are typically run overnight so that 
processor hungry tasks can be executed without affecting the manual users of the system. 

Planner Module 
The Planner module has two sorts of functionality: functionality that can be used by all 
users of the module and functionality for which permissions have to be granted in the 
Administration module 

 Functionality all users can access 

– Find and Open Floor Plans 

– Search and Print Floor Plans 

– Print Planograms (from active floor plan) 

 Functionality users require permissions for 

– Pre-Processing floor Plans 

– Immediate Publishing of Floor Plans 

– Immediate Publishing of Planograms 

Merchandiser Module 
The Merchandiser module has two sorts of functionality: functionality that can be used 
by all users of the module and functionality for which permissions have to be granted in 
the Administration module 

 Functionality all users can access 

– Print Planograms (from active floor plan) 

 Functionality users require permissions for 
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– Immediate Publishing of Planograms 

In-Store Space Collaboration Application 
This sister application to Macro Space Management gives users the ability to print 
planograms from the currently active floor plan. This is the same functionality as is 
available in the Planner and Merchandiser modules. 

Report Designer 
The Report Designer module allows users to design planogram reports that can be used 
to output information via the Planogram Publishing (batch process), Immediate 
Planogram Publishing and Planogram Printing options. 

Other Functionality 
The Configuration module allows users to specify where the folders holding published 
floor plans and planograms are located. Tables in the database hold information on the 
results of floor plan pre-processing, floor plan publishing and planogram publishing. 
These results can then be accessed via BI Publisher reports. 

Overview of Floor Plan and Planogram Publishing 
Floor Plan and Planogram Publishing is functionality that encompasses the 
Administration, Planner and Merchandiser modules in Macro Space Management and is 
also used in a limited way in the In-Store Space Collaboration application. It enables 
users to either print (hard copy form) or publish (electronic form) floor plans and 
planogram designs as an aid to implementing physical changes within stores. The 
diagram below summarizes how the functionality is configured and used. (A simpler 
form of this diagram can be found in the previous section). 
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Administration Module 
The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor plans 
and planograms. Finally, it is used to configure how the batch processes for publishing 
floor plans and planograms operate. 

Assigning Permissions 

The Administration Module has three options that affect publishing and printing of floor 
plans and planograms. 

 The Functional Security option (Security menu) allows Administrators to control 
who can run Floor Plan Pre-Processing, Floor Plan and Planogram Publishing as 
batch processes. It also controls who can access Pre-Processing Floor Plans, 
Immediate Floor Plan Publishing and Immediate Planogram Publishing in the 
Planner Module. Finally, it controls who can access Immediate Planogram 
Publishing in the Merchandiser Module. 

 The Data Security option (Security menu) allows Administrators to control what 
stores, store statuses and file statuses a user can print or publish from in the 
Planner and Merchandiser modules (and in In-Store Space Collaboration) - this 
in turn control what floor plans they see. It also allows Administrators to control 
what planograms a user can print or publish. 

  



Overview of Floor Plan and Planogram Publishing 

44 Oracle Retail Macro Space Management 

Fields in Dialog Boxes 

The Custom Query dialog box allows an Administrator to specify what fields will appear 
in the following dialog boxes: 

 Find and Open dialog box in the Planner module. 

 Search and Print dialog box in the Planner module. 

 Pre-Process Floor Plans dialog box in the Planner module. 

 Print Planograms dialog box in the Planner and Merchandiser modules and in 
the In-Store Space Collaboration functionality. 

 Immediate Floor Plan Publish dialog box in the Planner module. 

 Immediate Planogram Publish dialog box in the Planner and Merchandiser 
modules. 

Configuring Outputs for Batch Processes 

The outputs for two batch processes are configured in the administration module: 

 The Floor Plan Publishing Configuration option allows users to configure how 
floor plans will be published, either as a batch process, or immediately when 
invoked by a user in the Planner module. 

 The Planogram Publishing Configuration option allows users to configure how 
planograms will be published, either as a batch process, or immediately when 
invoked by a user in the Planner or Merchandiser modules. 

Note: the outputs for the Floor Plan Pre-processing batch 
process are configured via command line switches. 

Batch Processes 
Batch processes can be used to run Floor Plan Pre-processing, Floor Plan Publishing and 
Planogram Publishing. These batch processes are typically run overnight so that 
processor hungry tasks can be executed without affecting the manual users of the system. 

 Floor Plan Pre-Processing - running a series of calculations to make sure that 
information used for reporting, etc., is as accurate as possible. The outputs are 
configured via command line switches. 

 Floor Plan Publishing - printing or publishing all floor plans that are at or after 
their Publish Date. 

 Planogram Publishing - printing or publishing all planograms that are at or after 
their Publish Date. 

The rights to do this are set in Functional Security in the Administration Module. 

Planner Module 
The Planner module has two sorts of functionality: functionality that can be used by all 
users of the module and functionality for which permissions have to be granted in the 
Administration module. 

Functionality All Users Can Access 

 Find and Open - allowing users to list and open all floor plans they have rights 
to access. 

 Search and Print - allowing users to list and print all floor plans they have rights 
to access. 
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 Print Planograms - allowing users to list and print all planograms they have 
rights to access in the currently active floor plan. 

Functionality Users Require Permissions For 

 Pre-Processing floor Plans - allowing users to run a series of calculations on the 
floor plans they have rights to access to make sure that information used for 
reporting, etc., is as accurate as possible. 

 Immediate Publishing of Floor Plans - manually causing all floor plans they 
have rights to access and that are on or after their Publish Date to be printed or 
published. 

 Immediate Publishing of Planograms - manually causing all planograms they 
have rights to access and that are on or after their Publish Date to be printed or 
published. 

Merchandiser Module 
The Merchandiser module has two sorts of functionality: functionality that can be used 
by all users of the module and functionality for which permissions have to be granted in 
the Administration module. 

Functionality All Users Can Access 

 Print Planograms - allowing users to list and print all planograms they have 
rights to access in the currently active floor plan. 

Functionality Users Require Permissions For 

 Immediate Publishing of Planograms - manually causing all planograms they 
have rights to access and that are on or after their Publish Date to be printed or 
published. 

In-Store Space Collaboration 
Users in the In-Store Space Collaboration application can access the following 
functionality: 

 Planogram Printing - manually selecting planograms in the currently active floor 
plan for printing. 

Report Designer 
The Report Designer module allows users to design planogram reports that can be used 
to output information via the Planogram Publishing (batch process), Immediate 
Planogram Publishing and Planogram Printing options. Permission to access this module 
is assigned via Functional Security in the Administration Module. 

Other Functionality 
There are three other parts of the application that are affected by the Floor Plan and 
Planogram Publishing functionality. 

 Configuration Module - the Directories tab allows users to specify where the 
root folders holding published floor plans and planograms are located. Sub-
folders holding specific published floor plans and planograms will be created as 
children of these root folders. 

 Tables in the database hold the results of floor plan pre-processing, floor plan 
publishing and planogram publishing operations. 
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 BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of floor 
plans that have been processed. 

Business Flows and Floor Plan and Planogram Publishing 

Note: This illustration of the uses for Floor Plan and 
Planogram Publishing is a simplified example to show how 
this functionality might be used. Details of actual use are 
likely to be more complex and will be retail organization 
specific. 

Summary 
Information (in different forms) has to be distributed to different parts of retail 
organizations. Some of this information may be distributed in the form of reports. Other 
information may be distributed in the form of Floor Plans (showing the layout of 
equipment and merchandise) and Planogram Designs (showing specific arrangements of 
shelf objects and products in a planogram). 

The Floor Plan Publishing and Planogram Publishing functionality in Macro Space 
Planning provides the mechanism for distribution of Floor Plans and Planogram Designs. 
One way of achieving this is summarized in the simplified business process diagram 
below. 

 

Administrator 
The Administrator will configure who has access to the floor plan publishing and 
planogram publishing options in the Planner and Merchandiser modules. (All users with 
access to the Planner and Merchandiser modules and In-store Space Collaboration will be 
able to print planograms from the currently active floor plan). 

The Administrator will also configure the parameters determining the details of the 
output for bulk publishing of floor plans and planogram designs. These control the form 
of the output (electronic or hard copy), the pre-processing carried out to make sure the 
information presented is accurate and how the output is to be collated. 

Store Planner 
As part of the normal store planning process, a store planner will be instructed to create a 
new floor plan or revise an old one. 
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Store Plan Manager 
As part of the normal store planning process, a store planner manager will authorize the 
floor plan to come into service. As part of that process he will set the Publish Date (when 
information will be distributed to the store) and the Effective Date (when the floor plan 
will come into service). 

Reporting 
Other systems within the retail organization (for example BI Publisher running 
automated reports) generate data on the equipment and merchandise required to 
implement the floor plan. This data can then be fed into the retailer's purchasing systems 
to ensure the equipment and merchandise arrives at the store in a timely manner. 

Batch Processes 
The pertinent batch processes would be run at regular interval - possibly on a daily basis. 
When the publish date of a planogram or the floor plan is reached, those items will be 
published to a specified location. The retails will have other mechanisms to ensure that 
they are distributed to the store in question. 

Publishing a floor plan will result in the status of the floor plan changing to Published. 
Another batch process (Update Status) will change the status of the floor plan to Current 
when the Effective Date is met or exceeded. 

Store Management 
Store Management will receive a copy of the published floor plan, together with copies of 
the required planogram designs required to implement that plan. This will enable the 
store manager to start planning for the change. 

The ordering system should also have delivered the required equipment and 
merchandise at the store a short time before they are required. This will enable the store 
manager to ensure that they have the physical materials to implement the change. 

On the date the floor plan becomes Current (when the Effective Date is met or exceeded), 
the store manager and their staff can put the floor plan into service. 

Floor Plan Publishing and Status Change 
When floor plans are reviewed and accepted for subsequently being put into service, the 
status is set to Authorized and the Publish Date and Effective Dates set in the File 
Properties dialog box in Store Manager. 
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When Floor Plan Publishing is run, the status of the Floor Plan will be changed to 
Published. (Depending on settings in the Status dialog box, it may also be changed to 
Read Only). 

 

This change of status allows the progress of the floor plan through its business life cycle 
to be monitored. 

Planogram Publish and Effective Dates 
When planograms are designed, they are assigned a Publish Date and an Effective Date. 
These are set in the Details Tab of the Planogram Design dialog box in the Merchandiser 
module. 
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Publish Date is the date at which the planogram design information can be disseminated 
to the end user in preparation for implementing the planogram. This is often done by 
means of the Planogram Publishing functionality. 

Effective Date is the date at which the planogram design is scheduled to come into 
service. This is often used in conjunction with the Active Date (top of Object Browser in 
Planner and Merchandiser) to ensure that when in a floor plan is put into service it does 
not contain any planograms that are not yet ready for implementation. 

Configuring Floor Plan Publishing 

Overview of Floor Plan Publishing 

Purpose of Floor Plan Publishing 
The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing this floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 
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Note: publishing floor plans should not be confused with 
reporting on that floor plan. Reporting is used for the 
collation of information required for ordering the equipment 
and merchandise required to implement the floor plan. 
Reports will be used in conjunction with the purchasing 
system and supply chain planning in order to ensure the 
required equipment and merchandise arrive at the required 
locations in a timely manner. 

The Floor Plan Publishing functionality is used to disseminate floor plans to specified 
printers or Windows folders to facilitate implementing those floor plans. 

Note: a retail organization will still need a method of 
distributing the floor plans from the printer or Windows 
folder to the end user. 

The Floor Plan Publishing Configuration Dialog Box  
The Floor Plan Publishing Configuration dialog box is used to set up the parameters 
controlling floor plan publishing. 
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The dialog box contains five tabs; each with a specific purpose. 

Output Tab - this tab is used to configure how floor plans will be output. Settings here 
determine the folder structure and the type and naming convention for the floor plans. 

Rendering Tab - this tab is used to control the visual appearance of the floor plan: what 
layers are displayed, how it is drawn, what titles blocks or tabs to use. 

Collation Tab - this tab controls the sequence in which floor plans are published. It is 
more important when printing hard copy output. 

Pre-Processing Tab - this tab controls which pre-processing operations are run before 
publishing a floor plan. These include synchronizing, restructuring the blocks, updating 
annotation and updating the calculations used for reporting purposes. 

Validation Tab - this tab controls the validation operations used to ensure that the 
information in the floor plan will not lead to practical problems in implementing the 
floor plan. 

Using Floor Plan Publishing 
The basic method of operation is as follows: 
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1. Admin Module 

The Admin module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor 
plans and planograms. Finally, it is used to configure how the batch processes for 
publishing floor plans will work. There are four options that affect publishing and 
printing of floor plans. 

a. The Functional Security option (Security menu) allows Administrators to control 
who can run Floor Plan as a batch process. It also controls who can access 
Immediate Floor Plan Publishing in the Planner Module. 

b. The Data Security option (Security menu) allows Administrators to control what 
stores, store statuses and file statuses a user can use to print or publish from 
within the Planner module - this in turn control what floor plans they see. 

c. The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Floor Plan Publish dialog box in the Planner 
module. 

d. Configuring Outputs for Batch Process: the outputs for the batch process are 
configured in the administration module using the Floor Plan Publishing 
Configuration dialog box. 

2. Running as a Batch Processes 

Floor Plan Publishing can be run as a batch process - this is typically run overnight 
so that these processor hungry tasks can be executed without affecting the manual 
users of the system. The settings determining how Floor Plan Publishing operates 
when called by the batch process are set in the Floor Plan Publishing Configuration 
dialog box. 

Floor Plan Pre-Processing (running a series of calculations to make sure that 
information used for reporting, etc., is accurate) can either be done as a separate 
preceding batch process, or it can be done according to settings in the Pre-Processing 
Tab of the Floor Plan Publishing Configuration dialog box. 
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The rights to for both Floor Plan Pre-Processing and Floor Plan Publishing are set in 
Functional Security in the Admin Module. 

3. Planner Module  

Within the Planner module, the Immediate Publishing of Floor Plans functionality 
can only be accessed by users that have been granted permissions in the Admin 
module. 

4. Other Functionality 
There are three other items of functionality that affect floor plan publishing. 

a. Configuration Module - the Directories tab allows users to specify where the root 
folder holding published floor plans is located. Sub-folders holding specific 
published floor plans will be created as children of this root folder. 

b. Tables in the Macro Space Planning database hold the results of floor plan pre-
processing and floor plan publishing operations. 

c. BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database tables - for example the names and results of 
floor plans that have been processed. 

Dates Floor Plans will be Published 
The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing a floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 

Note: The Publish Date operates purely on the date and 
takes no account of the time. Publish Dates are stored in 
Date/Time format in the database, but the functionality only 
references the Date part of this data. 
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Another factor affecting the date at which at which floor plans will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Floor Plan Publishing 
Configuration dialog box. 

 

Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a floor plan that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if i t were running at 01.00 hrs 
in the morning of 3rd June. All  floor plans with a Publish Date of 3rd June would then be 
published. 

Criteria for Publishing Floor Plans 

There are two criteria for publishing floor plans: 

1. Publish Date has been exceeded 

If the Publish Date set in the File Properties dialog box in Store Manager matches or 
is before the current date (taking into account the Lead Time Tolerance (Hours) 
setting), the floor plan will be published. 
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2. Floor Plan has been Updated since it was Published  

In some implementations of Macro Space Planning it is possible that the floor plan 
may have been modified after it was last published. The condition for this is that the 
Modified by Planner date is greater than the Last Published Date. 

The Output Tab - Directory Structure 
The Output Tab  is used to configure how floor plans will be output. Settings here 
determine the folder structure and the type and naming convention for the floor plans. 

 

Directory Structure 
The Sample Directory text box contains an example of a path to a directory based on the 
current selections in this frame. 

 Create Layout Subfolder - if both Create Layout Subfolder and Create Store 
Subfolder are unchecked, all floor plans will be published to a single directory 
specified by the Floor Plan Publish option in the Directories tab of the 
Configuration module. If checked, the name of the layout will be added to the 
directory path below the Floor Plan Publish root. 

 Create Store Subfolder  - i f unchecked, all floor plans will be published to a 
single directory specified by the Floor Plan Publish option in the Directories tab 
of the Configuration module. If checked, the name of the store will be added to 
the directory path below the Floor Plan Publish root. 
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 Mimic Hierarchy - If Create Store Subfolder has been selected and this option is 
checked, an intermediate set of directories representing Clusters will be placed 
between the Store sub-folders and the Floor Plan Publishing root. 

 Cluster Type - this option allows the user to specify the cluster type to be used 
for the mimic hierarchy option. One type can be selected from the drop down list 
of cluster types. 

Note: for this option to work effectively, stores must have 
been assigned to cluster types in a logical way. Stores not in 
the selected cluster type will be placed in store specific sub-
folders immediately below the Floor Plan Publish root. 

 Include Week Number  - this option will add the week number to the path for 
the directory.  

Examples of Directory Structures 
The basic directory structure will be created in the sequence 

1. MSM Publish Folder 

2. Layout Name 

3. Store 

As examples: 

 With Create Layout Subfolder and Create Store Subfolder checked, a directory 
structure of MSM Publish Folder\Electrical\150 will be created where Electrical 
is an example layout name and 150 is an example store code. 

 With only the Create Layout Subfolder checked, a directory structure of MSM 
Publish Folder\Food&Drink will be created where Food&Drink is an example 
layout name. 

 With only the Create Store Subfolder checked, a directory structure of MSM 
Publish Folder\190 will be created where 190 is an example store code. 

 With neither the Create Layout Subfolder nor the Create Store Subfolder options 
checked all published floor plans will be created in the MSM Publish Folder. 

Other Settings 
 Mimic Hierarchy – this option allows users to mimic the cluster hierarchy based 

in a specific type of cluster. The Cluster type is set in the drop down list and 
corresponds to the cluster types set in the Clusters dialog box in Store Manager. 

 

 Include Week Number  - this option allows users to create further sub folders 
below the store sub-folder. These will be named based on the Active Date for the 
floor plan (set at the top of the Object Browser) and information in the Calendars 
option accessed from the General Menu. The Active Date will be compared to the 
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calendar dates associated with the 'Week' calendar type. If i t finds a match, the 
sub folder will be given the text name for that week. 

Note: this option will not work unless the Calendars option 
has been set up to include 'Week'  type information.    

Format 

The form in which the floor plan is published can be set by the radio button. It can be 
either electronic (Publish to File) or hard copy (Print). 

The following electronic formats are available: 

 AutoCAD DWG 2010 - produce the output in the form of an AutoCAD 2010 
DWG file. 

 AutoCAD DWG 2007 - produce the output in the form of an AutoCAD 2007 
DWG file. 

– If either of these options is checked, the Bind Xrefs option will be available. 
Binding Xrefs will use the AutoCAD 'Bind' rather than the 'Insert' option. 
This allows the Architectural Plan (if assigned) to be published along with 
the floor plan. 

 DWF - produce the output in the form of a Drawing Web Format (DWF) file. 

 PDF - produce the output in the form of an Adobe Portable Document Format 
(PDF) file. 

General 

 The System Publishing Lead Period sets the EFFECTIVE_DATE_LEAD_PERIOD 
system setting. This variable in turn is used to set the default publish date in the 
File Properties dialog box in Store Manager. (This date can be manually altered if 
required). 

 

When the Publish Date is reached or exceeded, Floor Plan Publishing will cause the 
floor plan to be published in either electronic or hard copy form. 
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 Lead Time Tolerance allows for the fact that some batch processes may be started 
before midnight. If a floor plan has a Publish Date of 18th June, the batch process 
could be run starting 22.00 hrs on 17th June. This would not pick up floor plans 
with Publish dates of 18th June. The Lead Time Tolerance can be set to any value 
up to 23 hours. This time will be added to the Publish Date for batch processes. 

For example, setting the Lead Time Tolerance to 6 hrs will ensure that a batch 
process started after 18.00 hrs on 17th June will publish all floor plans with a Publish 
Date of 18th June. 

 Republish Floor Plans if Missing - if selected, this option will put a fresh copy of 
the floor plan into the selected windows folders if the following circumstances 
are met: 

– A windows folder where a floor plan would be expected to be present is 
empty. 

– The Windows folder structure has been changed due to different settings in 
the output tab and an new set of folders needs to be populated with floor 
plans. 

Note: The floor plan will automatically be republished if i t has 
been modified since the last time it was published 

Publishing Structure 

If changes are made to the setting in the Format frame, the structure of the windows 
folders used to store the information will change. On closing the Planogram Publishing 
configuration dialog box, the user will be presented with a dialog box telling the user that 
the folder structure has changed. 

 

The options will have the following effect: 

 Yes - the existing structure will be purged and all subsequent floor plans 
published to the new structure. 

 No - the existing structure will be left unchanged and all subsequent floor plans 
published to the new structure. 

 Cancel - the user can go back to the dialog box and change the Directory 
Structure back to the old options. 

Print 

Selecting Print followed by Setup  brings up the standard Print dialog box. 
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This enables users to select the printer, paper orientation, etc. The sequence planogram 
designs will be printed depends on the settings in the Collation tab. 

The Output Tab - Filename Structure 
The Output Tab  is used to configure how floor plans will be output. Settings here 
determine the folder structure and the type and naming convention for the floor plans. 
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Filename Structure 
These options allow users to specify the format of the file name. It will be built up by 
combining all the selected options. 

The Sample Filename text box contains an example of a filename based on the current 
selections in this frame. 

 Prefix - this is the initial part of the file name. It can be up to 10 characters long 
and can contain any character except / \ : * ? “ < > and |. 

 Field Separator - this is the symbol used to separate the different parts of the file 
name. It can take the form of an underscore or a hyphen ( _ or - ). 

 Suffix - this is the terminating part of the file name. It can be up to 10 characters 
long and can contain any character except / \ : * ?  “ < > and |. 

 Include Store Code - the file name must include either the store code or store 
name. Which is to be used is selected by means of the radio button. 

 Include Store Name - the file name must include either the store code or store 
name. Which is to be used is selected by means of the radio button. 

Store Code and Store Name are set in the Store dialog box in Store Manager. 
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 The file name format can also include the Floor Type, Floor Description, Status 
Code or Status Description. They are selected by means of the appropriate check 
boxes. 

– Floor Type - if checked, the floor type will be included in the file name. 

– Floor Description - if checked, the floor description will be included in the 
file name. 

Floor Type is set from the drop down list in the floor dialog box in Store Manager. 
Floor Description is set in the text box in the same dialog box. 

 
– Status Code - If checked, the status code will be included in the file name. 

Status code is configured in the Status dialog box accessed from the General 
Menu of the Administration module. 
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– Status Description - If checked, the status description will be included in the 

file name. The Status for a floor plan is set in the File Properties dialog box 
accessed in Store Manager. 

 
 Include Layout will include the name of the AutoCAD Layout in the file name. 

  
 Include Date allows a date to be included in the file name. There are two options, 

one of which must be selected by mans of the Radio button. 

– Include Effective Date - this adds the Effective Date (the date the floor plan 
goes into service.  The format is set by the Format drop down list. 

– Include Week Number - this will take the Effective Date for the floor plan 
(set in the File Properties dialog box in Store Manager) and information in 
the Calendars option accessed from the General Menu. The Effective Date 
will be compared to the calendar dates associated with the 'Week' calendar 
type. If it finds a match for these dates, the sub folder will be given the text 
name for that week. 
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Note: this option will not work unless the Calendars option 
has been set up to include 'Week'  type information.     

The Rendering Tab 
The Rendering Tab  is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the check box is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 

These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Alias dialog box on the Format menu in the Planner module. 
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Change Visual Appearance 
If the check box is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 

 2D Wire Frame 

 3D Wire Frame 

 Hidden Detail 

 Shaded 

 Shaded with Edges  

 Conceptual 

 Realistic 

 

The images above show the different visual appearances available. Within the Planner 
module, the option can be set in either the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options using the radio button: 
Add Titleblock or Use Existing Layout. 

1. Add Titleblock 

If the Add Titleblock option is selected, users may select a title block from a drop 
down list. The list of available title blocks is configured using the Title Block option 
on the Planning menu in the Administration module. 
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2. Use Existing Layout 

If the Use Existing Layout option is selected, the user has two options; to publish all 
layouts except model space, or to publish selected layouts. 

 All layouts except model space 

If this option is selected, all layouts except the model space layout will be 
published for each floor plan. The layout names option will also be grayed out 
and unavailable. 

If this option is chosen, it will not be possible to republish floor plans. This is 
because without a list of specified layout names, it is not possible to determine 
which layouts require republishing. 

 Layout Names 

If this option is selected, users can enter a name matching the name of a paper 
space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down 
list is not case sensitive and the following wild cards may be used: 

Wild Card Comment 

* Any number of characters 

? Any single character 

# Any single number 

If wild cards are used, the Republish option will only publish a single match for each 
floor plan. For example, if the wildcard is Con*, the Confectionery layout will be 
published and the Consumables layout will be omitted. 

The names of the paper space tabs can be seen at the foot of the floor plan in the 
Planner module. In the example below they are named Overall Store, Food and 
Drink, Electrical and Clothing. 

 

If multiple layout names are required, these should be separated by a comma. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the floor plans will be published 
or printed in. Its main use is in printing hard copy versions of floor plans where the 
sequence they are printed in makes it easier to sort and distribute them after printing. 

At least one collation option must be selected, or the tab will show as having an error. 
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 

 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 
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 Floor Type is the type selected from the drop down list in the Floor dialog box in 
Store Manager. 

 Floor Description is the Description in the Floor dialog box in Store Manager. 

 

 Revision Number is the Revision Number in the Revision dialog box in Store 
Manager. 

 Revision Name is the Revision Description in the Revision dialog box in Store 
Manager. 
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 Publish Date is the Publish Date set in the File Properties dialog box in Store 
Manager. 

 Effective Date is the Effective Date set in the File Properties dialog box in Store 
Manager. 

 

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 

 Changes have been made in the floor plan using AutoCAD tools and these 
changes have not been written to the database. 

 Changes have been manually made to floor plans in the Merchandiser module, 
or in In-Store Space Collaboration. 

 Changes have been made to floor plans in the database by batch processes. 

 Changes have been made to the floor plan outside Macro Space Planning - for 
example in raw AutoCAD. 

The following options are available: 

 None - no synchronization operations will be carried out. 

 Auto-Synchronize - the application will automatically detect which form of 
synchronization is required: 

– If the information in the database exceeds the date the floor plan was last 
modified and saved in Planner (or modified in raw AutoCAD), the 
information will be synchronized "match the database". 

– If the date of the information in the floor plan (or the date it was modified in 
raw AutoCAD) exceeds the date the information was written to the database, 
the information will be synchronized "match the drawing". 
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– If (i) the date the floor plan was last modified in raw AutoCAD exceeds the 
date the floor plan was last modified in Planner and (ii) the date the floor 
plan was last modified in Planner is less than the date the floor plan was last 
modified in Merchandiser, In-Store Space Collaboration or by a batch 
process, synchronization will be by 'cross-matching'. 

- Information in the floor plan for zones, fixtures and other blocks and aisles will 
be written to the database. 

- Information in the database for shelves and merchandise will be written into 
the floor plan. 

 Synchronize to Match Database - information in the database will be written into 
the floor plan. 

 Synchronize to Match Drawing - information from the floor plan will be written 
to the database. 

 Cross Match - information on zones, fixtures and other blocks and aisles will be 
written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Date information can be seen in the File Properties dialog box in Store Manager. 

 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 

 Include Fixtures - fixtures and fittings will be synchronized. 

 Include Shelves - shelf objects will be synchronized. 

 Include Products - products and planograms will be synchronized 

 Include Other Blocks - this synchronizes all blocks assigned as type 'other' in 
Fixture Studio. 

 Include Zones - Zones will be synchronized. 

 Include Views - view positions in Planner or Merchandiser will be synchronized. 
(This will not affect In-Store Space Collaboration). 
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 Include Aisles - Aisles will be synchronized. 

 Include Markups - both Markups and Revision clouds will be synchronized. 

The following points should be noted: 

 If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the 
database. This will affect any instances of placed planograms using those 
shelves. 

 Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

 Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 

 Redefine Blocks from Disc - this results in the DWG files in the floor being 
updated with the latest versions of those DWG files held in the fixture library 
defined in Fixture Studio. 

 Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having 
Color, Line type and Line-Weight to set to BYLAYER. (This can be done using 
the Reset Color, Line Type and Line weight to BYLAYER command). 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

 Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture 
Studio. 

 Reset Color, Line type and Line-Weight to BYLAYER - this option will look at 
the color, line type and line weight of each instance of a block in the drawing. If 
they differ from the defaults for that layer, they will be set back to those defaults. 

 Reset Layer - if blocks have been moved to a layer different to that specified in 
the Insertion Tab of the Block Details dialog box in Fixture Studio, the block will 
be restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the Admin 
Module. 

 Annotate Fixtures - all fixtures that have the 'Include in Fixture Annotation' 
checkbox ticked in the Category Tab of the Block Details dialog box in Fixture 
Studio will have their annotation updated. 

 Annotate Products - all products, planograms and planogram profiles will have 
their annotation updated. 

 Annotate Zones - all zones will have their annotation updated. 
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 Update Title Block - all text boxes in the title block that reference information in 
the database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 

 Calculate Areas - this updates the area calculations; and hence the floor area 
assigned to each fixture. 

 Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence 
the relationship of one fixture to another. 

 Calculate Product Adjacencies - this updates the product adjacencies; and hence 
the relationship of one product to another. 

 Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence 
which products share an aisle. 

 Calculate Space Measures - this updates space measures: the volume occupied 
by each product in a planogram. 

 Calculate Face Planes - this updates face planes: the frontal area occupied by 
each product in a planogram. 

The Validation Tab 
The Validation Tab enables users to set a series of validation checks that must be 
satisfied before the floor plan is published. If any of the checks have failed, the floor plan 
will be not be published and details written to the Process File Log table. Information in 
this table can be read by means of a BI Publisher report or similar. 



File Options 

File Options 73 

 

The tolerance values will use the system units, i.e. inches for imperial systems, and 
millimeters for metric systems. The values on the left are the lower tolerance; the values 
on the right are the upper tolerance. 

 Check for equipment that is obsolete or not yet available - i f selected, this 
validation option will compare the effective and expiry dates of the equipment 
against the effective date of the planogram. 

The Effective and Expiry Dates of the equipment are set in the Category tab of the 
Block Details dialog box in Fixture Studio. 
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The Effective Date and Expiry date for the Planogram is set in the Details tab of the 
Planogram design dialog box in the Merchandiser module. 
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 Check for empty fixtures - if selected, this validation option will search for 
fixtures that can contain merchandise, but on which no merchandise has been 
placed. 

 Check for expired planograms - if selected, this validation option will compare 
the effective and expiry dates of the planogram against the effective date of the 
floor-plan. It will check: 

– The Effective Date of the Planogram is less than or equal to the Floor Plan 
Effective Date 

– The Floor Plan Effective Date is less than the Planogram Expiry Date 

The Effective Date and Expiry Date for the Planogram is set in the Details tab of the 
Planogram design dialog box in the Merchandiser module (see screen shot above). 

The Floor Plan Effective Date is set in the File Properties dialog box in Store Manager. 
(Store Manager can be accessed from the Planner or Merchandiser modules). 
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Note: Active Dates can also be set in the File Properties 
dialog box in Store Manager. 

The relevant part of the check will be ignored if the planogram effective or expiry 
date is undefined. 

 Check for store-specific planograms - if selected, this validation option will check 
the placed planograms are either store specific and associated with this store, or 
are generic planograms that are associated with all stores. 

Whether planogram are store specific or not is specified in the Stores tab of the 
Planogram Design dialog box in the Merchandiser module. 
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 Check that planograms are placed on correct length fixtures - if checked, this 
option will check that the length of the planogram conforms to the total length of 
the fixtures on which it is placed within the limits set by the tolerance controls. 

 Check that planograms are placed on correct depth fixtures - if checked, this 
option will check that the depth of the planogram conforms to the individual 
depths of the fixtures on which it is placed within the limits set by the tolerance 
controls. 

 Check that planograms are placed on correct height fixtures - if checked, this 
option will check that the height of the planogram conforms to the individual 
heights of the fixtures on which it is placed within the limits set by the tolerance 
controls. 

 Check that planograms are placed on correct fixture styles - if checked, this 
option will check that the fixture style assigned to the planogram matches the 
fixture styles assigned to the individual fixtures on which it has been placed. 

If an error occurs, it will prevent the floor-plan from being published. Errors will be 
logged in the File Process Log table identifying the process name, the floor-plan 
name and identifier, the date and time and the machine name on which it occurred. 
This information may be read in a report generated from (for example) BI Publisher. 

Note: For more information on the File Process Log table see 
the Oracle Retail Macro Space Planning Data Model. 



Floor Plan Automated Processing 

78 Oracle Retail Macro Space Management 

Floor Plan Automated Processing 

Overview of Floor Plan Automated Processing 

Overview of Floor Plan Automated Processing 
Floor Plan Processing is used to prepare floor plans for further use after manual or other 
batch operations have been carried out. The options available are: 

 

The basic method of operation is as follows: 

Admin Module 
 Permissions to use the floor plan pre-processing functionality are assigned in the 

Functional security dialog box in the Admin module. 

 The stores that users have permissions to process floor plans for are set in the 
Stores tab of the Data Security dialog box in the Admin Module. 

 The store statuses that users have permissions to process floor plans for are set in 
the Stores option of the Status tab of the Data Security dialog box in the Admin 
Module. 

 The file statuses that users have permission to process are set in the Files option 
of the Status tab of the Data Security dialog box in the Admin module. 

Note: the floor plans that a user has permission to process 
are dependent on the combination of store, store status and 
file status permissions. 

 The fields that users can see in the Floor Plan Processing dialog box are specified 
in the Custom SQL dialog box in the Admin Module. 

Batch Processes 
Floor Plan Pre-Processing can be run as a batch process. In order to do this, a user must 
first have been assigned permission in the Functional Security dialog box in the Admin 
Module. The Batch Process will then execute using command line switches to define 
parameters. 

Planner Module 
In order to use Immediate Floor Plan Pre-Processing a user must first have been assigned 
permission in the Functional Security dialog box in the Admin Module. When the Floor 
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Plan Processing dialog box first opens, the user must manually chose the required 
settings. 

The options available in Floor Plan Processing are: 

 Synchronization 

Synchronization is used to ensure that the floor plan (DWG file) used in the 
Planner module and the information held in the database is identical. Differences 
can occur if for instance, changes are made to the floor plan outside the Macro 
Space Planning, or changes are made to the database by processes such as 
planogram substitution. Using synchronize resolves these differences. 

 Rendering 

Rendering is used to ensure the visual appearance of the published or printed 
drawing conforms to a specified format. This includes configuring the layers 
used in the floor plan, the visual appearance of the blocks used, refreshing the 
data displayed in the title block and selecting the layout tab in AutoCAD paper 
space. 

 Restructuring Drawing 

The restructure options are used to ensure that the blocks in the floor plan 
conform to the latest versions defined in the Fixture Studio module. For example, 
the functionality can be used to ensure that the version of the DWG file used to 
represent the block is the latest version, that its color, line type and line weight 
are set to the correct values for the layer is designated to be on and that its 
elevation in the drawing (z coordinate) is identical to the value specified in 
Fixture Studio. 

 Annotation  

The annotation options are used to refresh zone, fixture and product annotation. 
They are also used to ensure the information displayed in the Title Block is up to 
date. For example, if the Planogram Substitution functionality has been used to 
change some of the planograms in the floor plan, it would be necessary to re-
annotate the floor plan to reflect the changed merchandise. 

 Calculations  

The calculation option is used to ensure that information used for reporting 
purposes is up to date. For example, if the Planogram Substitution functionality 
has been used to change some of the planograms in the floor plan, Product 
Adjacency, Aisle Adjacency, Face Plane and Space Measurement calculations 
would probably have to be re-run to ensure the information generated for any 
reports associated with that floor plan was up to date. 

Purpose of Floor Plan Automated Processing 
The purpose of Floor Plan Automated Processing is to prepare floor plans for further use 
after manual or other batch operations have been carried out. The options available are: 

Synchronization 
Synchronization is used to ensure that the floor plan (DWG file) used in the Planner 
module and the information held in the database are identical. Differences could build 
up between the two. For example changes could be made in the Merchandiser module - 
these changes are written directly to the database, but are not written to the floor plan 
(DWG file) used in the Planner module. Using synchronize resolves these differences. 
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Rendering 
Rendering is used to ensure the visual appearance of the published or printed drawing 
confirms to a specified format. This includes configuring the layers used in the floor plan, 
the visual appearance of the blocks used, refreshing the data displayed in the title block 
and selecting the layout tab in AutoCAD paper space. 

Restructuring Drawing 
The restructure options are used to ensure that the blocks in the floor plan conform to the 
latest versions defined in the Fixture Studio module. For example, the functionality can 
be used to ensure that the version of the DWG file used to represent the block is the latest 
version, that its color, line type and line weight are set to the correct values for the layer 
is designated to be on and that its elevation in the drawing (z coordinate) is identical to 
the value specified in Fixture Studio. 

Annotation 
The annotation options are used to refresh zone, fixture and product annotation. They 
are also used to ensure the information displayed in the Title Block is up to date. For 
example, if the Planogram Substitution functionality has been used to change some of the 
planograms in the floor plan, it would be necessary to re-annotate the floor plan to reflect 
the changed merchandise. 

Calculations 
The calculation option is used to ensure that information used for reporting purposes in 
up to date. For example, if the Planogram Substitution functionality has been used to 
change some of the planograms in the floor plan, Product Adjacency, Aisle Adjacency, 
Face Plane and Space Measurement calculations would probably have to be re-run to 
ensure the information generated for any reports associated with that floor plan was up 
to date. 

Examples of the use of Floor Plan Automated Processing are given below:   

 Ensure Floor Plan data is up to date before generating reports 

If manual changes have been made in floor plans, it is by no means guaranteed 
that the person editing the floor plan has remembered to update the calculations 
before saving and closing the drawing. Running the calculations via Floor Plan 
Automated Processing is a prudent step to ensure reporting accuracy. 

 Planogram substitutions have been run as a batch process 

The need then is to prepare the floor plans for when they are next manually 
opened, or for when they are published. The processing tasks would include: 

– Synchronize (batch the database) to bring the substituted planograms into 
the Planner floor plans (DWG files). 

– Annotation to update the annotation associated with the changed 
planograms. 

– Calculations (Product Adjacency, Aisle Adjacency, Face Plane and Space 
Measurement) to ensure than any subsequent reports are accurate. 

 Floor Plans are to be published and reports are to be generated 

If floor plans are to be published and reports are to be generated, business work 
flows may make it sensible to run Floor Plan Automated Processing as a 
predecessor to generating the reports and floor plans. In this case Floor Plan 
Publishing would be configured without any options selected on the pre-
processing tab. 
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Examples Uses of Floor Plan Automated Processing 

Ensure Floor Plan data is up to date before generating reports 
If manual changes have been made in floor plans, it is by no means guaranteed that the 
person editing the floor plan has remembered to update the calculations before saving 
and closing the drawing. Running the calculations via Floor Plan Automated Processing 
is a prudent step to ensure reporting accuracy. 

Planogram substitutions have been run as a batch process 
The need then is to prepare the floor plans for when they are next manually opened, or 
for when they are published. The processing tasks would include: 

 Synchronize (batch the database) to bring the substituted planograms into the 
Planner floor plans (DWG files). 

 Annotation to update the annotation associated with the changed planograms. 

 Calculations (Product Adjacency, Aisle Adjacency, Face Plane and Space 
Measurement) to ensure than any subsequent reports are accurate. 

Floor Plans are to be published and reports are to be generated 
If floor plans are to be published and reports are to be generated, business work flows 
may make it sensible to run Floor Plan Automated Processing as a predecessor to 
generating the reports and floor plans. In this case Floor Plan Publishing would be 
configured without any options selected on the pre-processing tab. 

Permissions to Run Floor Plan Automated Processing 
Before a user can run Floor Plan Automated Processing, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 

 

Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
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Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Automated Processing functionality. 

Note: Floor Plan Automated Processing (the right to run 
calculations on floor plans) is a separate user group to Floor 
Plan Publishing. Floor Plan Publishing users can run 
calculations on floor plans as part of the publishing process. 
To run Floor Plan Automated Publishing 'stand alone' as a 
preparatory action for outputting reports, etc, requires the 
user to have separate permission for that functionality. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 

 

This will bring up the Permissions dialog box. 

 

 If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the 
selections made using the check boxes. 
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 If the User Group only exists at this level in the hierarchy, the Permissions dialog 
box will initially have all check boxes blank. The Administrator must then assign 
Allow or Deny permissions.   

Running Floor Plan Pre-Processing 
There are two ways Floor Plan Pre-processing can be run once permissions have been 
granted: 

 As a batch process 

 Manually invoked In the Planner module from the File > Drawing Utilities 
module. 

Running Floor Plan Automated Processing through the Command Line 

Using Batch Runner 
The batch process is executed via a Macro Space Management executable called 
BatchRunner.exe. By default, this is installed in the C:\Program Files\Oracle 
Retail\MSM\Common Files\.NET folder. 

Note: It is recommended that batch processes be executed 
using an installation of Macro Space Management on a 
server. This ensures that the batch process can be executed at 
the specified time without the risk of the computer being 
turned off or the batch process being interrupted. 

Floor Plan Automated Processing is run as a batch process through the Windows 
Command Line. This can be done in two general ways: 

 Directly as a manually entered command or via a manually invoked batch file. 

 Automatically, where planogram publishing is run by a third party scheduling 
tool. 

The syntax for running via the command Line is as follows: 
BatchRunner /processplans username/password /t 

1. BatchRunner identifies that the batch process should be run using the Batch Runner 
utility. This utility is automatically installed with the rest of Macro Space 
Management. 

Note: The path to the directory containing BatchRunner 
should also be included in the command line syntax - for 
example C:\Program Files\Oracle Retail\MSM\Common 
Files\.NET\BatchRunner 

2. processplans identifies that the functionality to run as a batch process is called 
processplans. 

3. username/password must be a valid combination for a user in the Macro Space 
Planning database who belongs to a User Group with permissions to use the 
functionality controlled by the Floor Plan Automated Processing Command Group 
in the Functional Security dialog box. 

4. /t is an optional switch. It allows the third party scheduling tool to terminate the 
Planogram Publishing process after the current planogram has been published. 

Other Batch Runner Command Line Switches 
The following other command line switches are available. 
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 Files to be processed 

Files to be processed can be filtered as follows: 

– The /s switch will restrict files to be processed to files with a specific file 
status. The Syntax is /s Code 1, Code 2, Code 3, etc., where the Code is the 
code field in the Status dialog box accessed from the General menu. The code 
is user specific, but a typical example would be /S FIL-2, FIL-3. If no status 
code is defined, it will assume all non-read-only file status values should be 
processes. 

 

Note: The codes are case sensitive: FIL-1 is not the same as 
Fil-1. 

– The /OUTOFSYNC switch will only process those floor plans where 
differences exist between the Planner floor plan and the database. The first 
condition for this is AutoCAD File Date (from the DWG file properties) > 
Last Modified Date (in the database). The second condition for this is Last 
Processed Date (in the database) > Last Modified Date (in the database). 

Note: further switches have to be set to specify the nature of 
the synchronization. 

 Rendering 
The Rendering commands can be configured with the following switches: 

– The /THEME switch will cause the floor plan to be rendered with a specific 
layer theme. The syntax is /THEME a where 'a' is the name of the layer 
theme. A typical example would be /THEME "Full Annotation". The 
available themes can be seen in the Layer Themes dialog box accessed from 
the Layer Alias dialog box on the Format menu in the Planner module. 
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– The /VISUAL switch will cause the floor plan to be rendered with one of 
seven visual styles.  The syntax is /VISUAL a  where 'a' is the name of the 
visual style. A typical example would be /VISUAL"2D Wire Frame". The 
available options are 2D Wire Frame, 3D Wire Frame, Hidden Detail, 
Shaded, Shaded with Edges, Conceptual and Realistic. These correspond to 
those available in the Visual Styles toolbar or Visual Styles Manager. 

– The /TITLEBLOCK switch will cause a Title Block to be added to the floor 
plan being printed or published. The syntax is TITLEBLOCK a where 'a' is 
the name of the Title Block. A typical example would be /TITLEBLOCK 
"ANSI D".  The list of available title blocks is configured using the Title Block 
option on the Planning menu in the Admin module. 

 

– The /LAYOUT switch will cause a specific layout tab to be used for the floor 
plan being printed or published. The syntax is /LAYOUT a where 'a' is the 
name of  the layout. A typical example would be /LAYOUT "Overall Store". 
The names of the layout (paper space) tabs can be seen at the foot of the floor 
plan in the Planner module. In the example below they are named Overall 
store, food and drink, Electrical and Clothing. 

 
Note:  If a name used in the Rendering switches contains 
spaces, then it must be enclosed in double-quotes. 

 Synchronization 

The Synchronization command is configured using the following switch: /SYNC 
n, m. This controls similar options to those available in the Synchronization 
dialog box available in the Planner module.   
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The /SYNC n, m switch works as follows: 

– n is the type of synchronization: 

0 = None 
1 = Auto-Synchronize 
2 = Match Drawing 
3 = Match Database 
4 = Cross-Match 

– m is a bitwise integer for the items to synchronize: 

The values used to make up the bitwise integer are: 
1 = Include Fixtures 
2 = Include Shelves  
4 = Include Products  
8 = Include Other Blocks 
16 = Include Zones  
32 = Include Views 
64 = Include Aisles  
128 = Include Markups 
Setting m to a value of 7 would thus synchronize Fixtures, Shelves and 
Products. 

  Restructure Drawing 

The Restructure option is configured using the following switch: 
/RESTRUCTURE n, where n = bitwise integer for the restructuring options. 
These correspond to the options available in the Restructure Drawing dialog box 
accessed from the Modify > Blocks menu in the Planner module. 
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The values used to make up the bitwise integer are: 

1 = Redefine blocks from disk 
2 = Explode composite blocks  
4 = Reset level 
8 = Reset color, line-type, line-weight to BYLAYER 
16 = Reset layer 

Setting n  to a value of 5 would thus run the Redefine blocks from disk and Reset 
level options. 

 Annotation 

The Annotate option is configured using the following switch: /ANNOTATE n, 
where n = bitwise integer for the annotation options. The values used to make up 
the bitwise integer are: 

1 = Annotate Fixtures  
2 = Annotate Products 
4 = Annotate Zones  
8 = Update Title Block 

Setting n  to a value of 2 would thus run the Product Annotation option. 

  Calculate 

The Calculate option is configured using the following switch: /CALCULATE n, 
where n = bitwise integer for the calculation options. The values used to make up 
the bitwise integer are: 

1 = Calculate Areas 
2 = Calculate Fixture Adjacencies  
4 = Calculate Product Adjacencies  
8 = Calculate Aisle Adjacencies  
16 = Calculate Space Measures  
32 = Calculate Face Planes  

Setting n  to a value of 14 would thus run the Fixture Adjacency, Product Adjacency 
and Aisle Adjacency options. 
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Logging and Reporting Results from Floor Plan Automated Processing 
The results from Automated Processing of Floor Plans are stored in two tables within the 
database. 

File Process Flog Table 
This table holds information on the date, file, processes carried out, machine and log in 
ID and whether the result was successful or not. 

 The PFL_PROCESSTYPE field describes the type of process involved: 1 = Process 
Files 

 The PFL_LOGTYPE field describes the type of information in the PFL_DETAILS 
field: 1 = Error, 2 = Warning, 3 = Information and 4 = Summary 

Information in this table gives an overview of the results. 

Error Table 
This table holds information on errors generated during the floor plan processing. It is 
more technical than the File Process Log table and contains information that will be of 
assistance to Data Base Administrators. 

Note: for more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

BI Publisher 
In order to facilitate analysis of the results, it is normal to view results via a report 
generated from BI Publisher (or similar software). 

Running Floor Plan Publishing as a Batch Process 

Permissions to Run Floor Publishing as a Batch Process 
Before a user can run Floor Plan Publishing as a batch process, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Publishing functionality. 

Note: Floor Plan Automated Publishing (the right to run 
calculations on floor plans) is a separate user group. Users 
with permissions for Floor Plan Publishing can set 
calculation options in the Pre-processing tab of the Floor 
Plan Publishing Configuration dialog box. These will 
execute during the publishing of floor plans. They will not 
execute otherwise unless the user is a member of a User 
Group with permissions for the Floor Plan Automated 
Publishing User Group. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box. 

 

This will bring up the Permissions dialog box. 
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1. If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions.     

Running Floor Plan Publishing though the Command Line 

Using Batch Runner 
The batch process is executed via a Macro Space Management executable called 
BatchRunner.exe. By default, this is installed in the C:\Program Files\Oracle 
Retail\MSM\Common Files\.NET folder. 

Note: It is recommended that batch processes be executed 
using an installation of Macro Space Management on a 
server. This ensures that the batch process can be executed at 
the specified time without the risk of the computer being 
turned off or the batch process being interrupted. 

Floor Plan Publishing is run as a batch process through the Windows Command Line. 
This can be done in two general ways: 

 Directly as a manually entered command or via a manually invoked batch file. 

 Automatically, where planogram publishing is run by a third party scheduling 
tool. 

The syntax for running via the command Line is as follows: 
BatchRunner /publishplans username/password /t 

 BatchRunner identifies that the batch process should be run using the Batch 
Runner utility. This utility is automatically installed with the rest of Macro Space 
Management. 

Note: The path to the directory containing BatchRunner 
should also be included in the command line syntax - for 
example C:\Oracle Retail\MSM\Common 
Files\.NET\BatchRunner 

 publishplans identifies that the functionality to run as a batch process is called 
publishplans 

 username/password must be a valid combination for a user in the Macro Space 
Planning database who belongs to a User Group with permissions to use the 
functionality controlled by the Planogram Publishing Command Group in the 
Functional Security dialog box. 

 /t is an optional switch. It allows the third party scheduling tool to terminate the 
Planogram Publishing process after the current planogram has been published. 

  

 



File Options 

File Options 91 

Recording of Results 
When Planogram Publishing is run as a Batch Process, the following information is 
logged or modified: 

 Invalid username/password 
If an invalid user name and password is used to start the batch process, the 
invalid user name will be written to the Error Log (Error table), together with the 
machine name and the date and time. 

 Start times, finish times and floor plan publishing results 

The start time, finish time, user log in name, machine used, type of information 
and result will be written to the Floor Plan Publishing Log (Process File Log 
table). If the process was halted by the third party scheduling tool because the 
Terminate option was enabled, this will also be recorded. 

Publishing Logic 
The following logic will be used in publishing floor plans. 

 Floor plans will be published when the current date and time (taking into 
account the Lead Time Tolerance) reaches the Publish Date set for the Floor Plan. 

 Floor Plans will also be published when they have been updated since they were 
last published. The condition for this is that the Last Modified Date is greater 
than the Last Published Date. 

 Planograms will be republished if the Republish Planogram if the files are 
missing option is checked in the Output Tab of the Planogram Publishing 
configuration dialog box. In this case planograms at Publish or Current status 
will be republished where the published file is missing from the publish 
directory - this may occur if the file is deleted or the publish directory structure 
has changed. 

Changes to data stored for the Floor Plan 
After the floor plan has been successfully published, the following information will be 
updated for the floor plan: 

 The floor-plan Last Modified Date will be updated to the current date and time. 

 The floor-plan status will be changed to Published if its status order is less than 
published. For instances where a floor-plan is being republished, its current 
status may already be Published or Current. 

 The floor-plan’s Last Published Date will be updated to the current UTC date 
and time. 

The Last Modified Date, Last Published Date and Status can be seen in the File Properties 
dialog box accessed in Store Manager. 
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Logging and Reporting Results from Floor Plan Publishing  
The results from Floor Plan Publishing are stored in two tables within the database. 

Process File Log table 
This table holds information on the date, file, processes carried out, machine and log in 
ID and whether the result was successful or not. 

 The PFL_PROCESSTYPE field describes the type of process involved: 2 = Process 
Files 

 The PFL_LOGTYPE field describes the type of information in the PFL_DETAILS 
field: 1 = Error, 2 = Warning, 3 = Information and 4 = Summary 

Information in this table gives an overview of the results. 

Error Table 
This table holds information on errors generated during floor plan publishing. It is more 
technical than the Process File Log table and contains information that will be off 
assistance to Data Base Administrators. 

Note: for more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

BI Publisher 
In order to facilitate analysis of the results, it is normal to view results via a report 
generated from BI Publisher (or similar software). 
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Configuring Planogram Publishing 

Overview of Planogram Publishing 

Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators. The default settings for the 
Planogram Publishing dialog box are derived from settings 
in the Planogram Publishing Configuration dialog box in the 
Administration module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

 

The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs. 

Note: a retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 
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The basic method of operation is as follows: 

 

1. Administration Module  

The Administration module is used to configure access to the different parts of the 
functionality. It is also used to assign permissions to print or publish specific floor 
plans and planograms. Finally, it is used to configure how the batch processes for 
publishing floor plans will work. There are three options that affect publishing and 
printing of floor plans. 

 The Functional Security option (Security menu) allows Administrators to control 
who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 

 The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration). 
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 The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 

2. Configuring Outputs for Batch Process 

The outputs for the batch process output of Planograms are configured in the 
administration module using the Planogram Publishing Configuration dialog box. 

3. Running as a Batch Processes 
Planogram Publishing ban be run as a batch process - typically run overnight so that 
this processor hungry tasks can be executed without affecting the manual users of 
the system. The settings determining how this operates are set in the Planogram 
Publishing Configuration dialog box. 

The rights to do this are set in Functional Security in the Administration Module. 

4. Planner Module  

Within the Planner module, the Immediate Publishing of Floor Plans functionality 
can only be used by users for whom permissions have been granted in the 
Administration module. 

5. Merchandiser Module  

Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in 
the Administration module. 

6. Report Designer 
Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 

7. Other Functionality 

There are three other items of functionality that affect planogram publishing. 

 Configuration Module - the Directories tab allows users to specify where the root 
folders holding published planograms are located. Sub-folders holding specific 
planograms will be created as children of this root folder. 

 Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

 BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published. 

Permissions to Run Immediate Planogram Publishing 
Before a user can run Immediate Planogram Publishing in the Planner or Merchandiser 
modules in MSM, they must first have been assigned the appropriate permissions in the 
Administration module. This is done using the Functional Security dialog box accessed 
from the Security menu. 

Note: this dialog box will only be accessible to users with  
access rights to the Administration Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. The User Group's precise rights depend on settings 
in the Permissions dialog box. This is accessed by highlighting the User Group and 
selecting the Edit Permissions option from the right click menu. This will bring up the 
Permissions dialog box. 

 

1. If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions. 

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
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The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 

 

Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Administration Module. 

Note: this dialog box will only be accessible to users with  
access rights to the Administration Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 p.m. (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 

For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if i t were running at 01.00 hrs 
in the morning of 3rd June. All  planograms with a Publish Date of 3rd June would then 
be published. 

Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 

1. Publish Date has been exceeded 

If the Publish Date set in the Details Tab of the Planogram Design dialog box in 
Merchandiser exceeds the current date (taking into account the Lead Time Tolerance 
(Hours) setting in the Planogram configuration dialog box in the Administration 
module), the floor plan will be published. 

2. Planogram has been Updated since it was Published 

It is possible that the floor plan may have been modified after it was last published - 
for example of a later revision has been created. The condition for this is that the Last 
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Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 

 

Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in the 
Planogram Publishing Configuration dialog box. 

Master Planograms 
Master planograms act as placeholders in floor plans - see the detailed section on master 
planograms in the section on Merchandise. Because a master planogram acts as a 
placeholder for individual planograms, there is no need to update the floor plan every 
time an individual planogram is changed. Instead, when the planogram is published, the 
functionality will substitute the individual planogram for the master planogram present 
in the floor plan. 

Locations Planograms will Be Published To 
The locations Planogram designs will published to and the file names that will be used 
are specified in the Output tab of the Planogram Publishing Configuration dialog box in 
the Administration module. 

Note: This dialog box will only be accessible to users with 
access rights to the Administration Module. 
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This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. The starting point for 
the location planograms will be published to in electronic form can be seen in the details 
for the Planogram Publish system directory specified in the Directories Tab of the 
Configuration module. 
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The Output Tab - Directory Structure 
The Output Tab is used to configure how planogram designs will be output. Settings 
here determine the folder structure and the type and naming convention for the 
planogram designs. 
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Format 

The format in which the planogram design is published can be set by the radio button. It 
can be either electronic (PDF File) or hard copy (Print). The option selected by the radio 
button will gray out or make active the pertinent portions of the tab. 

PDF File 

The Sample Directory text box contains an example of a path to a directory based on the 
current selections in this frame. 

There are two ways that the directories containing the PDF files can be organized: 

1. In folders conforming to the parent Department, Class and Sub-class of the 
planogram 

2. In folders that conform to the store hierarchy in Store Manager. 

a. Organize by Planogram Hierarchy - if this option is selected, the folders will be 
organized by the following logic: 

Note: If this option is selected, Master Planograms cannot be 
used. As they are store specific, it will not be possible to 
determine which store the associated individual planograms 
are destined for. 

– If no check box is ticked, all planogram designs will be published to a single 
directory specified by the Planogram Publish directory specified in the 
Directories tab of the Configuration module. 
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– If the Create Planogram Department Sub-folder check box is ticked, 
planograms with that parent Department will be published to a Windows 
folder of that name below the Planogram Publish directory. 

– If the Create Planogram Class Sub-folder check box is ticked, planograms 
with that parent Class will be published to a Windows folder of that name 
below the Planogram Publish directory. 

– If the Create Planogram Sub-Class Sub-folder check box is ticked, 
planograms with that parent Sub-Class will be published to a Windows 
folder of that name below the Planogram Publish directory. 

– If multiple options are checked, then a hierarchy of folders will be created 
below Planogram Publish directory. For example, if the Create Planogram 
Department Sub-folder and the Create Planogram Class Sub-folder are 
checked, a set of Planogram Department sub-folders will be created below 
Planogram Publish directory. A further set of Planogram Class sub-folders 
will be created below the pertinent Planogram Department sub-folders. 

Planogram Group Types are assigned in the Type drop down list in the Planogram 
Group dialog box accessed in the Object Browser in the Merchandiser module. 

 

Note: users will require the appropriate permissions to 
access this functionality. These permissions are set in the 
Functional Security dialog box accessed from the Security 
menu in the Administration Module. 

b. Organize by Store - if this option is selected, the planograms will be put into 
folders named for their parent stores. They will be organized by the following 
logic: 

Note: This option must be selected if the Master Planogram 
functionality is to be used. Master Planograms have 
individual planograms assigned on a store by store basis. 
Accordingly, the individual planograms associated with the 
masters must be published to individual stores.  

– Mimic Hierarchy - If this option is checked, an intermediate set of folders 
representing Clusters will be placed between the Store sub-folders and the 
Planogram Publishing root. 

– Cluster Type - This option allows the user to specify the cluster type to be 
used for the mimic hierarchy option. One type can be selected from the drop 
down list of cluster types. If the selected cluster type has child clusters, then 
these child clusters will also be also be included in the folders used to hold 
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the planogram files. For example, if the cluster type of 'Region' has been 
selected, the hierarchy will contain folders named after the 'Region' type 
clusters. Each of these folders will have children named after the 'district' 
type folders. 

Note: for this option to work effectively, stores must have 
been assigned to cluster types in a logical way. Stores not in 
the selected cluster type will be placed in store specific sub-
folders immediately below the Planogram Publish root. 

Cluster types are set in the Clusters dialog box in Store Manager. 

 
 Include Week Number - this option allows users to create further sub folders 

below the store sub-folder. These will be named based on the Active Date for the 
floor plan (set at the top of the Object Browser) and information in the Calendars 
option accessed from the General Menu. The Active Date will be compared to the 
calendar dates associated with the 'Week' calendar type. If i t finds a match, the 
sub folder will be given the text name for that week. 

Note: this option will not work unless the Calendars option 
has been set up to include 'Week'  type information.   

General 
1. The System Publishing Lead Period sets the POG_PUBLISH_DATE_LEAD_PERIOD 

system variable. This variable in turn is used to set the default Publish Date in the 
Planogram Design dialog box in Merchandiser. (This date can be manually altered if 
required). 
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When the Publish Date is reached or exceeded, Planogram Publishing will cause the 
planogram design to be published in either electronic or hard copy form. 

2. Lead Time Tolerance allows for the fact that some batch processes may be starred 
before midnight. If a planogram design has a Publish Date of 18th June, the batch 
process could be run starting 22.00 hrs on 17th June. This would not pick up 
planogram designs with Publish dates of 18th June. The Lead Time Tolerance can be 
set to any value up to 23 hours. This time will be added to the Publish Date for batch 
processes. 

For example, setting the Lead Time Tolerance to 6 hrs will ensure that a batch 
process started after 18.00 hrs on 17th June will publish all planogram designs with a 
Publish Date of 18th June. 

3. Republish Planogram if files are Missing - If selected, this option will include all 
planograms which are at the published or current status but where the published file 
is missing from the publish directory - this may occur if the file is deleted or the 
publish directory structure has changed. 

Publishing Structure 
If changes are made to the setting in the Format frame, the structure of the windows 
folders used to store the information will change. On closing the Planogram Publishing 
configuration dialog box, the user will be presented with a dialog box telling the user that 
the folder structure has changed. 
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The options will have the following effect: 

 Yes - the existing structure will be purged and all subsequent planograms 
published to the new structure. 

 No - the existing structure will be left unchanged and all subsequent planograms 
published to the new structure. 

 Cancel - the user can go back to the dialog box and change the Directory 
Structure back to the old options. 

Print 

Selecting the Print radio button brings up the standard Print dialog box. 

 

This enables users to select the printer, paper orientation, etc. The sequence planogram 
designs will be printed depends on the settings in the Collation tab. 

The Output Tab - Filename Structure 
The Output Tab is used to configure how planogram designs will be output. Settings 
here determine the folder structure and the type and naming convention for the 
planogram designs. 
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Filename Structure 
These options allow users to specify the format of the file name. It will be built up by 
combining all the selected options. 

The Sample Filename text box contains an example of a filename based on the current 
selections in this frame. 

 Prefix - this is the initial part of the file name. It can be up to 10 characters long 
and can contain any character except / \ : * ? “ < > and |. 

 Field Separator - this is the symbol used to separate the different parts of the filer 
name. It can take the form of an underscore or a hyphen ( _ or - ). 

 Suffix - this is the terminating part of the file name. It can be up to 10 characters 
long and can contain any character except / \ : * ?  “ < > and |. 

 Include Store Code - the file name can include the store code. This is set in the 
Stores dialog box in store Manager. 
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 Include Planogram Department - this would include the Department assigned to 
the Planogram Group in the Planogram Hierarchy. 

 Include Planogram Class - this would include the Class assigned to the 
Planogram Group in the Planogram Hierarchy. 

 Include Planogram Sub-Class - this would include the Sub-Class assigned to the 
Planogram Group in the Planogram Hierarchy. 

Planogram Group Types are assigned in the Type drop down list in the Planogram 
Group dialog box accessed in the Object Browser in the Merchandiser module. 

 

If the selected option has not been assigned to the Planogram Group, the information will 
be left blank in the file name. 

 Include Planogram Name, Planogram Description, Planogram Code or 
Planogram Import Code 

The file name must include one of Planogram Name, Planogram Description, 
Planogram Code or Planogram Import Code. A radio button has been provided 
to ensure that one option is selected. 

– Planogram Name is set in the Details tab of the Planogram Design dialog box 
in Merchandiser. 
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– Planogram Description is set in the Details tab of the Planogram Design 
dialog box in Merchandiser. 

– Planogram Code is set in the Client Code field of the Details tab of the 
Planogram Design dialog box in Merchandiser. 

– Planogram Import Code can be seen in the Import Identifier field in the 
Properties tab of the Planogram Design dialog box in Merchandiser. 
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 Planogram Revision Number - the Revision Number is set automatically. It can 
be seen the Details tab of the Planogram Design dialog box in Merchandiser. 

 Include Date allows a date to be included in the file name. There are two options, 
one of which must be selected by mans of the Radio button. 

– Include Effective Date - this adds the Effective Date (the date the floor plan 
goes into service.  The format is set by the Format drop down list. 

– Include Week Number - this will take the Effective Date for the floor plan 
(set in the File Properties dialog box in Store Manager) and information in 
the Calendars option accessed from the General Menu. The Effective Date 
will be compared to the calendar dates associated with the 'Week' calendar 
type. If it finds a match, the sub folder will be given the text name for that 
week. 

Note: this option will not work unless the Calendars option 
has been set up to include 'Week'  type information.   

The Template Tab 
The Templates Tab allows users to specify the default template format to be used when 
printing planogram designs. 
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The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 

Use Associated Planogram document 
This option publishes the planogram design information using a pre-generated report 
using one of the following file formats: BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. 
This report will be imported when a planogram is imported using Oracle Data Integrator 
(ODI). The Associated Document (if available) is specified in the Associated Document 
text box in the Details tab of the Planogram Design dialog box in the Merchandiser 
module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

 Write an error to the Publish POG Log table. Information in this table can be read 
by means of a BI Publisher report or similar. 

 Use the default Report Designer template. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Use Template   
This option allows the user to define the way the template from the Report Designer 
module is selected. There are two options (selected using the radio button): 

 Use Planograms preferred template, if defined - this option is specified in the 
Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

 Use Selected Template from List Below - this option can be set by checking items 
in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf 

If necessary, the list of templates can be searched by entering a text string into the drop 
down list, then clicking the Find button. (Actual or implied wild cards can be used). Each 
click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 
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Note: the last 10 text searches can be selected using the drop 
down list in the text box. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in.  At least one collation option must be selected, or the tab will 
show as having an error. The order of the collation options can be modified highlighting 
therm and then using the Up or Down arrows. 

 

The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 

 Region is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 

 District is a specific type of cluster set in the Cluster type drop down list in the 
Cluster dialog box in Store Manager. 
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 Store Number is the Store Code in the Store dialog box in Store Manager. 

 Store Name is the Store Name in the Store dialog box in Store Manager. 

 

 Department is the department (zone) in the floor plan the planogram is 
associated with. 

 Aisle is the aisle the planogram is associated with. For this option to operate, 
aisles must first be drawn in the floor plan in the Planner module. In the example 
below, Aisle F-1 has been drawn between two runs of fixtures. 
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 Bay Number is the bay number associated with the fixtures the planogram is 
placed on. For this option to operate, the fixtures in the floor plan must 
previously have been bay numbered. 

 

 Bay Group is the Name assigned to a number of fixtures sharing a common 
characteristic. It is assigned in the Name field of the Bay Numbering dialog box 
in the Planner module. 

 

 Planogram Name is the name of the planogram. This is set in the Name field of 
the Planogram Design dialog box in Merchandiser. 
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 Planogram Code is the code for the planogram. This is set in the Client Code 
field of the Planogram Design dialog box in Merchandiser. 

 

The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks are failed, the details will 
be written to the Publish POG Log table. Information in this table can be read by means 
of a BI Publisher report or similar. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 
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1. Check for empty shelves - this option will check the parent fixture and associated 
shelf objects. It will raise an error report if: 

 The fixture and associated shelf objects can be populated with product 
placeholders, but no product placeholder has been placed. 

 The fixture and associated shelf objects can be populated with display styles, but 
no display styles have been placed. 

2. Check for products that have expired or are not yet effective - this option will check 
all products in the planogram against the effective date of the planogram. It will raise 
an error report if: 

 The Product Effective Date is after the Planogram Effective Date - i.e. the product 
is not yet available to place in the planogram. 

 The Product Expiry Date is before the Planogram Effective Date - i.e. the product 
will expire while the planogram is still in service. 

The check will be ignored if the product effective or expiry date is undefined. 

The Planogram Effective Date is set in the Details tab of the Planogram Design dialog 
box in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog 
box in Product Studio. 
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3. Check for equipment that is obsolete or not yet available - this option will check all 
equipment in the planogram against the effective date of the planogram. It will raise 
an error report if: 

 The Equipment Effective Date is after the Planogram Effective Date - i.e. the 
equipment is not yet available for the planogram. 

 The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 
equipment will be taken out of service while the planogram is still in use. 

The check will be ignored if the equipment effective or expiry date is undefined. The 
Equipment Effective and Expiry dates are set in the Category tab of the Block Details 
dialog box in Fixture Studio. 
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4. Validation Scope - this controls when to apply the validation checks. There are three 
options - selectable by the radio button. 

 Apply to all planograms. 

 Apply to non-imported (manually created) planograms. 

 Apply to imported planograms. 

The application will automatically distinguish between imported and manually created 
planograms by means of the information held in the Macro Space Planning database. 

Running Planogram Publishing as a Batch Process 

Permissions to Run Planogram Publishing as a Batch Process 
Before a user can run Planogram Publishing as a batch process, they must first have been 
assigned the appropriate permissions in the Administration module. This is done using 
the Functional Security dialog box accessed from the Security menu. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. 

Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In  the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. The User Group's precise rights depend on settings 
in the Permissions dialog box. This is accessed by highlighting the User Group and 
selecting the Edit Permissions option from the right click menu. This will bring up the 
Permissions dialog box. 

 

1. If the User Group belongs to a Command Group higher in the Command Group 
hierarchy, by default i t will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 
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2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions.   

Running Planogram Publishing through the Command Line 

Using Batch Runner 
The batch process is executed via a Macro Space Management executable called 
BatchRunner.exe. By default, this is installed in the C:\Program Files\Oracle 
Retail\MSM\Common Files\.NET folder. 

Note: It is recommended that batch processes be executed 
using an installation of Macro Space Management on a 
server. This ensures that the batch process can be executed at 
the specified time without the risk of the computer being 
turned off or the batch process being interrupted. 

Planogram Publishing is run as a batch process through the Windows Command Line. 
This can be done in two general ways: 

1. Directly as a manually entered command or via a manually invoked batch file. 

2. Automatically, where planogram publishing is run by a third party scheduling tool. 

The syntax for running via the command Line is as follows: 
BatchRunner /publishpogs username/password /t 

3. BatchRunner identifies that the batch process should be run using the Batch Runner 
utility. This utility is automatically installed with the rest of Macro Space 
Management. 

Note: The path to the directory containing BatchRunner 
should also be included in the command line syntax - for 
example C:\Program Files\Oracle Retail\MSM\Common 
Files\.NET\BatchRunner 

4. publishpogs identifies that the functionality to run as a batch process is called 
publishpogs 

5. username/password must be a valid combination for a user in the Macro Space 
Planning database who belongs to a User Group with permissions to use the 
functionality controlled by the Planogram Publishing Command Group in the 
Functional Security dialog box. 

6. /t is an optional switch. It allows the third party scheduling tool to terminate the 
Planogram Publishing process after the current planogram has been published. 

Recording of Results 
When Planogram Publishing is run as a Batch Process, the following information is 
logged or modified: 

1. Invalid username/password 

If an invalid user name and password is used to start the batch process, the invalid 
user name will be written to the Error Log (Error table), together with  the machine 
name and the date and time. 

2. Start times, finish times and planogram publishing results 

The start time, finish time, user log in name, machine used, type of information and 
result will be written to the Planogram Publishing Log (Publish POG Log table). If 

 

 



File Options 

File Options 123 

the process was halted by the third party scheduling tool because the Terminate 
option was enabled, this will also be recorded. 

Note: in order to read the varying log tables, a report will be 
required using a tool like BI Publisher. 

Publishing Logic 
The following logic will be used in publishing planogram designs. 

1. Planograms will be published when the three following conditions are met: 

a. The current date and time (taking into account the Lead Time Tolerance) exceeds 
the Publish Date set for the planogram 

b. The Planogram Last Published Date is null (i.e. the planogram has not been 
published) 

c. The Planogram Expired Date exceeds the current date and time (taking into 
account the Lead Time Tolerance) 

2. Planograms will also be published when they have been updated since they were last 
published. The condition for this is that the Planogram Last Modified Date is greater 
than the Planogram Last Published Date. 

Note: these dates can be found on the Details and Properties 
tab of the Planogram design dialog box in Merchandiser. 

3. Planograms will be republished if the Republish Planogram if the files are missing 
option is checked in the Output Tab of the Planogram Publishing configuration 
dialog box. In this case planograms at Publish or Current status will be republished 
where the published file is missing from the publish directory - this may occur if the 
file is deleted or the publish directory structure has changed. 

Validation 
Validation is described in more detail in the section on the Validation Tab in the 
Planogram Publishing Configuration dialog box. The following checks (if selected) will 
be carried out: 

1. The planogram will be checked to see if any shelf objects are empty. 

2. The planogram will be checked to see if any products are not yet available, or have 
expired. 

3. The equipment in the planogram will be checked to confirm it is available and has 
not been scheduled to go out of service. 

In the event of any planogram failing the validation check; publishing of that planogram 
will be stopped and an entry written to the Planogram Publishing log (Publish POG Log 
table). The process will then move on to publish the next planogram. 

Publishing 
What is published will depend on the settings in the Output Tab in the Planogram 
Publishing Configuration dialog box. 

1. The planogram design can be published as one of two options: 

a.  An imported planogram report from the third party software. 

b. A customized report set up using Macro Space Management's Report Designer 
module. 

2. The planogram designs will be published into Windows folders conforming to the 
selected options in the Output tab. These can be: 
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a. Based on the parent stores - in this instance a copy of the planogram design will 
be published into each pertinent store folder. 

b. Based on the Planogram Groups - in this instance a copy of the planogram design 
will be published into the pertinent folder. A further distribution mechanism will 
then be required to send the planograms to the pertinent stores. 

3. The planogram design report will be named according to the selected options in the 
Output tab. 

4. If the path to the folder containing the planogram designs is too long, or if the file 
name is too long, the planogram design will not be published and  an entry written 
to the Planogram Publishing log (Publish POG Log table). The process will then 
move on to publish the next planogram. 

5. Note: For more information on the tables in this section see the Oracle Retail Macro 
Space Planning Data Model. 

Logging and Recording Results from Planogram Publishing 
The results from Planogram Publishing are stored in two tables within the database. 

Publish POG Log Table 
This table holds information on the date, planogram, machine and log in ID and whether 
the result was successful or not. 

The PPL_LOGTYPE field describes the type of information in the PPL_DETAILS field: 1 
= Error, 2 = Warning, 3 = Information and 4 = Summary 

Information in this table gives an overview of the results. 

Error Table 
This table holds information on errors generated during planogram publishing. It is more 
technical than the Publish POG Log table and contains information that will be of 
assistance to Data Base Administrators. 

Note: for more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

BI Publisher 
In order to facilitate analysis of the results, it is normal to view results via a report 
generated from BI Publisher (or similar software). 
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6 
General Options 

Calendars 

Overview of Calendars 
The Calendars Option  allows the user to set up a series of calendars - each covering a set 
period of time for retailing activities. Set up can either be manual or by importing the 
data. These Calendars can then be used to control information within Macro Space 
Planning including financial reporting, importing POS data within specific date ranges, 
displaying KPI's for specific date ranges and rolling up weeks into four or five week 
months. 

 

Financial Reporting 
When financial data is imported, it will be imported with an associated calendar period. 
If this same calendar has previously been imported into MSP, financial reporting using 
identical time periods can be carried out within the application. 

POS Data 
 The transaction logs from tills will need to be aggregated up into summary data before 
import into MSP. Each item of aggregated data will have a calendar period associated 
with it to identify the time period the data  is associated with. 

KPIs 
Calendar information is also used when setting date ranges in KPIs. 
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Roll-Ups 
Sometimes, for accounting purposes, it is necessary to know exactly how a calendar 
period is sub-divided, or how many weeks are in each month (some may contain four 
weeks and some may contain five). After calendar information has been imported, it is 
possible roll up weekly information into an appropriate monthly calendar for reporting 
purposes.  

The Calendars Dialogue Box 
The Calendars Dialogue Box has a number of parts. 

 

The Menu Bar gives access to a series of options. 

The Toolbar also gives access to most of those options. 

The Calendar Hierarchy allows users to see the available calendars. 

The Calendar Details  section gives more information on the selected calendars. 

The Status Bar gives information on the number of calendars in the selected section. 
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Calendars Menu Bar and Toolbar 

File Menu 
The File menu allows users to exit the dialog box. 

 

Edit Menu 
The Edit menu allows users to add, edit and delete calendars. It also allows users to 
expand or collapse sections of the calendar hierarchy. 

 

View Menu 
The View menu allows users to turn the Toolbar and status bar display on or off. It also 
enables users to refresh the hierarchy with any changes made to the calendar information 
in the database while the dialog box has been open. 

 

Help Menu 
The Help menu allows users to call help and to get information on the version of the 
software. 

 

Toolbar 
The toolbar has basic options for manually adding, editing and deleting calendars. 
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Icon Option Description 

 

Exit  Exit the dialog box 

 

Add Calendar Add a calendar period to the hierarchy 

 

Edit Calendar  Edit an existing calendar period 

 

Delete Calendar Delete a calendar period 

 

Refresh 
Calendars 

Refresh the information on the dialog box with the latest information 
from the database 

Adding a Calendar 
Calendar information will normally be imported, but it is possible to manually add 
calendar periods. To Add a Calendar, pick the point in the hierarchy to add a calendar 
and then click on the Add Calendar icon. This will open a new line in the Calendar 
Details section. Type the details. Dates can be set by means of a calendar control. When 
all details have been entered, press <Return>. The calendar will be added to the list. 

Note: If <Return> is not pressed, the data will not be saved 
to the database. 

 

Editing and Deleting Calendars 
Editing a Calendar is done by selecting the appropriate entry and changing the selected 
values. 

Note: Caution should be used in editing calendars in case 
Import Routines and KPI's reference the calendar. 

To Delete a Calendar highlight the required calendar and click on the delete icon 

The calendar will be deleted without further warning if not in use. If in use, a delete 
conformation will be requested. 
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Color Themes 

Overview of Color Themes 
Color Themes are used to color code zones, fixtures, shelves or products in the Planner 
and Merchandiser modules when a Key Performance Indicator (KPI) is run. KPIs are also 
used in the In-Store Space Collaboration (ISSC) application. Color Themes are configured 
in the Administration Module. They are then assigned to KPIs when they are configured 
- also in the Administration Module.  

When in use in KPIs in Planner, Merchandiser or in ISSC, the specified color themes are 
displayed in the Legend window of the Object Browser and used to color objects in the 
floor plan. In the example below from Planner, the end caps fixtures have been 
designated at promotional fixtures. Two different color bands have been defined - one for 
standard and one for promotional fixtures. 

 

Configuring Color Themes 
Color themes can be configured manually or via a wizard. 

 

Color Themes consist of four pieces of information.  

 Band Size 
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The band size is the range of values that the band encompasses. Band sizes are 
cumulative. Thus: 

– The Low band will contain all values  in the range 0 - 100 

– The Medium band will contain all values  in the range 100 - 200 

– The  High band will contain all values  in the range 200 - 300 

 Color 

This is the color objects will be colored if the results being used for the KPI fall 
into that color band. 

 Description 

This is the description of the color band that will be displayed in the legend 
when the KPI is being run. 

 Hatch Style  

Users have the option of printing KPIs using hatch styles. This is useful when 
printing the results of KPIs using a black and white printer. 

Assigning Color Themes to KPIs 
Color Themes can be assigned to KPIs in the Key Performance Indicators dialog box 
accessed from the General menu. 

 

There are two ways of doing this: 

 From the Color Theme drop down list. 

 From the wizard located to the right of the drop down list. 

Creating a Color Theme Using the Wizard 
An alternative to using the Color Theme dialog box is to use the Color Theme Wizard. 
This can be invoked from the Color Theme Wizard button KPI Color Theme dialog box 
accessed from the General menu. 

Note: The Wizard invoked from the KPI Color Theme dialog 
box is different to the one invoked from the Key 
Performance Indicators dialog box. 
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Worked Example of Using the Wizard 
Using the Wizard is done as follows: 

1. Add the name of the new color theme by entering the name of the color theme in the 
text box at the top of the KPI Color Themes dialog box and pressing Return. 

 

2. Highlight the newly added color theme name in the list and click the Wizard button 
on the toolbar. 

 

3. This will bring up the Create Legend dialog box. 

 

a. Specify the Band Size and Quantity. 
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b. Specify the Start and End Colors 

c. Decide if the color bands are to be added to any existing color bands. 

d. click OK 

4. The KPI Color Themes dialog box will reappear with the band size, color and hatch 
style added. 

 

5. Complete the Descriptions. 

 

6. On clicking OK, the Color Theme will be added to the list of those available. 

Note: Color Theme bands are cumulative. In the above 
example, Low will contain results 0 - 100, Medium 101 - 200, 
etc. 

Manually Creating a Color Theme 
Manually creating a color theme allows custom band sizes and colors. As the sequence of 
color bands cannot be readily altered once added, it is suggested that the bands be 
planned out prior to entering them. 

Band Name Band Size Cumulative Band Size Color 

Profit $0 - $50/Foot 50 0 - 50 Red 
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Profit $51 - $150/Foot 100 51 - 150 Yellow 

Profit $151 - $250/Foot 100 151 - 200 Green 

To manually create a color theme: 

1. Add the name of the new color theme by entering the name of the color theme in the 
text box at the top of the KPI Color Themes dialog box and Pressing Return. 

 

2. Highlight the entry in the list of color themes on the left. 

3. Enter the required data into the dialog box. 

 

4. Click OK.  

There is no way to re-order the data once entered, so when entering long lists of data 
care must be taken to enter it in the correct sequence.  

Note: For hatch styles to work in the Merchandiser module, 
hatch patterns must first have been configured using the 
Hatch Styles option from the Planning menu in the 
Administration module. 
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Editing a Color Theme 
Once created, it is possible to edit a color theme. An example would be changing the 
band size for one or more bands or adding or removing bands. Care should be taken 
editing color themes as this may affect any KPI's dependent on them. 

Custom Search Query 

Custom Queries 

Preserving Confidentiality  
The Custom Queries dialog box can be used to create queries that can display a wide 
range of information from the database. This information may become visible to anyone 
with the privileges to log into Planner, Merchandiser, ISSC or ISSC Mobile. Accordingly, 
care should be taken not to display commercially sensitive information that is not 
appropriate for all users of these applications.  

Custom SQL 
Macro Space Planning has the ability to use a specially extended form of SQL called 
Custom SQL. The software code allows the use of placeholders - denoted by the use of 
curly brackets. Then the code will substitute a 'live' value into the SQL query every time 
it executes it. The screen shot below shows an example of Custom SQL with a query of 
the form SELECT STR_ID as ID, STR_NAME as Name, STR_CODE FROM 
AVTTB_STORE WHERE STR_NAME LIKE {text}  

 

As an example of its use, this Custom SQL is enabled in the Search function in the Find 
Store dialog box in the Planogram Substitution functionality accessed from the 
Merchandising menu in the Administration module. 
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When a user types London in as a search string (with Use Custom Search Query 
selected), the SQL statement is converted to SELECT STR_ID as ID, STR_NAME as 
Name, STR_CODE FROM AVTTB_STORE WHERE STR_NAME LIKE '%London%'. 
(Note the use of implied wild cards). The SQL query is then used to search though the 
data in the Find dialog box, stopping at each matching instance. 

The initial example only searches for a store name. It is possible to modify the Custom 
SQL to search for additional fields. In the example below, the Custom SQL has been 
extended to allow the user to search for either a store name or a store code. 
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Note: Placeholders are case sensitive. {Text} is not a valid 
placeholder, while {text} is. 

Individual Conditions Associated with  Each Instance of Custom SQL 
Each query meets specific rules to operate. These rules appear below the drop down list 
and will vary when different queries are selected. The required syntax must be followed 
for that specific query to work. 
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Testing the Query 

A test button has been provided for the convenience of Administrators. 

 

After the Custom SQL has been written, clicking the test button will validate it. SQL 
cannot be saved to the database until it has been validated successfully. 

Uses of Custom SQL 
Custom SQL is used in a variety of ways within the Macro Space Planning Application. 
The Custom Query dialog can be used by Administrators without access to the database 
to modify some of that custom SQL. Users doing this should have strong SQL skills and 
access to the Macro Space Planning database. The Custom Search Query can be used for 
two purposes: 

Modify the Custom Search Options in the Planogram Substitution Dialog Boxes 
There are three options that affect how Custom Searches can be configured in the 
planogram Substitution functionality. 

Find in the Planogram Substitution dialog box.  

If the Find Options  are selected from the drop down list by the Find icon on the toolbar 
of the Planogram Substitution dialog box, the Find dialog box will appear. If the Use 
Custom Search Query check box is used, the Custom SQL in the Planogram Substitution 
Definition  option in the Custom Search Query dialog box will be used for the search. 

 

Find in the Store and Planogram Tabs of the Planogram Substitution Definition dialog 
box 
Clicking Find on the Planogram Substitution Definition dialog box toolbar will bring up 
the Find dialog box. If the Use Custom Search Query check box is used, Custom SQL 
from the Custom Search Query dialog box will be used for the search. 
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 If in the Stores tab, the Stores Custom SQL will be used. 

 If in the Substitution Tab, the Planogram Custom SQL will be used. 

 

Populating Specific Dialog Boxes 
Custom SQL is also used to select the fields to populate a number of dialog boxes. 

Find and Open Dialog Box 

Find and Open Dialog Box 

The Fixture Swap dialog box is accessed from the File menu in the Planner module. It is 
used as an alternative method to Store Manager for opening floor plans for editing. The 
fields that appear are controlled by the Custom SQL in the Floor Plan Print option in the 
Custom Search Query dialog box in the Administration Module. 
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Note: In this instance, the Find and Open dialog box does 
not have its own separate Custom SQL. 

Fixture Swap 

The Fixture Swap dialog box is accessed from the Fixturing toolbar in the Planner 
module. It is used to swap out one fixture for another in the currently active floor plan. 
The fields that appear are controlled by the Custom SQL in the Fixture Swap option in 
the Custom Search Query dialog box in the Administration Module. 
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Process Floor Plans 

The Publish Floor Plan dialog box is accessed from the File > Drawing Utilities menu in 
the Planner module. It is used to carry out automated updating operations on floor plans 
such as refreshing annotation. The fields that appear are controlled by the Custom SQL 
in the Floor Plan Print option in the Custom Search Query dialog box in the 
Administration Module. 
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Note: In this instance, the Process Floor Plans dialog box 
does not have its own separate Custom SQL. 

Publish Floor Plans 

The Publish Floor Plan dialog box is accessed from the File menu in the Planner module. 
It is used to Publish (hard copy or electronically) floor plans in preparation for putting 
them into service. The fields that appear are controlled by the Custom SQL in the Floor 
Plan Print option in the Custom Search Query dialog box in the Administration Module. 
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Print Planograms 

The Publish Planogram dialog box is accessed from the File menu in the Planner module 
by selecting the Publish planograms immediately option. It is also available from the File 
menu in the Merchandiser module and from the toolbar in In-Store Space Collaboration. 
It is used to print planogram designs for planograms in the currently active floor plan. 
The fields that appear are controlled by the Custom SQL in the POG Print options in the 
Custom Search Query dialog box in the Administration Module. 
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Publish Planograms 

The Publish Planogram dialog box is accessed from the File menu in the Planner module 
by selecting the Publish planograms immediately option. It is also available from the File 
menu in the Merchandiser module. It is used to Immediately Publish (hard copy or 
electronically) planogram designs for planograms. This dialog box can be used as an 
alternative to waiting for planograms to be published via a batch process. 

The fields that appear are controlled by the Custom SQL in the Publish by Store 
Hierarchy or Publish by POG Hierarchy options in the Custom Search Query dialog box 
in the Administration Module. Which Custom SQL is used is determined by settings in 
the Configure Planogram Publishing dialog box accessed from the File menu is the 
Administration module. 
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Summary of Where Custom Queries are Used 
This section provides a brief summary of the Custom SQL accessed from the Custom 
Search Query dialog box accessed from the General menu. 

Dialog Box Function Modules How Accessed Custom SQL 

Planogram Substitution Find Administration General Menu 
Planogram 
Substitution 
Definition 

Planogram Substitution 
Definition - Stores Tab Find Administration 

Planogram 
Substitution dialog 
box 

Stores 

Planogram Substitution 
Definition - Substitution 
Tab 

Find Administration 
Planogram 
Substitution dialog 
box 

Planogram 

Find and Open Populate 
data Planner File menu Floor Plan Print 

Fixture Swap Populate 
Data Planner Fixturing toolbar Fixture Swap 

Process Floor Plans Populate 
Data Planner File Menu > 

Drawing Utilities Floor Plan Print 

Publish Floor Plans Populate Planner File Menu Floor Plan Print 
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Dialog Box Function Modules How Accessed Custom SQL 

Data 

Print Planograms Populate 
Data 

Planner 
Merchandiser  

File Menu 
File menu 

POG Print 

Publish Planograms Populate 
Data 

Planner 

Merchandiser  
In-Store Space 
Collaboration 

File Menu 

File Menu 
Toolbar 

Publish by Store 
Hierarchy 

Publish by POG 
Hierarchy 

  

Key Performance Indicators 

Overview of KPIs 
Key Performance Indicators (KPIs) are used in parallel with Quick Reports and BI 
Publisher reports to give information on the currently active floor plan. Quick Reports 
and BI Publisher reports give tabulated information; KPIs are used to color code the floor 
plan with performance related criteria. 

 

The above example from the Merchandiser module shows products on shelves and 
fixtures color coded as to the level of profit they are making relative to the length of base 
or shelf linear that they occupy. 
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Data Sources 
The following data sources can be used for KPIs: 

SQL Statements 
SQL statement can be used for simple KPIs. For example a SQL statement could be used 
to return a list of promotional fixtures or a list of unpopulated fixtures. 

Stored Procedures 
Stored Procedures are recommended for more complex KPI's. This is because they are 
more efficient at processing large volumes of data. A stored procedure might be used to 
generate data for a KPI giving the cumulative profit for the products on a fixture while 
taking into account the amount of aisle space allocated to it. 

Views 
There are a number of views included with the database. Existing KPI's can reference 
those views for data. This facility has been removed for new KPI's. 

Note: Providing the appropriate permissions exist, i t is 
possible to create data sources for KPIs that reference 
multiple schemas. For example data in the Macro Space 
Planning database could be combined with data from other 
databases to create a KPI referencing (for example) extended 
product attributes. 

Overview of Creating KPIs 
KPI's are created as follows: 

 

Create Data Source 
The data source is created. Typically this will be a SQL statement or a stored procedure. 
These can either operate on data inherent to Macro Space Planning or imported data. An 
example of imported data would be Point of Sale data, allowing the details of the 
financial performance of the store to be shown. 

Create Color Theme 
The next stage is to create a Color Theme to determine how the objects in the KPI will be 
colored. The example below show how objects can be color coded according to 
performance.  
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Color Themes can be edited or created using the KPI Color Themes dialog box accessed 
from the General Menu. 

Configure KPI 
KPIs are configured using the Key Performance Indicators dialog box accessed from the 
General Menu. 

 
This enables the KPI Name, Data Source, Color Theme and other parameters to be 
configured. 

Test KPI 
After the KPI has been configured it should be tested against a set of verified data to 
ensure that objects are color coding as required. 

Overview of Running KPI's 
KPI's are run from the toolbars on the KPI tab of the Object Browser in the Planner 
module, the Merchandiser Module and in ISSC. 
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The toolbar give users the option to run a KPI, remove the KPI from use, edit the 
parameters for the data being displayed in the KPI, refresh the KPI information, display 
the data being used in the KPI and refresh the list of KPIs with the latest from the 
database. 

Types of KPI 
There are four types of object that can be color coded using KPI's. 

 Zones 

 Fixtures  

 Shelves  

 Products  

These KPI's can be used in the Planner module, the Merchandiser module and In-Store 
Space Collaboration.  

Availability of KPI Types 

Planner Module 

Because the Planner module does not generally show shelves or products at Display 
Style level, these forms of KPI are not generally used in that module. 

Merchandiser Module 
All four types of KPI can be used in the Merchandiser module. 

In-Store Space Collaboration 
Which KPIs are available depends on the type of view in use. The options are: 



Admin Planning 

General Options 149 

 Top Graphical View: Zone and Fixture KPIs. 

 Front Graphical View: Fixture, Shelf and Product KPIs. 

  Shelf Graphical View: Product KPIs. 

Zones 
Zones can be color coded according to performance criteria. In the example below, the 
zones in Planner have been color coded according to the percentage of the available area 
taken up by equipment. As the number of fixtures in a zone increases, the color coding of 
a zone changes to reflect the increasing amount of floor area taken up by equipment. 

 

How a zone will color for a KPI in Planner depends on whether it is hatched or not. In 
the screen shot below, the left hand image shows a KPI applied with hatching turned off. 
In this case, the line defining the boundary of the zone will color. In the right hand image 
hatching has been applied. In this case the entire zone will color. 
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Zone KPIs will also display in the Merchandiser module. Objects not specific to the KPI 
in the Merchandiser module will display in a semi-transparent form. In  the example 
below, the fixtures have been turned semi-opaque. 

 

Fixtures 
Fixtures can also be color coded by performance criteria. In the example below from the 
Planner module, fixtures designated as promotional fixtures have been color coded 
differently to standard fixtures. 
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How Fixtures display in Planner depends on the visual style used. These can be changed 
using the visual style toolbar (shown below the fixtures). 

 

The fixtures on the left are shown in conceptual visual style, the ones on the right in wire 
frame. 

Note: If KPI's are displayed in wire frame mode, only the 
outlines of the fixture will color. 

Fixture KPI's will also display in the Merchandiser module. 
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Fixtures and Coloring for KPIs in Planner 
For fixture KPI's to work in Planner, the AutoCAD blocks used to represent the fixtures 
must have specific properties. Specifically, the block referenced by Fixture Studio must 
have the Color properties set to By Block. This enables individual fixtures to color as 
specified by the KPI functionality. If the Color property is left as the default (By Layer), 
the KPI will not work in Planner. 

 

Shelves 
Shelf KPI's are generally only be used in the Merchandiser module. In this example the 
shelves on the fixtures have been color coded according to their performance. Objects not 
specific to the KPI will display in a semi-transparent form. In the example below, the 
fixtures have been turned semi-opaque. 
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An example of a Shelf KPI might be a book shop giving the performance of the genre of 
books each shelf contains. 

Products 
Product KPI's can only be used in the Merchandiser module. In this example the 
products on the shelves and fixtures have been color coded according to their 
performance. Objects not specific to the KPI will display in a semi-transparent form. In 
the example below, the fixtures and shelves have been turned semi-opaque. 
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Configuring the KPI 

Data Source 
There are two main data sources for Key Performance Indicators: 

 SQL Statements  

 Stored Procedures 

These must first be created and tested before the KPI itself can be configured. These use 
standard SQL. The results must contain the following information: 

 A Store ID (STR_ID) to identify the bricks and mortar outlet the information is 
valid for. 

 A File ID (FIL_ID) to identify the specific floor plan the data is associated with. 

 A Calendar ID (CAL_ID) to identify the time period the data is valid for. 

 An Object ID to identify what object to color in the floor plan. This may be a 
Zone ID (ZON_ID), Fixture ID (FIX_ID), Shelf ID (SHF_ID) or Product ID 
(PRO_ID). Each of these IDs is for the instance of the object placed in the floor 
plan. 

 One or more columns of results. 

Configuring the KPI 
The KPI can then be configured in the Key Performance Indicator dialog box. 
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Note: This functionality allows the user to specify the data 
returned for KPIs using SQL statements and stored 
procedures. The functionality has been disabled by default. 
Please refer to the Functional Security section in the 
Administration Module User Guide for information on how 
to give access to this functionality. 

 

KPI Name 
This is entered in the text box at upper left then added by pressing Return. The name will 
then appear in the name field in the right hand side of the dialog box. 

Description 
This is used purely in the dialog box and gives information on the purpose of the KPI. 

Data Source 
This is the SQL s tatement or stored procedure used to generate the data used in the KPI. 

Note: Older KPI's may use a table or a view as the data 
source. This functionality has been maintained for backward 
compatibility and new KPIs cannot use these as a data 
source. 

Column 
The column must be a column in the results returned by the SQL statement of stored 
procedure. 

Units 
The units are those for the data. They are selected from a drop down list.  The most 
commonly used are 'Pure Number'  for data such as movement and currency values for 
financial results. 

Color Theme 
This is the color scheme used for coloring the results. The range of values it can cater for 
must be compatible with the expected range of results. Weekly financial results will thus 
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have a different color theme from monthly, quarterly or yearly financial results. In Macro 
Space Management, results outside the ones specific in the Color Theme will be colored 
Black. 

Legend Minimum 
This is used in In-Store Space Collaboration. Results below this value will result in the 
object being colored black.   

Legend Maximum 
This is used in In-Store Space Collaboration. Results above this value will result in the 
object being colored black.   

KPI Type 
This is used to specify the type of object to be colored. The SQL statement or stored 
procedure used to generate the result set must contain the appropriate ID for this type of 
object - for example a Fixture ID (FIX_ID) for KPIs designed for fixtures.  

KPI Type and KPI Group 

The KPI Type also determines which KPI Group the KPI will appear under in the Object 
Browser. It will be associated with the first group of that type. If there are multiple 
groups of the same type, the parent group can only be changed directly in the database. 

Query Type 
This drop down list specifies whether the data source is a SQL statement or stored 
procedure. 

Selecting a Color Theme Using the Wizard 
If no color theme has yet been created, clicking the Wizard button to the right of the 
Color Theme drop down list will start the Color Theme Wizard. 

 

Clicking Next will bring up the Chose Indicator screen. Highlight the KPI it is desired to 
create a color theme for. 
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Clicking Next will bring up the Chose Store and Calendar screen. Uncheck the check 
boxes and chose a store and a calendar period with representative data. If the data is not 
representative, the Color theme will not cover the correct intervals. 

 

Clicking Next will bring up the Choose Grouping Method screen. This will generally 
have one choice selected and the others grayed out. 
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Clicking Next will bring up the Select Color Theme screen. The Statistics will be 
determined from the selected store between the specified data range. The Theme Details 
will be set to default values and should be modified to the required band size, quantity 
and colors. 

Note: This screen may take some time to populate. 

 
Click Next. This will bring up the Preview Color Theme screen. This shows the selected 
data and how it will be color coded. The Cost, Price and Movement columns will only be 
populated if financial data is involved. This enables the person configuring the KPI to 
confirm the calculations for the indicator are working correctly. 
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Click Next. The final page of the wizard will appear. Enter the name of the new Color 
theme.  

 

Click Next and the color theme will be created while the user will be returned to the Key 
Performance Indicators dialog box. 

Validating the KPI 
When the OK button is clicked on the Key Performance Indicator dialog box, all KPI's are 
validated. If there is a problem with a KPI, an error message will result. In  the example 
below, an incorrect name for the required stored procedure has been entered. 
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On clicking OK on the error message, the dialog box will close and the user will be 
returned to the Key Performance Indicator dialog box. The name of the KPI with a 
problem will be highlighted, as will the field with the problem. In the example below, the 
Example Error KPI has been highlighted in the list of KPIs, while the incorrectly named 
stored procedure has been highlighted in the Data source field. 

 

It will not be possible to close the Key Performance Indicator dialog box by clicking OK 
until all KPIs validate correctly. 

Validating the KPI 
When the OK button is clicked on the Key Performance Indicator dialog box, all KPI's are 
validated. If there is a problem with a KPI, an error message will result. In  the example 
below, an incorrect name for the required stored procedure has been entered. 

 

On clicking OK on the error message, the dialog box will close and the user will be 
returned to the Key Performance Indicator dialog box. The name of the KPI with a 
problem will be highlighted, as will the field with the problem. In the example below, the 
Example Error KPI has been highlighted in the list of KPIs, while the incorrectly named 
stored procedure has been highlighted in the Data source field. 
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Possible Actions 
The Key Performance Indicator dialog box cannot be closed unless all KPI's validate 
correctly. Therefore the following options are available: 

 Correct the problem with the indicated KPI. If this can be done, when the OK 
button is clicked again, the KPI will validate correctly, the dialog box will close 
and the KPI will be saved back to the database. 

 Delete the KPI by highlighting it and clicking the Delete key. The KPI will be 
deleted without any further confirmation. 

 Click the Cancel button. The user will exit the dialog box without any recent 
changes being saved (except any deleted KPIs will remain deleted). 

It is recommended that administrators enter and save one KPI at a time. This will 
immediately show up a problem and allow it to be addressed. If multiple KPIs are 
configured before the UK button is clicked, correcting problems becomes more difficult 
as each has to be corrected in turn before the Key Performance Indicator dialog box can 
be closed. 

Worked Example for Creating a KPI 
This section of help gives a simple worked example of creating a KPI.  A similar 
technique can be used to create more complex KPIs to retailer specific requirements. 

KPI Groups 
KPI's can be assigned to KPI Groups. For the purposes of this worked example, a KPI 
Group called Demo Group has been created. 
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KPI Groups can only be created directly in the database by DBAs with access to the 
database. See the Oracle Retail Macro Space Planning Data Model for details of the table and 
fields. 

Selecting the Data 
There are two ways of selecting the data to display in a KPI: a SQL statement or a stored 
procedure. SQL statements are inherently less efficient as they return the entire data set 
before the KPI selects the subset of data required for the floor plan the KPI is to be 
displayed in. A stored procedure can return a set of results specific to the currently active 
floor plan and thus results in a smaller and more efficient data set. 

Example SQL Statement 
The SQL statement used to generate the results for the example KPI is as follows: 

 

Points to note are: 

Case Statement 

The case statement has been used to return two possible values; 0 and 1. This is because 
the color Theme used to display the results will have two bands; 0 - 1 and 1 - 2.  The 
name of the case will later be used in the KPI definition to define which column of data is 
to be displayed. 

Fields Selected 

The SQL statement also contains the five mandatory fields that must be present in any 
SQL statement or stored procedure. These are: 

 File ID (FIL_ID) 

The File ID is used to identify the specific floor plan the KPI is to be displayed 
for.  

 Store ID: (STR_ID) 

The Store ID is used to identify the store the state is for. Imported data is 
generally identified by store ID - i t will be up to the user to identify the floor plan 
the data is pertinent for when the KPI is run.  
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 Object ID (in this case FIX_ID) 

The Object ID identifies what is to be color coded. There are four types of objects 
that can be color coded in KPIs: 

– Zones (ZON_ID) 

– Fixtures (FIX_D) 

– Shelves (SHF_ID) 

– Products (PRO_ID) 

The range of objects that can be used in KPI's can be extended outside of this list 
by coloring the parent object. For example planogram performance can be 
displayed by displaying the results using their parent fixtures. 

 Calendar ID (CAL_ID) 

The calendar period identifies the time period the data is associated with. In this 
example, promotional fixtures are not associated with a specific time period, so 
the Calendar ID is been pre-defined as all periods. If data is time dependent, the 
CAL_ID will be used when to select data for the correct time range when 
running the KPI.  

 A Column of Results 

a. At least one column of results must be returned by the query. It is possible to 
return multiple columns of results, thus making a single query pertinent for 
multiple KPIs. An example would be for product performance, where the query 
could return movement, margin and profit.  

Commented Out Where Clause 
The where clause has been commented out and will not be used when configuring the 
KPI. It was used to return a set of results from a specific floor plan. These results were 
used to validate that the query was functioning correctly. In practice, the Where clause 
would be deleted after conforming the query was operating correctly. 

 

Color Theme 
Next the color theme is set up. For this worked example it has been called KPI Example. 
In this case we require just two bands; one for standard fixtures and one for Promo 
Fixtures. The case statement in the SQL statement gives values of 0.5 and 1.5. This 
ensures results in the middle of the two bands; 0 - 1 for standard fixtures and 1 - 2 for 
promotional fixtures. 
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Creating the KPI 
The KPI can then be created by selecting the Key Performance Indicator option from the 
general menu. This will bring up the Key Performance Indicator dialog box.  

1. Type in the name of the new KPI into the blank text box at top left of the dialog box 
and press return.  

2. Highlight the KPI name in the list of KPIs. This will bring up a set of blank fields on 
the right. Data can then be entered accordingly. 

 

a. The KPI Name will already be filled in. 

b. Enter a Description.  This will appear in the tooltip of the Object Browser in the 
Planner and Merchandiser modules and in In-Store space collaboration. 

c. Enter the Data source. As we will be using a SQL statement, this will be the SQL 
created and tested earlier. 

d. Enter the Column. This is the column from which the data to color the KPI will 
be selected. In this case it is the PROMO column from the case statement in the 
SQL statement. 

e. Enter the Units. This will generally be Pure Number. 

f. Select the Color Theme. In this case the KPI Example color theme created earlier 
is selected from the drop down list. 
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g. Set the Legend Min. This is the minimum value for which the KPI will be 
colored. Any value below this value will result in the object being colored black. 

h. Set the Legend Max. This is the maximum value for which the KPI will be 
colored. Any value above this value will result in the object being colored black. 

i. Set the KPI Type. This is the type of object that will be colored. In this case it is 
set to Fixture. This setting also determines which KPI Group the KPI will be 
associated with in the Object Browser in the Planner  

j. Set the Query Type. This specified the source of the data. In this case it is set to 
SQL statement from the options in the drop down list. 

3. Click the OK button. The data will be validated. If correct, the dialog box will close 
and the KPI will be added to the database. 

KPI Group 
When the KPI is created, it will be assigned to a KPI Group in the hierarchy that appears 
in the Object Browser in the Planner and Merchandiser Modules and in ISSC. KPI Groups 
are of type Zone, Fixture, Shelf or Product. The KPI will be assigned to the first KPI 
Group that matches the type set in the KPI Type drop down list in the Key Performance 
Indicators dialog box. If there are multiple KPI Groups of the same type, it may be 
necessary to change the parent group directly in the database. See the Oracle Retail Macro 
Space Planning Data Model for details of tables and fields. 

Running the KPI 
If the Planner or Merchandiser module was active at the time the KPI was configured, the 
new KPI can be displayed by clicking Refresh on the KPI tab of the Object Browser 
toolbar. To get the new KPI to show in In-Store space collaboration the ISSC Server 
Service must be restarted. This must be done at a carefully selected time as this will 
disconnect any currently active users. The recently created KPI will then appear in the 
KPI hierarchy. 

 

Manufacturers 

Overview of Manufacturers Option 
The Manufacturers Option  is used to create a list of manufacturers for use within the 
Macro Space Management software. 
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The list of manufacturers is used in two places in the software: 

1. It allows Manufacturers to be assigned to Fixtures in the Block Details dialog box in 
Fixture Studio. 

 

2. It allows Manufacturers and Suppliers to be assigned to Products at the SKU level in 
Product Studio. 
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Note: A Manufacturer would typically be the company that 
produces the product, a Supplier the wholesaler that 
supplies it. 

The list of manufacturers can either be entered manually in the Administration Module, 
or imported from a third party database. The Manufacturers option in the 
Administration Module allows this list of manufacturers to be reviewed and then edited. 
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Using the Manufacturers Dialog Box 
The list of manufacturers will be normally be added or updated using a data import. This 
section of help briefly describes how to manually add, edit or delete data. 

 

Adding a Manufacturer 
To Add a Manufacturer: 

1. Click on the Add Manufacturer icon. This will generate a fresh row of data at the top 
of the dialog box. 

2. Type in the Manufacturer's Name and Code into the pertinent boxes. 

3. Select the Manufacturer's Type from the drop down list. 

4. Press Return. This writes the information back to the database. Return must be 
pressed after each line of data is entered. 

Manufacturers assigned to the Fixtures Category will become available in the Fixture 
Studio Module. Similarly, manufacturers classed in the Products Category will become 
available in the Product Studio Module. 

Editing a Manufacturer 
To Edit a Manufacturer:  

1. Click on the entry in the table of manufacturers. 

2. Edit the entry as required. 

3. Press Return to write the information back to the database. Return must be pressed 
after each line of data is edited. 

Deleting a Manufacturer 
To delete a manufacturer: 

1. Highlight the required line of data  

2. Click Delete on the toolbar. 

3. Click Yes on the confirmatory dialog box that will appear. 

Refreshing Data 
The Refresh icon on the toolbar is for updating the dialog box with the latest information 
from the database. This would be used if several people were concurrently updating the 
list of manufacturers, 
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Status & Status Levels 

Overview of Statuses 
Statuses are used within Macro Space Management to indicate where an object is within 
a business life cycle. They also influence the behavior of In-Store Space Collaboration. 
Statuses are maintained using the Status dialogue box accessed from the General menu. 

Note: Customizing Macro Space Management may be done 
to customer specific requirements. Because of that 
customization, there may be small differences between the 
generic examples in this Help file and a specific 
implementation of Macro Space Management. For advice on 
any aspect of customization or terminology, please contact 
Oracle's Technical Support Team. 

For example a store could have Proposed status, Open status or Closed status depending 
on whether it was at the planning stage, was in operation, or had been closed for 
refurbishment. Similarly, a planogram could be at the planning stage (Proposed status), 
in use (Current status), or superseded by a newer version (Historical status). 

IMPORTANT NOTE: Once a status flow has been set up 
and is in use, it is generally difficult to change it because the 
software will not allow you to significantly edit or delete 
statuses that are in use. Accordingly, status flow should be 
carefully planned during the implementation of the software 
so that subsequent changes are not required. 

Statuses can be given to: 

Object Comment 

Blocks Blocks are typically fixtures and other AutoCAD objects used in the 
Planner environment 

Files Files are store plans associated with a floor of a store 

Floors A floor is the layout for a specific level within a store 

Planograms Planograms are arrangements of products designed to go onto specific 
fixtures 

Planogram 
Substitution 

Planogram Substitutions are lists of planograms to be swapped in specific 
stores at specific times 

Products Products can be given statuses at all levels in the hierarchy 

Report Statuses can be given to Planogram Report Layouts (not to the report 
themselves). 

Revisions Revisions are folders containing a specific implementation of a store plan 

Stores A store is a specific retail outlet. 

Some objects have independent status: for example Stores and Floors can have their 
status changed without affecting the status of any objects below them in the hierarchical 
tree. Other objects have their behavior determined by their status. For example, it is not 
possible to place a product of Historical status in a drawing. Some status changes are 
reversible. For example a file may generally be swapped between Proposed and 
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Authorized status. Other changes are irreversible. For example, once a file's status has 
been changed from Current to Historical it cannot normally be changed back. 
Understanding the changing status of objects is fundamental to the operation of Macro 
Space Management. 

Status Levels 
Each status must be assigned to a unique status level. The Status Level determines the 
sequence the Status is used in. Status Levels are maintained using the Status Level 
dialogue box accessed from the General menu. 

Factors Affecting Statuses 

System Variables 
Some System Variables have an influence on Statuses. 

Note: System Variables can be changed using the System 
Variable option on the General Menu. 

ENABLE_FILE_TRIGGER_DATES 
ENABLE_FILE_TRIGGER_DATES can be set to one of three values: 

Value Result Other Actions 

0 or 1 UpdateStatus.exe is disabled and has no effect 
on File or Revision statuses. Publish and 
Effective dates are disabled and cannot be set. 

Publish and Current statuses need to 
be selectable so that files can manually 
be taken through the software cycle. 

2 Effective date is enabled. UpdateStatus.exe 
will change file status if the Effective date is 
exceeded. 

Publish needs to be manually 
selectable. 

3 Publish and Effective dates are enabled. Publish and Current status should not 
be selectable by the user so that update 
status is the required method to 
change them. 

  

Note: If ENABLE_FILE_TRIGGER_DATES is set to 0, 
running UpdateStatus.exe will still change the status of a 
store from Proposed to Open or from Open to Closed if the 
Birth or Death dates are exceeded. 

Note: this system variable should not be changed with the 
Planner or Merchandiser modules open or unpredictable 
results may occur. 

MERCH_TREE_EFFECTIVE_DATE 
This system variable can be set to On (1) or Off (0 ). If set to On, it affects whether fixtures, 
products and planograms can be selected from the hierarchy in the object browser. 

Effective Date Set 
If an Effective date has been set for the drawing, fixtures, products and planograms 
cannot be placed if: 
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1. Their Effective date is after the Effective date of the drawing 

2. Their Expiry date is before the Effective date of the drawing 

If an Active date has been set for the drawing, this overrides the Effective date for the 
drawing. Then fixtures, products and planograms cannot be placed if: 

1. Their Effective date is after the Active date of the drawing 

2. Their Expiry date is before the Active date of the drawing 

Note: MERCH_TREE_EFFECTIVE_DATE does not affect the 
Object Grid. 

Custom SQL 
Custom SQL can be used in conjunction with statuses to control what displays in the 
hierarchies in the object grid. With the right custom SQL it is possible to: 

 Restrict the display of fixtures to those of Current status  

 Restrict the display of products to those of Current status 

 Restrict the display of planograms to those of Current status  

At present the default is to display fixtures, products and planograms of all statuses. 
Modifying the SQL to restrict the display of objects in the Object Browser can only be 
done by administrators with access to the database. 

Data Importer 

If data is imported using Data Importer, it is possible to set the status for imported 
objects to some default value - for example 'Proposal'. 

Statuses and UpdateStatus.exe 
UpdateStatus.exe is found in the C:\Oracle Retail\MSM\APPS Windows folder. When 
run, it will: 

1. Change the status of a floor plan from Published to Current if the Effective Date has 
been exceeded 

2. Change the status of a floor plan from Current to Historical if another file in that 
floor has had its status changed to Current. 

Note: The floor plan status, Publish and Effective Dates can 
be seen in the Properties dialog box accessed from the Store 
Manager module. 
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3. Change the status of a Store from Proposed to Open if the Opened Date has been 
exceeded 

4. Change the status of a store from Open to Closed if the Closed date has been 
exceeded 

Note: The Opened and Closed Dates can be found in the 
Store dialog box accessed from the Store Manager module. 

 

For UpdateStatus.exe to work correctly, the generic statuses associated with ID's in the 
Status Levels dialogue box in the Administration module should not be changed. For 
example, when UpdateStatus.exe changes statuses from Authorized to Current, it 
changes the ID in the database from 4 to 2.    
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Making (for example) Current Status anything other than ID 2 will cause problems with 
UpdateStatus.exe (and other Macro Space Management functionality). 

Where Statuses are Set in the Software 
Statuses can be manually set in the software. 

Note: Customizing Macro Space Management may be done 
to customer specific requirements. Because of that 
customization, there may be small differences between the 
generic examples in this Help file and a specific 
implementation of Macro Space Management. For advice on 
any aspect of customization or terminology, please contact 
Oracle's Technical Support Team. 

Clusters 
Clusters (and sub clusters) do not have statuses. 

Stores 
Store status is set in the Store Manager Module from the Add or Edit Store dialogue 
boxes. 
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Floors 
Floor status is set in the Store Manager Module from the Add or Edit Floor dialogue 
boxes. 

 

Revisions 
Revision status is set in the Store Manager Module from the Add or Edit Revision 
dialogue boxes. 

 

Files (Store Plans) 
File status is set in the Store Manager Module from the Properties dialogue box. 
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The status of a file can also be changed by clicking Accept or Reject on exiting a changed 
floor plan in In-Store Space Collaboration if the user has been assigned permissions to 
this dialog box. 

 

Blocks (Fixtures) 
Block (fixture) status is set in the Fixture Studio Module from the Block Details dialogue 
box. 
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Products 
Product status is set in the Product Studio module. They can be set at all levels in the 
hierarchy except for display styles. For levels in the hierarchy from Company to Item, the 
status is set in dialogue boxes similar to that below. 

 

 For items at SKU level, the status is set in the Product SKU dialogue box. 
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Planograms 
Planogram status is set in the Merchandiser module from the Details tab of the 
Planogram Design dialogue box. 

 



Status & Status Levels 

178 Oracle Retail Macro Space Management 

Planogram Substitutions 
The status of a planogram substitution is set in the Properties tab of the Definition details 
dialog box in the Planogram Substitution module. 

 

Reports 
Report Status is set in Report Designer in the Report Properties dialogue box (accessed 
from the File menu when a report is open). 
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Statuses and In-Store Space Collaboration 

Overview 
Although statuses cannot be directly configured in In-Store Space collaboration: 

1. The status of a store plan determines whether it can be seen in In-Store Space 
Collaboration or not. 

2. Clicking on the Save dialog box when closing a floor plan in In-Store Space 
Collaboration changes the status of the drawing. This will affect whether the floor 
plan is still visible in In-Store Space Collaboration and the status it is at in Macro 
Space Management. 

Status of Store Plan 
Store Plans can only be seen at specific statuses. This is configured using the Data 
Security option in the Admin Module. User Groups can be assigned to Statuses. 
Members of those User Groups will be able to see Store Plans (Files) belonging to those 
statuses in In-Store Space Collaboration. 

 

In the above example, users in the In-Store user group will be able to see files that have 
been set to ISSC status in Macro Space Managements' Store Manager module. 

Effect of Accept or Reject in In-Store Space Collaboration 
When a drawing is closed in In-Store Space Collaboration (after making changes) a Save 
dialogue box comes up. The nature of the dialogue box seen by a specific user will vary 
slightly depending on settings in the database. 

The most basic dialog box only has Save and Discard options. The floor plan can be 
saved, but the status remains unchanged. 

 

An alternative dialog box has a Save and Submit option. Clicking this button will change 
the current status of the floor to one further on in the status flow for the drawing 
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A further type of dialog box has Accept and Reject buttons. Clicking Accept will change 
the current status of the floor plan to one further on in the status flow for the drawing; 
clicking Reject will change the status of the floor plan back to a prior status. 

 

Example of Use of Statuses 

An example of using the statuses in this manner can be seen in the flowchart below. 

 

Planning starts in Macro Space Planning. The floor plan is only visible in Macro Space 
Management while it is at Proposed or Accepted sta tus. When the status reaches Ready 
for ISSC, the floor plan becomes visible in In-Store Space Collaboration. After working on 
the floor plan, the use will be presented with the dialog box containing Accept and 
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Reject buttons. Clicking Accept moves the status onto Authorized. Clicking Reject moves 
the status back to Accepted. This allows the ISSC user to take part in the store planning 
process. 

Overview of Status Levels 
Status Levels  are the generic stages where actions related to statuses can be triggered in 
the software. Status levels are called from the General menu. 

This will bring up the Status Levels dialogue box 

 

Generic Status Levels 
On installation, the software contains a series of generic statuses, each associated with a 
status ID. The software (particularly for Stores, Files and Revisions) will carry out specific 
actions associated with the Status Level ID (not the Status Level Description). 

1. In some circumstances, manually changing the status of a Revision will change the 
status of the files within it. 

2. In some circumstances, the status of files and revisions can be changed automatically 
by UpdateStatus.exe. 

3. In some circumstances, the status of stores can be changed automatically by 
UpdateStatus.exe. 

These generic statuses should not be edited or deleted or there may be problems with 
software functionality. The generic statuses are that should not be changed are: 

1. Authorized 

2. Published 

3. Current 

4. Historical 

Custom Status Levels 
It is possible to add custom status levels to the default status levels. This is because each 
status must be associated with a unique status level. If a status work flow has ten statuses 
in it, there must be ten status levels configured in the Status Levels dialogue box. 
Accordingly, the generic description can be slightly modified - for example changing 
'Proposed' to 'Proposal' - but the generic description associated with a particular Status 
Level ID should not be changed. For example associating 'Historic' status with Status 
Level ID 4 (rather than 3) will cause problems with the operation of the software. Custom 
Status Levels should therefore be added to the generic Status Levels and not substituted 
for them. 
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Using Status Levels 
The Descriptions in the Status Level dialogue box appear within the Status dialogue 
box as the Level for a specific status. Each status must be associated with a specific and 
unique status level. In the example below, each status for floor maps back to a specific 
status level. 

 

In the example below it has been decided to add an ISSC status to the statuses to denote 
store plans (files) available to users in In-Store space collaboration. In order to add the 
new status in the Status dialogue box, it is first necessary to add an ISSC status level to 
the Status Levels dialogue box. 

 

If you attempt to create a new status and associate it with a status level that is not unique 
to that status, a warning will be shown in the status bar of the dialog box. 

About Status Options 
The Status dialogue box is used to configure the varying Statuses used to control 
business flows within Macro Space Management. It can also be used to partially 
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configure the behavior of statuses within In-Store Space Collaboration, although the rest 
of this configuration has to be done directly in the database. 

Note: Customizing Macro Space Management may be done 
to customer specific requirements. Because of that 
customization, there may be small differences between the 
generic examples in this Help file and a specific 
implementation of Macro Space Management.  

 

Statuses may be added, edited or deleted by selecting the appropriate options from the 
menu bar or toolbar.  

It is recommended each status type contain a minimum of 
three sta tus levels. These would normally include Proposed, 
Current and Historic. 

Type 
Type defines the type of object the status will be assigned to. It is selected from a drop 
down list that is not user configurable. 

Level 
Level indicates where in the flow for that object that status comes. Each level must 
correspond to a unique status level defined in the Status Levels dialogue box. 

Note: Status Levels are assigned a Status ID in the database. 
These Status ID's are not visible to or configurable by the 
user. Certain Macro Space Management actions are tied to 
those Status ID's. For example archiving is carried out on 
files with a Status ID of 4. If superseded (Historical) files are 
given a Status with an ID of anything other than 4, archiving 
will not work. 

Description 
This is a user configurable field that allows users to customize the description of 
associated with the level. This description then appears in the varying dialogue boxes 
that use status. For example, it would be possible to assign the description 'Superseded' 
to the Historical level. 
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Order 
This is the order that the statuses will be used (and the order they will appear in any 
dialogue boxes). 

Reversible 
If a status is set to reversible, it can be changed back to a status lower in the order by the 
user. If a status is not reversible, then the user cannot revert to an earlier status. It would 
not be normal (for example) for the change between Authorized and Current Status to be 
reversible. 

Note: At present only file statuses are non-reversible. 

Read Only 
If a Status is set to read only status, all associated objects and files will be able to be 
viewed, but not altered. Objects with Statuses that are not set to read only status may be 
freely edited. As example of an object set to read only status would be a fixture that has 
been set to historic status - as the fixture is no longer in service, there would be no need 
to edit it. 

Note: At present only files are set to read only status. This 
can be directly as a result of the file having its status 
changed, or indirectly as a result of the parent store, floor or 
revision having its status changes to one with read only 
attributes.  For example, changing a floor to closed status 
will generally result in the files associated with that floor 
becoming 'read only'. 

Selectable 
If a status is selectable it can be set by the user. If it is not selectable, then the status can 
only be changed by the software. 

Accept 
The Status specified in the Accept column is the status that the original status will be 
changed to if a user: 

 Clicks Accept or Submit in the Save dialog box of In-Store Space Collaboration 

 When prompted to Submit or to Accept in Planogram Substitution   

Reject 
The Status specified in the Reject column is the status that the original status will be 
changed to if a User: 

 Clicks Reject in the Save dialog box of In-Store Space Collaboration 

 When prompted to Reject in Planogram Substitution   

Approve 
The Approve check box will enable and disable the existing functionality of listing of files 
for approval via the District Manager button in ISSC. This will only have an effect for file 
statuses. 
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Each file status that has the Approve check box ticked will appear in the list of available 
files in the Select Store dialog box when the district Manager button is clicked. 

Code 
The code column allows uses Administrators to enter any status codes in use in third 
party software. When data is imported from that software, the code column can be used 
as a 'look-up' to map the third party status to its Macro Space Management equivalent. 

Basic Example of Configuring Statuses 
A basic example for configuring statuses is the flowchart below for planograms designed 
within the Merchandiser module. 

 

This allows planograms to be started at the design stage, be accepted by a manager, go 
into service and be retired (historical). This is set up in the Status dialogue box as follows: 

 

Type 
This is obviously set to planogram. 
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Levels and Descriptions 
These are selected from the Status Levels dialogue box, ensuring that the description we 
will use later matches up to the appropriate level. 

 

In this instance the Proposed Status Level is matched to the Design description, the 
Authorized Status Level is matched to the Accepted Description, the Current Status 
Level to the In Service description and the Historic Sta tus Level to the Historical 
description. 

Order 
The order is set to the sequence the statuses will be used in: 1 for Design, 2 for Accepted, 
3 for in Service and 4 for Historical. 

Reversible 
Only Authorized status needs to be reversible - giving the option of revering back to 
Design status. Current and Historical statuses should not be reversible as planogram in 
service or having been retired (historical) should not be capable of being edited. 

Read Only 
Typically statuses would be set to read only when the planogram design has been fixed - 
for example at 'In Service' or 'Historical' status. 

Note: At present setting planograms to Read Only status has 
no effect. 

Selectable 
Statuses have to be marked as selectable to be visible in the Planogram design dialogue 
box. In this case, we need all statuses to be selectable, so all have been checked. They will 
then be available in the Planogram Design dialogue box. 
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Advanced Example of Configuring Statuses 
An advanced example of configuring file sta tuses can be seen in the flowchart below. 
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Here the file has three statuses that are set in Macro Space Management's Store Manager 
Module. The third of these statuses (ISSC) is also visible in In-Store Space Collaboration, 
where users can click Accept or Reject on exiting the drawing. 

Clicking Accept in In-Store Space Collaboration will change the status to authorized; 
clicking Reject will change the status back to Accepted. 

When the drawing reaches Authorized status (and Publish and Effective dates have been 
set), the UpdateStatus.exe tool will result in the file successively changing to Published, 
Current and Historical status. 

This is set up in the Status dialogue box as follows: 
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In order to add two additional statuses (Accepted and ISSC) to the existing statuses, two 
additional levels must first be added to the Status Levels dialogue box. 

 

The additional statuses can then be added to the Status dialogue box. 

Type 
This is obviously set to planogram. 

Levels and Descriptions 
These are selected from the Status Levels dialogue box, ensuring that the description we 
will use later matches up to the appropriate level. 

In this instance the Proposed Status Level is matched to the Proposed description, the 
Accepted Status Level is matched to the Accepted Description, etc. 

Note: care was taken to map the Authorized, Published, 
Current and Historical descriptions to their respective levels 
in the status levels dialogue box. This is because the software 
will carry out specific actions associated with these statuses. 

Order 
The order is set to the sequence the statuses will be used in: 1 for Proposed, 2 for 
Accepted, etc. 
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Reversible 
Several statuses have been made reversible (Authorized, ISSC and Accepted). This allows 
users to change the status back to a prior one if the floor plan is not regarded as 
acceptable. 

Read Only 
Statuses have been set to Read Only at Published, Current and Historical status. This is 
because once a drawing has been Published (sent to a store for implementation) it should 
be 'locked' to prevent further changes in it. 

Selectable 
Statuses have to be marked as Selectable to be visible in the Properties dialogue box. In 
this case, we need the Proposed, Accepted and ISSC statuses to be selectable, so they 
have been checked. Authorized status has not been made selectable. This means that the 
status can only be reached by clicking Accept in In-Store Space Collaboration. This is an 
example of how statuses can be used to ensure business processes are followed. 

Accept 
The Status specified in the Accept column is the status that the original status will be 
changed to if a User clicks the Accept or Submit buttons in the Save dialog box of In-
Store Space Collaboration. This is set to 'Authorized'. 

 

Reject 
The Status specified in the Reject column is the status that the original status will be 
changed to if a User clicks the Reject button in the Save dialog box of In-Store Space 
Collaboration. This is set to 'Accepted' . 

Approve 
The Approve check box will enable and disable the listing of files for approval via the 
District Manager button in ISSC. 
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Any status for files that should appear when the District Manager button is clicked 
should have the Approve checkbox ticked. 

Note: The District Manager button is set to disabled by 
default. It can only be enabled directly in the database. This 
is done by setting the MUG_PERMISSION_MASK to 1 for 
the pertinent User Group ID (USG_ID) for MSC_ID = 7243 in 
the Message User Group Link table. For more information 
on the tables in this section see the Oracle Retail Macro Space 
Planning Data Model. 

Code 
The code column allows uses Administrators to enter any status codes in use in third 
party software. When data is imported from that software, the code column can be used 
as a 'look-up' to map the third party status to its Macro Space Management equivalent. 
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System Variable Overview 

Overview of System Variables 
A System Variable is a parameter within the Macro Space Management database that 
specifies how one aspect of the software operates. System variables are often used as 
switches to toggle features on and off, hold dimensions and positions of dialogue boxes, 
etc. 

The following principles should be followed when working with system variables: 

1. System Variables should not be added or deleted. 

2. The only information that should be edited for a System Variable is the 
Description and the Value. 

 

System Variables can be changed in several ways. 

 Through dialogue boxes in the software 

 Through the Configuration Module 

 Through the Administration Module 

Through the Software 
System variables can be changed through the software. This may be explicit, as when the 
user deliberately selects a value in a dialogue box. It may also be implicit, as some system 
variables are used to hold the values of (for example) the positions and sizes of dialogue 
boxes. 
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For example, the Merchandiser Module allows the 'Add Shelf with Product Silently' 
option to be toggled on or off. The value of this setting is stored in the 
ADD_PRODUCT_WITH_SHELF system variable. 

Through the Configuration Module 
The Configuration Module allows a series of settings to be customized by the user. Some 
are saved as system variables. 
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For example, the colors for the connection points set in the Fixturing tab are stored in a 
series of system variables called MALE_BACK_COLOUR, MALE_BOTTOM_COLOUR, 
etc 

Through the Administration Module 
This option allows system variables to be directly changed instead of doing it via the 
software. This is done using the System Variable option from the General Menu. 

 

This allows a user with Administrator's privileges to change the value of a system 
variable. 

Changing system variables can have wide ranging effects on the way Macro Space 
Management. Before making a change it is recommended users should: 

 Ensure they understand the effect of changing the system variable 

 If necessary seek advice from Oracle's Technical Support team 

System Variable Options 
Each System Variable has a series of options associated with it. 

 

Name 
This is the name of the system variable. The name should not be changed as the software 
references these names - changing a name will result in the software failing to find data 
in the database. 
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Description 
This describes what the system variable does. It can be edited to suit customer needs. 

Type 
This specifies whether the system variable is System (global), User (specific to an 
individual) or File (associates properties with a file). System Variable Types are 
determined by the software code and changing the type from the Type drop down list 
has no influence on where the system variable value is stored. The Type should not be 
changed from the value it was set to on implementation.  

Value 
This is the current value held for the system variable. The value must be consistent with 
the data type. 

Note: System variables of the form 100|100|100|100 are 
known as pipe-delineated system variables. They hold the 
multiple values required for that system variable. 

For example, a system variable holding the position of a dialogue box might be of the 
form 100|300|600|600 where the data specifies the left bottom and top right coordinates 
of the dialogue box. When editing a pipe-delineated system variable, all pertinent values 
must be entered or an error will result. 

Data Type 
This is the type of data. It must be consistent with the value to be stored for the system 
variable. Types can selected from a drop down list, but should not be changed from those 
set on implementation. They are of the following types: 

Data Type Example 

String Any alphanumeric input (ABC123) 

Integer Any Integer (1, 2, 3) in the range -2 billion to +2 billion 

Long Any Integer (1, 2, 3) in the range -9 x 1018 to 9 x 1018. 

Single  Any number (1.23, 2.2345) in the range -3 x 1038 to 3 x 1038. 

Double Any number (1.23, 2.2345) in the range -2 x 10308 to 2 x 10308. 

Date Date (10/10/07 12.15:00:00) 

Boolean True or False values (0,1) 

Image Bit Maps, GIF and JPG images 

Currency Financial data (£1234.00) 

Active 
This specifies whether the system variable is in use or not. Settings should not be 
changed from those set on implementation. 

Category 
This specifies which module the system variable a ffects. Settings should not be changed 
from those set on implementation as the software uses this setting to see which system 
variables should be read when opening a module. 
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System Variable Types 
The System Variable Type determines the purpose of the system variable. There are 
three system variable types: 

 System 

 User 

 File 

System 
System Variables of type 'System' are global system variables. Changing the value of this 
type of system variable will affect all users of the system. The values of this type of 
system variable are written to the System Variable table in the database. 

User 
System Variables of type 'User' are specific to one user. They are typically used to hold 
that users' preference. The values of this type of system variable are written to the User 
Variable table in the database. When a user first uses functionality on becoming a Macro 
Space Management, they start with the defaults from the System Variable table; 
thereafter their preferences are s tored in the User Variable table. 

File 
System Variables of type 'File' are used to assign properties to files on creation. Users can 
then overwrite the default with their own value. The values of this type of system 
variable are written to the System Variable table in the database. The default value is 
then also written to the appropriate table for a file when that file is created. 

Note: more information on these tables can be found in the 
Oracle Retail Macro Space Planning Data Model. This is 
available on My Oracle Support for all Oracle customers. 

Adding, Editing and Deleting System Variables 
Adding, Editing or Deleting a system variable is via the options on the Toolbar or Menu 
Bar. The following principles should be followed when working with system variables: 

 System Variables should not be added or deleted. 

 The only information that should be edited for a System Variable is the 
Description and the Value. 
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Adding System Variables 
There is no purpose in adding system variables. These will only have an effect if they are 
referenced the code in the software. 

Editing System Variables 
System variables can be edited via the Administration Module as an alternative to 
changing them via the software. This should be done with caution. 

Deleting System Variables 
System Variables should only deleted after consulting the Oracle Support team. Deleting 
a system variable in use with the software can cause significant problems. 

Note: Deleting key system variables referenced by the 
software may cause the system to suffer a critical failure. 

Grouping by Columns 
The user has the option of grouping system variables together by column header types. 
To do this, drag a column header into the indicated space at the head of the dialogue box. 

 

This will group all the system variables by the selected criteria - for example Type. 

 

Clicking on the '+' sign will expand the list and allow users to see all system variables in 
that group. 
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To return to the default display, just drag the selected column header out of the space at 
the head of the dialogue box. 

In-Store Space Collaboration System Variables 

When Changes to ISSC System Variables Take Effect 
The basic configuration for Macro Space Planning can be specified as follows: 

 

Macro Space Management 
Macro Space Management has a direct connection to the Macro Space Planning database, 
Changes made to system variables in the Administration module are immediately 
written back to the database. 

In-Store Space Collaboration 
The application users see - the ISSC client - is installed on their personal PC or laptop. 
The client has connection details for the ISSC Server service. This is typically installed on 
the server containing the MSP database and serves as a gateway to that database. 
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The ISSC Server Service and ISSC System Variables 

The ISSC Server Service holds system variables in memory. This speeds up use of the 
ISSC application but it means system variables do not dynamically update. In order to 
make changes made to ISSC system variables take effect on the ISSC Clients, the ISSC 
server Service must be stopped and restarted. This causes the system variables to be 
reloaded into memory, updating their values. 

ISSC System Variables not in Use 
The following ISSC System Variables are not in use. 

Note: This list is not exhaustive. 

IN-STORE_FIXTURE_ATTRIBUTES_PRINT_FONT 

IN-STORE_FIXTURE_ATTRIBUTES_PRINT_FONT_SIZE 

N-STORE_FIXTURE_ATTRIBUTES_PRINT_HEADING_FONT 

IN-STORE_FIXTURE_ATTRIBUTES_PRINT_HEADING_FONT_SIZE 

IN-STORE_FIXTURE_ATTRIBUTES_PRINT_HIGHLIGHTS 

IN-STORE_FIXTURE_ATTRIBUTES_VERSION 

IN-STORE_GRIP_COLOUR 

IN-STORE_GRIP_HOTCOLOUR 

IN-STORE_GRIP_SIZE 

IN-STORE_MERGE_PLANOGRAMS 

IN-STORE_PROMOTION_USER_GROUP 

IN-STORE_SELECTION_LEVEL 

IN-STORE_STMPSERVER 

IN-STORE_SUBMIT_STATUS 

MAX_FIXTURE_SELECTION 

OPTIONS_PRE_POPULATED_PRODUCTS 

System Variables used to Configure ISSC 

Client and Server Version 
The CLIENT_VERSION  system variable is set automatically on installation of In-Store 
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run. 
There is no need to manually change the value. 

The SERVER_VERSION system variable is set automatically on installation of In-Store 
Space Collaboration. It will be updated automatically if upgrade scripts, etc, are run. 
There is no need to manually change the value. 

Problems Communicating with the Server Service 
If the ISSC Server Service cannot establish a connection to the database, a warning 
message will result. The times it takes for this dialog box to appear and how long it is 
visible are controlled by two system variables. 
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The IN-STORE_TIMEOUT system variable sets the time in seconds that the In-Store 
Space Collaboration Client will wait for a response before it detects a time out has 
occurred. 

The IN-STORE_TIMEOUT_MESSAGE system variable determines the amount of time 
the warning message will display. After the specified time has expired, In-Store Space 
Collaboration will automatically shut down (unless the wait button is clicked). 

Help Files 
The IN-STORE_HELPLOCATION system variable contains the URL (Uniform Resource Location) 
for the help files for In-Store-Space Collaboration. It should detail both the path to the directory 
and the name of the file used to open the help. The default name for the file used to open help is 
In-Store_Space_Collaboration.htm. The path to the file will depend on where the implementer 
has chosen to install the files. 

Note: The ISSC help is in Webhelp format. This differs from 
the CHM files used for Macro Space Management. 

Module Block ID 
The MODULE_BLOCK_ID system variable is used to identify the block used when 
moving products temporarily into an aisle. This functionality is used in In-Store Space 
Collaboration, but not in Macro Space Management. The value should correspond to the 
ID of a suitable block in the table of Block Details in Fixture Studio. 

 

Skipping Zone Selection 
The SKIP_ZONE_SELECT  system variable affects whether the Select Data dialogue box 
is shown during the process of selecting a floor plan. All users see the Select Store 
dialogue box. 
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When a store has been selected, an optional Select Data dialogue box allows users to 
select which of the zones they wish to display. 

 

SKIP_ZONE_SELECT determines where the Select Data dialogue box displays or not; 

 If set to 0, the dialogue box will display and users will be able to select zones 
before opening the store plan 

 If set to 1, the dialogue will not appear and the store plan will open displaying all 
zones 
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Controlling Fixture, Product and Planogram Annotation 

Overview of ISSC Annotation 
There are five forms of annotation used in top graphical view. The appearance of each is 
controlled by system variables. 

Zone Annotation 
Zones are annotated with the zone name and area. 

 

The only thing that can be controlled for zone annotation is the text size. 

Other Forms of Annotation 
The other four forms of annotation are more controllable. 

 

Fixture Numbering 

Fixture Numbering is used to allocate a reference number for a fixture. This is unique 
within a floor plan and can be used for reporting purposes or to locate a fixture. Fixture 
Numbering can be one of three forms: 

 Bay Numbering - this depends on bay numbering being assigned to the floor 
plan in the Planner module. 

 Fixture Tags - this depends on information being imported into the Macro Space 
Planning Database 

 Fixture IDs - these are based in Macro Space Planning's own internal fixture 
identification numbers. 

Fixture Annotation 

Fixture annotation is used to identify the type of fixture. 

Product Annotation 

Product annotation specifies the name of the product or planogram present on the 
fixture. 

Profile Annotation 
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Profile annotation is associated with planograms. It gives information on individual bays 
within a planogram. 

Configuring Annotation Position 
The position of each type of annotation is configured in a similar way. This is done via a 
set of system variables. 

Text Insertion Position 

The origin of the annotation position is specified relative to the extents of the fixture. 
There are nine options. 

 

For example, specifying option 1 will result in the annotation being located relative to the 
bottom left corner of the fixture; option 9, the top right corner. 

Text Justification Position 
A datum position is also specified for the justification of the text. There are 9 options. 

 

For example, specifying option 8 will result in the text being justified from the centre top 
position, while specifying position 4 will result in the text being justified from the left, 
centre position. 

Text Offsets 

In addition, text can be offset by a standard distance in the X and Y axes. 

 

Positive values of X move the text to the right, negative values to the left. Similarly, 
positive values of Y move the text up, negative values of Y move the text down. 
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Example of Positioning 

In the example below, the text has been given a Text Insertion Position of bottom left [1] 
and a Text Justification Position of top left [7]. It has also been moved to the right with  a 
positive X offset and down with a negative Y offset. 

 

Configuring Annotation Appearance 
The annotation's appearance can be modified by specifying the font and font size. 

Font 

The font may be specified as any font present on the computers used to run the ISSC 
client. If the font is not present, it will default to Arial. 

Font Size 

Font size is an arbitrary value. Increasing it increases the size of the text, reducing it 
makes the text smaller. 

ISSC Zone Annotation 
Zones are annotated with the zone name and area. 

 

The only thing that can be controlled for zone annotation is the text size. This done using 
the TEXT_ZONE_TEXTSIZE system variable. 

ISSC Fixture Numbering 
The following system variables affect fixture numbering. 

ISSC_BAY_ANNOTATION 
The ISSC_BAY_ANNOTATION system variable determines what form of annotation is 
used for fixtures in an ISSC floor plan. This annotation is used for reference purposes, 
enabling fixtures to be uniquely identified in reports and subsequently located by users 
examining a floor plan. 

There are three options: 
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SV 
Value Description 

0 

This will use the Bay Number Prefix and Bay Number from the Fixture table. This option 
will result in the same bay numbering appearing as is present in the Planner module of 
Macro Space Management. If the floor plan has not been bay numbered in the Planner 
module, no bay numbers will be present in the ISSC version of the floor plan. 

1 
This will use the Fixture Tag (FIX_TAG) from the Fixture table. This value can only be 
populated from data import. If data is not imported, no bay numbers will be present in the 
ISSC version of the floor plan. 

2 

This will use the Fixture ID (FIX_ID) from the Fixture table. This will ensure that all fixtures 
within a floor plan have a unique number allocated. These numbers will be allocated in the 
sequence that the fixtures were placed in the floor plan. Accordingly, numbers may not run 
in adjacent sequences. In addition, as fittings are excluded from this form of numbering it, 
their FIX_ID;'s will be omitted from the annotation - resulting in gaps in the numbering. 

Note: For more information on the Fixture table see the 
Oracle Retail Macro Space Planning data model. 

Annotation based on Bay Numbering 

The bay numbering must first be created in the Planner module. 

 

The numbers can then be seen in ISSC. 

 

Annotation based on the Fixture Tag 

 

Note: This example has been produced by populating the 
field in the database using a SQL statement. 
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Annotation based on Fixture ID 

 

TEXT_FIXTURE_TEXTSIZE 
The TEXT_FIXTURE_TEXTSIZE system variable controls the size of the annotation used 
for fixtures and bay numbering in In-Store Space Collaboration. The value is in inches for 
imperial databases and millimeters for metric ones. This enables administrators to set the 
fixture annotation text size to any pertinent value. The example below shows the effect 
on fixture numbering. 

 

 

ISSC Fixture Annotation 
The system variables described below enable users to configure fixture annotation for In-
Store Space Collaboration. 

 

It shows the TEXT_FIXTURE_OPTION system variable set to 15361, which has resulted 
in the fixture being annotated with the fixture description, plus the fixture dimensions. 

TEXT_FIXTURE_COLOUR 
This option affects the color of the text. It can be set to any value between 0 - 255. These 
values correspond to the AutoCAD Color Index values. The first eight values in the series 
are: 

Value Color 

0 Black 



Admin Planning 

General Options 207 

Value Color 

1 Red 

2 Yellow 

3 Green 

4 Cyan 

5 Blue 

6 Mauve 

7 White 

Note: This system variable is not currently in use. 

TEXT_FIXTURE_DIMASZ 
This system variable is not in use. 

TEXT_FIXTURE_DIMSD1 
This system variable is not in use. 

TEXT_FIXTURE_DIMSD2 
This system variable is not in use. 

TEXT_FIXTURE_DIMSE1 
This system variable is not in use. 

TEXT_FIXTURE_DIMSE2 
This system variable is not in use. 

TEXT_FIXTURE_INSERTION 
This option affects where the fixture is positioned relative to the fixture. There are nine 
options. 

 

For example, specifying option 2 will result in the bay number being located in the centre 
of lower face of the fixture. 

Note: This system variable is not currently in use. 

TEXT_FIXTURE_JUSTIFICATION 
This option affects how the text is justified. There are 9 options. 
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For example, specifying option 8 will result in the fixture text being justified from the top 
centre. 

Note: This system variable is not currently in use. 

TEXT_FIXTURE_NARROWFIXTUREOFFSET 
This system variable is not in use. 

TEXT_FIXTURE_OPTIONS 
This system variable holds a bitwise variable governing what and how the fixture text is 
displayed. The bitwise values are: 

1 - Turn fixture text on. 

2 - Scale size: this option turns on scaling for fixture text. It currently has no effect in 
ISSC. 

4 - Scale offset: this option turns on scaling for the X and Y offsets for product text. It 
currently has no effect in ISSC. 

8 - Reduce text size to fit. This option currently has no effect in ISSC. 

16 - Reduce text width to fit. This option currently has no effect in ISSC. 

32 - Change text to multiline to fit. This option currently has no effect in ISSC. 

64 - Narrow Fixture Check. This option currently has no effect in ISSC. 

128 - Major display units. This option currently has no effect in ISSC. 

256 - This option is not currently in use. 

512 - Include block name. 

1024 - Use block description. 

2048 - Include the block length. 

4096 - Include the block depth. 

8192 - Include the block height. 

16384 - Separate. This option affects how fixture annotation works for gondolas. If 
the Separate option is selected, the fixture annotation will display once per fixture. If 
the Separate option is not on, the fixture annotation will display once per gondola 
side. This option currently causes an error in ISSC if selected. 

TEXT_FIXTURE_PRECISION 
The TEXT_FIXTURE_PRECISION system variable determines the number of decimal 
places if the block length, depth or height is specified in the TEXT_FIXTURE_OPTIONs 
bitwise system variable. 

TEXT_FIXTURE_TEXTFONT 
The TEXT_FIXTURE_TEXTSIZE system variable controls the font used for fixture 
annotation. It can be set to any font supported by Windows. If the font does not exist on a 
user's computer, the font will default to Arial. 

TEXT_FIXTURE_TEXTSIZE 
The TEXT_FIXTURE_TEXTSIZE system variable controls the size of the annotation used 
for fixtures and bay numbering in In-Store Space Collaboration. The value is in inches for 
imperial databases and millimeters for metric ones. This enables administrators to set the 
fixture annotation text size to any pertinent value. The example below shows the effect 
on fixture numbering. 
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TEXT_FIXTURE_WIDTHFACTOR 
This system variable is not in use. 

TEXT_FIXTURE_X_OFFSET 
The X offset is used to 'fine-tune'  the position of the fixture annotation. 

 

Positive values of X move the text to the right, negative values to the left. 

Note: This system variable is not currently in use. 

TEXT_FIXTURE_Y_OFFSET 
The X offset is used to 'fine-tune'  the position of the fixture annotation. 

 

Positive values of Y move the text up, negative values of Y move the text down. 

Note: This system variable is not currently in use. 
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ISSC Product Annotation 
The system variables described below enable users to configure product annotation for 
In-Store Space Collaboration. 

 

The example shows the TEXT_PRODUCT_OPTION system variable set to 3585. As a 
result, there are three items of information in the product text. 36 refers to the length of 
the fixtures containing the product and Rice is the product name.1M refers to the number 
of bays (modules) 

TEXT_BAYNUMBER_COLOUR 
This option affects the color of the text. It can be set to any value between 0 - 255. These 
values correspond to the AutoCAD Color Index values. The first eight values in the series 
are: 

Value Color 

0 Black 

1 Red 

2 Yellow 

3 Green 

4 Cyan 

5 Blue 

6 Mauve 

7 White 

Note: This system variable is not currently in use. 

TEXT_PRODUCT_DIMASZ 
This system variable allows the user to set the size of the dimension arrows. 

Note: This system variable is not currently in use. 

TEXT_PRODUCT_DIMSD1 
This system variable allows the user to suppress the left dimension line for the product 
text. 0 = do not suppress dimension line, 1 = suppress dimension line. 

Note: This system variable is not currently in use. 

TEXT_PRODUCT_DIMSD1 
This system variable allows the user to suppress the right dimension line for the product 
text. 0 = do not suppress dimension line, 1 = suppress dimension line. 
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Note: This system variable is not currently in use. 

TEXT_PRODUCT_DIMSE1 
This system variable allows the user to suppress the left extension line for the product 
text. 0 = do not suppress extension line, 1 = suppress extension line. 

Note: This system variable is not currently in use. 

TEXT_PRODUCT_DIMSE2 
This system variable allows the user to suppress the right extension line for the product 
text. 0 = do not suppress extension line, 1 = suppress extension line. 

Note: This system variable is not currently in use. 

TEXT_PRODUCT_INSERTION 
This option affects where the product text is positioned relative to the fixture. There are 
nine options. 

 

For example, specifying option 5 will result in the product text being located in the centre 
of the fixture. 

TEXT_PRODUCT_JUSTIFICATION 
This option affects how the text is justified. There are 9 options. 

 

For example, specifying option will 5 result in the product text being justified from the 
centre of the text. 

TEXT_BAYNUMBER_NARROWFIXTUREOFFSET 
This system variable is not in use. 

TEXT_PRODUCT_OPTIONS 
This system variable holds a bitwise variable governing what and how the product text is 
displayed. The bitwise values are: 

1 - Turn product text on. 

2 - Scale size: this option turns on scaling for product text. It currently has no effect in 
ISSC. 

4 - Scale offset: this option turns on scaling for the X and Y offsets for product text. It 
currently has no effect in ISSC. 

8 - Reduce text size to fit. This option currently has no effect in ISSC. 

16 - Reduce text width to fit. This option currently has no effect in ISSC. 
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32 - Change text to multiline to fit. This option currently has no effect in ISSC. 

64 - Narrow Fixture Check. This option currently has no effect in ISSC. 

128 - Major display units. This option currently has no effect in ISSC. 

256 - Show flow direction. This option currently has no effect in ISSC. 

512 - Use planogram description. This option is not active and the product or 
planogram description will be automatically displayed. 

1024 - Include number of bays. This value has M (for module) as a suffix. 

2048 - Display sum of fixture lengths for products or planogram. 

4096 - Use alternative units for product text. This option currently has no effect in 
ISSC. 

Note: failure to add a  valid bitwise value will cause the 
product text to default to a basic option. 

TEXT_PRODUCT_TEXTFONT 
The TEXT_PRODUCT_TEXTFONT system variable controls the font used for profile 
annotation. It can be set to any font supported by Windows. If the font does not exist on a 
user's computer, the font will default to Arial. 

TEXT_PRODUCT_TEXTSIZE 
The TEXT_PRODUCT_TEXTSIZE system variable controls the size of the annotation 
used for product text in In-Store Space Collaboration. The value is in inches for imperial 
databases and millimeters for metric ones. This enables administrators to set the product 
text size to any pertinent value. 

TEXT_PRODUCT_WIDTHFACTOR 
This system variable is not in use. 

TEXT_PRODUCT_X_OFFSET 
The X offset is used to 'fine-tune'  the position of the product text. 

 

Positive values of X move the text to the right, negative values to the left. 

TEXT_PRODUCT_Y_OFFSET 
The X offset is used to 'fine-tune'  the position of the product text. 
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Positive values of Y move the text up, negative values of Y move the text down. 

ISSC Profile Annotation 
The system variables described below enable users to configure profile annotation for In-
Store Space Collaboration. Profile annotation is used to give additional information on 
planogram bays. 

 

The example shows the TEXT_PROFILE_OPTION system variable set to 20481. The first 
number is the assortment code, the second the bay number. Items of data are separated 
by a backslash. 

TEXT_PROFILE_COLOUR 
This option affects the color of the text. It can be set to any value between 0 - 255. These 
values correspond to the AutoCAD Color Index values. The first eight values in the series 
are: 

Value Color 

0 Black 

1 Red 

2 Yellow 

3 Green 

4 Cyan 

5 Blue 

6 Mauve 

7 White 

Note: This system variable is not currently in use. 



Controlling Fixture, Product and Planogram Annotation 

214 Oracle Retail Macro Space Management 

TEXT_PROFILE_INSERTION 
This option affects where the planogram profile information is positioned relative to the 
fixture. There are nine options. 

 

For example, specifying option 5 will result in the profile information being located in the 
centre of the fixture. 

TEXT_PROFILE_JUSTIFICATION 
This option affects how the text is justified. There are 9 options. 

 

For example, specifying option will 5 result in the bay number text being justified from 
the centre of the text. 

TEXT_BAYNUMBER_NARROWFIXTUREOFFSET 
This system variable is not in use. 

TEXT_PROFILE_OPTIONS 
This system variable holds a bitwise variable governing what and how the profile text is 
displayed. The bitwise values are: 

1 - Turn profile text on. 

2 - Scale size: this option turns on scaling for profile text. It currently has no effect in 
ISSC. 

4 - Scale offset: this option turns on scaling for the X and Y offsets for profile text. It 
currently has no effect in ISSC. 

8 - Reduce text size to fit. This option currently has no effect in ISSC. 

16 - Reduce text width to fit. This option currently has no effect in ISSC. 

32 - Change text to multiline to fit. This option currently has no effect in ISSC. 

64 - Narrow Fixture Check. This option currently has no effect in ISSC. 

256 - Separate. This option will result in separate annotation for each bay of a multi-
bay planogram if the information being displayed is common to all bays. For 
example, if the Separate option is selected, the Assortment code will display once per 
bay. If the Separate option is not on, the Assortment Code will display once per 
planogram. 

128 - Include Planogram number (POG_ID from the Plano table). 

256 - Include planogram number. This option currently has no effect in ISSC 
although it will result in a '1' appearing in front of each bay. 

512 - Include segment profile. This option currently has no effect in ISSC although it 
will result in a '1' appearing in front of each bay. 

1024 - Not used. 
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2048 - Not used. 

4096 - Include assortment code. 

8192 - Include product count. This option currently has no effect in ISSC although it 
will result in a single digit number appearing in front of each fixture. 

16384 - Include bay sequence number. 

Failure to add a valid bitwise value will cause the product text to default to a basic 
option. 

Note: For more information on the Plano table, see the 
Oracle Retail Macro Space Planning Data Model. 

TEXT_PROFILE_ORDER 
This system variable holds a comma separated list specifying the order items of data will 
appear. 

1 = Layout Group. 

2 = Assortment Code. 

3 = Profile Segment. 

4 = Product Count. 

5 = Bay Sequence Number. 

6 = Planogram Number. 

TEXT_PROFILE_SEPARATOR 
This system variable contains the character used to separate multiple items of data. An 
example would be a backslash / or a hyphen -. 

TEXT_PROFILE_WIDTHFACTOR 
This system variable is not in use. 

TEXT_PROFILE_X_OFFSET 
The X offset is used to 'fine-tune'  the position of the profile annotation. 

 

Positive values of X move the text to the right, negative values to the left. 

TEXT_PROFILE_Y_OFFSET 
The X offset is used to 'fine-tune'  the position of the profile annotation. 
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Positive values of Y move the text up, negative values of Y move the text down. 

TEXT_PROFILE_TEXTFONT 
The TEXT_PROFILE_TEXTFONT system variable controls the font used for profile 
annotation. It can be set to any font supported by Windows. If the font does not exist on a 
user's computer, the font will default to Arial. 

TEXT_PROFILE_TEXTSIZE 
The TEXT_PROFILE_TEXTSIZE system variable controls the size of the annotation used 
for planogram profile information in In-Store Space Collaboration. The value is in inches 
for imperial databases and millimeters for metric ones. This enables administrators to set 
the profile text size to any pertinent value. 

Copying Floor Plans 

DUPLICATE_FLOOR_PLAN_STAUTUS_LEVEL 
The DUPLICATE_FLOOR_PLAN_STATUS_LEVEL system variable determines what the 
default status for a floor plan will be if it is copied using the Duplicate button on the 
Select Store dialog box. The value of the system variable must correspond to a Status 
Level ID (STL_ID) in the Status Level table in the database. 

Note: For more information on the Status Level table, see 
the Oracle Retail Macro Space Planning Data Model. 

 

This STL_ID cannot be that corresponding to Authorized (STL_ID = 4), Published 
(STL_ID = 5), Current (STL_ID = 5) or Historical (STL_ID = 3). 

Note: The resulting default status can be edited after a 
specific floor plan has been copied. This is done using the 
Edit Properties option. 
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Controlling Report and KPI Text 

Controlling ISSC Report Font and Size 
The font and font size for the header and footer in reports printed from ISSC can be 
controlled by means of four system variables. 

 

OPTIONS_FOOTER_FONT 
This system variable specifies the font to be used in the report footer. The Administrator 
may choose any font in the Windows Collection. If a font name is misspelled, or the font 
is not available, ISSC will default to a standard font. 

OPTIONS_FOOTER_FONTSIZE 
This system variable sets the size used for the font in the footer in all printed reports. 

OPTIONS_HEADER_FONT 
This system variable specifies the font to be used in the report header. The Administrator 
may choose any font in the Windows Collection. If a font name is misspelled, or the font 
is not available, ISSC will default to a standard font. 

OPTIONS_HEADER_FONTSIZE 
This system variable sets the size used for the font in the footer in all printed reports. 

Controlling KPI Legend Font and Size 
The font and font size for the header and footer in the ISSC KPI Legend using on screen 
and in printed reports can be controlled by means of two system variables. 
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OPTIONS_LEGEND_FONT 
This system variable specifies the font to be used. The Administrator may choose any 
font in the Windows Collection. If a font name is misspelled, or the font is not available, 
ISSC will default to a standard font. 

Note: This system variable is currently not functional. 

OPTIONS_LEGEND_FONTSIZE 
This system variable sets the size used for the font. 

Note: This system variable is currently not functional. 

KPI Tab 

IN-STORE_ENABLE_KPI_BLOCK_SELECTION 
The IN-STORE_ENABLE_KPI_BLOCK_SELECTION system variable controls whether 
objects in the floor plan can be selected while the user has selected the KPI option in an 
ISSC floor plan. 

0 = No objects can be selected. 

1 = Objects can be selected. 

Dimensions, Mark-ups and Notes 

ISSC Markups and Revision Clouds 

Markups 
Markups are freehand lines in In-Store Space Collaboration. There are two possible line 
weights, each controlled by a system variable. 
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The IN-STORE_MARKUP_LINEWIDTHMIN System Variable is used to specify the 
line weight for the thinner line. It also affects the line weight for Revision clouds. 

The IN-STORE_MARKUP_LINEWIDTHMAX System Variable is used to specify the 
line weight for the thicker line. It also affects the line weight for Revision clouds. 

Revision Clouds 
The REVISION_CLOUD_ARC_DISTANCE  System Variable is used to specify the 
length of the arc used to draw the revision arc. 

 

ISSC Notes 
Notes can be added to zones or fixtures. Their appearance is controlled by two system 
variables. 

 

The NOTE_FONT system variable determines the font used for notes. If a font name is 
misspelled, or the font is not available, ISSC will default to a suitable font. 

The NOTE_FONT_SIZE  system variable determines the size of the font used for notes. 

ISSC Dimensions 
Dimensions can be used to annotate ISSC floor plans with physical distances. The 
appearance of these dimensions is controlled by three system variables. 
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Dimension Text Font and Size 
The IN-STORE_MARKUP_TEXT_FACE System Variable allows users to select the Font 
Type used for annotating dimensions. If a font name is misspelled, or the font is not 
available, In-Store Space Collaboration will default to a suitable font. 

The IN-STORE_MARKUP_TEXT_SIZE System Variable allows users to select the Font 
Size used for annotating dimensions. The font size is in arbitrary units and users may 
need to experiment before finding a suitable setting. 

Dimension Style 
The IN-STORE_DIMENSION_STYLE  system variable controls the way dimensions 
display. 

 

There are three options for the system variable: 

0 will display the dimension without ticks or arrows (left hand image) 

1 will display the dimension using ticks (centre image) 

2 will display the dimension using arrow heads (right hand image). 
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Merchandise Options 

MERCH_MULTI_PROFILE 
The MERCH_MULTI_PROFILE system variable determines how fixtures populate with 
products or planograms. There are three options: 

SV 
Value Description Comment 

0 Allow fixtures to be 
multi-profiled 

This option allows fixtures to be multi-populated. A fixture is 
allowed to contain more than one planogram or product 
placeholder. 

1 Don't allow fixtures to 
be multi-profiled 

This option will only allow fixtures to be populated if there is 
sufficient room for the new merchandise. 

2 
Replace Merchandise on 
fixture 

This option will allow fixtures to be populated if there is 
insufficient room by removing preexisting merchandise from the 
fixtures. 

System Variable = 0: Multi-Profiling Allowed 
In the example below, a 3 bay planogram is to be inserted into a space where only two 
fixtures are available. 

 

In this instance, one fixture will be multi-profiled with two planograms being present on 
the fixture. 

System Variable = 1: No Multi-Profiling Allowed 
In the example below, a 3 bay planogram is to be inserted into a space where only two 
fixtures are available. 

 

In this instance, the three bay planogram cannot be placed. 

System Variable = 2: Replace Merchandise 
In the example below, a 3 bay planogram is to be inserted into a space where only two 
fixtures are available. 
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In this instance, an existing planogram will be removed to make room for the three bay 
planogram being placed. 

IN-STORE_PREVIEW_POG_REVISIONS 
The IN-STORE_PREVIEW_POG_REVISIONS system variable controls whether the 
option to view different revisions for a specific planogram is available in Schematic 
Preview. 

 
0 = Not available. 

1 = Available. 

IN-STORE_DEFAULT_POG_FILTERS 
This system variable controls the default settings in the Planogram Filters dialog box. 
Data is stored as a bitwise variable. 

 

Setting Bitwise Value 

Match Fixture Depth 1 

Match Fixture Height 2 

Match Fixture style  4 

Match Fixture Temperature Range 8 
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ISSC Mobile System Variables 

MOBILE_USER_TIMEOUT 
One system variable affecting the use of ISSC Mobile is MOBILE_USER_TIMEOUT. 
This is in seconds and controls the time the application will await a manual input before 
manually timing out.  It is suggested that a setting of 1200 seconds (20 minutes be set for 
normal use.  Settings above this value can be used during the implementation process, 
but a value of 2,000,0000 seconds should not be exceeded or the application will error. 

Note: If using a high value for this system variable during 
implementation, it should be set back to 1,000 - 2,000 
seconds for normal use  to ensure ISSC mobile times out if 
left unattended for a short period.  

Adjacency Calculations 

Overview of Adjacency Calculations 
Adjacency Calculations  are used to establish the relationship of objects to one another. 
There are three forms of Adjacency Calculations: 

 Fixture Adjacency is the relationship of one fixture to another. 

 Product Adjacency is the relationship of one product to another. 

 Aisle Adjacency identifies which products share an aisle. 

Fixture Adjacency calculations can be initiated from the Planner and Merchandiser 
modules in Macro Space Management and from In-Store Space Collaboration. Product 
and Aisle Adjacency calculations are initiated from the Planner module in Macro Space 
Management 

Fixture Adjacency 
There are a series of System Variables that affect how the Fixture Adjacency calculations 
work. These are: 

 ADJACENCY_FIXTURESIZE 

 ADJACENCY_FRONTBACK 

 ADJACENCY_LATERALGAP 

 ADJACENCY_MAX_ANGLE 

 ADJACENCY_OVERLAP 

 ADJACENCY_SEARCH 

 ADJACENCY_TOLERANCE 

 ADJACENCY_VERTICALGAP 

Note: some of these system variables are not currently in 
use. 

Product Adjacency 
Product Adjacency relies on the relationship of fixtures to one another - determined by 
the Fixture Adjacency calculation. This relationship can then be used to determine what 
products are on the fixtures, and hence which products are adjacent to one another. 

There is no system variables associated with Product Adjacency. 
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Aisle Adjacency 
Aisle Adjacency is used to establish which fixtures are adjacent to an aisle (defined as a 
line in a Planner store plan).  This relationship can then be used to determine what 
products are on the fixtures, and hence which products share the aisle. 

There is a single system variable affecting Aisle Adjacency: ADJACENCY_AISLESIZE. 

Fixture Adjacency Calculations 
Fixture Adjacency is the relationship of one fixture to another. It is called from three 
places within the software: 

 From the Calculations menu or toolbar in the Planner module 

 From the Calculate menu in the Merchandiser Module 

 From the toolbar in In-Store Space Collaboration 

In each instance, the same functionality is called and the results written back to a 
common table in the database. 

Note: Fixture Adjacency only applies to fixtures. Fittings, 
shelves, etc are excluded from the calculations 

For Fixture Adjacency calculations, fixtures may be: 

 To the right of another fixture 

 To the left of another fixture 

 Behind another fixture 

 In front of another fixture 

 Sharing an aisle with a fixture 

 Above another fixture 

A specific adjacency for a fixture may be a combination of these options. 

 

In the example above: 

 Fixture 1 is adjacent to the left of fixture 2. 

 Fixture 3 is adjacent to the right of fixture 2. 

 Fixture 6 is adjacent to the left and behind fixture 2. 

 Fixture 5 is adjacent behind fixture 2. 

 Fixture 4 is adjacent to the right and behind fixture 2. 

Fixture Adjacency is subsequently used in Product Adjacency calculations, where the 
relationship of one fixture to another can be used to establish the relationship between 
the products they have been merchandised with. 

ADJACENCY_FIXTURESIZE 
The ADJACENCY_FIXTURESIZE System Variable is used to filter out fixtures below a 
certain size for the purpose of Fixture Adjacency calculations. 
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In the above example, the central fixture is narrow. If its length (width) is above the value 
of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be included 
in the fixtures used for Fixture Adjacency calculations. If i ts length (width) is below the 
value of the ADJACENCY_FIXTURESIZE System Variable, the central fixture will be 
excluded from the Fixture Adjacency calculations. 

ADJACENCY_FRONTBACK 
The ADJACENCY_FRONTBACK System Variable is used to specify the maximum 
distance between fixtures that are back to back that allows them to be regarded as 
adjacent behind a specific fixture. 

 

In the example above, fixture 2 is separated by a gap from fixture 5. If this gap is below 
the value specified in ADJACENCY_FRONTBACK, fixture 5 will be regarded as adjacent 
(behind) fixture 2. If the gap is above the value specified in ADJACENCY_FRONTBACK, 
fixture 3 will not be regarded as adjacent. 

Note: At present the Front/Back distance used for fixture 
adjacency calculations is taken from the 
ADJACENCY_LATERALGAP System variable. 

ADJACENCY_LATERALGAP 
The ADJACENCY_LATERALGAP  System Variable is used to specify the maximum 
lateral distance between fixtures that allows them to be regarded as adjacent to left and 
right of a specific fixture. 

 

In the example above, fixture 3 is separated from fixture 2 by a gap. If this gap is below 
the value specified in ADJACENCY_LATERALGAP, fixture 3 will be regarded as 
adjacent (to the right) to fixture 2, if the gap is above the value specified in 
ADJACENCY_LATERALGAP, fixture 3 will not be regarded as adjacent. 

It is possible to set ADJACENCY_LATERALGAP to a value such as 24 inches (610 mm) 
so that fixtures that are either side of a pillar are regarded as adjacent. 
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ADJACENCY_MAX_ANGLE 
The ADJACENCY_MAX_ANGLE System Variable is used for gondolas. 

If the angle between adjacent fixtures is less than the ADJACENCY_MAX_ANGLE 
System Variable, the fixtures will be regarded as belonging to the same side. If the angle 
between adjacent fixtures is greater than the ADJACENCY_MAX_ANGLE System 
Variable, the fixtures will be regarded as belonging to the different sides. 

In the double sided gondola with endcaps below, the ADJACENCY_MAX_ANGLE 
System Variable was set to 30 degrees. Each time the angle between two successive 
adjacent fixtures have an angle exceeding thirty degrees, a new side is created. The 
fixtures making up the example gondola have been numbered according to the gondola 
numbering convention: Gondola Number/Side/Level/Fixture Number. The gondola 
thus has four sides. 

 

In the snake gondola below, the angle between the second and third fixtures is below that 
specified in the ADJACENCY_MAX_ANGLE System Variable, so the first three fixtures 
are treated as belonging to a single gondola side. The angle between the third and fourth 
fixtures is above that specified in the ADJACENCY_MAX_ANGLE System Variable, so 
the last two fixtures are treated as belonging to another gondola side. 

 

ADJACENCY_OVERLAP 
The ADJACENCY_OVERLAP system variable is not presently in use. 

ADJACENCY_SEARCH 
The ADJACENCY_SEARCH system variable is not presently in use. 

ADJACENCY_TOLERANCE 
The ADJACENCY_TOLERANCE system variable is not presently in use. 
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ADJACENCY_VERTICALGAP 
The ADJACENCY_VERTICALGAP System Variable is used to specify the maximum 
distance between fixtures that are stacked vertically that allows them to be regarded as 
adjacent above a specific fixture. 

 

In the example above, one fixture is above another. If the vertical gap between the 
fixtures is less than the ADJACENCY_VERTICALGAP System Variable, the top fixture 
will be regarded as adjacent above the lower fixture. If the vertical gap between the 
fixtures is more than the ADJACENCY_VERTICALGAP System Variable, the top fixture 
will be regarded as adjacent above the lower fixture. 

Note: the ADJACENCY_VERTICALGAP System Variable is 
not taken into account by the software at present, so any 
fixture above another is regarded as 'adjacent above'. 

ADJACENCY_AISLESIZE 
The ADJACENCY_AISLESIZE system variable is used to establish a distance tolerance 
from an Aisle. Fixtures within this distance from an aisle are regarded as adjacent to it; 
fixtures outside this distance are not. 
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Depending on the setting of the ADJACENCY_AISLESIZE system variable, Fixtures 15 
and 16 may or may not be regarded as adjacent to the Aisle. It is then possible to 
determine which products are on the fixtures adjacent to the aisle, and hence which 
products share the aisle. 

Note: Aisle adjacencies are calculated relative to the front 
direction of the fixture. Fixtures 1, 8 and 9 - 14 will not be 
shown as adjacent to the drawn aisle because a line drawn 
out perpendicular from the front face of the fixtures will not 
intersect the aisle. 

Area Calculations 

Overview of Area Calculations 
Area Calculations are used to establish the amount of floor area apportioned to 
individual fixtures.  The function can only be called in the Planner Module from the 
Calculations menu or the Calculations toolbar. This will bring up the Area Calculation 
dialogue box. 
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This shows the area allocated to specific fixtures - lighter shades of blue indicating that 
areas shared by two or more fixtures. The settings in the Area Calculation Directions 
frame in the Category tab of the Block Details dialogue box affect the nature of area 
calculations - areas will only be calculated in the ticked directions. 

 

This can be seen by comparing the two examples of area calculations below. The top 
image shows an area calculation based on fixtures set for West East and South Directions. 
The bottom image shows and area calculation based on South Direction only. 
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Note: the results of the Area Calculations are subsequently 
used in Space Calculations. 

Theory of Area Calculations 
Area Calculations are used to apportion areas to all fixtures that are within the Internal 
Area zone. 

The first factor affecting area calculations is the Area Calculation Directions specified in 
the Category Tab of the Block Details dialogue box in Fixture Studio. 
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The maximum area available for Area Calculations is based on the Internal Area Zone 
and the AREA_BOUNDARY_DISTANCE System variable. 

1. If an Internal Area zone is present, no fixture can be allocated any area that is outside 
of the zone boundary. 

2. The maximum distance a fixture can be allocated area within is determined by the 
AREA_BOUNDARY_DISTANCE System variable. 

 

In the above example, the maximum distance the fixture can be allocated area within is 
determined by the AREA_BOUNDARY_DISTANCE System variable (red box). The 
fixture can therefore only be allocated part of the area within the Internal Area Zone 
(blue box). However, at one point the Internal Area Zone boundary is closer that the 
distance set by the AREA_BOUNDARY_DISTANCE System variable, so part of the 
potential area available to the fixture is excluded from the area calculations because it lies 
outside of the boundary of the Internal Area Zone. 

Each fixture then establishes the distance of other fixtures from it using the 
AREA_LARGE_INCREMENT, AREA_MEDIUM_INCREMENT and 
AREA_SMALL_INCREMENT System Variables. 

The fixture starts out using the Large Increment. It feels out one 'large 
increment' distance from the fixture. If it does not detect anything it feels out another 
large increment distance from the fixture until it detects something, or reaches an 
Internal Area Zone Boundary or the Area Boundary distance.    

Once another fixture had been detected using large increment, the software s tarts using 
the Medium Increment distance to get a more precise 'range'. It keeps feeling out using 
'medium increment' using as a starting point the last 'large increment' distance that did 
not find a fixture in that direction. It feels out one 'medium increment' distance. If i t does 
not detect anything, it feels out another medium increment distance until i t detects 
something, or reaches an Internal Area Zone Boundary or the Area Boundary distance. 
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Once a fixture has been identified by feeling out a 'medium increment distance, the same 
process starts with the 'small increment' distance using as the last 'medium increment' as 
a starting point. 

 

The process can be seen in the above example. Fixture 1 starts feeling out with large 
'increment' (500 inches) and detects that there is a fixture within that distance. It then 
starts feeling out with 'medium increment' (50 inches). It detects there is no fixture within 
50 inches, but there is one within 100 inches. Finally, it starts feeling out using 'small 
increment' (5 inches) using the 50 inch medium increment datum as a starting point. It 
does not detect a fixture within the first small increment distance, but does within the 
second. Fixture 1 has therefore detected another fixture (Fixture 2) within 50 + 5 = 55 
inches of its position. 

Finally, the software takes into account the Area Calculation Directions, the limits within 
which the area calculation will be carried out (Internal Area Zone, etc) and the position of 
the fixtures. It then apportions areas to each fixture. If an area is 'shared' by multiple 
fixtures, the shared area is subdivided up between the fixtures. 

 

In the example above, both Fixture 1 and Fixture 2 have areas exclusive to them. There is 
a shared area between then. The software will detect this and allocate part of this shared 
area to Fixture 1 and part to Fixture 2. 
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This can be seen in the Allocated Areas dialogue box (below) where the dark areas blue 
areas represent areas that have been exclusively allocated to specific fixtures and the 
lighter blue areas represent areas that will be apportioned pro rata to different fixtures. 

 

AREA_BOUNDARY_CLIPPING_LEVEL 
The AREA_BOUNDARY_CLIPPING_LEVEL  System Variable is allows users to specify 
whether the area calculations for a fixture should be relative to the Internal Area Zone or 
the Department Zone that it is in. 

This functionality has not yet been implemented and area calculations can only be done 
relative to the Internal Area Zone 

AREA_BOUNDARY_DISTANCE 
The AREA_BOUNDARY_DISTANCE System Variable is not presently in use. 

AREA_LARGE_INCREMENT 
AREA_LARGE_INCREMENT is one of three system variables affecting the logic of how 
the Area calculation is carried out, the other two being AREA_MEDIUM_INCREMENT 
and AREA_SMALL_INCREMENT. 

The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software then 
successively uses AREA_MEDIUM_INCREMENT and AREA_SMALL_INCREMENT to 
establish a progressively more accurate distance between fixtures. 

AREA_MAX_DISTANCE 
The AREA_MAX_DISTANCE System Variable specifies the maximum distance from a 
fixture the software will take into account when allocating areas. This distance will apply 
unless the Area Max distance exceeds crosses the boundary of the internal Area Zone. If 
this is the case, any part of the AREA_MAX_DISTANCE outside of the boundary will be 
excluded for calculation purposes. 
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AREA_MEDIUM_INCREMENT 
AREA_MEDIUM_INCREMENT is one of three system variables affecting the logic of 
how the Area calculation is carried out, the other two being 
AREA_LARGE_INCREMENT and AREA_SMALL_INCREMENT. 

The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. The software then 
successively uses AREA_MEDIUM_INCREMENT and AREA_SMALL_INCREMENT to 
establish a progressively more accurate distance between fixtures. 

AREA_SMALL_INCREMENT 
AREA_SMALL_INCREMENT  is one of three system variables affecting the logic of how 
the Area calculation is carried out, the other two being AREA_LARGE_INCREMENT 
and AREA_MEDIUM_INCREMENT. 

The three work in conjunction, the software 'feeling out' from the fixture using 
AREA_LARGE_INCREMENT setting until a fixture is encountered. It then uses 
AREA_MEDIUM_INCREMENT and AREA_SMALL_INCREMENT to establish a 
progressively more accurate distance between fixtures. 

The setting for AREA_SMALL_INCREMENT will affect the accuracy of the calculation. If 
set to a high value the Area Calculation exercise will complete quickly but with a lower 
degree of accuracy. If set to a small value, the result will be more accurate but the 
processing time will be significantly longer. 

Important note: the AREA_SMALL_INCREMENT system 
variable must also be set with reference to the smallest 
dimension on a fixture. Fixtures that have dimensions less 
than the AREA_SMALL_INCREMENT value will not be 
included in the calculations, but will be included in the 
results. This can lead to significant errors. For example, if a 
slat wall has a thickness of one inch, but the 
AREA_SMALL_INCREMENT system variable is set to two 
inches, the slat walls will be excluded from the area 
calculations. Because the slat walls will be included in the 
results, the results will not be accurate.   
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AREA_UNIT_OF_MEASURE 
The AREA_UNIT_OF_MEASURE  system variable is used to set the type of unit used for 
the results of Area Calculations. The value of the AREA_UNITS OF_MEASURE System 
Variable refers to the Unit ID in the Units dialogue box. 

 

For example, if the results are wanted in Square Feet, Unit ID 31 would be selected, if the 
results were wanted in Square Meters, Unit ID 32 would be selected. 

Note: This functionality is not yet fully implemented. 

Automated Calculations 

AUTOMATION_CALCS 
The AUTOMATION_CALCS System Variable holds information on the types of 
Automated Calculations selected for user initiated processing. 

 

It is a bitwise system variable: 
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Value Calculation 

0 No selection 

1 Aisle Adjacency 

2 Allocated Areas 

4 Face Planes 

8 Fixture Adjacencies 

16 Product Adjacencies 

32 Space Measurements 

AUTOMATION_CALC_STATUS 
The AUTOMATION_CALC_STATUS System Variable holds information on the types of 
Status selected for Automated Calculations for user initiated processing. 

 

The statuses are stored as pipe delimited STA_ID's from the Status table: for example 
23|25|27. 

Note: For more information on the Status  table see the Oracle 
Retail Macro Space Planning Data Model. 

General 

BATCH_USE_UTC 
The BATCH_USE_UTC System Variable is used to specify whether the Batchrunner.exe 
file (used for batch operations) in the C:\Program Files\Oracle Retail\MSM\Apps 
directory uses local or UTC time. 

0 = Local tome 

1 = UTC time 
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DBSCHEMADATE 
The DBSCHEMADATE System Variable holds the date the schema was last updated by 
means of an upgrade script. (The upgrade script must be set to update the date). The 
information is purely held in the database. 

DBVERSION 
The DBSCHEMADATE System Variable holds the information on the version the 
schema has been updated to by an upgrade script. It is used in the status bar of the 
configuration module. (The upgrade script must be set to update the version). 

 

MERCH_TREE_EFFECTIVE_DATE 
The MERCH_TREE_EFFECTIVE_DATE system variable controls the graying out rules 
for products and planograms in the Object Browser. If this functionality is turned on, all 
products and planograms that have an Effective date after the Active Date of the 
currently active floor plan will be grayed out and unavailable for selection from the 
object browser. 

0 = Turn graying out off. 

1 = Turn graying out on. 

Merchandiser 

ADDITIONAL_FIXTURE_HEIGHT 
The ADDITIONAL_FIXTURE_HEIGHT system variable is used to increase the height 
of the merchandisable area for all fixtures in the Merchandiser module beyond that set in 
the Merchandisable Areas Tab of the Block Details dialogue box in Fixture Studio.   
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It has the following effects: 

Fixture Studio  
It is added onto the setting for the upper part of the Merchandisable area. For example, if 
the Z value for offset is set to 0, the merchandisable area will finish at the top of the 
fixture (left hand image above). If the ADDITIONAL_FIXTURE_HEIGHT system 
variable is set to 12 inches, the merchandisable area will extend above the top of the 
fixture despite the offset being set to 0 (right hand image above). 

 

Merchandiser Module 
There will be two effects in the Merchandiser module. 

 The AutoFill command (Standard toolbar) will fill to a volume that includes the 
ADDITIONAL_FIXTURE_HEIGHT setting. 

 All fixtures and shelves will fill to a volume that includes the 
ADDITIONAL_FIXTURE_HEIGHT setting. 
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FINGER_GAP 
The FINGER_GAP system variable is used in the Merchandiser module. It specifies the 
minimum gap between the top of a group of products and the shelf above it. 

 

The purpose of the system variable is to ensure that there is always sufficient space for a 
customer to reach in and lift products off of a shelf. 

Note: The 'Vertical Gap' setting on the Size and Shape tab of 
the Display styles dialogue box may also influence the gap 
between the topmost item of merchandise and the shelf 
above. 

Object Grid 

OBJECT_GRID_DATALIMIT 
The OBJECT_GRID_DATALIMIT system variable is used to set the maximum number 
of limits that will be returned in the Object Grid. The optimum value for this system 
variable will vary from system to system depending on the performance of that system. 
The value set will have to be a compromise between execution speed of the query and 
whether the result set returned is sufficient for the user's needs. 

Planogram Importer 

About Planogram Import 
Planogram Import can be carried out using Oracle Data Integrator from third party 
planograming tools like Apollo, Galleria and ProSpace. 

When planograms are imported, they need to be matched to suitable fixtures and shelves 
in the Macro Space Planning database. (This is done by using the planogram dimensions 
and data in the Style Import Map table). If no suitable fixtures are found, then defaults 
can be assigned using three system variables: 

 DEFAULT_IMPORT_FIXEL_BLK_ID specifies a default shelf. 

 DEFAULT_IMPORT_FIXTURE_BLK_ID specifies a default fixture 

 DEFAULT_IMPORT_BLOCK_ID specifies a default product block. 

Note: For more information on the Style Import Map table, 
see the Oracle Retail Macro Space Planning Data Model. 
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DEFAULT_IMPORT_FIXEL_BLK_ID 
The DEFAULT_IMPORT_FIXEL_BLK_ID system variable is used for Planogram 
Import. The value should correspond to the ID of a suitable default shelf in the table of 
Block Details. This default shelf will be associated with the imported planogram if no 
more suitable match exists in the Macro Space Planning database. 

 

Note: i t would be usual for the default shelf to be 
'stretchable', allowing it to suit any size of planogram. 

DEFAULT_IMPORT_FIXTURE_BLK_ID 
The DEFAULT_IMPORT_FIXURE_BLK_ID system variable is used for Planogram 
import. The value should correspond to the ID of a suitable default fixture in the table of 
Block Details. This default shelf will be associated with the imported planogram if no 
more suitable match exists in the Macro Space Planning database. 

 

Note: i t would be usual for the default fixture to be 
'stretchable', allowing it to suit any size of planogram. 

DEFAULT_IMPORT_BLOCK_ID 
The DEFAULT_IMPORT_BLOCK_ID system variable is used for Planogram import. 
The value should correspond to the ID of a suitable default product block in the table of 
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Block Details. This default product block will be associated with the imported planogram 
if no more suitable match exists in the Macro Space Planning database. 

 

Planner 

CMDECHO 
The CMDECHO system variable can be used to turn on or off echoing commands to the 
AutoCAD command line in the Planner Module. 

 

0 = suppress showing some AutoCAD commands in the command line 

1 = show all AutoCAD commands in the command line. 

Note: Setting CMDECHO to 1 increases the number of 
prompts that appear in the command line - this may be 
useful to new users of the software. 

DEFAULT_MERCH_BLOCK 
The DEFAULT_MERCH_BLOCK system variable holds the name of the default product 
block to be used in Planner if no product block has been defined in the Product Block 
frame of the Fixture tab of the Block Details dialog box in Fixture Studio. 
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This ensures that a generic product placeholder will be displayed if no specialized 
product block has been defined. 

MENUECHO 
The MENUECHO system variable can be used to turn on or off echoing which toolbar or 
menu items were selected to the AutoCAD command line in the Planner Module. 

 

0 = suppress showing menu items selected. 

1 = show menu items or toolbar items selected in the command line. 

LAYER_STANDARD 
The LAYER_STANDARD  system variable is used to specify the AutoCAD Layer 
Standard used in the Planner module. The value of the system variable refers LAS_ID in 
the Layer Standard table. 

Note: For more information on the Layer Standard table, see 
the Oracle Retail Macro Space Planning Data Model. 

 

There are two default standards: 
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 MSM (Macro Space Management) which contains information on layers specific 
for Macro Space Management 

 BS1192/ISO13567 which contains information on the ISO13567 International 
standard 

Note: It is possible to add additional standards to the 
database, but this should be done in conjunction with 
Oracle's Technical Support department as additions need to 
be made to a number of different tables. 

Only one layer standard can be used at any one time. Accordingly, i t is normally 
configured during the implementation of the software and then left unchanged. 

CUSTOM_BUTTOM_TIMESTAMP_CHECK 
The CUSTOM_BUTTOM_TIMESTAMP_CHECK system variable controls whether the 
cross-check on the date and time a stored procedure for the Customizable Button 
functionality was last modified and the date and time held in the CPR_LAST_DDL_TIME 
field of the Custom Procedure table match.  

0 = Checking disabled 

1 = Checking enabled 

If checking is enabled this can be used as a security feature as a stored procedure that 
might have been maliciously modified will not execute because of the differing dates. 

Note: For more information on the Custom Procedure table, 
see the Oracle Retail Macro Space Planning Data Model. 

Planogram Substitution 

PLANOGRAM_SUBSTITUTION_COPY_FILE 
The PLANOGRAM_SUBSTITUTION_COPY_FILE system variable is used to 
determine whether planogram substitutions can be made in files of Current status. 

0 = Off 

1 = On 

If set of 0 (Off) Current status will not be available for selection in the Planogram 
Substitution Definition dialog box and the Planogram Substitution Assistant. If set to 1 
(On) current status will be available for selection and planogram substitutions can be 
carried out based on files of Current status. Because files of Current status are set to 'read 
only' status the actual substitutions cannot be made in the current file. Instead, they will 
be made in an Authorized file belonging to the floor the Current file is associated with. 
This authorized file could already exist, or it could be created by the Planogram 
Substitution Process (cloning). What Authorized file is used depends on the Floor Plan 
Effective Date set in the Properties Tab of the Planogram Substitution Definition dialog 
box. 
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If an existing Authorized file exists in the same floor with an Effective Date that falls 
within the range set in the Floor Plan Effective Date, substitutions will be made in that 
file. If no existing Authorized file exists in the same floor with an Effective Date that falls 
within the range set in the Floor Plan Effective Date, an Authorized file will be created in 
the same Revision holding the Current file. This Authorized file will have its Effective 
Date set to the earliest date in the Floor Plan Effective Date. 

PLANOGRAM_SUBSTITUTION_LOG_EXPLODED 
This system variable has been superseded and is no longer in use. 

PLANOGRAM_SUBSTITUTION_RUN_CALCS 
The PLANOGRAM_SUBSTITUTION_RUN_CALCS  system variable determines 
whether Product Adjacency calculation are automatically run on a drawing immediately 
prior to carrying out a planogram substitution. 

0 = Do not run Product Adjacency calculation. 

1 = Run Product Adjacency calculation. 

Whether this system variable is set to On of Off depends on whether planogram 
substitutions are being run as a batch process or not. If (for example) Automated 
Calculations are run immediately prior to planogram substitution, there is no need to re-
run Product Adjacency. If Automated Calculations are not being run, there is merit in 
using the PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable to force an 
automatic run of Product Adjacency prior to making substitutions. 
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PLANOGRAM_SUBSTITUTION_WARNING_SHOW 
The PLANOGRAM_SUBSTITUTION_WARNING_SHOW system variable determines 
whether an individual user has chosen to suppress display of the warning dialog for 
removing planograms without replacement when specifying Planogram Substitutions.    

 

0 = Individual user has suppressed warning 

1 = Warning will be displayed for individual user 

The results are stored referenced by User ID (USR_ID) in the User Variable table. 

Note: For more information on the User Variable table see 
the Oracle Retail Macro Space Planning Data Model. 

PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant impact on the way planogram substitutions are carried out. It can be set to 0, 
1, 2, 3 or 4. 

Planogram Form 
There are three forms planograms can be placed in the merchandiser module. 

 2D Planogram (Placeholder) 

 3D planogram (called 2.5 D in the Merchandiser Module). 

 3D with Product Items (Full Detail). 

These appear in the Merchandiser module as follows: 

 

A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows 
the shelves and a simple product block to show the shelves are occupied. A 3D 
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planogram with Product items shows the shelves, together with full  details of the 
products. 

Note: Planograms are only represented in placeholder (2D) 
form in the Planner module and in Top Graphical View in 
In-Store Space Collaboration. 

Once placed in the Merchandiser module planograms can be manually toggled between 
2D and 3D mode by means of the Implode or Explode options on the toolbar. 
Merchandiser floor plans can therefore contain planograms in a variety of states. The 
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED  system variable determines 
how planogram substitution caters for the different cases. 

System Variable Values 

System 
Variable 

Description 

  

0 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. No information on 
the planograms that have been ignored for substitution will be written to the 
Planogram Substitution Log. 

1 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. Information on the 
planograms in 3D form that have been ignored for substitution will be written to the 
Planogram Substitution Log. 

2 Planograms in 2D form will be substituted with planograms also in 2D form. 
Planograms in 3D and 2.5D form will be placed in 2D form when substituted. 

3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be 
written to the Planogram Substitution Log identifying the 3D and 2.5 D planograms 
that were placed in 2D form during the substitution. 

4 Planograms in 3D form will be substituted with planograms also in 3D form. 
Planograms in 2D form will be placed in 3D form when substituted. Planograms in 
2.5D form will be replaced by a 2.5D form if that is the way the planogram design 
has been defined. Alternatively, it will be replaced by a 3D form if the planogram 
design is in 3D format. 

Revision Substitution 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has no 
effect on Revision Substitution (the changing of a planogram for a later version of that 
design. 

Impact on Reporting Accuracy 
Whether planograms are in 2D, 2.5D or 3D form affects the form of information held in 
the database. For example, a planogram in 2D form will only contain 'header' 
information with no entries for individual products of shelf objects. This impacts on 
reporting accuracy. For example, if planograms are in 2D mode, this needs to be taken 
into account when generating a bill of materials for the equipment in the floor plan as 
shelf information will not be stored in the Shelf table. 

Note: For more information on the Shelf  table see the Oracle 
Retail Macro Space Planning Data Model. 
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PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE 
The PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE system variable sets 
the default values for the plus and minus tolerance for planogram length that appear in 
the Rules Tab of the Planogram Substitution Definition dialog box called from the 
Planogram Substitution dialog box in the Admin Module. 

 

These default values can be over-ridden in the Planogram Substitution Definition dialog 
box by the user when setting up individual definitions. 

PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE 
The PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE system variable sets the 
default values for the plus and minus tolerance for planogram height that appear in the 
Rules Tab of the Planogram Substitution Definition dialog box called from the Planogram 
Substitution dialog box in the Admin Module. 
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These default values can be over-ridden in the Planogram Substitution Definition dialog 
box by the user when setting up individual definitions. 

PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE 
The PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE system variable sets the 
default values for the plus and minus tolerance for planogram depth that appear in the 
Rules Tab of the Planogram Substitution Definition dialog box called from the Planogram 
Substitution dialog box in the Admin Module. 

 

These default values can be over-ridden in the Planogram Substitution Definition dialog 
box by the user when setting up individual definitions. 

PLANO_SUBS_WARNING_DATES 
The PLANO_SUBS_WARNING_DATES system variable determines whether an 
individual user has chosen to suppress display of the warning dialog for manually 
running Planogram Substitutions when the current date is outside of the date range the 
selected planogram substitutions are valid for.    

 

0 = Individual user has suppressed warning 

1 = Warning will be displayed for individual user 

The results are stored referenced by User ID (USR_ID) in the User Variable table. 

Note: For more information on the User Variable table see 
the Oracle Retail Macro Space Planning Data Model. 
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Product Studio 

DEFAULT_TRANPARENCY_COLOUR 
The DEFAULT_TRANSPARENCY_COLOUR system variable holds the value of an RGB 
value that will be colored transparent when displaying a product image in the 
Merchandiser module. An example can be seen below: 

 

If the area of an image that is to be made transparent is colored with that specific RGB 
value, the image will appear transparent when displayed. 

 

In the example above, the television on the left has had a transparency applied; the one 
on the right has not. 

Note: See Product Studio help for detailed information on 
how to use transparencies. 

Report Designer 

About Report Designer 
Report Designer is a module within Macro Space Management. It allows customized 
reports to be produced for planograms. Report Designer can be invoked in one of two 
ways: 

 From the File > Print > Planogram menu. This allows printing of planogram 
reports, but does not allow editing 

 From the C:\Oracle Retail\MSM\APPS\AVT5PogReporter directory. This 
allows both editing of the report layout and printing of planogram reports. 
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RPTDSG_HELPFILE 
The RPTDEG_HELPFILE system variable contains the URL (Uniform Resource Location) 
for the help files for Report Designer. It should detail both the path to the directory and 
the name of the file used to open the help. 

Note: Report Designer Help is in Webhelp format. This 
differs from the CHM files used for Macro Space 
Management. 

RPTDSG_TESTPOGID 
The RPTDSG_TSTPOGID system variable specifies the planogram that will be 
displayed for testing the Planogram Report.  The planogram is identified by its POG_ID 
in the Plano table. 

 

Note: For more information on the Plano table see the Oracle 
Retail Macro Space Planning Data Model. 

RPTDSG_IMAGEBASE 
The RPTDSG _IMAGE_BASE System variable holds the identity of the mapped drive or 
UNC path to a directory where any images associated with the report are held. These 
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images can then be incorporated into the report - for example as a logo. attempting to use 
Images outside of this path will result in a warning that the image cannot be used. 

 

Because these images are going to be used by all users of the report, the folder holding 
them should be on a server or some other centrally available resource. 

RPTDSG_MAXUNDO 
The RPTDSG_MAXUNDO system variable holds an integer specifying the maximum 
number of undo actions that can be carried out in Report Designer. 

Space Calculations 
Space Calculations  are used to calculate a set of parameters for fixtures and the products 
occupying them. These parameters can then be used in reports specifying the efficiency 
with which a store has been merchandised. 

Space Calculations  

Base Linear 
Base Linear is the greater value of: 

 The merchandisable length of the fixture as defined in the Merchandisable Areas 
tab of the Block Details dialogue box. 

 The nominal length of the fixture as defined in the Sizes tab of the Block Details 
dialogue box. 

Shelf Linear 
Shelf Linear is the total merchandisable length of the shelves on a fixture. Shelf Linear 
may also include the length of the fixture itself, if that fixture is populatable. 
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Footprint 
Footprint is the greater value of: 

 The merchandisable area of the fixture as defined in the Merchandisable Areas 
tab of the Block Details dialogue box. 

 The nominal area of the fixture as defined in the Sizes tab of the Block Details 
dialogue box. 

Allocated Area 
Allocated Area is calculated using the Calculate Areas option on the Calculate Menu and 
toolbar in Planner. It will not be discussed further here. 

Display Volume 
The display volume is the actual volume occupied by a specific product and is calculated 
from the length, depth and height assigned to it, multiplied by the number of instances 
placed on a specific fixture. 

Nominal Volume 
The nominal volume is the base linear of a fixture multiplied by the depth specified in 
the CALC_STND_DEPTH system variable and the height defined in the 
CALC_STND_HEIGHT system variable. 

Allocated Volume 
The allocated volume is the Allocated Area multiplied by the height defined in the 
CALC_STND_HEIGHT system variable. 

CALC_STND_DEPTH 
The CALC_STND_HEIGHT system variable is used by Space Calculations in the 
Planner Module. It is used in conjunction with the CALC_STND_DEPTH system variable 
and the Base Liner of a fixture to calculate the nominal volume. 

CALC_STND_HEIGHT 
The CALC_STANDARD_HEIGHT system variable is used by Space Calculations in the 
Planner Module. It has two purposes: 

 It is used in the calculation of Nominal Volume 

 It is used in the calculation of Allocated Volume. 

Nominal Volume 
The nominal volume is the base linear of a fixture multiplied by the depth specified in 
the CALC_STND_DEPTH system variable and the height defined in the 
CALC_STND_HEIGHT system variable. 

Allocated Volume 
The allocated volume is the Allocated Area multiplied by the height defined in the 
CALC_STND_HEIGHT system variable. 
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Store Manager 

PUBLISH_DATE_LEAD_PERIOD 
The PUBLISH_DATE_LEAD_PERIOD  system variable was used in Store Manager. It 
affected the file Properties dialogue box. This system variable has now been replaced by 
the System Publishing Lead Period  setting in the Floor Plan Publishing Configuration 
dialog box accessed from the File menu in the Administration module. 

EFFECTIVE_DATE_LEAD_PERIOD 
The EFFECTIVE_DATE_LEAD_PERIOD system variable is used in Store Manager. It 
affects the file Properties dialogue box 

 

When a user sets a file to Authorized status, the previously grayed out Publish and 
Effective dates become active. The Publish Date is set to the current date plus the time 
interval specified in the System Publishing Lead Period setting in the Floor Plan 
Publishing Configuration dialog box accessed from the File menu in the Administration 
module. 

The Effective Date is then set to the Publish date plus the number of days set in the 
EFFECTIVE_DATE_LEAD_PERIOD system variable. 

ENABLE_FILE_TRIGGER_DATE 
The ENABLE_FILE_TRIGGER_DATE system variable determines the behavior of both 
the File Properties dialogue box and UpdateStatus.exe. 
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Value Result Other Actions 

0 or 1 UpdateStatus.exe is disabled and has no effect 
on File or Revision statuses. Publish and 
Effective dates are disabled and cannot be set. 

Publish and Current statuses need to 
be selectable so that files can manually 
be taken through the software cycle. 

2 Effective date is enabled. UpdateStatus.exe 
will change file status if the Effective date is 
exceeded. 

Publish needs to be manually 
selectable. 

3 Publish and Effective dates are enabled. Publish and Current status should not 
be selectable by the user so that update 
status is the required method to 
change them. 

 

Synchronisation 

Overview of Synchronization 
Synchronization is used in the Planner module to ensure the AutoCAD floor plan 
contains the same information as the Macro Space Planning (MSP) database. This 
information could differ because: 

 Changes have been made in the Planner module using AutoCAD tools and this 
information has not been registered in the database. 

 Changes have been made in to a floor plan in the Merchandiser module. This 
will write information to the database but will not update the AutoCAD floor 
plan. 

 Changes have been made in to a floor plan in In-Store Space Collaboration. This 
will write information to the database but will not update the AutoCAD floor 
plan. 

 Changes have been to a floor plan using batch tools like Planogram 
synchronization. Again, this will write information to the database but will not 
update the AutoCAD floor plan. 

There are two forms of synchronization: 

 Automatic 

This is done as the floor plan is opened in the Planner module. The date the 
AutoCAD floor plan was last modified is compared with information in the 
database. If necessary, modifications are made either to the floor plan or 
database. 

 Manual 

This can be done manually by the users once the floor plan has been opened. 
This is done in the synchronization dialog box accessed from the File menu or 
Retail toolbar in the Planner module. 



Admin Planning 

General Options 255 

 

The following system variables affect synchronization: 

 AUTOSYNC 

 SYNC_SETTINGS 

 SYNC_OBJECTS 

 SYC_DIRECTION 

These are described in more detail in the following topics. 

AUTOSYNC 
The AUTOSYNC system variable is used to specify whether a floor plan in the process of 
opening in the Planner module will be automatically synchronised to ensure the 
information in the AutoCAD floor plan matches the information in the MSP database. 
The possible values are: 

0 - Do not Auto-Synchronize. 

1 - Prompt when Auto-synchronization is required. 

2 - Auto-Synchronize automatically when the floor plan is opened. 

If the 'Prompt when Auto-synchronization is required' option is selected, a confirmation 
dialog box will come up 

 

Note: See Oracle Retail Macro Space Management Planner Help 
File for more information on how the Auto-Synchronize 
functionality works. 
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DYNAMIC_SYNC 
The DYNAMIC_SYNC system variable allows users to dynamically synchronize changes 
made in a Planner floor plan using AutoCAD tools back to the database at the time the 
changes are made. 

0 = Off 

1 = On 

This affects equipment and merchandise. Other types of objects such as zones are not 
affected by dynamic synchronization and have to be manually synchronised by the user 
if required. 

SYNC_SETTINGS 
The SYNC_SETTINGS System Variable determines whether to use default options for 
the synchronization options, or whether to save user specific options. 

0 = Use Default Options 

1 = Save User Specific Options  

If Use Default Options  is selected, the default settings will be read from the 
SYNC_DIRECTION and SYNC_OBJECTS system variables from the System Variable 
table. If Save User Specific Options  is selected, the current Synchronize Options and 
Synchronize Objects will be written back as User Specific Variables to the User Variable 
table. 

Note: For more information on the these tables see the Oracle 
Retail Macro Space Planning Data Model. 

SYNC_DIRECTION 
The SYNC_DIRECTION System Variable holds the default value for the direction 
synchronization is set to occur. 

 

The possible values of the system variable as follows: 

0 = Match the Drawing 

1 = Match the Database 

2 = Merge 

3 = Keep Identical  

Note: See Store Planning Help for more information on how 
the Synchronize direction functionality works. 
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SYNC_OBJECTS 
The SYNC_OBJECTS System Variable specifies which options are to be present as 
defaults when the synchronization dialog box opens. 

 

The defaults are stored as a bitwise value with: 

0 = No defaults  

1 = Synchronize Fixtures  

2 = Synchronize Shelves  

4 = Synchronize Products  

8 = Synchronize Other Blocks  

16 = Synchronize Zones  

32 = Synchronize Views 

64 = Synchronize Lights [not currently in use] 

128 = Synchronize Notes/Markups  

256 = Synchronize Aisles 

Note: See Store Planning Help for more information on how the Synchronize 
functionality works. 

Tax Codes 

About Tax Codes 
The Tax Codes Option in the Admin Module allows users to enter rates for varying 
types of tax. These rates can then be assigned to products at SKU Level in Product 
Studio. Generally, once the tax codes have been set up, they are referenced by the data 
import process bringing in new products. 

 
The Tax Code Window has three main parts. 

 Pull down menus give access to various Tax Code options. 
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 The Toolbar gives access to other Tax Code options. 

 The Tax Codes are displayed in the Tax Code Grid. 

Manually Assigning Tax Codes 
Tax Codes are manually assigned in the Financial Tab SKU dialogue box in Product 
Studio 

 

Menus and Toolbars 
The File Menu  allows users to exit Tax Codes. 

 

The Edit Menu allows users to Add, Edit or Delete Tax Codes  

 

The View Menu allows users to switch On and Off display of the Toolbar and Status 
Bars. It also allows them to refresh the Tax Code grid. 

 

The Help Menu allows users to call help and to determine the current version of the 
software. 

 
Clicking on About displays the current version number of the software. 
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The Toolbar gives access to varying Tax Code options 

 

Icon Description 

 

Exit  

 

Add Tax Code 

 

Exit Tax Code 

 

Delete Tax Code 

 

Refresh 

 

Adding, Editing and deleting Tax Codes 
Manually Adding, Editing and Deleting Tax codes can be done via the options from the 
menus or toolbar.  

 

Tax Code Options 

Adding a Tax code 
To Add a Tax Code  

1. Click on the Add Tax Code icon or select Add from the edit pull down Menu. 

2. Type a description into the Description text box then click in the Rate text box and 
enter the required Tax Rate. 

3. Press <Return> to send the values to the central Macro Space Management database. 

Note: The values will not be stored in the database until 
return has been pressed. 
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Editing a Tax Code 
To Editing the Tax Code:  

1. Click in the relevant box in the Tax Code grid, then type in the amended values. 
Alternatively, highlight the relevant tax code and use the edit options in the edit 
menu or in the toolbar.  

2. Press <Return> to store the changed values in the central Macro Space Management 
database. 

Note: The values will not be stored in the database until 
return has been pressed. 

Deleting a Tax Code 
To Delete a Tax Code: 

1. Highlight the required Tax Code  

2. Click on the Delete icon or select the Delete option from the Edit pull down menu.  

The tax code will be deleted without further confirmation 
being requested. 

Refreshing and Exiting 
Refreshing is of use when multiple people are using the same option in Administration 
Module. Clicking on the Refresh Icon will cause the list of Tax Codes to be updated based 
on current information from the central Macro Space Planning database.   

Units 

Overview of Units Option 
The Units Option within the Administration Module allows the user to specify the units 
that will be available within Macro Space Management. They are specified relative to 
fundamental SI units and can be specified according to the user's needs. 

The Units Window contains three main parts. 
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The Menus and the Toolbar allow the user to access varying options concerning units. 

The Unit Details section allows the user to see the values assigned to specific units. 

About SI Units 
The International System of Units (abbreviated SI from the French le Système 
International d'unités) is the modern form of the metric system. 

It contains seven basic units; 

Name Symbol Measurement 

Metre (Meter) m Length 

Kilogram Kg Weight 

Second s Time 

Ampere A Electric current 

Kelvin K Temperature 

Mole mol Quantity of matter 

Candela cd Light intensity  

 

All units used in Macro Space Management are relative to these basic units. 

For example grams are 1/1000th of a kilogram. 

Note: For convenience Macro Space Management uses the 
degree Centigrade rather than degrees Kelvin as the 
measurement of temperature. 

File Pull Down Menu 
The File menu allows users three options. 
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Reload Units 

This option allows users to reload the display grid with the values for the units when 
they were last saved. This will overwrite any alterations made to the values of the units 
but not saved. 

Save Units 

This option allows users to save any changes made to the values for units. 

Exit 

This allows users to exit the unit option. If changes have not been saved, then a warning 
dialogue will appear. 

 

Units Pull Down Menu 
The Units pull down menu allows users to Add a new unit or Delete an exiting one. 

 

To add a unit, click Add. This will add a new line in the table of units. 

To delete a unit, highlight a line and click Delete. The Unit will then be deleted from the 
table of units. 

Additions or deletions will not be permanent until the Save option has been used in the 
File pull down menu. 

Dimensions Pull Down Menu 
The Dimensions pull down menu allows users to bring up the Dimensions dialogue 
box. 
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When entering a new dimension, it has to be related to the basic dimensions of Number, 
Length, Mass, time, Charge, Intensity, Money, or Angle. 

The power is that which the original basic dimension has to be changed to describe the 
new one. This will generally only involve the length basic dimension.    

Basic 
Dimension 

Power Result 

Length 1 Length 

  2 Area 

  3 Volume 

Help Pull Down Menu 
The Help menu  allows users to call this Help File. Clicking on About will bring up a 
small dialogue box showing the current version of the software.   
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Toolbar 
The Toolbar allows users to access varying options affecting the addition, editing, 
deletion and saving of units. 

 

Icon Description 

 

Exit  

 

Save 

 

Add Unit 

 

Delete unit 

 

Refresh 

 

Edit Unit 
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Unit Details 

 

 The Unit ID is used internally within the central Macro Space Planning database. 
It is not editable by the user. 

 The Symbol is used in Reports, and so on. 

 The Description is used to prompt users as to the purpose of the dimension. 

 Prefixes are used before units. An example would be where a £ or $ sign was 
wanted before a monetary value. 

 The Suffix is the symbol that will be displayed after the unit if it appears in a 
drawing etc. 

The suffix for Kilograms is Kg so weights will be displayed as follows: 

5 Kg, 10.7 Kg, 0.3 Kg 

Similarly the suffix for meters is m so lengths will be displayed as follows: 

5 m, 10.7m, 0.3 m 

 The Order is used to specify the order units appear in a drop down list. 

 The Offset Option is used where the unit is related to a base dimension by a y = 
mx + c relationship. It represents the constant c in the equation.  

For example the offset for degrees Kelvin is -273.16. The relationship between 
degrees Centigrade and Kelvin is Degrees Kelvin = Degrees Centigrade - 273.13. 
Offsets are sometimes used in conjunction with SI Factors. For example the offset 
between degrees Centigrade and Fahrenheit is -32 and the SI Offset is 0.555. 
Degrees Fahrenheit = (Degrees Centigrade x 0.555) -32 

 The SI Factor is used where the unit is related to a base dimension by a y = mx + 
c relationship. It represents the coefficient m in the equation.  

The SI factor is the factor by which the basic dimension has to be scaled by to 
give the correct value for the unit. For example there are 2.204 pounds to the 
kilogram, so the SI Factor is 0.454: 1 lb = 0.454 Kg. As another example, there are 
39.37 inches to the meter, so the SI factor is 0.0254: 1 in = 0.0254 meters. 

 The Display Option allows the user to select whether a unit will be displayed in 
the appropriate drop list when used in Macro Space Management. Units with a 
tick will be displayed. Units without a tick will not. 

 Precision determines the number of decimal places that will display when the 
value of a unit is shown. 
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Number of 
decimal 
places 

Result 

0 10 

1 10.1 

2 10.25 

3 10.375 

Note: This functionality is being implemented, and not all 
variables may display to the set number of decimal places. 

 Mandatory Units are units that cannot be deleted. These are units that are 
fundamental to Macro Space Management and correspond to the fundamental SI 
units, plus the Number, Money and Angle options. More on SI Units. 

 Default Units are the units that will be preferentially displayed when the selected 
measurement system is in use. For example, if the imperial system is used, the 
default units might be selected as inches, pounds and degrees Fahrenheit. For the 
metric system, the default units selected might be centimeters, kilograms and 
degrees centigrade. 

User Defined Attributes 

Overview of User Defined Attributes 

Overview of UDAs 
User Defined Attributes (UDAs) allow a Macro Space Management Administrator to 
configure customizable fields for Users, Stores, Files, Fixtures, Products and Planograms. 
These fields can then be populated with data by import or by manual entry. 

 

In the example above, additional information is being assigned to the user in the 
Administration module via User Defined Attributes. 
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The flexibility given by UDAs gives individual retailers the option to do one of two 
things: 

 Import UDA information from other software applications to assist in store 
planning functionality. 

  Manually enter UDA information to describe information or parameters related 
to the store planning process  

How UDAs Work 
UDAs have a slightly different table structure to standard relational database tables. 

 

The User Defined Attributes dialog box in the Administration Module is used to write 
data to a template table to hold information on how data is structured. 

 

Each of the individual UDA tables is made up of a specific number of columns. When 
data is entered into the User Defined Attributes dialog box in the Administration Module 
it specifies (for example) that Column 1 in the User UDA table is to be used to store the 
user's manager name, that column 2 is to be used to store the user's work e-mail address, 
etc. Individual retail chains can thus decide which items of data to store as user defined 
attributes up to the limit of the number of columns in the tables. 

Note: The exception to this is the Variable Attributes 
assignable to fixtures placed in floor plans. These are 
configured in Fixture Studio, but the general principle is the 
same. 

When a UDA is displayed to the user, the column header is read from the UDA template 
table and the data from the individual UDA table - for example the User UDA table. This 
gives considerable flexibility as to the quantity and type of data stored. 

Once configured, the attributes can be used in two main ways: 



User Defined Attributes 

268 Oracle Retail Macro Space Management 

 All MSM users can see customized, organization specific information for those 
objects with UDA data assigned. 

 Reports can be produced based on the information in the User Defined 
Attributes.   

Modifying User Defined Attributes 
Once User Defined Attributes have been configured, the configuration should only be 
modified after careful thought. 

 

Adding Additional UDAs 

Adding additional UDAs will not generally cause any problems. Unless data is 
retrospectively added for existing objects in the database, these will have blank values for 
the newly created UDAs. 

Modifying UDAs 
Modifying UDAs is not recommended as this could leave a database table holding a 
mixture of information from the old and new version of the UDA. It is better to create a 
new UDA and either delete or conceal the existing UDA. 

Deleting UDAs 

It is possible to delete UDAs. This can generally be done my means of a simple SQL 
script. 

Consequences of Modifying UDAs 

Before existing UDAs are modified in any form, it is suggested that the person making 
the changes verifies this will not impact existing functionality. Possible areas to check 
include: 

 Custom SQL: This could affect operations such as populating the Object Grid 
with data. 

 Data Importer Module: This could cause problems if a deleted UDA field is 
populated during an import. 

 ODI: Again, this could cause problems if a deleted UDA field is populated 
during an import. 

 Reports: Problems could occur if a UDA field referenced by a report is modified 
or deleted. 

Overview of Configuring and Populating UDAs 
User Defined Attributes require two stages: 

 

Configuring UDA's in Admin 
The required UDA's are configured in the Admin Module. 
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Individual UDA's can be assigned specific names, date types, default values, etc. In the 
above example, UDA fields have been designated for files (floor plans). 

Auto-populating UDAs by Data Import 
Once UDA's have been set up in the Administration module, it is possible to populate 
them via data import. The UDA tables affected are: 

UDA Table Primary Key 

File File UDA FIL_ID 

Fixture Block UDA BLK_ID 

Product Product UDA PRD_ID 

General Planogram Data Plano UDA POG_ID 

Planogram Profile (Bay) Data Profile UDA PRF_ID 

Planogram Equipment Data POG Fixel UDA FXL_ID 

Planogram Product Data POG Product UDA PPR_ID 

Store Store UDA STR_ID 

User User UDA USR_ID 

Variable Fixture Attributes are stored in the Attribute table. 

Note: for more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

There are two options for importing data: 

MSMs Data Importer Module 

MSM contains a data import module. 
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This can be used to populate the majority of tables in the Macro Space Planning database. 
Because UDAs can be customized to meet a specific retailer's requirements, additional 
data imports will need to be set up to bring in the information. 

Oracle Data Integrator 

Oracle Data Integrator (ODI) is an Extract-Transform-Load tool. Because planograms are 
more complex to import than the majority of information in the Macro Space Planning 
database, it is recommended that ODI be the tool of choice for importing planogram 
information. These planogram imports can be configured to include UDA information 
for the planogram itself, its profiles (bays), its equipment and its products.  

Manually Assigning UDA's in Modules 
Once UDA's have been configured in the Administration Module, individual values can 
be assigned to instances of Fixtures, Files, Planograms (general properties, profile 
information, equipment information, product information), Products, Stores and Users. 
In the example below, UDA's are being assigned to a floor plan - each field being 
populated previously having been designated in the Administration Module. 

 

Values can be entered, selected from drop down lists or calendars or assigned by ticking 
or unticking a check box. 
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Dialogue Boxes where UDA's are Set 
UDA's can be assigned to specific Users, Stores, Files, Fixtures, Products and 
Planograms. The dialogue boxes where this can be done are as follows: 

Users 
UDA's for Users are set in the Attributes tab of the User dialogue box accessible from the 
Functional Security Option in the Administration Module. 

 

Stores 
UDA's for Stores are set in the Attributes tab of the Add or Edit Store dialogue box in Store Manager. 
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Files 
UDA's for floor plans can be accessed by clicking the UDA button in the File Properties 
dialogue box in Store Manager. 

 

Fixtures 
Fixture UDA's are in two forms: Fixed and Variable. 

 Fixed Attributes are set in the User Defined Attributes section of the 
Administration module. These attributes are constant to all fixtures of that type. 

 Variable Attributes are configured using the Edit Menu > Edit Attribute 
Definitions option in Fixture Studio. They can then be set for individual instances 
of fixtures in Planner, Merchandiser and In-Store Space Collaboration by 
selecting a fixture in the drawing and clicking the Attributes option in the 
respective toolbars. 

The Fixed Attributes are set at the top of the Block Details dialog box. These are common 
to all fixtures of that type. 
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The Variable Attributes are configured in the Block Details dialog box in Fixture Studio. 
Specific values are set on a case by case basis for individual fixtures placed in floor plans. 
This can be done in both the Planner and Merchandiser modules (and in In-Store Space 
Collaboration). 

 

In the example above, the variable attributes have been configured for compliance 
checking. A user would survey the store on-site using In-Store Space Collaboration. The 
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result then becomes available to a planner at headquarters using Macro Space 
Management. They could (using a set of specially developed KPI's) easily identify any 
problematic fixtures on-site at the real life store. 

Products 
UDA's for Products are set at SKU level in Product Studio using the Custom Tab of the 
SKU dialogue box. 

 

Planograms 
Four sorts of UDA's are associated with planograms. 

 UDA's Associated with the general planogram design 

 UDA's associated with Planogram Profiles (bays) in the planogram design  

 UDA's associated with specific items of equipment in the planogram design 

 UDA's associated with specific products in the planogram design 

UDA's Associated with the general planogram design 
General UDA's for Planograms are set in the UDA tab of the Planogram Design dialogue 
box in the Merchandiser module. 
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UDA's associated with Planogram Profiles (bays) in the planogram design 
UDA's associated with a specific profile (bay) in a planogram can be seen by highlighting 
that bay in the Planogram Design window in the Merchandiser module and clicking the 
Object Properties icon on the toolbar. 

 

This will bring up the Profile User Defined Attributes dialog box. 
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Note: the number after the parent fixture for the profile (not 
shown in this screen shot) is the FIX_ID from the Fixture 
table. It is a unique identifier for the profile/bay the UDA 
refers to. 

UDA's associated with specific items of equipment in the planogram design 
UDA's associated with a specific item of equipment in a planogram can be seen by 
highlighting that item of equipment in the Planogram Design window in the 
Merchandiser module and clicking the Object Properties icon on the toolbar. 

 

This will bring up the Equipment User Defined Attributes dialog box. 

 

Note: the number after the item of equipment (62 in the 
above example) is the FXL_ID from the POG Fixel table. It is 
a unique identifier for the item of equipment the UDA refers 
to. 

UDA's associated with specific products in the planogram design 
UDA's associated with a specific product in a planogram can be seen by highlighting that 
item of merchandise in the Planogram Design window in the Merchandiser module and 
clicking the Object Properties icon on the toolbar. 

 

This will bring up the Product User Defined Attributes dialog box. 
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Note: the number after the item of merchandise (659 in the 
above example) is the PPR_ID from the POG_Product table. 
It is a unique identifier for the item of merchandise the UDA 
refers to. 

Multi-Page Results 
If multiple objects are selected, up to five results will be displayed on the opening page. If 
more than five objects are selected, the multi-page controls become active and users can 
move between pages. 

 

Note: For more details about these tables see the Oracle Retail 
Macro Space Planning Data Model. 

Configuring User Defined Attributes 
Configuring User Defined Attributes is done using the User Defined Attribute Option 
from the General menu of the Administration Module. This will bring up the User 
Defined Attributes dialogue box. 

Overview of the UDA Dialog Box 
UDAs are configured in the User Defined Attributes dialog Box 
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Menu and Toolbar Options 

The File and view menus five the option to close the dialog box, refresh the contents and 
toggle display of the toolbar and status bar on and off. 

UDA Types 
User Defined Attributes can be configured for the following objects. Users can see the 
varying UDA options as gray bars. They can be expanded or contracted by using the '+' 
or '-' signs. 

UDA Type Where Used Dialogue Box and Module 

Block Fixture (Block) 
Definitions 

1) Block Definition dialog box/Fixture Studio 

2) Fixture Attributes option from toolbar in Planner 
and Merchandiser modules 

Planogram 
Design 

Planogram Definitions UDA tab of the Planogram design dialog 
box/Merchandiser Module 

Planogram 
Profile 

Profiles (Bays) within 
Planograms 

Design tab of the Planogram design dialog 
box/Merchandiser Module 

Planogram 
Equipment 

Equipment within 
Planograms 

Design tab of the Planogram design dialog 
box/Merchandiser Module 

Planogram 
Products 

Products within 
Planograms 

Design tab of the Planogram design dialog 
box/Merchandiser Module 

Product Product Definitions Product SKU Dialogue/Product Studio  

File file Properties File Properties dialog box/Store Manager 

Store Store Definition Add/Edit Store dialogue box /Store Manager 

User User Definition User dialog box in Functional 
Security/Administration  Module 

Each UDA option has a fixed number of options that can be configured to user specific 
requirements. 

Configuring UDAs 
Configuring UDAs is done in the User Defined Attributes dialog box. 
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Selecting Type of UDA 

The initial stage is to select the UDA type. This is done by highlighting the required type, 
then clicking the '+' sign of open it up. Each type of UDA contains a fined number of lines 
of data. Any line can be edited by highlighting it. 

Note: When entering data, it is generally necessary to press 
Return  or click in another cell before the entry is written 
back to the database. 

Type 

The Type field is specified in the database and cannot be edited in the User Defined 
Attributes dialog box. Rows are in blocks of different types including Text, Number, Date 
and Flag. Fields of type Text can be set to any value using the Data Type drop down list. 
Fields of other types cannot be set to any other value than their native type. 

Note: If a text field is set to another data type (for example 
Date), any SQL statement referencing the field will need to 
convert it to the correct type of data. For example if a date 
has been stored in the text field, the Oracle To_Date function 
should be used to convert it into a date for reporting 
purposes. Similarly, if numbers are stored as text, they will 
sort in alpha numeric sequence rather than numerical 
sequence. 

Check box data (ticked or un-ticked values) are stored in the flag fields. The application 
assumes that o is not selected, while any non-zero value is selected. If currencies are 
stored, they are normally stored in the Number fields. It is common to define a currency 
type in a drop down list in a text field. This currency type can then be combined with the 
currency value in a report. 

Note: Because the data types are predefined, the drop down 
list should be set to the same as the predefined type. 

Number 

The Number field is specified in the database and cannot be edited in the User Defined 
Attributes dialog box. It references the column number in the pertinent IDA table in the 
database. 
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In the example above the Number 1 field is the PGU_VALUE1 column, the Number 2 
field is the PGU_VALUE2 column, etc., in the Plano UDA table. 

Note: For more information on the Plano UDA table see the 
Oracle Retail Macro Space Planning Data Model. 

Name 

The Name field is the Name that will be shown in the appropriate UDA dialog box. In 
the example below, the names assigned in the UDA Dialog box in the Administration 
module appear in the Property field of the UDA Tab of the Planogram Design dialog box 
in the Merchandiser module. 

 

Data Type 
The Data Type is set from a drop down list. This specified the form of data for a specific 
UDA and constrains the data that can be entered in the pertinent UDA dialog box. Only 
text fields can be set to anything other than their native type. 

 

For example, if a field is set to type 'Date', users will be invited to pick a date from a 
Calendar; conversely, if a field is set to Boolean, uses will be able to tick or un-tick a 
check box.   

Mandatory 

This specifies whether the data is mandatory (must be entered) or not. If this check box is 
ticked, the user will not be allowed to close the associated dialogue box (for example the 
Planogram Definition dialog box) until the data has been entered. 
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Sequence 

This is the sequence the UDA's will be display in the dialogue box they are associated 
with. For example, assigning a UDA the sequence number of 3 means it will display 3rd 
in the list of UDA's. 

 

Specifying the sequence is useful when specifying data of different types. For example, 
the first field to be displayed could be a text field, the second a numeric field, the third a 
flag field and the fourth another text field. Using sequences allow data to be displayed in 
a very specific sequence. 

Default 

This specifies the default value that will appear when the dialogue box is first opened to 
enter UDA's. This can be left blank if no default is required. 

 

In the above example, the default value for Design Office has been set to St Albans. This 
value will appear when the UDA dialog box is opened for the first time. It can be 
overwritten as necessary. 

Lookups 

This field specifies values that may be selected from a drip down list. Values must be 
entered using a pipe (vertical bar) to separate them. An example would be A|B|C. If a 
look up is entered in this column, users can only select values from the look ups. If no 
value is entered, the user will have to manually enter data. In the example below the 
customer demographic for a specific store is selected from a look ups via a drop down 
list. 
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Blank Lines 

Each type of UDA can have multiple options configured. For example, Planogram UDAs 
can have up to 60 lines of data. Only lines that have been configured in the User Defined 
Attribute dialog box will appear in the UDA dialog boxes assigned by users. For 
example, if only eight lines of data have been configured, only eight lines will appear in 
the dialog box. 
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Imported Data 
As well as manually setting up data, data can be imported via Macro Space Planning's 
Data Importer module or via Oracle Data Integrator (ODI). If data is imported via these 
applications, the data type must be matched to the data type in the pertinent fields in the 
database or errors will result. 
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7 
Admin Planning 

Hatch Styles 

Hatch Styles Dialogue Box 

About Hatch Styles 
The Hatch Styles Option allows users to set up Hatch Styles to indicate the dimensions 
of Zones, etc. These hatch styles can be customized in the Admin Module and are used in 
both the MSM Merchandiser Module and In-Store Space Collaboration. Hatch Styles in 
the Planner Module is based on the pre-configured hatch styles in AutoCAD. Changing 
Hatch Styles in Admin thus has no effect on this module. 

The Hatch Styles Dialog Box 
The Hatch Styles dialogue box gives brief details of the available styles. 

 

The Menu Bar gives access to the drop down menus. 

The Toolbar gives access to many of the options available from the menus. 

The Style List lists the styles that have been defined. 

The Status Bar gives the total number of styles. 

Selecting the Add or Edit option from the toolbar will bring up the Add/Edit Hatch Style 
dialogue box. 



Hatch Styles 

286 Oracle Retail Macro Space Management 

 

This allows users to specify the pattern details to be used in Merchandiser and In-Store 
Space Collaboration. 

Overview of Configuring Hatch Styles for Merchandiser/In-Store Space Collaboration 
The data structure for a hatch pattern is very similar to an AutoCAD hatch pattern file 
(*.PAT): The hatch pattern is made up of one or more pattern lines. These pattern lines 
are repeated until they fill the area defined for hatching.  

 

  

Pattern lines can be specified to have a specific start point, length, gap between segments, 
and angle. Hatch patterns can be made up of multiple pattern lines. In the example below 
(coded red and blue for ease of understanding) two separate pattern lines have been 
combined to make a zigzag pattern. 
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Configuring Hatch Styles for Merchandiser and In-Store Space Collaboration 
To Add or Edit a Hatch style for Merchandiser, respectively click on the Add Hatch Style 
icon [outlined in red/left], or highlight a hatch style and click on the Edit hatch style icon 
[outlined in red/right]. 

 

This will bring up the Add (or Edit) Hatch Styles dialogue box. The settings to be 
configured are in the Merchandiser/In-Store Space Collaboration Representation frame. 



Hatch Styles 

288 Oracle Retail Macro Space Management 

 

 Angle should be a numeric value between 0 and 360o. 

 X Origin and Y Origin values can be positive or negative decimal numbers. They 
specify the offset relative to the 0,0 datum the Zone is drawn from. 

 X Delta and Y Delta specify the spacings between the lines in the X and Y planes. 
Delta spacings are specified in the drawing units (normally inches or mm).  

 X Delta is only meaningful for dashed lines and gives the offset for each 
successive line. In  the example below, the left hand example has X Delta offset = 
0, while the right hand example has X Delta offset = 1. (One line in each family of 
dashes has been highlighted in red to show the effect). 

 

 Y Delta affects the vertical gap between the lines. The example on the left has a Y 
Delta offset = 1, while the example on the right has Y Delta offset = 2. 

 

 Dash and Gap determine the length of each dash in a line, and the gap between 
them. Up to three dash lengths and gaps can be specified for each line. 

In the example below the first unit has been colored in blue, and the second in red. 
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The dash and gap lengths are as follows: 

Dash 1 Gap 1 Dash 2 Gap 2 Dash 3 Gap 3 

1 1 2 0.5 1.5 0.5 

If the first dash and gap are not defined, then a continuous line will be drawn. Dash 2 
and Gap 2 cannot be defined until Dash 1 and Gap 1 have been entered. Dash 3 and Gap 
3 cannot be defined until Dash 2 and Gap 2 have been entered. 

Detail of Hatch Style Parameters for Merchandiser/In-Store Space Collaboration 

 

The Angle of the line is the angle measured anticlockwise from horizontal. Angles can 
take up any value between 0 and 360 degrees. 

 

The X and Y origins are specified in terms of Cartesian coordinates. 

 The Red dot has an X origin of 0 and a Y origin of 0. 

 The Green dot has an X origin of 1 and a Y origin of 2. 

 The Blue dot has an X origin of 3 and a Y origin of 1. 
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The X and Y offsets are the distances between lines. 

 The Green lines have a Y offset of 1. 

 The Red lines have a Y offset of 2. 

 

The Dash and Gap give respectively the length of a section of the line and the gap to the 
next part of the line. 

 The Green Line has a Dash of 2 and a gap of 1. 

 The Red Line has a Dash of 1 and a Gap of 1. 

Scales 

Overview of MSM Scales 
Scales potentially affect Text Styles and Symbols as they are inserted into a drawing in 
the Planner Module. There are two drawing environments in the Planner Module, Model 
Space and Paper Space. Users can toggle between the two using tabs at the bottom of the 
drawing. 
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Model Space 
Model Space is where an object is designed in Planner. Objects can be drawn in 3 
dimensions in model space, and can be viewed at any degree of magnification. Objects 
drawn in model space are always drawn at a 1:1 ratio; 1 unit in model space = 1 unit of 
the chosen setting. For example, if the units in model space are inches, 1 unit = 1 inch. 
Similarly, if the units in model space are centimeters, 1 unit = 1 cm. Users can zoom in or 
out to see the drawing at any scale. 

Paper Space 
Paper Space is where the drawing produced in model space is prepared for printing. 
Because a drawing in model space is always drawn at a 1:1 ratio, i t will generally have to 
be scaled to get it to print within the limits of A2, A3 or A4 paper. For example 1 inch 
may represent 8 feet (1:96) in the printed output. This enables an 11" x 7" section of paper 
to represent an 88 ft x  56 foot section of floor - adequate to represent an entire 
department. Using a yet smaller scale would enable an entire store to be represented. 

Scales 
Because of the scaling applied to get an object to print in paper space, some objects that 
may have been easily readable at a 1:1 ratio in model space may become very difficult to 
see when the drawing has been scaled for printing purposes in paper space. The Scales 
functionality allows users to automatically scale up the size of specific items when 
inserted into model space, so that when they are scaled back in paper space, they remain 
readable. For example, if it is known that the drawing will be plotted at 1" = 8ft (1:96) 
scale in paper space, it is possible to set the drawing scale to 1" = 8ft in model space. Text 
Styles (if the Scale option has been selected in the text style rules) and Symbols will then 
be scaled up by this factor. This means they will appear very large in model space. When 
scaled in paper space, they will effectively be drawn at a 1:1 size because the scaling up 
in model space will exactly counteract the scaling down in paper space. 

Overview of MSM Scales 

Scales are used for setting the scales used for annotative objects (Text styles, etc), so that 
they are readable when set up in ViewPorts in Paper Space in Planner for printing out. 

Configuring Scales in Admin 
Scales can be configured using the Scales option on the Planning menu in the 
Administration module. This brings up the Scales dialogue box. 
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Scales can be added, edited or deleted using the option on the menu bar or toolbar. 
Refresh will update the Scales dialogue box with the latest information from the 
database: 

Units 

Imperial Units 

For imperial units the scales will depend on the base units of the drawing in Model 
Space. In the table below, the results are based on inches. 

Units Scale Result in Model Space 

Inches 48 1 inch is scaled to 4 feet. 

Inches 120 1 inch is scaled to10 feet 

Inches 240 1 inch is scaled to 20 feet. 

Metric Units 

Similarly, for metric units the scales will depend on the base units of the drawing in 
Model Space. In the table below, the results are based on millimeters  

Units Scale Result in Model Space 

mm 100 1 mm is scaled to 10 cm. 

mm 500 1 mm is scaled to 50 cm 

mm 1000 1 mm is scaled to 1 metre 

Configuring Objects to be Scaled 
Scaling is applied to two types of objects: 

 Symbols 

 Text Styles  
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In order for them to be scaled in the Planner environment, they must first be configured 
accordingly. 

Symbols 
Symbols are shapes like arrows, etc, that are used to indicate points of interest in a store 
plan. 

 

In order to designate an AutoCAD block as a symbol, the Symbol radio button must be 
selected in the Categories Tab of the Block Details dialogue box in Fixture Studio. Once 
an object has been designated as a Symbol, the Drawn 1:1 checkbox also has an effect: 

 If left unchecked, the symbol will be drawn at 1:50 scale 

 If checked, the symbol will be drawn at 1:1 scale - i.e. at the nominal size of the 
block. 

Note: Symbols are currently not scaling properly in the 
Planner module. 

Text Styles 
In order for a text style to scale when added into a Planner store plan, the Scale options 
must be checked in the Text Style rules dialogue box of Text Styles in the Admin Module. 

 

 If Scale (and Scale Offset) are left unchecked, the Text Style will be drawn at a 1:1 
scale 
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 If Scale (and Scale Offset) is checked, the Text Style will be drawn at the scale set 
in the Set Up dialogue box in the Planner module. 

Using Scales in the Planner Module 
The Scales setting in the Admin Module is picked up in Planner via the Drawing Setup 
option in the Format pull down menu. 

 

This calls the Setup dialogue which allows the user to set the required scale for the 
drawing. The required scale must correspond to the scale it is intended to use in paper 
space. For example, if it is decided to plot at 1 in: 16 feet in paper space, the same scale 
should be selected in set up. 

 

Symbols and specified Text Styles will then be scaled up by a factor of 192:1 when placed 
in model space, and scaled down by 1:192 when plotted at 1 in: 16ft in paper space. This 
enables the specified objects to be visible in the printed store plan. 

Overview of Text Styles 

Overview of Text Styles 
Text Styles are used to annotate objects in the Planner environment. Different Text Styles 
can be defined and assigned to varying classes of objects. 
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In the above example, text styles have been defined so fixtures are annotated in black, 
planograms in red with the profiles (bays) numbered in blue. Products have been 
annotated in purple. The annotation has been defined so it does not overwrite itself. 

Text Styles can be assigned to all three types of Zone: 

 Department Zone 

 Internal Zone 

 Zone (Other) 

Text styles can also be assigned to: 

 Fixtures  

 Products  

 Planograms 

Both products and planograms can have different types of annotation associated with 
them. Products are often configured with one form of annotation for placeholders and 
another form of annotation for products at SKU level. Multi bay planograms are often 
configured with both planogram details and the numbers of the profiles (bays). 

Text styles can be set to draw automatically when an object is placed in the drawing. 
Alternatively, text styles can be set so that they will only annotate specific objects in the 
drawing that have been selected by a user. 

Note: Manual annotation is controlled using the 'Annotate'  
option on the Retail toolbar in Planner. 

It is also possible to make text styles conditional so that they only apply in specific cases. 
This is done through changes in the custom SQL used to extract information used in the 
text styles. 

The Text Styles Admin Tool 
The Text Styles Admin Tool is used to display details of all available text styles. 

 

Options can be selected from the menu bar or from the toolbar. These include: 

Text Style Dialog Box Options 

Exiting from the Text Styles Admin Tool dialogue box 

Exiting from the Text Styles Admin Tool will not save any changes made since the last 
time the Save option was used. 

Saving changes to Text Styles back to the Database 
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Note: changes to text s tyles will not be saved back to the 
database until the Save option has been used (toolbar icon or 
from the File menu). 

If there are no outstanding changes to be saved back to the database, the save icon will be 
grayed out. 

Adding a New Text Style 

Text styles can be added by selecting the 'Add Text Style' option from either the Edit 
menu or the toolbar. This will bring up the Text Styles dialogue box. 

Editing an Existing Text Style 

Existing text styles can be edited by highlighting the required style in the list of available 
styles and selecting the 'Edit Text Style' option from either the Edit menu or the toolbar. 
This will bring up the Text Styles dialogue box. 

Deleting an Existing Text Style 

Text styles can be deleted by selecting the delete Text Style' option from either the Edit 
menu or the toolbar. System text styles cannot be deleted. (The 'System' attribute can only 
be set within the database). 

Before the text style can be deleted, confirmation will be required. 

 

Copying a Text Style 

Existing text styles can be copied by highlighting the required style in the list of available 
styles and selecting the 'Copy Text Style' option from either the Edit menu or the toolbar. 
This will bring up a Text Styles dialogue box containing a duplicate of the selected style. 
This duplicate can then be edited to produce a text style that is slightly different from the 
original. 

Refreshing from the Database 

The Refresh option (available from the toolbar or from the View Menu) updates the Text 
Styles Admin Tools dialogue box (and its associated dialogue boxes) with the 
information currently held in the database. Using the Refresh option will overwrite any 
changes made in Text Styles that have not yet been saved back to the database. 

If changes have been made to the Text Styles a warning message will be displayed. 
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Text Style Wizard  

The Text Style Wizard provides an alternative to manually configuring a text style. Four 
screens take users through creating a text style and automatically create the SQL required 
to extract information from the database. 

Overview of Configuring Text Styles 
Text Styles are specific to Planner and are integrated with AutoCAD functionality. (A 
different form of annotation is used in the Merchandiser Module). 

 

The Text Styles Admin Tool contains a list of the available text styles. Some of these text 
styles will be in use, others may be temporarily inactive. 

 

The list of text styles can be added to, selected for editing or deleted.  In addition, a Text 
Style Wizard can be used to simplify creating text styles. The Text Styles dialogue box 
allows the broad details of a text style to be configured. This includes the font type and 
color, AutoCAD layer, type of object the text is to be associated with and so on. The Text 
Style Rules tab allows the user to set up a series of rules governing the annotation - each 
rule will be tested in turn until one meets the requirements of the fixture being 
annotated. 
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The Query tab shows the custom SQL that extracts the information from the database 
used for the annotation. This custom SQL is user customizable. 

 

The Text Style Rules dialogue box is used to configure the details of a specific text style. 
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It is possible to have multiple text style rules for a specific text style. When the annotation 
is drawn, each text style is 'tested' in sequence. The first text style that meets the 
requirements is used. For example text styles might be configured with text sizes of 6 
inches, 4 inches and 3 inches. Each text style will be tested in turn, until the largest text 
size that will allow all the text to be displayed is identified. 

Types of Text Styles 
It is possible to set up a variety of generic types of text styles. The objects they apply to 
can be selected from the Auto Placement options in the text styles dialogue box, while the 
layers they appear on are determined by what is selected from the Layer alias drop down 
list. 
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Alternatively, the type of text style can be selected from the third page of the Text Style 
wizard. 

 

Text Style Types 

Department Zone 

The Department Zone is one form of zone: specifically the Zone - Fixture Links ensure 
that Fixtures in the Fixture Table are only associated with a single department. 

Note: For more information on the Fixture table see the 
Oracle Retail Macro Space Planning Data Model. 
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Internal Zone 

The Internal Zone is one of three types of zones. It denotes the maximum area of the store 
used for retail purposes. 

Zone 

The 'Zone' zone is a third type of Zone that gives an alternative to zones of type 'Internal 
Area' or 'Department'. 

Fixture 

This text style is used for fixtures. 

Note: for fixtures to annotate, the 'Include Fixture 
Annotation' option must be checked in the Categories Tab of 
the Block Definitions dialogue box in Fixture studio.  

Product SKU 

This text style is used for products that have been placed at SKU (Stock Keeping Unit) 
level from the product hierarchy 

Product Placeholder 

This text style is used for products that have been placed at Placeholder level (i.e. above 
SKU level) from the product hierarchy 

Planogram 
This text style is used to annotate planograms. Planogram information can sometimes 
include profile annotation - information on specific bays within a multi-bay planogram. 

General 

This text style is not yet implemented. 

Turning on Fixture Annotation 
Whether Fixture Annotation for a specific fixture (or fitting) displays in Planner depends 
on settings in Fixture Studio. 

 

For a specific fixture to annotate in Planner, the Include in Fixture Annotation option 
must be checked. 
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This allows flexibility in what gets annotated. One option is to specify all fixtures will 
annotate, but that fittings will not. This simplifies the annotation for gondola runs 
contain a mixture of fixtures and fittings. 

Note: the Auto Placement option (set in the Text Styles 
dialogue box) determines whether fixture annotation for 
fixtures that have had the 'Include in Fixture Annotation' 
check box ticked is placed automatically, or has to be drawn 
as a result of a command from a user. 

Annotation in Planner 
Annotation in Planner is first determined by the Auto Placement settings in the Text 
Styles dialogue box in the Admin Module. 

 

 If a Text Style has an Auto Placement option selected, (for example Planogram), 
when that type of object is placed the annotation will be automatically added. 

 If a Text Style has Auto Placement option set to 'None', then when that type of 
object is placed, no annotation will automatically be added. (It can subsequently 
be manually added by a user). 

Retail Toolbar in Planner 
The Retail Toolbar within Planner is used gives three options to annotate objects in the 
drawing   
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 Annotate Fixtures will cause fixture annotation to be drawn according to the text 
style rules currently active in Planner 

 Annotate Products will cause product and planogram annotation to be drawn 
according to the text style rules currently active in Planner 

 Annotate allows the text style rules currently active in Planner to be updated 
from the database. It also allows objects to be manually annotated when Auto 
Placement has been set to None in Text Styles in the Administration Module. 

Note: the text style rules active in planner are those present 
when the application was opened, or when text style rules 
were last refreshed using the Annotate dialogue box. 

Annotate Fixtures 

If the Auto Placement option is set to 'Fixtures', fixtures will be re-annotated with the 
currently active text style(s). 

Annotate Products 

If the Auto Placement options are set to 'Products' or 'Planograms', merchandise will be 
re-annotated with the currently active text style(s). 

Annotate 

The Annotation dialogue box gives more control over what annotation is displayed in the 
drawing. 

 

The Refresh Button will update all text styles currently held in Planner with the latest 
version held in the database. 

Note: this would be applicable if an Administrator is 
updating text styles in the Administration Module and 
simultaneously testing the effects of the changes in the 
Planner Module. 

The Annotation dialogue box contains a list of text styles. Any individual text style can 
be selected by highlighting it. 
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 If the OK button is clicked, all instances of annotation associated with that text 
style in the drawing will be updated. 

 If the Select button is clicked, the user will be taken to the drawing. Objects can 
then be selected using standard AutoCAD selection methods. On completing the 
selection sequence with a right click, all selected objects will have their 
annotation updated. 

Using Multiple Text Styles for a Specific Object 

It is possible to use multiple text styles to annotate a specific type of object. 

 

In the above example of the Annotation dialogue box there are four text styles for 
planograms: 

 Basic Planogram Details 

 Clothing Planogram Details 

 Electrical Planogram Details 

 Food and Drink Planogram Details 

If the Auto Placement option in the Text Styles dialogue box is set to 'None', then 
planograms will not be annotated on insertion. It is then possible to highlight a text rule 
and select the planograms to be annotated. Working in this way, it is possible to annotate 
Food and drink planograms in a completely different style to clothing planograms. 

Text Style Placement Logic 
The Logic of Text Style placement is as follows: 
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1. When a text style is placed, the software checks to see whether Auto Placement is on. 

2. If Auto Placement is On, the annotation will be added when the object is inserted. 

3. If Auto Placement is set to 'None', the object will be placed in the drawing but 
annotation will not be drawn during insertion. 

4. Annotation can be added or updated manually by the user by means of the 
Annotation option in the Retail toolbar in Planner. 

5. When annotation is added, the software checks to see if there are multiple text style 
rules. 

6. If there is only a single text style rule the annotation is placed immediately. 

7. If there are multiple text styles rules, the text styles rules are tested in sequence. As 
soon as a text style rule passes, the annotation is placed. 

Text Styles and Custom SQL 
The Text Style Wizard can be used to generate the Custom SQL statement used to 
retrieve the information used in annotation. This Custom SQL can then be seen in the 
Query tab of the Text Style dialogue box. 
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It is possible to modify this Custom SQL statement to customize the annotation for each 
type of object being annotated. For example fixtures that are children of the 'Racking' 
node in the Fixture Hierarchy could have different annotation from fixtures that are 
children of the 'Fittings' node in the Fixture Hierarchy. 

When fixtures are annotated, all text styles of type 'Fixture' will be applied, but specific 
fixtures will only be annotated if they meet the conditions set out in the Custom SQL - 
one type of annotation will be applied if the item of equipment is determined to be 
'Racking' and another if it is determined to be a 'Fitting' .     

The Text Style Wizard 

Overview of the Text Style Wizard 
The Text Style Wizard provides an alternative way to manually configuring a text style. 
It consists of a series of four screens that the user moves through in sequence. 
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Once the screens have been completed, a Text Style will have been configured. 

Using the Text Style Wizard 
The First Page of the Text Style Wizard is used to select whether the user wished to 
create a new Text Style or overwrite (edit) an existing one. 

 

Note: To overwrite an existing rule it must be highlighted in 
the main Text Styles Admin Tool Window before the Wizard 
is invoked.  

Click on Next > to move to the next stage. 

The Second Page of the Text Style Wizard is used to input the name and description 
(type) of the Text Style. 

 

Enter the Text Style Name and Description as required. If a new style is created and it 
duplicates an existing name, a warning will result and the Next button will be disabled.  
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Click on Next > to move to the next stage. 

The Third Page of the Text Style Wizard is used to specify the type of Macro Space 
Management feature the Text Style is to be associated with. 

 

Select the required type of Text style. This is done by means of a radio button, so only 
one type of Text Style can be selected at one time. If a Text Style already exists a warning 
dialogue will appear. It is not possible to have a second version of the same Text Style, so 
if it is desired to change this Text style it must be edited. 

Click on Next > to move to the next stage. 

The Fourth (and last) Page of the Text Style Wizard is used to set the characteristics of 
the Text style. 

 

The Font can be set from a drop down list of available fonts. 
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The Font Color can be set by clicking on the color button and selecting the required color 
from the pallet. 

The Font Size can be set using the spin controls. 

Bold or Italic  fonts can be selected by ticking the relevant check boxes. 

The Layer determines what AutoCAD layer the annotation is to be placed on. 

The Text that will be displayed can be selected by ticking the appropriate check boxes. 
The items of text that can be displayed will vary with the type of text style selected in the 
previous screen. For example, the Zone Text Style will have a different set of options to 
the Planogram Text style. 

Note: Checking the list of items in the Text Box causes a 
Custom SQL statement to be generated. This query extracts 
information from the central Macro Space Planning database 
and annotates Zones, Fixtures or Merchandise accordingly.   

Click on Finish to add the Text style to those available. 

The Text Styles Dialogue Box 

The Text Styles Dialogue Box 
The Text Styles dialogue box allows the basic rules of Text Styles to be configured. The 
Text Style Rules tab gives a list of the available Text Style rules for that Text Style. The 
Query Tab shows the Custom SQL used to extract information from the database to be 
used in the text style annotation. This Custom SQL can be modified by a user if i t is 
desired to change the information displayed. 
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The Style Options Frame 
The Style Options frame allows users to configure the appearance of the text used for the 
Text Style. 

 

Options 

Style Name and Description 

Style Name is the name assigned to a text style. Style Description allows a longer, more 
comprehensive description to be associated with the Style Name 

Layer Alias 

Layer Alias specifies which layer the annotation is placed on. It is selected from a drop 
down list of the layers that make up the store plan. (The store plan can be regards as 
being made up of all the objects on all the layers in the drawing. The Planner and 
Merchandiser modules (and In-Store Space Collaboration) allow users to turn these 
layers on or off, thus showing or hiding the annotation.   
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In the above example, when fixtures are placed, they would be placed on the Fixtures 
layer. If the fixtures are annotated, the text would go on the Fixture Text Layer - 
similarly, if bay numbering is added, it would go on the Bay Numbering layer. 

 

So, although the above example with fixtures, fixture annotation and bay numbering 
looks like a single entity, it is made up of three separate layers, each of which can be 
turned on or off to control what is displayed. 

Auto Placement  
Auto Placement allows the user to specify whether annotation will be added 
automatically on inserting an object into the Planner environment, or whether the user 
will have to manually initiate annotation. There are a series of options: 

Option Description 

None Setting a text style to 'None' disables automatic annotation of objects when they 
are added in the planner environment. Annotation can be added manually via 
the Annotation dialogue box at user discretion.  

Department 
Zone 

Associates the text style with zones of type 'Department Zone' - see Zone Types 
option from Planning menu. 

Internal Zone Associates the text style with zones of type 'Internal Area' - see Zone Types 
option from Planning menu. 

Zone Associates the text style with zones of type 'Zone' - see Zone Types option from 
Planning menu. 

Fixture Associates the text style with fixtures 

Product SKU Associates the text style with products placed as SKU level 

Produce 
Placeholder  

Associates the text style with products placed as placeholders (above SKU level) 

Planogram Associates the text style with planograms 

Multi-Profile Offset 
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Multi-Profile Offset is used when two or more instances of the same annotation are 
associated with an object. An example would be if two products were placed onto a 
fixture. Each product would have separate annotation. 

 

In the above example, bacon and fresh milk have been placed on a fixture. In the left 
hand image, no offset has been used and the text has overwritten itself. In the right hand 
image, a multi profile offset has been applied and the text appears without overwriting 
itself. 

Note: this will not work if Word Wrap has been selected in 
the Fit Within frame of the Text Style Rules dialogue box. 
Because the word wrap fixture puts text onto multiple lines, 
the second line of the first product to be placed will be 
overwritten by the firs t line of the second line to be placed. 

Scale Offset 

Scale Offset: This checkbox is used in conjunction with Multi Profile Offsets. It is 
applicable when a scale has been applied to the drawing (Format > Drawing set up in the 
Planner module. 

Font Parameters 
Font can be selected from a drop down list. 

The Bold and Ita lic check boxes result in the text font being changed to bold or italic as 
required. 

Color refers to the color of any text. It can be selected from a standard color pallet. 

Bring Text to Front results in the text overwriting any objects that are present in the 
drawing. For example, it there is a fixture present where the text is to be written, the 
annotation will be placed on top of the fixture. (If Bring Text to Font is not selected, the 
text might be obscured by the fixture). 

Dimension Color 

Dimension  Color refers to the color of any dimension and extension lines. These can be 
set to be different from the text. Dimension color can be selected from a standard color 
pallet. 

Keep Parallel  

Keep Parallel is used when fixtures are not in a straight line. It will only apply if the 
Keep Separate Text check box is not checked. It will draw the annotation parallel to the 
average direction of the fixtures. 
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Note: this functionality is not fully implemented. 

Keep Separate Text  

Keep Separate Text is used when a run of adjacent objects are similar. An example 
would be if three adjacent fixtures contain identical products. 

  

In the above examples, if Keep Separate Text is not checked, objects that are similar and 
adjacent will be annotated as a single item. If Keep Separate Text is checked, then each 
item will be annotated separately, even if they are adjacent. 

The Text Style Rules Tab 
The Text Style Rules frame allows users to configure a number of text style rules for a 
given text style. When adding annotation based on that text style, each rule will be tested 
in turn and the first rule that complies will be applied.  

 

In the example above, the three test style rules are based on text size. The annotation first 
tries to use text of 6 inch size. If that will not fit into the existing space, the text size is 
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reduced to three inches. If that rule has not resulted in text fitting, the final rule would 
have been applied. 

 

In the above example, the annotation for the product placed on the left (Tea) will fit into 
the available space using 6" high letters. The annotation for the product placed on the 
right (Juice) is too long to fit into the available space using 6" high letters, so the software 
applies the next rule - which is to apply 3" letters. 

Note: For information on how to configure Text style rules, 
see the section on the Text Style Rules dialogue box. 

The toolbar options are as follows: 

Option Description 

 

Add Text Style Rule  

 

Edit Text style Rule  

 

Delete Text Style Rule  

 

Copy Text Style Rule 

 

Move selected item up in list  

 

Move selected item down in list  

The Query Tab 
The Query Tab contains the Custom SQL used to retrieve the required information for 
the annotation from the Macro Space Planning database. 
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The SQL can be derived from one of two sources: 

 It can be produced using the Wizard. 

 It can be input directly. 

Note: Direct Input of SQL is not recommended unless the 
user has good SQL skills and is familiar with the Macro 
Space Planning database. Also note that the SQL contains 
non-standard syntax such as {FIL_ID} and {IDS}. The 
purpose of these should be understood before modifying the 
SQL. 

The SQL is used to select information from the database. Which information is displayed 
in the annotation is determined by settings in the Options frame of the Text Style Rules 
dialogue box. 

 
The Field Index specifies the items of data required. 

The Field Separator determines the character use to separate items of data. 

Note: the Fix ID and AutoCAD are used to identify specific 
objects. The selectable items of data start after these items. In  
the above example, the first item that can be selected is 
BLK_NAME (Block Name). 
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The Text Style Rules Dialogue Box 

The Text Style Rules Dialogue Box 
The Text Style Rules dialogue box is used to configure the details of specific Text Style 
rules. 

 

The Options  frame allows users to specify the appearance of the text that appears. 

The Fit Within  frame allows users to specify what happens if the text is too long relative 
to the length of the fixture. 

The Use Dimensions frame allows users to specify whether dimension and extension 
lines are used when annotating the object. 

The Position frame details with how text is justified. 

The Options Frame 
The Options  frame is used to specify the size of the text and what fields from the 
database will be displayed. 
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Settings 

Size 
Size is the size used for the text that annotates objects. If an imperial size, the value is in 
inches, if a metric size, the value is in millimeters. 

Width Factor 

Width Factor determines the ratio of width to height of the text. Values of less than 1 will 
result in the width being reduced relative to the height. Values of greater than one will 
result in the width being increased relative to the height. Width Factors may be set within 
a range of 0.5 - 1.5. In the example on the left the width factor has been set to 0.5. In the 
example on the right, the width factor has been set to 1.5. 

 

Line Spacing 

Line Spacing determines the spacing between successive lines of text if word wrap (Fit 
Within options) is on. 

Scale and Scale Offset  

Scale and Scale Offset are used when an AutoCAD drawing has been given a scale via 
the Format > Drawing Set Up option in the Planner module. 

If Scale and Scale Offset are selected and the drawing has been assigned a scale, the text 
and dimension arrows will be scaled up relative to the scale of the drawing, so they stay 
at a standard size. For example, if the drawing is at a 1:100 scale, text will be scaled up 
100 times, so it draws at an absolute size. 

If Scale and Scale Offset are not selected, the text and dimension arrows will draw at the 
scale of the drawing. For example, if the drawing is at a 1:100 scale, text will be drawn at 
a hundredth of its absolute size. 

Note: scaling does not fully work at present. 

Field Index 
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Field Index allows the user to select the items that will be displayed from the SQL 
statement for a specific text style in the Text Style GUI. This SQL can be seen in the Query 
Tab of the Text Style GUI. 

 

The SQL statement is in the form of a 'Select' statement that identifies specific items of 
data from the database. The first two items in the statement are the ID of the object in the 
MSM database and the AutoCAD handle (ID). Any further items can be selected by 
entering a number giving its position in the SQL statement (ignoring the Block and 
AutoCAD ID's). Successive values can be separated by a comma. In the example below, 
the product description has been selected. 

Field Separator 

The Field Separator can be selected by means of a drop down list. 

In the example below, the block description, length and depth have been  selected and 
separated by a '/'. 

 

The Fit Within Frame 
The Fit Within  options control how text appears if the selected text is too long to fit on a 
single line. Rotate Vertically can be selected by means of a check box, the other four 
options are selected by means of a radio button. 
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Rotate Vertically allows text too long to be written horizontally relative to the fixture to 
be rotated through 90 o so that it can be written vertically relative to the fixture. 

Note: Rotate Vertically is not functioning correctly at 
present. 

Selecting None results in the text being displayed "as is", even if it too long to fit on a 
single line. 

Selecting Abbreviate results in a shortened version of the text string being displayed. 

 

Selecting Truncate results in the text string being truncated to fit. 

 

Selecting Word Wrap results in the description being wrapped onto several lines. 

 

The Dimensions Frame 
The Dimensions Frame is used to specify how dimension and extension lines appear. 
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Note: Dimension and extension lines are not available for all 
types of annotation. For example, this option will be grayed 
out for zones. 

 

The Use Dimensions check box can be used to toggle dimension lines On or Off in their 
entirety. 

The Dimension Lines checkbox will toggle dimension lines on or off. 

The Extension Lines checkbox will toggle extension lines on or off. 

The Arrows checkbox will toggle the arrow head display on or off. 

The Arrow Size can be set by means of the spin control. 

The Arrow Type can be selected from the drop down list. 

The Position Frame 
The Position Frame determines how text places relative to the fixture. 
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Options 

Relative Position and Justification 

Relative Position determines where the datum point for the text is within the object. 
There are nine options ranging from upper left to lower right. In the example below 
upper left has been selected.  Justification specifies how the text is justified relative to its 
datum position. In the example below the text has been inserted using its bottom, right 
corner as the origin. An example in the lower right of the frame updates to show how the 
text is positioned relative to the currently selected options. 

 

X and Y Offsets 

The X and Y Offsets allow the user to fine tune the position of the text. This is often used 
when the text is above or below the object. For example, using a negative Y offset enables 
the user to configure text to appear below the bottom of the selected object. As an 
example or its use, if different offsets are specified for fixture and product information, it 
is possible to avoid these two types of annotation overwriting each other. 
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Title Blocks 

Overview of Title Blocks 
Title Blocks are used to put a frame round a drawing in preparation for publishing it in 
hard copy or PDF form. Title Blocks can also contain information on the drawing. 

 

Option Description 

Title Block 
This is an special form of AutoCAD DWG file that overlays the store plan on 
model space. It contains text based information on the floor plan and one or more 
View Ports to display the drawing. 

View Port 
The View Port (of which there may be one or several) can be a window cut through 
the title block to show the floor plan underneath. 

Title Block 
Information 

This is a series of fields that can be populated with specific items of information. In 
the example above data like the store code and store name are shown, but any 
information in the database can be configured to appear. 

Scaled Floor 
Plan The floor plan is visible through the View Port. It is set to a specific scale.  

Each Title Block is designed for a specific size of paper, so if drawings are to be printed 
off in a range of sizes, title blocks should be created for each size. A metric 
implementation of Macro Space Management may contain title blocks for A2, A3 and A4 
size paper, while and imperial one may contain title blocks for ANSI A, ANSI B, ANSI C, 
ANSI D and ANSI E size paper. 
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Using Title Blocks 
There are three ways title blocks can be used: 

Option Description 

Manually Publish 
from AutoCAD 

Once a title block has been added to a floor plan it can be published using 
AutoCAD Plot functionality. Using this method, floor plans can be published 
at any status. 

Publish Floor Plans 
from Planner 
module 

The Publish Floor Plans option on the File menu allows users to manually 
publish selected floor plans. Dependent on settings in the Floor Plan 
Publishing configuration dialog box, a title block can be included. 

Batch Publish Floor 
Plans 

Floor plans can be batch published - the normal way of publishing floor plans 
in bulk. The functionality allows a title block to be specified. 

Overview of Creating T itle Blocks 
There are two stages to creating title blocks: preparation and configuration. 

Preparation 

There are two actions required for preparation. These are carried out at the 
implementation stage and will generally not be modified afterwards. 

 

Action Description 

Read in 
Canonical 
Media 

Canonical media is the AutoCAD term for paper size. These have to be read into 
the database from the network printers before floor plans can be published.  

Create Custom 
SQL 

Custom SQL is a slightly modified form of standard SQL. It can be used to extract 
information from the Macro Space Planning database so that it can be inserted into 
the title block. 

Configuration 

There are a series of steps to be following in order to create a title block and make it 
available for use in published floor plans. 

 

Action Description 

Create Title Block in 
Planner 

A Title Block is a special form of AutoCAD drawing. This had to be created 
in the Planner module and written to a specific Windows folder. 

Register Title Block in 
Fixture Studio  

After the Title Block has been created, it must next be registered in Fixture 
Studio. This will make it appear in the list of blocks available for placement. 
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Action Description 

Add Title Block 
Information in 
Administration 

Once the title block has been registered in Fixture Studio, some additional 
information needs to be added in the Administration module. This includes 
information such as the size of the viewport - in effect a window cut 
through the title block so that the floor plan can be seen through it. 

Add Title Block to 
floor plans 

After the Title Block has been created in Planner registered in Fixture Studio 
and added to the list of title blocks in Administration, it can then be used in 
floor plans. 

Influence of AutoCAD Settings on Title Block Parameters 
Some AutoCAD parameters influence the configuration of Title Blocks.  An example is 
the AutoCAD options dialog box.  

 

One of several settings that a ffect how title blocks function is the option to plot offset 
from the printable area or edge of the paper. This affects the parameters set in the Title 
Blocks dialog box accessed from the Planning Menu in the Administration module. 
 These AutoCAD settings should be consistent on all machines used to publish floor 
plans. 

Note: See the AutoCAD help files for more information. 
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Canonical Media 
Canonical Media is the range of paper sizes recognized by AutoCAD for printing 
purposes. They typically need to be installed once immediately after installing the 
software.  This is an implementation task but the basics will be described in this section. 

 

Where to Read Canonical Media From 
When following the process below to identify canonical media and read the information 
into the database, select a computer that is connected to the pertinent network printers. 
This will ensure that the correct information is read. If the computer selected in only 
connected to a local printer, this will cause problems when other users reference the 
canonical media. 

Process Stages 
1. Download and install VBA Enabler 

The VBA Enabler is a small add on that can be downloaded from the AutoDesk 
website. It enables scripts written in languages such as Visual Basic or C++ to be run 
from within AutoCAD. 

2. Create Script to Run Canonical Media  
The next stage is to create the required script for reading the canonical media. 
Information on this can be found on the AutoDesk website.  The specific function 
name that has to be invoked is GetCanonicalMediaNames(). 

3. Read Canonical Media to File  

Reading the canonical media is done as follows: 

a. Type VBARUN into the AutoCAD command line and press Return. 

 

b. This will bring up the Macros dialog box.  
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See the Autodesk help files for how to load macros into this dialog box and run them. 
The macro should be able to write the pertinent information to a file (or database 
table).  

4. Import the information into the MSP database 

The information then needs to be imported into the table within the MSP database 
holding information on canonical media. Information on this table can be found in 
the Oracle Retail Macro Space Planning Data Model.  

5. Data is now available to all users 

Once the database table has been populated, information on canonical media 
becomes available to all users. 

Data Read from the Database 
Title blocks contain information such as the name of the store, the store manager of the 
size of the store and the number of fixtures within it.  There are two ways this 
information can be obtained:  

 Hard coded information.  

 Custom SQL.  

Hard coded information is extracted from the Macro Space Planning database by means 
of a SQL statement in the code. This generates a standard list of information that cannot 
be varied by the user. Custom SQL is a slightly modified form of standard SQL. It allows 
an implementer to extract retailer specific information from the database so that it can be 
populated into title blocks associated with floor plans. 

Note: How this information is associated with a Title Block 
is covered in the section on creating Title Blocks. 

Hard Coded Options 
Hard coded options are based on a SQL statement not accessible to implementers. It 
contains nine column names. If the name of an AutoCAD attribute in a title block 
associated with a floor plan matches one of these column names, the data from the SQL 
statement will be added to the title block. 

STORECODE 
Store Code brings in the Store Code specified in the Add/Edit Store dialogue box in 
Store Manager. 
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STORE 

Store brings in the Store Name specified in the Add/Edit Store dialogue box in Store 
Manager. 

      

REVISION 

Revision brings in the Revision Description specified in the Add/Edit Revision dialogue 
box in Store Manager.    
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FLOORCODE 

Floor Code brings in the FLT_NAME (a numerical value) from the Floor Type table that 
is associated with the corresponding Floor Type specified in the Add/Edit Floor dialogue 
box in Store Manager. 

Note: for more information on the Floor Type table see the 
Oracle Retail Macro Space Planning Data Model. 

   

FLOOR 

Floor brings in the Revision Description specified in the Add/Edit Floor dialogue box in 
Store Manager.    
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SCALE 

Scale brings in the scale set in the Drawing Setup option of the Format menu in Planner. 

 

DATE 

Date brings in the date that the title block was generated or updated on. 

DWGNAME 

Drawing name brings in the name of the AutoCAD DWG file as specified on the Details 
Tab of the File Properties dialogue box in Store Manager. 
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FULLFILENAME 

File Full Name brings in the name and path to the file specified in the Location text box 
of the Details Tab of the File Properties dialogue box in Store Manager. 

 

The full file name can be long as it will include the full path as well as the file name.  This 
length should be taken into account when defining the attribute. 

Custom SQL 
Macro Space Planning allows for the use of Custom SQL. This is standard SQL that has 
been extended to have an additional capability called placeholders. These can be 
identified by having a field enclosed by curly brackets. In the example below it is 
{FIL_ID}. When the SQL statement is called by the code, it substitutes the actual FIL_ID 
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for the currently active floor plan for the placeholder. This means the SQL statement will 
always be executed against the currently active floor plan. 

 

When a Title Block is created AutoCAD Attribute Definitions can be added to it. There 
are nine hard coded Attribute Definition options described above. If it is desired to 
extend the information to be displayed in the title block - for example the total area of the 
store - then a Custom SQL statement can be used to extract additional information from 
the database.  If an attribute definition in the title block matches a column name or alias 
in the Custom SQL statement, the title block will be populated with that information.  

Creating a Custom SQL Statement 

Writing a Custom SQL is much like writing a standard SQL statement. The statement can 
be developed and tested by using a known FIL_ID in place of the placeholder - for 
example FIL_ID = 123. When the SQL statement is returning the required results, 
placeholders can be substituted for every instance of the FIL_ID used for testing. The 
final form of the Custom SQL can then be placed in the pertinent table in the database - 
see the Oracle Retail Macro Space Planning  Data Model for details. The specific piece of 
Custom SQL for title blocks is named TITLEBLOCK_UPDATE . 

Note: Custom SQL can only be inserted directly in the 
database - there is no dialog box for the purpose. 

Using the Custom SQL Statement 

Once the custom SQL statement is in the database it will be called when one of two 
options is used from the Insert Menu in the Planner module. 

 

 Using Add Title Block will result in the title block being placed and the Custom 
SQL automatically run to populate any pertinent fields in the title block. 

 Using Update Title Block will manually update the pertinent fields in the title 
block. 

Creating the Title Block in Planner 
Creating the Title Block in the Planner Module requires a series of actions to be carried 
out. 
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Establishing Required Paper size 
Title Block Size has to take into account the printable area on the selected paper size. For 
example, A3 paper is 297 x 420 mm. However, printers (and plotters) cannot make use of 
all that area. A border (called the non-printable area) that cannot contain any lines or text 
exists around the edges of the paper. The size of the title block needs to allow for the non-
printable area. If A3 paper is used, and the non-printable area is 6 mm wide, then the title 
block needs to be drawn at 285 x 408 mm to fit exactly into the printable area of the 
paper. The insertion point of the title block is normally defined as 0,0 when it is created.  

 

Draw Frame and Text Boxes 
After the size has been established a frame can be drawn in planner, and text boxes 
added. 
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The Title block is usually drawn with the origin at 0,0. 

Add Attribute Definitions 
Attribute Definitions are used to set up the 'template'  Attributes for the text boxes. They 
are invoked by typing ATTDEF into the AutoCAD command line in Planner and 
pressing Return. 

 

This will bring up the Attribute Definition dialogue box. 

 

The Attribute Definitions can then be put into the drawing. 
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Attribute Tags should not contain spaces. If necessary, join two words with an 
underscore: WORD1_WORD2. The Attribute Tags should either match the names of the 
hard coded data or the column names or aliases in the Custom SQL  Two forms of 
attribute definition may be put into the Title Block: constant and populated. The constant 
attribute acts as a title for each item of information and remains the same irrespective of 
the floor plan it is inserted into. The populated attribute will update with data specific to 
the floor plan it is being inserted into. 

 

Note: See the AutoCAD help file for more information on 
Attributes. 

Convert into Block 
The Title Block can then be turned into a block with the 'block' command. This can either 
be initiated from the AutoCAD command line. 
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The individual components of the Title Block will then be combined to make a single 
object. This block definition is stored in the current drawing and is not yet globally 
available. 

Write Block to External fo lder 
The Write Block (WBlock) command is used to write the block definition to an external 
directory where it can be used in any Macro Space Management drawing. The command 
is invoked by typing WBlock into the command line. 

 

The destination should be a directory specified in the Directories Tab of the 
Configuration Module.  This tab can only be accessed from within the Administration 
module. 
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Registering the Title Block in Fixture Studio 
Registering the Title Block  in Fixture Studio requires the following steps. 

 

Registering the Block 

Selecting the Parent Fixture Group 

All blocks within Fixture Studio are arranged within a hierarchy. The default hierarchy 
provided with the application contains a Fixture Group called Title Blocks. This is the 
usual location for title blocks. 

 

Create a Block and Enter the Block Name 

Highlight the Title Blocks Fixture Group  and create a block by invoking the Add Block 
option from the Edit menu or the toolbar. This will bring up the New block name 
dialogue box.   

 

Ensure that the block name entered exactly matches the block name specified in the 
WBlock command used in Planner.  If these names do not match, the title block will not 
work when inserted into a floor plan.  On clicking OK, the Block Details dialogue box 
will appear for editing. 

Enter Settings in the Block Details Dialogue Box 

The Block Details dialogue box allows custom properties to be assigned to the title block. 
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Full details of how to use this dialogue box can be found in the Fixture Studio help file. 
The principal settings pertinent to title blocks are: 

Category Tab 

Option Description 

Retail Type 
This must be set to Title Block. This will be used by the software to identify blocks 
that can be used for this purpose. It will also ensure that the title block is grayed out 
and unavailable for placement except via the Insert menu in Planner. 

Directory 
This must be set to the same directory that the Title block was written to (WBlocked) 
from Planner. If this is not done, the application will not be able to find the title block 
when it is inserted into a floor plan. 

Units 
This is to ensure the Title Block is displayed at the correct scale when it is used. 
Using millimeters in place of inches will result in an incorrectly sized Title Block. 

Icon 
This should be set to title block. This provides an easy way of identifying title blocks 
in the Fixture Studio hierarchy. 

Exclude 
From 
Reports 

This option sets a flag which can be used to exclude the title block from the list of 
blocks in a floor plan. This flag improves accuracy in reporting. 

Insertion Tab 
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Option Description 

Layer The application comes with a pre-configured layer called TITLEBLOCK. 

Level This should be set to undefined 

Insertion 
Position 

Set the Insertion Position to match that of the AutoCAD insertion position for the title 
block. In the example in this help file, this is Bottom, Front, Left  

Size Tab 

Option Description 

Length This should be set to the actual dimension of the paper - including that on the non-
printable area. 

Depth This should be set to the actual dimension of the paper - including that on the non-
printable area. 

Height The height should be set to 0.00001. This nominal value is to avoid 'divide by zero' 
errors in the code. 

Saving Locally 

With all information entered into the Block Details dialog box, click OK to save the 
information locally. 

Saving to the Database 
To save the information to the database: 

1. Highlight the title block in the list of blocks. 

2. Select Save Blocks from the File menu. This will bring up the Save block Definitions 
dialog box. 

 

3. Select Database, Add New Definitions, Enforce Save and Only Save Selected Blocks. 

4. Click OK and the information will be saved to the database. 
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Adding Title Block Information in the Admin Module 
Adding Title Block Information in the Administration Module is in two stages: 

 

The first stage is to enter the title block details so that the title block will display at the 
correct size and with the correct offsets. After that information has been entered a View 
Port has to be configured. This is essentially a window through the title block allowing 
the floor plan to be seen through it.  

Specifying Title Block Details 
Title Blocks are Added, Edited or Deleted using the Title Blocks option from the Planning 
menu. This will bring up the Title Blocks dialogue box.   

 To add a Title Block to the list of those available click Add on the toolbar or select 
the Add option from the Edit Menu. 

 To edit a Title Block, highlight it in the list of those available. The data can then 
be modified as required. 

 To delete a Title Block to the list of those available, highlight it and click Delete 
on the toolbar or select the Delete option from the Edit Menu. 

 

Adding or Editing a Title Block 
Using the Add Title Block option being up a new line in the Title blocks dialog box. This 
information needs to be filled in as follows: 

Item Description 

Name This is the name of the title block 

Blockname 
This is the name of the block for the title. It can be selected from a drop down list. 
This list contains the name of all blocks of type 'Title Block' is Fixture Studio. 

Width 
This is the nominal with of the paper the title block is designed for. It is for display 
purposes only 

Height 
This  is the nominal height of the paper the title block is designed for. It is for display 
purposes only. 

Width Offset This is the offset of the insertion point of the title block in the 'X' plane relative to the 
lower left corner of the printable area on the paper the title block is designed for. 

Height Offset This is the offset of the insertion point of the title block in the 'Y' plane relative to the 
lower left corner of the printable area on the paper the title block is designed for. 
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Item Description 

Default Scale  
This is the default scale that will be applied to the ViewPorts when they are first 
defined in the Title Block dialogue box. 

Canonical 
Media 

The canonical media is selected from a drop down list. It should be set to the size of 
paper the title block is designed for. 

In order to make sure that information saves correctly back to the database: 

 After the last item of data has been set, click in another cell in the dialog box. 
Without this, the last item will not save. 

 Press Return to write the new line of data into the dialog box. 

 Exit the  dialog box and reopen it to verify the information has saved correctly. 

Title Blocks can be added or deleted using the appropriate options on the Edit menu or 
the toolbar. Selecting the edit option on the edit menu or the toolbar will bring up the 
Title Block dialogue box. 

Note: Some of these settings will be influenced by AutoCAD 
settings, for example in the Options dialog box. See the 
AutoCAD help files for more information. 

Specifying Viewport Details 
The Title Block dialogue box is used to specify the details of the View Ports in the Title 
Block. These are effectively windows cut through the title block so the floor plan 
underneath the title block is visible. It is called by the Edit option on the toolbar or from 
the Edit menu of the Title Blocks dialogue box. 

 

The information to the left of the dialogue box mirrors that of the Title Blocks dialogue 
box. The information on the right of the dialogue box is used to set up View Ports. Title 
blocks may have multiple View Ports although the example above only has a single on 
configured. 

Option Description 

Width 
This is the size of the viewport in the X plane. It is measured from the origin of the View 
Port, not the origin of the title block. 
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Option Description 

Height 
This is the size of the viewport in the Y plane. It is measured from the origin of the View 
Port, not the origin of the title block. 

Width 
Offset This is the X offset of the origin of the View Port from the origin of the Title Block. 

Height 
Offset This is the X offset of the origin of the View Port from the origin of the Title Block. 

Scale  This is the default scale at which the floor plan will appear in the viewport. 

View This is the direction the floor plan will be shown from. The most common is a plan view 
but it can also be shown from isometric directions. 

In order to make sure that information saves correctly back to the database: 

 After the last item of data has been set, click in another cell in the dialog box. 
Without this, the last item will not save. 

 Press Return to write the new line of data into the dialog box. 

 Click Save on the toolbar. 

 Exit the dialog box and reopen it to verify the information has saved correctly. 

Reuse of Title Blocks 
Once a Title Block has been defined, it can be used multiple time by creating multiple 
entries in the Title Blocks dialog box. For example, one version of the title block could be 
used at one scale to show an overall view of the store 

Deleting Title Blocks from Macro Space Management 
Deleting Title Blocks from Macro Space Management takes place in three stages: 

 

Note: Title Blocks cannot be deleted if in use in a floor plan. 

Delete Title Block Definition from Administration Module 
To delete the Title Block definition from the Administration Module: 

1. Select the Title Block in the Title Blocks dialogue box. 

2. Highlight the required Title Block and select Edit. This will open the Title Block 
dialogue box. 

3. Delete any View Ports associated with the Title Block. 

4. Close the Title Block dialogue box. 

5. Delete the Title block from the Title Blocks dialogue box by highlighting in and 
clicking Delete. 
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Delete Title Block from Fixture Studio 
To mark the Title Block for deletion from Fixture Studio: 

1. Highlight the Title Block in the Fixture Hierarchy. 

2. Select Delete Block from the right click menu - the block name will change from black 
text to grey. 

3. Save the changes (Save Option) so that the 'delete' flag is set in the database. 

Note: the Title Block has not been deleted at this stage - it 
has merely been marked for deletion. 

Purge Title Block in the Admin Module 
To permanently delete the Title block from the MSM database: 

1. Select the Purge option from the Tools menu. 

2. Select the Fixtures checkbox and click OK. 

Note: this will delete the information from the database. 
However, the block will not be deleted from the directory it 
is stored in. This is because the block might be referenced by 
other software. 

Placing and Updating Title Blocks in Planner 
To place Title Blocks in Planner, select the Add Title Blocks option from the Insert menu. 

 

This will bring up the Title Blocks dialogue box. 

 

The list of available Title Blocks is that specified in the Administration Module.  To place 
a Title Block, highlight it in the list then click OK. 
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Updating Title Block Information 
The text information in the Title block is populated when added. However, if the floor 
plan is subsequently modified, the information may become outdated.  An example 
would be if the number of fixtures and planograms is changed. In  this event the 
information in the title block can be updated by means of the Update Title Block  option 
on the Insert menu. 

Editing the T itle Block Attributes 
The Title Block attributes can be edited for that instance of the title block by double 
clicking on the frame of the Title Block. This will bring up the AutoCAD Properties 
dialog box. This can be used to modify the values of the attributes for that floor plan. 
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Modification of Title Blocks 
On occasion Title Blocks can be redesigned in Planner and reregistered in Fixture Studio. 
 Providing the title block has kept the same name, any new instance in a floor plan will 
be automatically be added using the latest version of the Title Block. Any existing 
instances of the older version of the title block should be updated with the Redefine 
blocks from Disc option in the Restructure Drawing dialog box available from the 
Modify > Blocks menu in Planner.  Once the Title Block has been redefined, the 
attributes it contains should be updated by the Update Title Block option on the Insert 
Menu in Planner. 

 

Zone Types & Definitions 

Purposes of Zones 
Zones are ways of dividing up a store into areas of specific purpose. 

Note: Zones are sometimes called Departments. This should 
not be confused with Zone Types of Type 'Department'  
which have a specific purpose in MSM. 
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Once placed, Zones can be used for measuring, reporting and filtering purposes. 

User for Zones 

Measuring Area 

Once placed, the area of the zone can be calculated. This can be: 

 Gross Area - the area of the zone without taking into account any obstructions  

 Net Area -The area of the zone after obstructions (such as pillars and staircases) 
are taken into account 

These areas can subsequently be used for calculation purposes - for example determining 
the profit per square foot or meter. 

Reporting 

Once fixtures and merchandise are placed in a store plan, Zones can be used to get 
reports on the performance of specific parts of the store. For example, it is possible to find 
the sales turnover, sales margins, profitability, etc, for any zone. If there is a hierarchy of 
zones present in the store, it is possible to get reports of differing levels of detail. For 
example, it would be possible to get reports on the Clothing department or just one of its 
sub-departments - say Children's Clothing. 

Filtering 

Zones can be used for filtering purposes - primarily in the Object Grid. It is possible to 
associate either products or planograms with specific zones - when a zone is selected in 
the Object Browser these products or planograms will appear in the Object Grid. These 
are called Zone - Product or Zone - Planogram links and are controlled by means of 
Custom SQL. 

Overview of Zone Types and Zone Definitions 
Zones have both a Zone Type and a Zone Definition. 
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Zone Types 

 

Zone Types is used to set broad properties that can be assigned to a specific Zone 
Description. 

 Description is the name given to the group of properties  

 Layer is the AutoCAD layer the zone will be drawn on 

 Auto Text Type describes the Text Style to use (Planning Menu in the Admin 
Module) 

 Type describes the category the Zone Type will be assigned to - either Internal 
Area, Department Zone or Other Zone 

Zone Definitions 

 

Zone Definitions are used to create the Zone Hierarchy. This zone hierarchy will also 
appear in the Zone Tab of the Object Browser in the Planner and Merchandiser Modules. 

 Name is the Name of the Zone 

 Description expands on the Name of the Zone 

 Zone Type puts the Zone into one of the classes described in the Zone Type 
dialog box 

 Hatch Style selects a hatch style from those defined in the Hatch Styles option on 
the Planning menu in the Administration Module 

 Color is the color the boundary of the zone (and any hatching) will be in the 
Planner and Merchandiser Modules  
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 Code is any code that a customer might assign to a Zone Definition  

Object Browser 

Details of the Zone Definition will appear in the Properties Window of the Object 
Browser in the both the Planner and Merchandiser Modules. 

 

Criteria for Arranging Zone Types and Descriptions 
Some broad criteria have to be obeyed when designing a zone hierarchy 

Components of Zone Hierarchy 

Internal Area Zone 

There should be an Internal Area zone in a store plan. This determines the maximum 
area used for retailing purposes and is used in Area Calculations and assigning specific 
parts of the floor to specific fixtures. 

Zones Types of Type Department 

Zones Type of Type Department has particular properties. 

 

 Fixtures are allocated to Zones of Type Department for calculation and reporting 
purposes when placed in a store plan. 

 Because products are associated with specific fixtures, products are indirectly 
associated with Zones Types of Type Department for reporting purposes when 
placed in a store plan 

 Synchronize automatically maps fixtures to Zones of Zone Type 'Type'  
Department as part of the synchronization process  
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This imposes a restriction when designing a zone hierarchy: Zones of Zone Types 'Type'  
cannot overlap each other as this would cause problems with the underlying business 
logic of the software. 

'Department' Type Zone Types 

The minimum requirement for laying out a store plan with zones is Zone Descriptions of 
Zone Type 'Type' department. 

 This is necessary for reporting purposes, for example associating Fixtures with 
zones 

 In-Store Space Collaboration requires Zones of Zone Type 'Type' department to 
be present before a store plan can be opened. 

 

In the above example, the user might place 'Staff Area' and 'Stock Storage' Department 
Zones for the 'Back of Store' areas and 'Checkouts', 'Clothing', 'Concession Areas', 
'Electrical', 'Entrance Areas and Aisles' and Food and Drink'  for the retail areas. 

Zones at other levels in the hierarchy can be placed to increase reporting flexibility, but 
are not essential. For example, 'Computing' , 'Household' and 'TV and Audio' child zones 
(which are not of Zone Type 'Type'  Department) could be placed as children of the 
'Electrical' zone. 

Planner (AutoCAD) Layers 

Zones are drawn onto specified AutoCAD Layers in the Planner module. Different levels 
in the zone hierarchy can be drawn onto different AutoCAD layers. Zones that are on a 
specific AutoCAD layer can be detected as overlapping (clashing), whereas zones on 
different levels are not detected as clashing. 

Zones must be assigned to AutoCAD layers in such a way that zones that should not 
clash are on the same layer. Similarly, where zones have children, the must be drawn on 
different layers so that the child zones do not clash with the parent. For example the 
'Clothing' zone should be drawn on one AutoCAD layer and its children (Children's 
Clothing, Men's Clothing and Women's Clothing) drawn on another. This allows the 
'Child' zones to be superimposed on the parent. 
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Strategies for Zone Types and Descriptions 
There are two broad strategies for creating a zone hierarchy. 

 Have only one level in the hierarchy of Zone Types 'Type' department 

 Have multiple levels in the hierarchy of Zone Types 'Type' department and only 
place a Zone Description from one level in the hierarchy 

One level in the h ierarchy of Zone Types 'Type' department 

 

Here, the 'Department' type zones are represented by the blue folders ('Sta ff Areas' and 
'Food and Drink''). These, (together with the Internal Area zone) are placed as a 
minimum in the hierarchy, with  other Zone Descriptions (of Zone Types Type 'Other') 
added to give more options for reporting purposes. For example, 'Computing', 
'Household' and 'TV and Audio' child zones (which are not of Zone Type 'Type' 
Department) could be placed as children of the 'Electrical' zone (which is of Zone Type 
'Type' Department). This allows reports to be produced for either the 'Electrical' zone as a 
whole or the 'Computing', 'Household' and 'TV and Audio' child zones if a finer level of 
granularity is required in the reporting. 

Note: i t is important to ensure that all zones of Zone Type 
'Type' Department share the same AutoCAD layer. Clash 
Detection can then be used to detect if zones are clashing 
(overlapping).   
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Multip le levels in the hierarchy of Zone Types 'Type' department  

 

In this form most of the hierarchy is of Zone Types 'Type' department and the user opts 
to place from one level of every branch in the hierarchy. For example, the user would 
either place an 'Electrical' zone or the 'Computing' , 'Household' and 'TV and Audio' child 
zones. They could not place both the 'Electrical' zone and the 'Computing', 'Household' 
and 'TV and Audio'  child zones. 

Here, reporting is by aggregating zones. The 'Computing', 'Household'  and 'TV and 
Audio' child zones can be reported on as individual zones. To get a result for the 
'Electrical', the results from the 'Computing', 'Household'  and 'TV and Audio' zones are 
consolidated into a single report. 

Note: i t is important to ensure that all zones of Zone Type 
'Type' Department share the same AutoCAD layer. Clash 
Detection can then be used to detect if zones are clashing 
(overlapping).    

  

Overview of Clash Detection 
Clash Detection  is used to identify where zones sharing the same AutoCAD layer are 
overlapping. It can be invoked in one of two ways: 

 From the Configuration Module 

 From the Object Browser Toolbar 

If zones overlap (clash) this may affect MSM functionality - particularly if they are Zone 
Descriptions of Zone Types 'Type' Department. 

Turning on Clash Detection 

From the Configuration Module 

If the Detect Clashes option is checked, warnings will automatically be given when a 
zone being placed overlaps a zone sharing the same AutoCAD layer. 
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From the Object Browser Toolbar 

If the Detect Clashes button is clicked, this will cause the currently active store plan to be 
checked for any overlapping (clashing) zones sharing the same AutoCAD layer. 

 

Why Clash Detection is Needed 
Fixtures are assigned to zones when they are placed in the drawing. This Zone - Fixture 
link is used for calculation purposes. If a fixture is placed in two Zone Definitions of the 
same Zone Type, MSM's internal functionality may not work correctly. In additions, 
there will be errors in reporting. 
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In the above example, fixtures have been placed in two overlapping Department Type 
Zones. This means the fixtures may be allocated to the wrong zone for reporting 
purposes. For example, it may have been intended to put the fixtures in the Food and 
Drink zone, but they may have been assigned to the clothing zone. If Clash Detection is 
On, then a warning dialog will appear, enabling the user to correct the clashing 
(overlapping) zones. 

 

How Clash Detection Works 
Clash detection works as follows: 
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Clash Detection Mechanism 

Create Layers in Planner 

Zone Descriptions are drawn on specific layers in the AutoCAD drawing in the Planner 
Module. Where necessary, these layers have to be created using the Layer Aliases option 
from the Format menu in Planner. 

Assign Layers to Zone Types 

When Zone Types are being defined in the Admin Module, each Zone Type is mapped to 
a specific layer created in Planner. For example 'Department' Type zones are mapped to 
the 'Department' Layer, 'Sub-Department' Type zones are mapped to the 'Sub-
Department' Layer, etc. 

Assign Zone Types to Zone Definitions 

When each Zone Definition is created, it must be assigned to a Zone Type. Each Zone 
Definition will therefore be mapped (indirectly) to a specific layer in Planner. 

Draw Zone Definitions in Planner 

When the Zone Definitions are drawn in Planner, they will be drawn on specified layers. 
The locations of the edges of the Zone Definition will be accurately known. 

Clash Detection 

After the Zone Definition is drawn, when Clash Detection is selected, the software will 
examine all Zone Definitions drawn on the same Planner Layer. If the boundaries of any 
Zone Definitions are shown to be overlapping (clashing) a warning will be generated. 

Consequences of Clashing 
Because Zone Descriptions that overlap (clash) can cause problems with the operation of 
the software (and with reporting accuracy) any clashes should be corrected. 
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Zones and Hatch Styles 
Zones Definitions can be assigned Hatch Styles. The Hatch Styles are specified in the 
Hatch Styles option on the Planning Menu of the Administration Module. 

 

These Hatch Styles are pre-loaded into AutoCAD, but have to be defined for the 
Merchandiser Module. 
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Zone Technicalities 

Building Up Zones 

Uses of Zones 

Internal Area Zone 

The Internal Area zone is used to specify the maximum area available for retail purposes. 

 

In the example above, it is confined to the boundaries of the store. Equally, i t could be 
confined to the area accessible to customers, or include areas outside of the store - for 
example those used to display and sell garden plants. 

The Internal Area Zone is also used to set the boundary for Area Calculations. 

Sales Area and Non Sales Area Zones 

Sales Area and Non Sales Area Zones can be used to divide the store into areas used for 
sales activities (i.e. accessible to the public) and areas used for support functions - offices, 
stockrooms, etc. 
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In the example above the stockrooms and staff areas can be differentiated from the parts 
of the store used for selling to customers. 

Departments 

Departments are used to divide the store into areas of more closely defined purpose. 

 

In the above example the store has now been divided into areas of specific use. For 
example, the area to be used for sale of clothing is designated by the red rectangle. 

Sub-Departments 
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It is possible to continue dividing the store into ever finer divisions, for example the 
Clothing department could have Children's Clothing, Women's Clothing and Men's 
Clothing Sub departments. 

Note: i f Zone Definitions are 'layered' on top of each other 
like this, each 'layer' must be of a different Zone Type (and 
hence drawn on a different AutoCAD Layer).  

Fixtures and Zone - Fixture Links 
Fixtures can be linked to Zones using Zone - Fixture Links. Zone - Fixture links are 
stored in two places within the database. 

 Fixture Table. 

 Zone Fixture Link table. 

Each of these tables is used for a different purpose. 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

Fixture Table 
The Fixture table contains a ZON_ID (Zone ID) field. This holds is a foreign key to the 
Zone table for the Department level zone that the fixture has been placed in. Each fixture 
can only be associated with a single Department level zone - which is why care must be 
taken that Department level zones do not clash (overlap). 

 

Note: The Zone Description may vary from that held in the 
 Zone Definition  table as it is editable by the user when 
placing the zone. 

Where a Fixture straddles a Department zone boundary, it will be allocated to the zone in 
which the majority of the fixture is. 
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In the above example, the insertion point of the fixture is in the left hand zone, but the 
bulk of the fixture is in the right hand zone. It will be allocated to the right hand zone. 
The information in the Fixture table is most accurate for reporting purposes as each 
fixture should only be associated with a single 'Department' type zone. This ensures that: 

 Equipment take-offs do not show fixtures in multiple zones, resulting in 
inaccurate orders for equipment when building or refurbishing stores   

 Merchandise is not reported in multiple zones, avoiding inaccurate orders for 
products when stocking stores  

Zone Fixture Link Table 
The Zone Fixture Link  table can associate fixtures with multiple zones. It contains 
ZON_ID's (Zone ID) fields - there are also read from the Zone table. These are the foreign 
keys for each zone that the fixture has been placed in. An example of this would be if the 
"Clothing" department level zone contained a sub-department called "Children's 
Clothing". A fixture would then be associated with both the Clothing and Children's 
Clothing zones. 

 

Note: The Zone Description may vary from that held in the 
Zone Definition table as it is editable by the user when 
placing the zone. 

The ZFL_CROSSING field in the Zone Fixture Link  table should be noted. A value of -1 
indicates that a fixture crosses zone boundaries. 

 

This can mean that the same fixture (FIX_ID) is shown in multiple zones. 

 

Care needs to be taken during reporting to ensure the fixture is not duplicated in reports. 
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Zone - Fixture Links and Custom SQL 
The exact nature of the reports generated from Zone - Fixture Links will depend on the 
Custom SQL used to generate the reports. Macro Space Management comes with some 
standard reports. Anyone with a good knowledge of SQL can produce their own 
customized reports - often in conjunction with other Oracle software such as BI 
Publisher. 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

Overview of Zone - Product and Zone - Planogram Links 
Zone - Product Links and Zone - Planogram Links provide a way of filtering products 
or planograms by the Zone they are associated with. For a given implementation of 
Macro Space Management either zone - Product Links or Zone - Planogram Links can be 
used: it is not possible to operate both. 

Note: For more information on the tables in this section see 
the Oracle Retail Macro Space Planning Data Model. 

Zone - Product Links 
Zone - Product links operate by linking nodes in the Product Hierarchy to specific Zones. 
Clicking on that zone in the Zones tab of the Object Browser will cause all products that 
are children of the linked node in the Product Hierarchy to display in the Object Browser. 
Products are arranged in a Product Hierarchy. (This can be viewed and modified in 
Product Studio). It is possible to link specific zones to nodes in the product hierarchy. 
This is done by inserting a foreign key (PRD_ID) into the Zone Definition table. This 
foreign key then links the Zone Definition and Product Definition  tables. This link 
enables products to be filtered by zone. 
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In the above example, Department level zones have been linked to the equivalent nodes 
in the products hierarchy and similarly Sub-department zones have been linked to nodes 
at Department level. This means that (for example) if the Children's Clothing zone is 
selected in the Object Browser, the Zone - Product link will result in products displaying 
in the Object Grid that are associated with (or children of) the Children's Clothing node 
in the product hierarchy. 

Zone - Planogram Links 
All planograms are arranged in a Planogram Hierarchy. Planograms are also linked to a 
specific node in the Product hierarchy. This node is the node in the product hierarchy 
that is the lowest common link between all the products in the planogram. Specific nodes 
in the Product Hierarchy are then linked to specific Zones. Clicking on that zone in the 
Zones tab of the Object Browser will cause all Planograms that contain products that are 
children of the node in the Product Hierarchy to display in the Object Browser. 
Planograms are linked to the product hierarchy by means of the Product ID's (PRD_ID's) 
of the products in the planogram. The planogram will automatically be linked to the 
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node in the product hierarchy that is the lowest common link between all the products in 
the planogram. 

 

For example, Planogram 1 contains trousers, shorts and socks.  The lowest common link 
between these products is the node above them in the product hierarchy - "Men's 
Clothing". Planogram 1 will therefore be assigned the Product ID of that node (PRD_ID = 
11 in this example). Planogram 2 only contains trousers, so can be linked to a node 
further down in the hierarchy: the "Trousers" node (PRD_ID = 22 in this example). In the 
extract from the Plano table below, each planogram has automatically been assigned a 
Product _ ID (PRD_ID) that corresponds to the node in the product hierarchy that is the 
lowest common link between all the products in the planogram. 

 

By using this Product _ ID (PRD_ID) in the Plano table, it is possible to find all 
planograms containing products associated with a specific zone. This is done by inserting 
a foreign key (PRD_ID) into the Zone Definition table. This foreign key then links the 
Zone Definition and Product Definition  tables. This link enables planograms 
(containing specific products) to be filtered by zone. 
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The Internal Area Zone 
The Internal Area Zone is used to define the maximum area used for retail purposes. It 
may be confined to the bounds of the store walls (as in the example below), or it may 
encompass areas outside - for example a space used for selling plants for the garden. 

 

Once the Internal Area Zone has been placed, it is then used to set maximum limits for 
area calculations. 
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Individual retail organizations decide what to encompass in the Internal Area zone: some 
include non sales areas (like stock rooms and staff canteens, some do not. The area 
encompassed within the Internal Area will impact on reporting: an internal area that did 
not include non-sales areas would show a different 'profit per square meter' value than 
one that did.   

Note: i f a hole is cut in the internal area zone, the space 
within the hole will not be included in area calculations, but 
area calculations will resume the other side of the hole. 

Cutting Holes in Zones 
Cutting Holes in Zones is used to allow for the effects of obstructions, etc. In the simple 
example below, a zone contains some gondola runs and a staircase. The staircase reduces 
the area available in the zone for retailing purchases. The 'Cut Holes' option allows the 
user to remove the area used for the staircase from the total area of the zone for 
calculation purposes. 
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The zone might therefore have a gross area of 3,600 square feet and a net area of 3,200 
square feet. Using the net area of the zone (i .e. taking into account the area enclosed by 
the hole) allows profit per square meter to be calculated more realistically. 

Aliased Layers 
Aliased Layers are a way for the functionality in the Planner Module of Macro Space 
Management to communicate with that in AutoCAD.   

 

AutoCAD Layers are information held within AutoCAD drawings. This cannot be 
directly written to the database, so an Alias for the Layer is provided within the database. 
This enables users to assign (Aliased) Layers to objects within MSM. For example a 
Fixture might be assigned to the 'Fixtures' Layer within Fixture Studio. 

When the time comes to insert a copy of that fixture into the drawing, the software 
identifies which Aliased Layer the Fixture has been assigned to, identified which 
AutoCAD Layer that has been mapped to and (via a connection in the code) causes the 
object to be drawn on the correct AutoCAD layer. If the AutoCAD layers does not yet 
exist in the drawing (for example, if it is the first time a fixture has been added to the 
drawing) then the software will automatically create the required AutoCAD layer at the 
same time as it inserts the Fixture into the drawing. 

Mapping between Layers and Layer Aliases is done in the Planner Module using the 
Layers and Aliases dialog box (called from the Format menu). 

 

The Alias Name is the name of the Layer held in the MSM database and the Layer is the 
name of the layer in the AutoCAD (Planner) drawing. 

Zone Types 

Overview of Zone Types 
Zone Types are a way of assigning broad properties to specific Zone Descriptions. 
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Zone Types is used to set broad properties that can be assigned to a specific Zone 
Description. 

 Description is the name given to the group of properties  

 Layer is the AutoCAD layer the zone will be drawn on 

 Auto Text Type is not currently in use 

 Type describes the category the Zone Type will be assigned to - either Internal 
Area, Department Zone or Other Zone 

Zone Type Configuration 

Description 
The Description will appear in the Zone Type option for the Zone Definition. 

 

Layer 

The Layer is the AutoCAD layer the Zone Type will be drawn on. These are configured 
using the Layers and Aliases dialog box accessible from the Format menu in the Planner 
Module. 
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Only Zone Descriptions drawn on the same layer will be detected as clashing. So, all 
Zone Descriptions of Zone Type Department should be drawn on the Departments Layer 
so any overlaps (clashes) for that Zone Type can be detected. Similarly, all Zone 
Descriptions of Zone Type Sub-Department should be drawn on the Sub-Departments 
Layer so any overlaps (clashes) for that Zone Type can be detected. However, if a Zone 
Description of Type Sub-Department is drawn overlapping a Zone Description of Type 
Department, it will be drawn on a different layer and will not be shown as clashing. This 
ability to detect clashes between Zone Descriptions of the same Zone Type but not 
between Zone Descriptions of a different Zone Type is important when setting up a Zone 
Hierarchy. For example, the Internal Area encompasses the entire area used for retail 
purposes. The majority of other zones will probably be drawn within the Internal Area 
Zone, so it is important that they are not shown as clashing - arranged by ensuring the 
Internal Area Zone occupies its own specific layer. 

Auto Text Type 

The Auto Text Type option in the Zone Types dialog box currently has no effect. 
However, the text that annotates a Zone will depend on the Custom SQL associated with 
Zones in the Text Styles option on the Planning Menu in the Administration Module. 

 

The Text Style invoked will depend on the setting in the Auto Field (Internal Area, 
Department Zone or Other Zone), and any filters that might be present in the Custom 
SQL statement associated with the Text Style. 

Type 

There are three categories the Zone Type can be assigned to - Internal Area, Department 
Zone or Other Zone. 
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 Internal Area is used to for the single zone that defines an area used for retail 
purposes. The Internal Area zone is used for Area Calculation purposes 

 Department Zones can be used for reporting purposes - they give the most 
accurate reports  

 Other zones are assigned to all Zones Types not 'Internal Area' or 'Department' 

These types are hard coded into the software and cannot be changed 

Changes made to Zone Types and Zone Definitions 

Changes made to Zone Types in the Administration Module do not take immediate effect 
as far as Zone Descriptions are concerned. They are only read when the Administration 
Module is restarted - this must be allowed for when configuring Zone Descriptions. 

Planning Zone Types 
Before creating a zone hierarchy, it is necessary to plan the Zone Types. 

 Decide on the Strategy for the Zone Hierarchy. 

 Decide on the Number of Levels in the Zone Hierarchy. 

 Decide on the Layer Aliases required. 

 Decide on the Text Styles Required. 

 Decide on the Zone Descriptions required and how they will map to Zone Type 
'Types'. 

Steps for Planning Zone Types 

Decide on the Strategy for the Zone Hierarchy 

There are two broad strategies for creating a zone hierarchy: . 

 Have only one level in the hierarchy of Zone Types 'Type' Department. 

 Have multiple levels in the hierarchy of Zone Types 'Type' Department and only 
place a Zone Description from one level in the hierarchy. 

Which is to be used has to be decided at the outset as it will affect all other decisions on 
setting up the Zone Hierarchy. 

Decide on the Number of Levels in the Zone Hierarchy 

The number of levels in the hierarchy must be determined. More levels will lead to more 
flexibility in reporting, but may increase the difficulty in generating accurate reports. The 
hierarchy could consist of just two levels - for example Internal Area and Departments. 
Alternatively, it could consist of multiple levels - for example Internal Area, Areas, 
Departments and Sub-Departments.   
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Not all these zones would necessarily be placed in a drawing: for example the 'Areas' 
level in the hierarchy could be used to organize zones into broad types. 

Decide on the Layer Aliases Required 

Macro Space Management provides functionality called Clash Detection to determine 
whether Zones in a store plan are overlapping (clashing). Only Zones on the same 
AutoCAD Layer can detected as clashing. 

 Zones that should not clash (overlap) should be placed on the same Layer 

 Zones that are intentionally superimposed on each other need to be placed on 
different layers - for example the 'Clothing'' zone would need to go on one layer 
and its children (Children's Clothing, Men's Clothing and Women's Clothing) on 
another Layer 

How many Layer Aliases are required will depend on the whether the user has chosen to 
have only one level in the hierarchy of Zone Types 'Type' Department or to have multiple 
levels in the hierarchy of Zone Types 'Type' Department and only place a Zone 
Description from one level in the hierarchy. The minimum number of Layer Aliases 
required is two: one for the Internal Area Zone and one for Departments. A more 
complex hierarchy that places at several levels might require multiple Aliased Layers: in 
the example below, Internal Area, Areas, Departments and Sub-Department Layers have 
been set up to allow a four level hierarchy to be placed. 

 

Decide on the Text Styles Required 

Each Zone Type can have a Text Style associated with it. This Text Style determines the 
form of the Annotation that will be drawn when the zone is placed. 
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Note: Text Styles are configured by selecting the Text Styles 
option from the Planning menu in the Administration 
Module. 

Adding, Editing and Deleting Zone Types 
Zone Types can be accessed from the Edit Menu in the Administration Module. 

 

This will bring up the Zone Types dialog box. 

 

Options can be selected from the Edit pull down menu. 

 

Alternatively, they can be selected from the toolbar. 

Icon Meaning 

 

Exit 

 

Add Zone Type 
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Icon Meaning 

 

Edit Zone Type 

 

Delete Zone Type 

 

Refresh from Database 

Adding Zone Types 
When Add Zone is selected from the options on the pull down menu or toolbar, the Add 
Zone Type dialogue box appears. 

 

The Description can be typed in and should be appropriate to the Zone Type being 
created. The Auto Text Type can be selected from a drop down list and specifies the Text 
Style to be used for annotation on the drawing. 

 

The Layer Type is also selected from a drop down list. 

  

This determines which Layer the Zone will be placed on. 

Note: Clashes can only be detected between Zones on the 
same layer alias (Layer Type in the above dialogue box). The 
Type can also be selected from a drop down list. 

The type refers to one of three possible classes the Zone Type can be assigned to. 



Admin Planning 

Admin Planning 371 

 

Editing Zone Types 
When Edit Zone is selected from the options on the pull down menu or toolbar, the Edit 
Zone Type dialogue box appears. 

 

The Description can be edited and should remain appropriate to the Zone Type being 
created. The AutoText Type can be edited from a drop down list and specifies the list of 
what is to be annotated on the drawing. 

 

The Layer Type is also edited from a drop down list. 

 

This determines which Layer the Zone will be placed on. 

Note: Clashes can only be detected between Zones on the 
same layer alias (Layer Type in the above dialogue box). 

The Type can also be edited from a drop down list. 

 

Deleting Zone Types 
Zone Types can be Deleted  by highlighting them, then selecting the Delete Zone type 
option from the drop down list on the menu bar, or using the appropriate icon on the 
toolbar. 
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Delete Zone 
Type 

 

Note:  Zone Types cannot be deleted if there is a Zone 
Definition associated with it – the associated Zone 
Definitions must be deleted or assigned to another category 
first. 

The Internal Zone and Department Zone Types cannot be deleted – only other user 
defined Types within the Zone Type definition can be deleted. Zone Types cannot be 
deleted if there is a Zone Definition associated with it – the associated Zone Definitions 
must be deleted or assigned to another category first. 

Zone Text 
Zone Text is controlled by the Text Styles Option on the Planning Menu in the 
Administration module. 

 

It provides three default text styles for Zones: Internal Area, Department Zone and Zone 
- these correspond to the three Default Zone Types. The number of available Text Styles 
may be increased by modifying the Custom SQL used to specify how the annotation is 
carried out. 

Zone Definition  

Accessing Zone Definition Options 
Zone Definitions can be accessed from the Edit Menu in the Administration Module. 
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Note: changes made to Zone Definitions in the 
Configuration Module only take effect the next time the 
Planner Module is restarted. 

The Zone Definitions Window 
The Zone Definitions Window  allows Zone Definitions to be Added, Edited and 
Deleted. 

 

Options can be selected from the Edit pull down menu. 

 

Alternatively, they can be selected from the toolbar. 
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Icon Meaning 

 

Exit  

 

Add Zone Definition 

 

Edit Zone Definition 

 

Delete Zone Definition 

 

Refresh View 

 

View Zone Types 

 

View Hatch Types 

Adding Zone Definitions 
When Add Definition is selected from the options on the pull down menu or toolbar, the 
Add Zone Type dialogue box appears. 

 

The Name and Description can be edited and should be appropriate to the Zone 
Definition being created. The Zone Type can be edited from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types. The Hatch Style can also be edited from a drop down list. 
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This will determine how the Zones appear when colored on the drawing of the floor 
plan. The Zone Color can be edited from a pallet. 

 

It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. The Zone Description Icon can also be 
edited from a drop down list. 

 

Finally an edited user defined Code can be typed into the Code window. 

Editing Zone Definitions 
When Edit Definition is selected from the options on the pull down menu or toolbar, the 
Edit Zone Definition dialogue box appears. 
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The Name and Description can be changed and should be appropriate to the Zone 
Definition being edited. The Zone Type can be selected from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types. The Hatch Style can also be selected from a drop down list. 

 

This will determine how the Zones appear when colored on the drawing of the floor 
plan. The Zone Color can be selected from a pallet. 

 

It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. The Zone Definition Icon can also be 
selected from a drop down list. 
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Finally a user defined Code can be typed into the Code window. 

Deleting Zone Definitions 
Zone Definitions can be Deleted by highlighting them, then selecting the Delete Zone 
Definition option from the drop down list on the menu bar, or using the appropriate icon 
on the toolbar. 

 

Delete Zone 
Definition 

 

A confirmation dialogue box will appear. 

 

Click on Yes to confirm deletion. 

View Zone Types and View Hatch Types 
View Zone Type and View Hatch Types can be activated using the buttons in the Zone 
Description toolbar. 
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Icon Meaning 

 

  

View Zone Types 

 

  

View Hatch Types 

  

Clicking on either button will bring up the appropriate window 

Note: If the Zone Description window is maximized, the 
View Zone Type and View Hatch Types windows will tend 
to appear behind the Zone Description window. It will have 
to be minimized before the new windows can be seen. 
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Zone Definition  

Accessing Zone Definition Options 
Zone Definitions can be accessed from the Edit Menu in the Administration Module. 

 

Note: changes made to Zone Definitions in the 
Configuration Module only take effect the next time the 
Planner Module is restarted. 

The Zone Definitions Window 
The Zone Definitions Window  allows Zone Definitions to be Added, Edited and 
Deleted. 

 

Options can be selected from the Edit pull down menu. 
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Alternatively, they can be selected from the toolbar. 

Icon Meaning 

 

Exit  

 

Add Zone Definition 

 

Edit Zone Definition 

 

Delete Zone Definition 

 

Refresh View 

 

View Zone Types 

 

View Hatch Types 

Adding Zone Definitions 
When Add Definition is selected from the options on the pull down menu or toolbar, the 
Add Zone Type dialogue box appears. 
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The Name and Description can be edited and should be appropriate to the Zone 
Definition being created. The Zone Type can be edited from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types. The Hatch Style can also be edited from a drop down list. 

 

This will determine how the Zones appear when colored on the drawing of the floor 
plan. The Zone Color can be edited from a pallet. 

 

It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. The Zone Description Icon can also be 
edited from a drop down list. 

 

Finally an edited user defined Code can be typed into the Code window. 

Editing Zone Definitions 
When Edit Definition is selected from the options on the pull down menu or toolbar, the 
Edit Zone Definition dialogue box appears. 
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The Name and Description can be changed and should be appropriate to the Zone 
Definition being edited. The Zone Type can be selected from a drop down list 

 

As well as the predefined types shown in the example above, the list will also include 
any user defined types. The Hatch Style can also be selected from a drop down list. 

 

This will determine how the Zones appear when colored on the drawing of the floor 
plan. The Zone Color can be selected from a pallet. 

 

It is suggested that Zone colors are selected using a logical scheme; for example clothing 
in shades of red, electrical goods in shades of blue. The Zone Definition Icon can also be 
selected from a drop down list. 
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Finally a user defined Code can be typed into the Code window. 

Deleting Zone Definitions 
Zone Definitions can be Deleted by highlighting them, then selecting the Delete Zone 
Definition option from the drop down list on the menu bar, or using the appropriate icon 
on the toolbar. 

 

Delete Zone 
Definition 

 

A confirmation dialogue box will appear. 

 

Click on Yes to confirm deletion. 

View Zone Types and View Hatch Types 
View Zone Type and View Hatch Types can be activated using the buttons in the Zone 
Description toolbar. 
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Icon Meaning 

 

  

View Zone Types 

 

  

View Hatch Types 

  

Clicking on either button will bring up the appropriate window 

Note: If the Zone Description window is maximized, the 
View Zone Type and View Hatch Types windows will tend 
to appear behind the Zone Description window. It will have 
to be minimized before the new windows can be seen. 

Adjacency Rules 

Overview of Adjacency Rules 
Adjacency Rules can be used to set up a series of guidelines about which products 
should be in proximity to one another, and which should not be. For example, it would 
not be good placement to put bleach next to meat or vegetables. However, more pasta 
sauce will be sold if is placed next to pasta. 

 

Note: Rules are configured in the Severity Types Option 
from the same menu. 

These Adjacency Rules can then be used (in conjunction with other MSM database tables) 
to produce reports on whether products are well or badly placed. These reports (often in 
the form of Quick Reports or KPI's) can then be used to improve the layout of 
merchandise in a store plan - and hence the profitability of the store. 

Severity Types 
The Severity Types (rules) for the Adjacency Rules are set up using the Severity Types 
option from the Merchandising menu of the Admin Module. 
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Note: User can only alter the text and color for the Severity 
types via the dialog box. Altering the number of available 
Severity Types can only be done in the Adjacency Severity 
Type table. For more information on this table see the Oracle 
Retail Macro Space Planning Data Model. 

Setting Up Adjacency Rules 
To set up an Adjacency Rule, click on the Add Button. 

 

This will bring up the Product Adjacency Rule dialogue box. 
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To add a Product Adjacency Rule: 

1. Type in a Rule Description 

2. Select Product 1 (clicking on the button will bring up the Select Products dialogue 
box) 

3. Select Product 2 (clicking on the button will bring up the Select Products dialogue 
box) 

4. Select the Severity Type 

The Select Product dialogue box allows users to manually select the required products. 
Alternatively, the find button can be used to locate successive instances of the search 
string in the product hierarchy. 

 

Users can select from products at Department, Class (Category) or Sub-Class (Sub-
Category) level in the Product Hierarchy. These levels in the hierarchy should not be 

 



Tools and Logs 

Admin Merchandising 387 

subject to frequent change, so a set of Adjacency Rules should only require updating at 
irregular intervals.  

Keeping Adjacency Rules Updated 
Adjacency rules are set up at Department, Class (Category) or Sub-Class (Sub-Category) 
level in the Product Hierarchy. 

 

Products are generally subject to regular change at Style, Item and SKU levels in the 
Product Hierarchy. Department, Class (Category) or Sub-Class (Sub-Category) levels do 
not change very often, so once Adjacency Rules are set up, they should remain valid for 
extended periods of time. It would be possible to produce periodic reports that identify: 

1. Deleted Department, Class (Category) or Sub-Class (Sub-Category) items in the 
Product Hierarchy that are no longer needed in the Adjacency Rules. 

2. Newly added Department, Class (Category) or Sub-Class (Sub-Category) items in the 
Product Hierarchy that may need adding to the Adjacency Rules. 

Editing and Deleting Adjacency Rules 
Editing and Deleting Adjacency Rules can be carried out by using the appropriate 
buttons from the toolbar. 
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Editing Rules 
Editing rules only allows the user to change the Severity Type. 

 

In order to change the products in an existing rule, it is necessary to delete the rule and 
create a new one. 

Deleting Rules 
To delete a rule, highlight it and then click the Delete icon. The rule will be deleted 
without further confirmation. 

Using Adjacency Rules 
After the Adjacency Rules have been set up, it is necessary to set up an output for them 
so that users can see how products in a specific drawing match the specified Adjacency 
Rules. The results can be based on either: 

 Product Adjacencies  

 Aisle Adjacencies  

Note: i t is also possible to base the results on distances.  

Product Adjacencies 
Product Adjacencies (Product Adjacency table) can be used to look at the relationship of 
products on the same fixture and on the fixtures to the immediate left and right. 

Aisle Adjacencies 
Aisle Adjacencies (Aisle Adjacency table) can be used to look at the relationship of 
products sharing an Aisle. 
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Note: An Aisle is a MSM object. It is a line drawn in a store 
plan in the Planner module that is used to represent one (or 
more) real life aisles. Fixtures within a specific distance of 
that line are regarded as belonging to the MSM Aisle. As 
products are linked to fixtures in the Product table, it is then 
possible to determine what products belong to that MSM 
Aisle. 

Configuring Use of Adjacency Rules 

SQL 

Generally, in order to make use of the Adjacency Rules, it is necessary to use SQL 
statements to link information from tables in the MSP database into an output that shows 
the results of the Adjacency rules. 

Tables 

For information on which tables to reference when using SQL to generate an output from 
the Adjacency Rules, please see the Macro Space Management data model. This is 
available to registered MSM users on application to Oracle. 

Quick Reports 

Quick Reports are available in both the Planner and Merchandiser Modules. It would be 
able to produce a Quick Report that shows all the products in a drawing and the results 
of any Adjacency Rule calculations. 

 

Note: The SQL that populates the Quick Reports is stored in 
the Custom SQL table. 

KPIs (Key Performance Indicators) 

KPIs (Key Performance Indicators) are available in both the Planner and Merchandiser 
Modules. It would be able to produce KPI's that show all the products in a drawing and 
the results of any Adjacency Rule calculations. 
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Reports 

It is possible to use Oracle tools such as BI Publisher to produce tabulated reports on the 
results of adjacency calculations within a drawing. Contact Oracle Technical Support for 
further information on Oracle applications suitable for producing reports on Adjacency 
Rules.  

Note: For more information on the tables in this section see 
the Oracle Retail Macro Space Planning Data Model. 

Distances in Adjacency Rule Output 
It is possible to use distances in the results from Adjacency Rules  

Using Distances 

Product Adjacency Rule Table 

The Product Adjacency Rule table has a PAR_DISTANCE Field. 
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This field cannot currently be accessed via the Adjacency Rule dialog box in the Admin 
module, but can be used to set a distance for each Adjacency Rule. 

Aisle Adjacency Table 

The Aisle Adjacency table has AIL_DISTANCE_FROM_START and 
AIL_DISTANCE_FROM_AISLE fields 

 

These fields could be used to calculate the relative distances of fixtures (and hence 
products) along the Aisle 

Note: An Aisle is a MSM object. It is a line drawn in a store 
plan in the Planner module that is used to represent one (or 
more) real life aisles. Fixtures within a specific distance of 
that line are regarded as belonging to the MSM Aisle. As 
products are linked to fixtures in the Product table, i t is then 
possible to determine what products belong to that MSM 
Aisle. 

Product Adjacency Table 

The Product Adjacency table contains PAJ_LENGTH_LEFT and PAJ_LENGTH_RIGHT 
fields that show the distance of products to the left and right of the current field. 
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Fixture Table 

The Fixture table contains information on the X and Y coordinates (FIX_XPOS and 
FIX_YPOS) of a fixture within a store plan. 
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Products are associated with their parent fixtures in the Product table. Using the X and Y 
coordinates (FIX_XPOS and FIX_YPOS) of fixtures would enable Adjacency Rules to 
work on distances between products. This provides an alternative to using the Aisle 
Adjacency and Product Adjacency tables. 

Note: For more information on the tables in this section see 
the Oracle Retail Macro Space Planning Data Model. 
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Severity Types 

About Severity Types 
Severity Types are used in conjunction with Adjacency Rules. They enable users to 
describe the form of the relationship between two products in the Adjacency Rules. 

 

There are five default severity types: These range from badly placed to well placed. For 
example, a Product Adjacency Rule might state that bleach cannot be displayed within 5 
meters of fresh meat. If this was infringed a warning might appear in the Product 
Adjacency Report flagging up that this rule had been infringed: ERROR: Layout groups 
far too close. 

Similarly, a Product Adjacency Rule might state that pasta sauces have to be displayed 
within 2 meters of pasta. If this was achieved during merchandising, then the Product 
Adjacency Report might flag up: EXCELLENT: Layout groups well  placed. 

Editing Severity Types 
To edit a Severity Type, click on it to highlight it. Next, select the Edit option in the Edit 
pull down menu or click on the Edit icon. 

 

This will bring up the Severity Types editing dialogue. 
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The description and color can be customized to user requirements. Click OK to confirm 
and return to the Severity Types window. 

Modifying the Severity Type List 
There are five default Severity Types supplied with Macro Space Management. 

 

It is possible to increase or decrease the number of Severity Types, but this must be done 
directly in the database. This is done by changing the entries in the Adjacency Severity 
Type table. 

 

All three fields are mandatory, with the AST_ID field being the primary key. This table is 
only referenced by SQL and not by the code, so changes to the table will not affect the 
operation of the Planner and Merchandiser Modules. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 
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Category Roles 

Overview of Category Roles 
The Category Roles dialog box is accessed from the Merchandising menu of the 
Administration module. It is used to assign Category Roles to varying levels in the 
product hierarchy. These Category Roles are then used in Category Management - 
software complementary to Macro Space Planning used to determine the range of 
products optimum for a floor plan. 

 

Category Roles are used to define the purpose the category serves for the retailer. In the 
above example, a retailer has six customer roles it can assign to products: 

 Destination - a category used to define the retailer's position in the market in the 
mind of the customer. For example televisions might be a destination category 
for an electrical retailer. 

 Routine - regular merchandise purchased as a matter of routine - for example 
washing up liquid or other cleaning products  

 Convenience - items brought by customers as impulse buys. A good example 
would be batteries. 

 Seasonal - merchandise that is only on sale at specific times of the year - an 
example might be Easter Eggs. 

 Flagship - a category used to improve the status of a retail chain. An example 
would be a category containing the latest consumer electronics. 

 Cash Machine - a category used to generate high profit margins. 

Although Category Roles can be assigned manually to products in Product Studio, it is 
more likely that they will be imported. Accordingly, the Category Roles entered in the 
Administration module should be similar to any that exist in the third party software 
used to maintain product information at a retail chain. Category Roles can be assigned to 
products at all levels from Sub-class to SKU level in the Product hierarchy. From Sub-
Class to Item level it is assigned in the following dialog box: 
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At SKU level it is assigned in the Details Tab of the SKU dialog box. 
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Category Roles Menus and Toolbar 
The File Menu  allows users to add new Category Roles, save the changes and exit the 
dialog box. 

 

The Edit Menu allows users to cut copy and paste information, and to delete Category 
Roles. 

 

The Help Menu allows users to call this Help File. 

 

The following options are available on the toolbar: 

Icon Option 

 

Add a new Category Role 

 

Save the contents of the dialog box 

 

Cut 

 

Copy 

 

Paste 

 

Delete 

 

Move up in List 

 

Move Down in List 

 

Help 
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Using the Category Roles Dialog Box 
The Category Roles dialog box can be used to Add, Edit and Delete Category Roles from 
the list of those available for use within at SKU level product hierarchy. 

Dialog Box Options 

Adding a Category Role 

Adding a Category Role can be done by clicking the Add button on the toolbar (or the 
File menu) to create a new line in the list of Strategies. 

 

Once the line has been created, data can be entered by typing it in, or by using the copy 
and paste options on the toolbar. 

 

Editing a Category Role 

Category Roles can be edited by typing the required changes in, or by using the copy and 
paste options on the toolbar (or the edit menu). 

Deleting a Category Role 

Deleting one or more Category Roles can be achieved by highlighting the ones it is 
desired to delete in the list of Category Roles and clicking the Delete option on the 
toolbar (or the edit menu). 

 

Promoting or Demoting Category Roles in the List of Category Roles 

Category Roles can be promoted or demoted in the sequence Category roles are 
displayed in by using the Up and down icons in the toolbar. 

 

 This will affect how the drop down lists display in the dialog box used to set Category 
roles in Product Studio. 

Saving Changes 

Changes can be saved by clicking the Save icon on the toolbar (or the file menu). 
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If users attempt to exit the dialog box without saving changes, they will be prompted as 
to whether they wish to do so. 

 

Planogram Financial Weighting 

Planogram Financial Weighting 
The Financial Weighting Dialog Box is used to assign a ranking score to planograms. This 
enables users to weigh the relative merits of alternative planograms when defining a 
planogram substitution in the Planogram Substitution Assistant. 

 

The process works as follows: 

1. When a planogram definition is imported, the imported information will include 
financial data. (Imported into the Plano Finance table). 

2. Financial Weightings are set in the Administration module using the Planogram 
Financial Weighting dialog box. 

3. When planogram substitutions are being defined, the ranking scores (calculated from 
the imported financial data and the financial weightings) are displayed in the 
Planogram Substitution Assistant. 

The Financial Weighting Settings are universal - once set in the Administration module, 
they apply to all planograms until the settings are changed. The new settings will then be 
applied universally. It is therefore important to develop a single, agreed set of financial 
weightings for planogram substitution creators to use. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 
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Importing Information for Planogram Financial Weighting  
As part of the implementation process, arrangements have to be made to import 
planogram design information into the database. There, financial data will be stored in 
Plano Finance table. Financial information can be brought in for new planogram designs 
and refreshed for existing ones. This information can then be used in conjunction with 
the financial weighting information to assign a ranking score to each planograms. This 
ranking score is displayed in the New Planograms page of the Planogram Substitution 
Assistant as an aid to planogram selection. 

Planogram Financial Weighting Dialog Box 
The Planogram Financial Weighting dialog box is accessed from the Merchandising 
menu in the Administration Module. 

 

It holds five items of data that can be used to assign a ranking score: 

1. Forecast Sales  

2. Gross Margin 

3. Movement 

4. Profit 

5. Sales 

The precise nature of the data for each of these items may depend on the software 
package used to produce the planogram design. 

Menus and Toolbars 

Menu Options  

Menu Option Shortcut Key 

File Save Ctrl + S 

  Exit  Alt + F4 

Edit Reset Multiplier    

  Clear Size Divider    

The other menu options are: 

 Save 
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 Weight by Length 

 Weight by Area 

 Weight by Volume 

 Clear Size Weightings  

 Increase Multiplier by 1 

 Decrease Multiplier by 1  

 Reset Multiplier by 0. 

 Help 

Financial Weighting Calculation 
The following data can be used in the weighting calculations: Forecast Sales, Gross 
Margin, Movement, Profit, Sales. 

This data is imported as part of the planogram definition. It will not be updated unless it 
is done via a data import, or a new revision of the planogram is imported. 

The Size Divider 

The Size Divider allows users to take into account the physical size of the planogram 
when calculating a ranking. 

  If no Size Divider is set, the data will be the 'raw' data for the planogram. 

 If the Length Size Divider is set, the data will be the raw data for the planogram, 
divided by the length of the planogram. 

 If the Area Size Divider is set, the data will be the raw data for the planogram, 
divided by the floor area (length x depth) of the planogram. 

 If the Volume Size Divider is set, the data will be the raw data for the planogram, 
divided by the volume (length x depth x height) of the planogram 

The Multiplier 

The multiplier is a scaling factor to use to weight the 'raw' data in the calculation. 

 Multipliers can only be zero or positive integer values. 

 If set to 0, that particular factor will not be used in the calculation 

 If set to 1, the 'raw' data for that particular factor will be used in the calculation. 

 If set to values greater than 1, the raw data will be scaled accordingly. 

The Calculation 

The planogram weighting is based on the sum of the scaled factors. 

Item Value Multiplier Size 
Divider 

Result 

Forecast 
Sales 

10,000 1 Ft 10,000 

Gross 
Margin 

3,000 0     

Movement 3,000 0     

Profit 5,000 3   15,000 

Sales 7,000 0     
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Total: 25,000 

The resulting ranking of 25,000 provides a basis to compare this planogram with other 
planograms with ranking calculated using exactly the same formula. 

Planogram Import Styles 

Overview of Planogram Import Styles 
Planogram Import Styles are used when planogram designs are imported. 

 

The purpose is to map the fixture and shelf styles used by a third party planograming 
tool to the fixture and shelf styles used by Macro Space Management. This means MSM 
can use the style relationships from the third party planograming tool to validate the 
placement of the shelf objects when they are placed onto the parent fixtures. 

The functionality also has the ability to specify a default block for each MSM style. When 
fixture and shelf object information is imported from the third party planograming tool, 
the import tool will try and match the imported fixture or shelf object with  their 
equivalent in the MSM database. If no match can be made, the specified default block 
will be used (stretched to the dimensions required by the planogram design. 

The dialog box allows users to specify the codes used by up to four third party 
planograming tools. This enables a Macro Space Management user to import planogram 
designs from up to four third party planograming tools. 

Planogram Import style Menus and Toolbar 
The File Menu  allows users to configure a new import style, save the contents of the 
dialog box and exit the dialog box. 
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The Edit Menu allows users to cut, copy and paste information. They can also delete 
single or multiple planogram import style definitions. 

 

The Tools Menu  allows users to select the names for the third party planogram design 
software data is being imported from. 

 

The Help Menu calls this help file. 

 

The following options are available on the toolbar: 

Icon Option 

 

Add a new Import Style 

 

Save the contents of the dialog box 

 

Cut 

 

Copy 

 

Paste 

 

Delete 

 

Help 

Configuring Sources of Planogram Imports 
The sources of planogram imports can be configured using the Options dialog box 
selected from the Tools menu. 
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This will bring up the Options dialog box. 

 

This enables users to select up to four sources of planogram imports from the drop down 
lists. 

Using the Planogram Import Style Dialog Box 
The Strategies dialog box can be used to Add, Edit and Delete strategies from the list of 
those available for use within the product hierarchy. 

Dialog Box Options 

Adding a Planogram Import Style 

Adding a Planogram Import Style can be done by clicking the Add button on the toolbar 
(or the File menu) to create a new line in the list of Strategies. 

 

Once the line has been created, data can be entered by typing it in, or by using the copy 
and paste options on the toolbar. 
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Editing a Planogram Import Style 

Planogram Import Styles can be edited by typing the required changes in, or by using the 
copy and paste options on the toolbar (or the edit menu). 

Deleting a Planogram Import Style 

Deleting one or more Planogram Import Styles can be achieved by highlighting the 
Planogram Import Styles it is desired to delete in the list of Planogram Import Styles and 
clicking the Delete option on the toolbar (or the edit menu). 

 

Saving Changes 

Changes can be saved by clicking the Save icon on the toolbar (or the file menu). 

 

If users attempt to exit the dialog box without saving changes, they will be prompted as 
to whether they wish to do so. 

 

Planogram Substitution 

Introduction to Planogram Substitution 

Introduction to Planogram Substitution 
This section of the Planogram Substitution User Guide provides an introduction to the 
Planogram Substitution functionality. 

Overview of Functionality 
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1. Logging in validates that a user has been assigned privileges to access the 
functionality. These privileges can be one of three types: 

 Admin User - giving full access to the functionality, including specifying who 
can access it and who can't. 

 Merchandise Manager - who can set up and run planogram substitutions, but 
who does not control access to the functionality. 

 Normal User - restricted to running predefined substitutions in the currently 
open drawing in the Planner or Merchandiser modules. 

Note: Normal Users only have limited access to Planogram 
Substitution functionality - the majority can only be accessed 
by users with Merchandise Manager or Admin Privileges. 

2. The Planogram Substitution dialog box is the first dialog box that opens. It allows 
users to select planogram substitutions for adding, editing or deleting via the 
Planogram Substitution Definition dialog box. It also allows users to open the 
Planogram Substitution Assistant dialog box - a tool that helps users to create 
planogram substitutions. The Planogram Substitution dialog box also allows users 
to manually run multiple substitutions. 

3. The Planogram Substitution Definition dialog box enables users to manually set up 
the details of a specific planogram substitution. 

4. The Planogram Substitution Assistant aids users with the details of planning a 
specific planogram substitution by allowing them to select information from pre-
populated lists. It can be used in conjunction with the Planogram Substitution 
Definition dialog box. 

5. Once Planogram substitutions have been defined, the Dry Run option allows users to 
test whether the substitutions will execute as intended. The results can be seen in the 
Dry Run Log. 

6. Any defined planogram substitutions can either be run as a batch process or 
manually. If run manually: 

 Users with Admin privileges can run multiple substitutions from within the 
Planogram Substitution module. 
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 Users with normal privileges can run predefined substitutions in the currently 
open drawing in the Planner or Merchandiser modules 

7. The results of any substitutions that have been carried out can be seen in the 
Planogram Substitution Log 

Note: As well as actual planogram substitution (swapping 
planogram A for B), the functionality will also carry out 
Revision Substitution - swapping an earlier version of a 
planogram design for a later one. 

Dialog Boxes 
This section gives an overview of the primary dialog boxes in the functionality. 

Log In Dialog Box 

The Log in dialog box is used to control access to the functionality. 

 

The exact privileges depend on settings within the Administration module: 

Administrator Level 
Users with Administrator's access have access to all aspects of planogram studio 
functionality: 

 They can configure the access to the planogram substitution functionality. This 
involves setting up user groups and assigning users to the appropriate ones. 

 Administrators can also define and bulk run planogram substitutions. 

 Administrators can also set up and control batch processes. 

Merchandise Manager Level 

Users with Merchandise Manager privileges have access to the planogram substitution 
module, but not to the Administration module. This enables them to define and 
manually bulk run planogram substitutions but not to control access to planogram 
substitution, or to control batch processes. 

Normal Users 

Users with normal privileges have the ability to run substitutions on individual active 
store plans in the Planner and Merchandiser modules. They do not have the privileges to 
define planogram substitutions or run them in bulk. 

Planogram Substitution Dialog Box 

The Planogram Substitution dialog box is the initial dialog box to appear. It allows users 
to control different aspects of the planogram substitution process: 



Tools and Logs 

Admin Merchandising 409 

 

Users can: 

 Add new planogram substitution definitions via the Planogram Definition dialog 
box or the Planogram Substitution Assistant. 

 Edit existing planogram substitution definitions via the Planogram Definition 
dialog box. 

 Delete planogram substitution definitions. 

 Manually carry out Dry Runs to test that the substitutions will run without 
problems. 

 View the Dry Run Log to see the results of the test. 

 Manually carry out planogram substitutions. 

 View the process log to see the results of planogram substitutions. 

Planogram Substitution Definition Dialog Box 

This dialog box can be invoked from the Planogram Substitution dialog box. It allows 
users to manually configure the details of a specific planogram substitution. 
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This dialog box has six tabs: 

Substitution Tab 

The Substitution tab allows users to select the planograms to be substituted and the 
planograms that are to be their replacements. 

The Rules Tab 

The Rules tab allows users to select the validation rules that will apply to the planogram 
substitution. 

The Properties Tab 

The Properties tab allows users to define the criteria for when a planogram substitution 
will be carried out. 

Stores Tab 
The Stores Tab allows users to specify if planogram substitutions should only be carried 
out in specific stores. 

Status Tab 

The Status tab allows users to specify the file statuses of the floor plans that will be 
subject to planogram substitution operations. 
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Bays Tab 

The Bays tab allows users to limit planogram substitutions to specific numbered bays. 

Planogram Substitution Assistant 

The Planogram Substitution Assistant is a tool to help users set up a planogram 
substitution. It can be invoked from both the Planogram Substitution and the Planogram 
Substitution Definition dialog boxes. 

 

Initial Stage 

The initial page allows the user to select the existing planogram it is intended to 
substitute. 

Second Stage 

The second stage allows users to specify the floor plan statuses the planogram 
substitution will apply to. 

Third Stage 
The third stage allows users to extend the selection of planograms for substitution by 
selecting planograms that are adjacent to the originally selected planogram. These 
additional planograms can be to the left, right or sharing the same fixture. 

Fourth Stage 

The fourth stage allows the user to specify any stores the planogram substitution is to be 
excluded from. 

Final Stage 

The final stage allows the user to specify the planograms to be substituted for the 
originally selected planograms.  On clicking the Finish button, users will be taken to the 
Planogram Substitution Definition dialog box, which will have been populated with 
information from the Planogram Substitution Assistant. Additional information can then 
be added to complete the Planogram Substitution definition. 

Dry Run Log 

The Dry Run facility enables Administrators or users who have been assigned an 'Admin 
role' to test any Planogram Substitutions they have created. Each substitution is 
simulated using data in the database and the results logged. Dry Runs are invoked using 
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the Dry Run option on the toolbar (or from the Tools menu) in the Planogram 
Substitution dialog box. 

 

Dry Runs can be carried out for single or multiple substitutions by highlighting the 
required substitutions in the Planogram Substitution or Planogram Substitution 
Definition dialog boxes, then carrying out a Dry Run. Once the Dry Run has been 
completed, the Dry Run log will appear. 

 

This contains the results of all the selected dry runs and enables an Administrator to 
identify problems with substitutions before they are carried out. 

Running Planogram Substitutions 

There are three ways of running planogram substitutions: 

As a Batch Process 

Planogram Substitutions can be run as a batch process. This would normally be set up by 
System Administrators and will not be discussed further in this section. 

Manually from within the Planogram Substitution Module 

Single or multiple planogram substitutions can be run by highlighting them in the 
Planogram Substitution dialog box and then invoking the Run option from the toolbar 
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(or from the Tools menu). If no substitutions are highlighted, all valid substitutions will 
be run. 

 

Manually from within the Planner and Merchandiser Modules 

Planogram substitutions can be run from within the currently open drawing by invoking 
the Run Planogram Substitution option from the Tools menu. This will run all currently 
active substitutions for that drawing. 

 

Planogram Substitution Log 
The Planogram Substitution Log can be called from the toolbar (or Tools menu) in the 
Planogram Substitution dialog box. 

 

This will show results from any planogram substitutions that have been run. It enables 
Administrators to identify planogram substitutions that have been successfully executed 
and planogram substitutions that have failed. 
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Planogram Substitution Technicalities 

Definition of Terms 

Terms Used  

Planogram Design 

A planogram design is an arrangement of equipment (shelves) and merchandise 
(products ). 

 

When an instance of that planogram design is placed in the drawing, the shelves and 
products can be represented in varying levels of detail. Only planograms at the lowest 
level of detail (2D) can currently be substituted. 
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Planogram Substitution 

A planogram substitution is the automated changing of one or more planogram designs 
for other planogram designs. These substitutions can be run manually for a single 
drawing, manually for multiple stores if the user has Administrators rights or 
automatically as a batch process for multiple stores in the database. 

Revision Substitution 

Revision Substitution occurs when an updated version of a planogram design is 
available. It results in the older version of a planogram in one or more store plans being 
changed for the more recent version. For example, a planogram containing different 
brands of baked beans might be adjusted so that curried beans take up fractionally more 
space than in the earlier version of the planograms. When Revision Substitution is carried 
out in a store plan, information in the database is changed to show that the planogram 
design has been changed from the old to the new. 

Examples of Planogram Substitution 
Planogram Substitution can come in many forms. This allows users complete flexibility 
in selecting planograms to be substituted and defining the planograms that are to be 
inserted as their replacements. 

Note: A number of examples are given below - in practice 
the validity of each substitution will be determined by rules 
selected on the rules tab of the Planogram Substitution 
Definition dialog box. For example, if the 'Length' rule is off, 
lengths will not be validated and planograms of unequal 
lengths can be substituted. 

Substitution Types 

One to One 
The simplest form of planogram substitution is a 'one to one' substitution. One 
planogram of a specified length is replaced by another planogram of equal length. 

 

In the above example, the 12 foot planogram 'B' has been replaced with another 12 foot 
planogram 'C'. 

One to Many 

Another form of planogram substitution is a 'one to many' substitution. One planogram 
of a specified length is replaced by two or more planograms whose combined lengths are 
the same as that of the planogram they are replacing. 

 

In the above example the 12 foot planogram 'B' has been replaced by the 4 foot 
planograms 'D', 'E' and 'F' . 

Many to One 
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In Many to One planogram substitutions, several planograms are selected and replaced 
by a single planogram equal in length to the sum of the lengths of the planograms it is 
replacing. 

 

In the above example, the 8 foot planogram 'A'  and the 12 foot planogram 'B' are to be 
replaced by the single 20 foot planogram 'G'. 

Many to Many 

A 'Many to Many' planogram substitution occurs when multiple planograms are selected 
for replacement and are substituted for by multiple planograms occupying the same 
length as the planograms they are replacing. 

 

In the above example, the 8 foot planogram 'A'  and the 12 foot planogram 'B' are to be 
replaced by the 4 foot planogram 'H' and the 16 foot planogram 'J'. 

One to None 

It is possible to carry out a One to None Substitution - the removal of a planogram 
without specifying a replacement. This might be called for when a planogram has to be 
removed for legal reasons, etc., but no replacement has been decided on. 

 

In the above example the planogram 'X' on the end cap of the gondola is to be removed 
without a replacement being specified. 

Note: i t is also possible to carry out 'Many to None' 
substitutions. 

One to None with Fixture Removal 

As well as a One to None substitution, it is also possible to remove the parent fixture. 
This might be because parts of a store are being assigned to a different purpose and the 
fixturing is changing as well as the planograms. 

 

In the above example the planogram 'X' on the end cap of the gondola is to be removed 
along with its parent fixture. 

Revision Substitution 

If no existing planograms have been selected for substitution, it is still possible to carry 
out Revision Substitution.  Revision Substitution is when slight changes have been made 
to a planogram design and it has been saved as a new version rather than a new design. 
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When planogram substitution is carried out, all other planograms in the store will be 
automatically be updated to the latest revision providing the Effective Date of the 
revision is less than the Active Date of the floor plan the Revision Substitution is being 
carried out in. 

Forms of Planogram Representation 
Planograms can be placed in both the Planner and Merchandiser modules and in In-Store 
Space Collaboration. In the Planner module and in In-Store Space Collaboration 
planograms are represented as placeholders - that is to say they are shown as occupying 
the fixture without any additional detail. In the Merchandiser module, planograms can 
be represented at three different levels of detail. 

How planograms are represented in Merchandiser 

Planograms can be displayed at different levels of detail in the Merchandiser module. 
The default for how planograms are represented is set on a user by user basis using the 
Details drop down list in the Merchandising tab of the Configuration module. 

 

The user has three options: 

 2D Planogram (Placeholder) 

 3D planogram (called 2.5 D in the Merchandiser Module). 

 3D with Product Items (Full Detail). 

These appear in the Merchandiser module as follows: 



Planogram Substitution 

418 Oracle Retail Macro Space Management 

 

A 2D planogram is purely a placeholder. A 3D planogram (2.5 D in Merchandiser) shows 
the shelves and a simple product block to show the shelves are occupied. A 3D 
planogram with Product items shows the shelves, together with full  details of the 
products. 

How the Planogram display form is changed in Merchandiser 

If planograms are first placed in the Planner Module, or in In-Store Space Collaboration, 
when initially viewed in Merchandiser, they will appear in 2D form (placeholders). If 
planograms were first placed in the Merchandiser module, how they appear is 
determined by the settings individual users chose in the Configuration module (see 
above). Once in merchandiser, users have the option of toggling planogram display from 
2D to 3D with Product Items and back again. This is controlled by the Explode and 
Implode options on the View Toolbar. 

 

This version of planogram substitution is only designed to operate when the planograms 
are in 2D format, with no entries in the Shelf table for the planograms, and only a single 
entry in the Product table for the product block acting as a placeholder. Because of this, 
each drawing it is desired to run planogram substitution on will have to be manually set 
to 2D format before the planogram substitution can be carried out. 

How Planograms are stored in the Database 

Depending on whether planograms are in 2D, 2.5D or 3D form, different information is 
stored in the database. 
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 The File table specifies the file in use 

 The Fixture table holds a list of fixtures placed in the drawing 

 The Shelf table holds a list of shelves placed in the drawing 

 The Plano table holds header information on planogram designs  

 The POG table holds information on which planograms have been placed in floor 
plans. 

 The Product table holds information on which products have been placed in the 
drawing; either directly or in planograms. 

When planograms are in 2D format, the POG table will hold details of the planograms 
placed. The Shelf table will not have any information on shelves and the Product table 
will only have a single entry for the product block acting as the placeholder for the 
planogram. When planograms are placed in 2.5D and 3D format, the POG table will hold 
details of the planograms placed. The Shelf table will have details of the shelves and the 
Product table will have multiple entries for the products on each shelf. These entries 
could be product blocks acting as placeholders for the products on each shelf (2.5D 
format), or product blocks representing products at display style level. 

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable is used to 
determine how planograms are processed when the form of the planogram in the floor 
plan does not match the form of the planogram that will be substituted for it. For 
example, if the planogram in the floor plan is in 2D form and the planogram being 
substituted for it is in 3D form, the setting for the 
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable will determine 
the form the replacement planogram is displayed in. 

When Planogram Substitutions will be Carried Out 

Planogram Substitutions will only be carried out if the drawing is checked in and not in 
use. 

Note: For more information on the tables in this section see 
the Oracle Retail Macro Space Planning Data Model. 
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Cloned Drawings 
It is possible to set up planogram substitutions for files of current status. As files of 
current status are set to 'read only', the substitutions are carried out into 'cloned' files. 

 

1. Planogram Substitutions can only be carried out if the 
PLANOGRAM_SUBSTITUTION_COPY_FILE system variable is set to On (1). (If this 
system variable is set to Off, Current cannot be selected as a file status for 
substitutions). 

2. A Status of Current must have been selected in the status tab of the Planogram 
Substitution Definition dialog box. If Current status is not selected, cloning will not 
take place. 

3. Cloning will only be carried out for a specific store if a floor within that store has an 
existing file of current status. 

4. All revisions in the floor will be checked for Authorized files with an effective date 
falling within the date range set in the Floor Plan Effective Date option in the 
Properties tab of the Planogram Substitution Definition dialog box. If such a file 
exists (even in a different revision), then the substitutions specified for the Current 
file will be carried out in that file. 

5. If an Authorized file with an effective date falling within the date range set in the 
Floor Plan Effective Date option in the Properties tab of the Planogram Substitution 
Definition dialog box does not exist, a new Authorized revision will be created in the 
same revision as the Current file. The effective date for the Authorized file will be set 
to the earliest date on the Floor Plan Effective Date range. 

6. When all possible substitutions have been run, the user will be able to change the 
status of the Authorized file to Current at the required time - either manually, or via 
Update Status. 
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Cloning with Different Floor Plan Effective Dates 

It is possible to set up a range of planogram substitutions effective for files of current 
status with differing Floor Plan Effective Dates. 

 

In the above example a range of substitutions have been set up for files of current status; 
some with Floor Plan Effective Dates of 1st May and some for 1st July. This has resulted 
in the creation of two new Authorized files in the Revision containing the Current file. 
These Authorized revisions are accordingly set to become current on 1st May and one on 
1st July. 

Synchronization 
Planogram substitutions are carried out by making changes directly in the database. The 
Merchandiser Module and In-Store Space Collaboration read data directly from the 
database, so will show the changes directly the drawing is next opened. The Planner 
Module also stores information in an AutoCAD DWG drawing. After planogram 
substitutions have been made and the information in the database changed, the 
information in the DWG drawing has to be brought into line. This is done by means of 
the Synchronization dialog box. 
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Synchronizing 'Match the Database' will update the DWG drawing with the changes 
made in the database. 

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED System Variable 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant impact on the way planogram substitutions are carried out. It can be set to 0, 
1, 2, 3 or 4. 

Planogram Form 

There are three forms planograms can be placed in the merchandiser module. 

 2D Planogram (Placeholder) 

 3D planogram (called 2.5 D in the Merchandiser Module). 

 3D with Product Items (Full Detail). 

The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant impact on the way planogram substitutions are carried out. It can be set to 0, 
1, 2, 3 or 4. 

Once placed in the Merchandiser module planograms can be manually toggled between 
2D and 3D mode by means of the Implode or Explode options on the toolbar. 
Merchandiser floor plans can therefore contain planograms in a variety of states. The 
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable determines 
how planogram substitution caters for the different cases. 

System Variable Values 

System 
Variable 

Description 

0 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. No information on 
the planograms that have been ignored for substitution will be written to the 
Planogram Substitution Log. 

1 Only planograms in 2D form will be substituted - with planograms in 3D form being 
ignored. The substituted planograms will be placed in 2D form. Information on the 
planograms in 3D form that have been ignored for substitution will be written to the 
Planogram Substitution Log. 

2 Planograms in 2D form will be substituted with planograms also in 2D form. 
Planograms in 3D and 2.5D form will be placed in 2D form when substituted. 

3 3D and 2.5D planograms will be substituted by 2D planograms. A warning will be 
written to the Planogram Substitution Log identifying the 3D and 2.5 D planograms 
that were placed in 2D form during the substitution. 

4 Planograms in 3D form will be substituted with planograms also in 3D form. 
Planograms in 2D form will be placed in 3D form when substituted. Planograms in 
2.5D form will be replaced by a 2D form if that is the way the planogram design has 
been defined. It will be replaced by a 3D form if the planogram design is in 3D 
format. 

Business Processes and the PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED 
System Variable 
The PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable has a 
significant effect on the business processes used by a customer. The setting for this 
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system variable needs careful consideration during the implementation of the software. If 
a decision is taken to change the system variable during the lifetime of the Macro Space 
Planning application this needs be considered carefully as well. 

Consistency of Form 

The initial form of planogram placement for individual users is controlled by the 
Planogram Rules setting in the Merchandising tab of the Configuration Module. The 
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable should be set 
as to achieve consistency with the setting users have been instructed to set in the 
Configuration module. 

Impact on Reporting Accuracy 

Whether planograms are in 2D, 2.5D or 3D form affects the form of information held in 
the database. For example, a planogram in 2D form will only contain 'header' 
information with no entries for individual products of shelf objects. This impacts on 
reporting accuracy. For example, if planograms are in 2D mode, this needs to be taken 
into account when generating a bill of materials for the equipment in the floor plan as 
shelf information will not be stored in the Shelf table. Once placed in the Merchandiser 
module planograms can be manually toggled between 2D and 3D mode by means of the 
Implode or Explode options on the toolbar. Merchandiser floor plans can therefore 
contain planograms in a variety of states. The 
PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED system variable determines 
how planogram substitution caters for the different cases. For maximum reporting 
accuracy, the system variable should be set to 4. The planograms that are substituted will 
be placed in 3D form. If the other (existing) planograms in the drawing are in 2d or 2.5D 
form, they will be replaced with planograms in 3D form. 

Accessing the Functionality 

Overview of how Privileges Work 
There are three broad types of access to the Planogram Substitution functionality. 

Available Privileges 

Administrator Level 

Users with Administrator's access can control all aspects of planogram substitution 
functionality: 

 They can configure the access to the planogram substitution functionality. This 
involves setting up user groups and assigning users to the appropriate ones. 

 Administrators can also define and bulk run planogram substitutions. 

 Administrators can also set up and control batch processes. 

Merchandise Manager Level 

Users with Merchandise Manager privileges have access to the planogram substitution 
module, but not to the Administration module. This enables them to define and bulk run 
planogram substitutions but not to control access to planogram substitution, or to control 
batch processes. 

Normal Users 
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Users with normal privileges have the ability to run substitutions on individual active 
store plans in the Planner and Merchandiser modules. They do not have the privileges to 
define planogram substitutions or run them in bulk. 

Setting up Access to Planogram Substitution Functionality 

Access to the Planogram Substitution functionality is configured in the Administration 
Module using the Functionality Security and Data Security options. Functional Security 
controls the access to the Planogram Substitution functionality, and Data Security 
controls which planograms can be selected to define substitutions. This is discussed in 
more detail in the next section. 

Configuring User Privileges 
What privileges a user has depends on settings in Functional Security and Data Security 
in the Administration Module. This configuration is carried out by Administrators with 
access to the Administration Module. 

Functional Security 

Within Functional Security, Users can be assigned to User Groups. The User Groups that 
Users belong to determine the type of access to the Planogram Substitution functionality. 

User Groups are set up using the Add (or Edit) User Group dialog box in Functional 
Security. 

 

The Role assigned to the User Group is important. 

 If the User Group has a Role set to Admin User, members of that User Group 
will be able to run bulk planogram substitutions, either from by using the 'Run' 
control 
in the Planogram Substitution dialog box or via batch processes. 

 If the User Group does not have the Role set to Admin User, members of that 
User Group will be able to run substitutions within open store plans, but will not 
be 
able to run bulk planogram substitutions. 

Any User Group associated with the Planogram Substitution Command Group will have 
access to the planogram substitution functionality. Depending on the Role assigned to 
the User Group, members of that group may or may not be able to run bulk substitutions. 

Giving access to the Functionality 

Once a User Group has been created, it can be assigned to the Planogram Substitution 
User Group on the Group Relationships tab of the Functional Security dialog box. 
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Data Security 

Within the Data Security dialog box, the Planogram tab allows Administrators to specify 
what parts of the planogram hierarchy can be accessed by specific users within  
the Planogram Substitution functionality. The following rules apply: 

1. A User must belong to at least one User Group with 'Read' permissions to access 
planograms within the Planogram Hierarchy. 

2. 'Deny' permissions take precedence over 'Read' permissions. 

3. If a User belongs to a User Group with 'Read' permissions for a branch of the 
Planogram hierarchy they will be able to read all child branches of that part of the 
planogram hierarchy unless a 'deny' permission is encountered. 

 

In the above example for a single User Group: 
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 The 'Clothing' Planogram Group has been given no permissions, so no member 
of the User Group can access any planograms related to clothing. 

 The 'Electrical' Planogram Groups has been not given 'Read' permission, but two 
of its child Planograms Groups has. Members of the User Group can access 
planograms belonging to the 'Kitchen' and 'Phone' child Planogram Groups, but 
not planograms belonging directly to the 'Electrical' Planogram Group, or 
planograms belonging to the 'TV and Audio' child Planogram Group. 

 The 'Food and Drink'  Planogram Group has been given a 'Read' permission, with  
one of its child Planogram Groups being given a 'Deny' permission. Members of 
the User Group will be able to see planograms belonging directly to the 'Food 
and Drink' Planogram Group and to its 'Bakery', Fruit and Vegetables' and 
'Tinned 
Goods' child Planogram Groups. They will not be able to see planograms 
belonging to the 'Wines and Spirits' child Planogram Group. 

Configuring Access to the Planogram Hierarchy 

Configuring access to the planogram hierarchy is configured in two stages: 

 A User Group is assigned to a branch of the Planogram Hierarchy 

 'Read' or 'Deny' permissions are assigned. 

 

Assigning a User Group 

To assign a User Group to a Planogram Group: 

1. Highlight the Planogram Group in the Planogram hierarchy. 

2. Select the Add User Group option from the Toolbar or the Edit menu. 

3. The Add User Group dialog box will appear. 
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4. Check the required User Groups and click OK. 

5. It is now possible to assign 'Read' or Deny' permissions to those nodes in the 
Planogram Hierarchy. 

Setting 'Read' or Deny' Permissions 

To Set 'Read' or 'Deny'  permissions: 

1. Highlight the required Planogram Group in the Left Hand pane of the Planogram 
Tab of the Data Security dialog box. 

2. Highlight the associated User Group in the Right Hand pane of the Planogram Tab of 
the Data Security dialog box 

3. Right click to bring up the Permissions dialog box. 

 

4. Select either 'Allow Read' or Deny Read' to specify whether members of the user 
group can or cannot access the planograms in that Planogram Group and its 
Children. 
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Controlling Access with Multiple User Groups 

It is possible to use multiple user groups to control access to the Planogram Substitution 
functionality. This would be done by MSM users with access to the Administration 
Module and allows users to be given very specific access to the functionality. 

User Group Types for access to the Planogram Substitution Functionality 

There are two basic types of User Groups that determine the actions that a user can carry 
out within the Admin Module: groups with Roles set to Admin User and Groups with 
Roles that are not set to Admin User. The former can carry out bulk planogram 
substitutions; the latter cannot. These are configured in Functional Security. 

User Group Types for access to the Planogram Hierarchy 

Other User Groups can be created to control access to different parts of the planogram 
hierarchy. For example, User Groups could be created to control access to (a) Food and 
Drink, (b) Electrical and (c) Clothing planograms. Putting Users into specific User 
Groups controls their access to the hierarchy. This is configured in Data Security. 

Controlling Access 

Access is controlled by the cumulative privileges that the User inherits from the User 
Groups they belong to. It would be possible to set up two types of user groups to control 
access: 

   User groups to control access to the software. 

   User groups to control access to the planogram hierarchy. 

As an example, an Administrator might go into the User Groups tab in Functional 
Security and create the following two User groups: 

   Merchandise Manager - of User Group Type 'Admin User' 

   Merchandiser - of User Group Type 'Merchandiser User' 

Members of the first User Group can carry out bulk planogram substitutions; members of 
the second cannot. The administrator would then assign those two User Groups to 
Planogram Substitution in the Group Relationships tab. 

Similarly, an Administrator might go into the User Groups tab in Functional Security and 
create the following User groups: 

   Merchandiser - Food and Drink 

   Merchandiser - Electrical  

   Merchandiser - Clothing 

Membership of specific User Groups would confer access to planograms of that type. 
Having configured the User Groups in Functional Security, the Administrator would go 
to the Data Security module and assign 'read' permissions to the appropriate nodes in the 
planogram hierarchy - for example the 'Electrical' User Group would be assigned 'read' 
permissions to all nodes in the planogram hierarchy containing Planograms with 
electrical products. 

The Administrator can then put Users into the appropriate User Groups. 
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  Jane 
Doe 

John 
Smith 

William 
Brown 

Susan 
Green 

Merchandiser Manager X       

Merchandiser   X X X 

Merchandiser - Food and 
Drink 

X X X   

Merchandiser - Electrical X X   X 

Merchandiser - Clothing X X     

The Users will then have different privileges: 

   Jane Doe can define substitutions for all types of planograms and can run those 
substitutions either individually or in bulk. 

   John Smith can define substitutions for all types of planograms, but can only 
run those substitutions in opened store plans (i.e. individually). 

   William Brown can only define planogram substitutions for 'Food and Drink' 
planograms and can only run those substitutions in opened store plans. 

   Susan Green can only define planogram substitutions for 'Electrical' planograms 
and can only run those substitutions in opened store plans. 

Logging into Planogram Substitution  
This section describes how Users Log In to Planogram Substitution. 

Security Server 

Security Server is a background executable file (.exe) that starts and runs in the 
background when MSM is opened by a user. It holds details of the privileges that user 
has been granted in the Administration module. 

Note: Security Server can be seen in the Applications tab of 
the Windows Task Manager dialog box when Macro Space 
Management is running. 

If the User has already accessed another MSM module, then tries to access Planogram 
Substitution, the application will query Security Server to see if that specific User has 
permission to access the Planogram Substitution module. 

Logging In 

Planogram Substitution can be started from the Windows start menu, Windows desktop 
and from the Tools menu in MSM Planner and Merchandiser modules. 

 If another MSM application is running, the application will query Security server 
to see the User has the appropriate permissions to access Planogram 
Substitution. 

 If the User is opening Planogram Substitution as their initial MSM application, 
the Log In dialog box will appear. 
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 After the User has entered his User Name and Password and clicked OK, an 
instance of Security Server will open in the background and the Users 
permissions will be validated. 

Planogram Substitution Dialog Box 

Overview of Planogram Substitution Dialog Box 
The Planogram Substitution dialog allows users to manually control the planogram 
substitution process. 

 

Users can: 

 Add new planogram substitution definitions via the Planogram Definition dialog 
box or the Planogram Definition Assistant. 

 Edit existing planogram substitution definitions via the Planogram Definition 
dialog box. 

 Delete planogram substitution definitions. 

 Manually carry out 'dry runs' to test that the substitutions will run without 
problems. 

 View the 'dry run' log to see the results of the test. 

 Manually carry out planogram substitutions. 

 View the process log to see the results of planogram substitutions. 

Note: In order to manually bulk run planogram 
substitutions members must belong to a User Group with 
the User Group Role set to Admin User. 

The Planogram Substitution dialog box interacts with the Planogram Substitution 
Definition and Planogram Substitution Assistant dialog boxes as per the diagram below: 
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1. The Planogram Substitution Definition dialog box can be opened from the 
Planogram Substitution dialog box, either to add or to edit Planogram 
Substitutions. 

2. The Planogram Substitution Assistant dialog box can be opened from the Planogram 
Substitution dialog box as an aid to creating a new planogram substitution. On 
saving a Planogram Definition created in the Assistant, the data will be transferred to 
the Planogram Substitution Definition dialog box. 

3. The Planogram Substitution Assistant dialog box can also be opened from the 
Planogram Substitution Definition dialog box. The tab the Planogram Substitution 
Assistant opens in is dependent on where the user is within Planogram Substitution 
Definition dialog box. On saving a Planogram Definition edited in the Assistant, the 
data will be transferred to the Planogram Substitution Definition dialog box. 

4. On saving a planogram substitution that has been defined in the Planogram 
Substitution Definition dialog box, the summary information will be added or 
updated in the Planogram Substitution dialog box. 

Menus and Toolbars 

Menu Options 

Menu Option Icon Shortcut Key 

File New 
 

Ctrl + N 

  Open 
 

Ctrl + O 

  Exit    Alt + F4 

Edit Cut 
 

Ctrl + X 
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Menu Option Icon Shortcut Key 

  Copy 
 

Ctrl + C 

  Paste 
 

Ctrl + V 

  Delete 
 

Del 

  Select All   Ctrl + A 

  Find Next   F3 

View Dry Run Log... 
 

  

  Substitution Log... 
 

  

  Refresh 
 

Ctrl + F5 

Tools Substitution Assistant...  
 

  

  Run 
 

  

  Dry Run 
 

  

Help Contents 
 

F1 

Toolbar Options 

Option Icon Short Cut Key 

New 
 

Ctrl + N 

Open 
 

Ctrl + O 

Assistant 
 

Alt + F4 

Cut 
 

Ctrl + X 

Copy 
 

Ctrl + C 

Paste 
 

Ctrl + V 

Delete 
 

Del 

Run 
 

  

Dry Run 
 

  

Substitution Log... 
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Option Icon Short Cut Key 

Help 
 

F1 

 

Adding, Editing and Deleting Planogram Substitution Definitions 
Adding Planogram Substitution definitions can be done in one of two different ways: 

   By using the Planogram Substitution Definition dialog box 

   By using the Planogram Substitution Assistant 

Editing existing planogram substitutions can be carried out by using the Open option. 

Dialog Box Options 

Invoking the Planogram Substitution Definition dialog box 

 

Clicking the Add New Planogram Substitution Icon will open a blank Planogram 
Substitution Definition dialog box. Alternatively, users can select the New option from 
the File menu. 

 

Highlighting one or more planogram substitutions and clicking the Open Planogram 
Substitution icon will open those substitutions. Alternatively (after highlighting the 
required substitutions), users can select the Open option on the File menu. 

Note: If multiple planogram are selected for editing all tabs 
but the Substitution tab can be edited. The selected settings 
become common to all the planograms being edited. 

Calling the Planogram Substitution Assistant 
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Clicking the Planogram Substitution Assistant icon (or using the Assistant option on the 
Tools menu) will open a blank Assistant. This can then be used to define many parts of a 
new planogram Substitution. On saving a Planogram Definition created in the Assistant, 
the data will be transferred to the Planogram Substitution Definition dialog box. 

Deleting Planogram Substitutions 
Deleting Planogram Substitutions is carried out by highlighting them in the Planogram 
Substitution dialog box and then clicking the Delete option. Alternatively, the delete 
option can be used from the Edit menu. 

 

Cut, Copy and Paste Options 

The Cut, Copy and Paste options are used to delete planograms or to copy and paste a 
copy of a planogram. The Cut, Copy and Paste icons are on the toolbar: 

 

 Cut will delete any highlighted items while storing the information on the 
clipboard 

 Copy will place a copy of the information on the clipboard. 

 Paste places a copy of the information on the clipboard into the Planogram 
Substitution dialog box. 

The most common use of the copy and paste option is to create copies of existing 
planogram substitutions. The copies can then be edited as a quick way of producing 
alternative planogram substitutions. 

 

In the above example, a copy has been created of the Berlin planogram substitution. 
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Other Options 
There are several other options available to the user in the Planogram Substitution dialog 
box. 

Other Dialog Box Options 

Dry Run Option 

The Dry Run option can be invoked from the toolbar, or from the Tools menu. 

 

Dry Runs (and the associated Dry Run Log) can be used to validate any planogram 
substitutions that have been defined before they are run. 

Note: for more information see the chapter on the 
Planogram Substitution and the Dry Run Logs. 

Run Option 
The Run option allows Administrators to manually run single or multiple planogram 
substitutions. 

 

After a single or multiple planogram substitutions have been highlighted in the 
Planogram Substitution dialog box, clicking the Run option will cause these substitutions 
to be executed in the database. This provides an alternative to running planograms via a 
batch process. 

Note: In order to use the Run option, Users must belong to a 
User Group that has been assigned to the Admin User role in 
the Role drop down list. 
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Planogram Substitution Log 

The Planogram Substitution Log gives the results of all planogram substitutions that 
have been executed. It is opened by clicking the Planogram Substitution Log option on 
the toolbar. Alternatively, i t can be opened from the View menu. 

 

Note: for more information see the chapter on the 
Planogram Substitution and the Dry Run Logs. 

Find dialog box 

The find dialog box enables users to search for Planogram Substitutions using different 
filter criteria. It is opened by clicking the Find option on the toolbar. 

 

Note: for more information see the chapter on the Find 
dialog box. 

Selecting columns to display 

It is possible to select the columns to be displayed. To do this, right click in the list of 
planograms to bring up the right click menu. The columns to display can then be selected 
by checking or unchecking the required columns. 
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Planogram Substitution Definition Dialog Box 

Overview of Planogram Substitution Definition Dialog Box 
This section gives a brief overview of the Planogram Substitution Definition dialog box. 
The dialog box contains six tabs. 

 Substitution Tab 

 Rules Tab 

 Properties Tab 

 Stores Tab 

 Status Tab 

 Bays Tab 

These tabs can be used in any sequence, the results being saved back to the database by 
clicking the Save button. 

Note: The Substitution, Stores and Statuses tabs can be 
populated with the aid of the Planogram Substitution 
Assistant. 

Planogram Substitution Definition Dialog Box Pages 

There are six tabs within the Planogram Substitution dialog box. The purpose of each is 
briefly described in this section. 

The Substitution Tab 
The Substitution Tab holds details of the planograms that are to be removed (substituted) 
and their replacements. 
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Planograms to be substituted are specified in the top right hand pane, while the 
replacement planograms are specified in the bottom right hand pane. 

The Rules Tab 

The rules tab specifies the validation rules that will apply when carrying out the 
planogram substitution. 
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As well as validation rules, the user can also specify some of the notifications to be 
written to the Planogram Substitution error log when substitutions are being carried out. 

The Properties Tab 

The Properties tab has details of the dates the substitution is valid for. 
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As well as enabling the user to set the dates, the user can also set the Status and State of 
the planogram substitution. This tab also contains read only information on who created, 
modified and last ran the substitution. 

The Stores Tab 

The Stores Tab enables users to restrict the list of stores that the planogram will be 
carried out in. 
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The Status Tab 

The Status tab enables users to specify what statuses floor plans must be at for a 
planogram substitution to take place. 
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The Bays Tab 

The Bays Tab enables users to restrict the planogram substitution to specific bay numbers 
within floor plans. 



Tools and Logs 

Admin Merchandising 443 

 

The Planogram Substitution Assistant 
Some of the data in the Planogram Substitution Definition dialog box can be filled in with 
the aid of the Planogram substitution assistant. The Planogram Substitution Assistant can 
be used in one of two ways: 

 The Assistant can be invoked directly from the Planogram Substitution dialog 
box. When the Planogram Substitution Assistant is closed, the defined data will 
be transferred to the Planogram Substitution Definition dialog box. 

 The Assistant can also be invoked from the Planogram Substitution Definition 
dialog box. Data can then be refined in the Assistant with the data transferred to 
the Planogram Substitution Definition dialog box when the Assistant is closed. 

The following tabs in the Planogram Substitution Definition dialog box can be populated 
with data from the Planogram Substitution Assistant pages: 

Planogram 
Substitution Definition 
Tab 

Planogram Substitution Assistant Page 

Substitution tab Can be populated by the results of the Existing Planogram page, the 
Adjacent Planograms tab on the Adjacent Planograms page and the 
New Planograms page. 
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Planogram 
Substitution Definition 
Tab 

Planogram Substitution Assistant Page 

Status tab Can be populated by the results of the Status tab on the Adjacent 
Planograms page. 

Stores tab Can be populated by the results of the stores tab on the Adjacent 
Planograms page. 

 

Menus and Toolbar 
The following Menu and Toolbar options are available: 

Menu Options 

The following options are available from the menus. 

Menu Option Icon Shortcut Key 

File New 
 

Ctrl + N 

  Save 
 

Ctrl + S 

  Save As     

  Exit    Alt + F4 

Edit Cut 
 

Ctrl + X 

  Copy 
 

Ctrl + C 

  Paste 
 

Ctrl + V 

  Delete 
 

Del 

  Select All   Ctrl + A 

  Find 
 

  

Tools Substitution Assistant...  
 

  

  Add Existing 
 

  

  Add New 
 

  

  Reverse Substitution. 
 

Ctrl + R 

  Substitution Rule Test 
 

  

  Dry Run 
 

  

Help Contents 
 

F1 
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Toolbar Options 

The following options are available from the toolbar. 

Option Icon Short Cut Key 

New Definition 
 

Ctrl + N 

Save Definition 
 

Ctrl + S 

Planogram Substitution Assistant 
 

  

Cut 
 

Ctrl + X 

Copy 
 

Ctrl + C 

Paste 
 

Ctrl + V 

Find 
 

  

Add Existing Planogram 
 

  

Add New Planogram 
 

  

Add Store 
 

  

Delete 
 

  

Move planogram up in list  
 

  

Move planogram down in list 
 

  

Reverse planogram 
 

  

Validate substitution rules 
 

  

Dry Run 
 

  

Help Contents 
 

  

Substitution Tab 
The Substitution Tab is used to specify the planograms to be substituted (removed) and 
the planograms that will be used as their replacement. 

Description of the Substitution Tab 

The Substitution Tab has the following parts: 
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 The Menus contain a list of all actions available to the user. 

 The toolbar contains a more restricted list of actions available to the user. 

 The Definition Details gives the name and description of the current planogram 
substitution. 

 The Planogram Hierarchy contains the list of planograms available to the user. 

 The Planogram Properties contain details of a specific planogram. 

 The planograms that will be substituted (removed) are specified in the top right 
pane. 

 The planograms that will be their replacement are specified in the bottom right 
plane 

Using the Substitution Tab 

Planogram Hierarchy 

Two factors need to be taken into account when using the Planogram Hierarchy: 

 The Planogram Hierarchy will only contain the latest revision of a planogram for 
any given planogram lineage. 

 Which planograms are visible to a specific User will be governed by which User 
Groups they have been assigned to and what branches of the planogram 
hierarchy those User Groups have access to. 
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Note: i f the user has not been assigned access to any 
Planogram Groups in the Data Security dialog box (Security 
menu), then they will not be able to access any planograms 
when defining substitutions. 

Adding and Deleting Planograms 

Planograms can be added or removed from the pane specifying the planograms to be 
substituted (removed) and the planograms that are to be their replacement. Whether 
planograms are to be substituted or added as replacements will depend on which pane 
they are added to. 

There are several ways planograms can be added or deleted: 

 Planograms can be selected by dragging a planogram or a planogram group 
from the hierarchy and dropping it to the appropriate pane. 

 Planograms can be added to the appropriate pane by highlighting an item in the 
hierarchy and selecting the Add Existing Planogram option from the toolbar or 
Tools menu. 

 Planograms can be added to the appropriate pane by using the Find… option on 
the toolbar or Edit menu. 

 Planograms can be added to the appropriate pane by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

If a planogram group is selected from the hierarchy then all of the planograms that are 
direct descendants of the group will be added to the selection set. 

Reordering Planograms 

The list of planograms can be reordered by means of the up or down arrows on the 
toolbar. 

 The up and down toolbar options will be enabled when one or more consecutive 
rows are selected in the existing planograms list. They will be grayed out if the 
selected rows are not consecutive or no rows are selected. 

 Using the up or down arrows will promote or demote the selected rows in the 
sequence that planograms are substituted. The planogram at the top of the list 
will be substituted first, the next in the list second, etc.... 

Cut Copy and Paste Functionality 

The cut, copy and paste functionality has two main functions: 

1. To edit the list of Existing Planogram Substitutions. 

2. To transfer data to and from external applications. 

The list of existing planograms can be edited as follows: 

 Planograms can be added to the appropriate plane by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

 Planograms can be removed from the list of planograms by highlighting rows 
and using the Cut option. 

Data can be transferred to and from external programs (for example a spreadsheet) by: 

 Highlighting data in the Planogram Hierarchy, Properties Window or list of 
selected Planograms. Data can then be transferred to the Clipboard by means of 
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the Copy command. Once the external program (for example a spreadsheet) is 
open, the Paste command can be used within that program to enter the data. 

 Highlighting data in an external program (for example a report) and using the 
Copy command to transfer it to the Clipboard. Once in the Planogram 
Substitution 
Assistant, the Paste command can be used to add Planogram Names or 
Planogram Codes to the list of selected planograms. 

Revision Substitution 

If i t is desired to just carry out Revision Changes (update planogram designs, not change 
them) then it is possible to define a substitution without any planograms, but with the 
Revision Change check box checked. 

 

Note: If a planogram substitution has been defined, then 
Revision Substitution will automatically be carried out for all 
planograms in the selected stores. This is in addition to any 
substitutions that have been defined. 

Deleting Fixtures 

If a planogram is being removed because no replacement planogram is being substituted 
in, it is possible to delete the parent fixture(s ) as well as the planogram. This is done by 
checking the Delete Fixtures check box. 
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Rules Tab 
The Rules tab is used to set criteria used to validate the substitution. The rules are used 
twice for this purpose: 

 On exiting the Planogram Substitution Definition dialog box, the rules will be 
used to validate the substitution is valid. 

 On running the Planogram Substitution, the rules will be used to validate each 
successive substitution within a store plan. 

Description of the Rules Tab 

The Rules tab has the following parts: 
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 The menus contain all options available to the User. 

 The toolbars contain a more restricted list of options available to the User. 

 The Definition Details give the Name and Description of the Planogram 
Substitution Definition. 

 The Existing Planogram Validation specified whether adjacent planograms to 
those being substituted should be verified. 

 The Validation Rules enable the user to set how the planogram substitution is to 
be tested when it is saved and when it is carried out. 

 The Notifications give the options for writing messages to the error log. 

Description of Rules and Notifications 

This section describes the purpose of each rule or notification 

Each rule functions as follows: 

Planogram Adjacency (Existing Planograms) 

The existing planogram adjacency rule validates if all the existing planograms in the floor 
plan are calculated to be adjacent to the left or right. 

Length Rule (New Planograms) 

The length rule validates if the merchandisable length of the fixtures containing each 
successive profile (bay) in the existing planograms in the floor plan matches the 
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individual lengths for each successive profile of the new planograms as defined in the 
MSM planogram library. 

The length rule may be assigned a plus and minus tolerance by means of the spin 
controls. If a tolerance has been assigned, the planogram will place if the length defined 
for each successive bay of the planogram falls within the length range defined by the 
tolerances. 

Note: The default length tolerance is set by the 
PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE 
system variable in the System Variable dialog box accessed 
from the General Menu in the Admin Module. 

Depth Rule (New Planograms) 

The depth rule validates if the merchandisable depth of the fixtures containing each 
successive profile (bay) in the existing planograms in the floor plan matches the 
individual depth for each successive profile of the new planograms as defined in the 
MSM planogram library. 

The depth rule may be assigned a plus and minus tolerance by means of the spin 
controls. If a tolerance has been assigned, the planogram will place if the depth defined 
for each successive bay of the planogram falls within the length range defined by the 
tolerances. 

Note: The default length tolerance is set by the 
PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE 
system variable in the System Variable dialog box accessed 
from the General Menu in the Admin Module. 

Height Rule (New Planograms) 

The height rule validates if the merchandisable depth of the fixtures containing each 
successive profile (bay) in the existing planograms in the floor plan matches the 
individual height for each successive profile of the new planograms as defined in the 
MSM planogram library. 

The height rule may be assigned a plus and minus tolerance by means of the spin 
controls. If a tolerance has been assigned, the planogram will place if the height defined 
for each successive bay of the planogram falls within the length range defined by the 
tolerances. 

Note: The default height tolerance is set by the 
PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE 
system variable in the System Variable dialog box accessed 
from the General Menu in the Admin Module. 

Note: The Height rule does not currently take into account 
the effect of the ADDITIONAL_FIXTURE_HEIGHT system 
variable. 

If no offsets have been set for the merchandisable area for the fixture (Merchandisable 
Areas tab of the block Details dialog box) in Fixture Studio, the length, depth and height 
of the merchandisable area will match those of the fixture. If offsets have been used, the 
length, depth and height of the merchandisable area will differ from the fixture 
dimensions. 

Fixture Style (New Planograms) 
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The fixture style rule validates if the styles assigned to the fixtures containing each 
successive profile (bay) in the existing planograms in the floor plan match the fixture 
styles for each successive profile of the new planograms as defined in the MSM 
planogram library. 

Splittable Rule (New Planograms) 
The splittable rule deals with two cases: 

 If a planogram that is being substituted into the drawing is not defined as 
splittable, the software will validate that all the fixtures containing the existing 
planogram(s) in the store plan that are to be substituted by the new planogram 
are adjacent to the left or right of each other and are co-linear. 

 If a planogram that is being substituted into the drawing is defined as splittable, 
the software will allow it to be placed on non-adjacent fixtures. 

Note: For the splittable rule to be validated correctly, the 
Fixture Adjacency Calculations must be up to date for the 
store plan that the planogram substitution is to be carried 
out in. There are two ways of achieving this: By running the 
Fixture Adjacency Calculation manually within a specific 
store plan or by running the Fixture Adjacency Calculation 
throughout the entire database via a batch process. 

Temperature Range (New Planograms) 

The temperature range rule validates if each temperature ranges of the fixtures 
containing the existing planograms in the floor plan that are to contain a whole new 
planograms overlap the temperature range of the new planogram as defined in the MSM 
planogram library. 

The validation options are used when the planogram substitution is run. They specify the 
warning messages that will be written to the error log. They will only be used if the 'All 
Stores' check box has been unchecked on the Stores tab. 

Existing Planogram not found in Floor Plan 

The existing planogram rule will log a warning if all the existing planograms are not in 
the floor plan and the 'All Stores' check box has been unchecked on the Stores tab. 

Floor Plan not found in Store 

The floor plan rule will log a warning if at least one floor plan was not found for each 
store and the 'All Stores' check box has been unchecked on the Stores tab. 

Note: If the All Stores check box is checked on the Stores 
Tab, no warnings will be generated. 

Settings in the rules tab determine how detailed a validation the planogram substitution 
will be subjected to. 

The 'All Rules' Check Box 

The All Rules check box has three states: 

1. Checked 

Checking the All Rules tick box will check all the rules tick boxes and so enable all 
the rules. The All Rules tick box will also automatically change to checked when all 
the individual rules tick boxes have been checked. 
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2. Unchecked 

Unchecking the All Rules tick box will uncheck all the rules tick boxes and so disable 
all the rules. The All Rules tick box will also automatically change to unchecked 
when all the individual rules tick boxes have been unchecked. 

3. Indeterminate  

The All Rules tick box will be set to indeterminate when some of the individual rules 
tick boxes are checked and some are unchecked. 

Individual rules can be set or deselected by ticking the individual check boxes. The 
state of the All Rules check box will be changed automatically depending on whether 
all, no or some rules are selected. 

Copy and Paste Options 

The copy and paste options provide an easy way to transfer a set of rules from one 
Planogram Substitution Definition to another. 

   Selecting the copy option on the toolbar, Edit menu or using the Ctrl+C shortcut 
key will copy the details of the checked rules to the Windows clipboard. 

   Selecting the paste option on the toolbar, Edit menu or using the Ctrl+V 
shortcut key will copy the rules currently copied to the windows clipboard and 
check the settings in the Rules tab accordingly. 

Exiting the Rules Tab 
On leaving the Rules tab, the software will test if any rules have been selected. If no rules 
are selected, two warnings will be given: 

   A Warning Icon will be displayed on the Rules tab itself. 

   The message "No rules selected" will be displayed on the status bar. 

Properties Tab 
The Properties tab holds information on the dates the planogram substitution definition 
is valid for, together with its Status and State. 

Description of the Properties Tab 

The Properties tab has the following parts: 
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 The menus contain all options available to the User. 

 The toolbars contain a more restricted list of options available to the User. 

 The Definition Details give the Name and Description of the Planogram 
Substitution Definition. 

 The Substitution details enable the user to set dates the planogram substitution is 
valid between. 

Using the Properties Tab 

Settings in the Properties tab determine when and how the planogram substitution will 
run. 

Execution Date 

The Execution Dates can be set using the date time picker to any date equal to the current 
date or to a date in the future. The definition will be able to be run during the inclusive 
period set by the execution dates, i.e. when the current date is equal to or less than the 
first execution date and the current date is equal to or less than the execution date. 
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Floor Plan Effective Date 

The Floor Plan Effective dates can be set using the date time picker to any date equal to 
the current date or to a date in the future. They are used in two circumstances: 

 When planogram substitutions are being made into files of Authorized status. 

 When planogram substitutions are being made into files of Current status and 
files are being cloned. 

When planogram substitutions are made into files of Authorized status, the Effective 
Date of the file must fall within the range of dates specified in the Floor Plan Effective 
Date or no substitutions will be made. 

For planogram substitutions to be carried out on files of Current status, the 
PLANOGRAN_SUBSTITUTION_COPY_FILE system variable must be set to On (1). The 
substitutions will then be carried out in an existing file of Authorized status if the 
Effective Date of the file falls within the range of dates specified in the Floor Plan 
Effective Date. If no such Authorized file exists, then one will be created in the same 
revision as the Current file with an Effective date matching the earliest date in the Floor 
Plan Effective Date. 

Status 

The Planogram Substitution Status drop down list enables users to show where the 
Planogram Substitution Definition is in the business work flow. 

Note: Statuses are configurable in the Administration 
module. This section of the help file describes the default 
statuses supplied with the application. 

The default statuses set up with the application are: 

Status Comment 

WIP (Work in 
Progress) 

Planogram Substitution Definition being developed 

Proposed Planogram Substitution Definition ready for approval 

Authorized Approved Planogram Substitution Definition - when this status is reached the 
Planogram Substitution Definition will be set to 'Read Only' and no further 
changes will be possible. 

Rejected Rejected Planogram Substitution Definition 

Statuses can be changed in one of two ways: 

 Manually, by changing the status using the drop down list in the Status Tab. In 
this case, only the statuses before and after the currently set status will be 
available for selection. 

 Via a dialog box that appears when exiting the tab. 

If a User manually changes the s tatus before exiting the tab, they will be allowed to exit 
the tab without the Submit or Approval dialog boxes appearing. If the User has not 
manually changed the status, the Submit or Approval dialog box will appear depending 
on the currently set status for the Planogram Substitution. 
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Priority 

The priority spin control can be used to set priorities for executing Planogram 
Substitutions when being run as a batch process. The priority will determine which 
definition is run first if more than one definition is to be executed on the same date. 
Priority 1 will run first, followed by Priority 2, etc. Each priority must be unique. If the 
execution priority is set to the same value as another definition then the existing 
priorities will be incremented by one to ensure they remain unique. 

For example if the Priority is set to 3 and there is an existing Priority 3, the existing 
priority will be changed to 4. 

Run Once 

The Run Once flag enables user to specify whether the planogram substitution will run 
once only, or will run all the time the Execution Date is valid. Checking the tick box 
ensures the substitution will only be executed once. 

The information below is displayed 'Read only' depending on the current information in 
the database. 

State 

The State List shows the current condition of the planogram substitution. 
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State Comment 

Ready The Planogram Substitution is ready to execute. 

Running The Planogram Substitution is currently executing  

Stopping The Planogram Substitution is currently running but a manual or batch command has 
been issued to stop/terminate the substitutions. 

Stopped The Planogram Substitution was running but was stopped by means of a manual or 
batch command. 

Pausing The Planogram Substitution is currently running but a manual or batch command has 
been issued to pause the substitutions. 

Paused The Planogram Substitution was running but was paused by means of a manual or 
batch command. 

Finished The Planogram Substitution has been run to completion. 

The state can only be changed by users with Admin privileges and indicates whether the 
substitution definition has been run or is in the process of being run. 

Created By 

This field shows the name of the MSM User that first saved the planogram substitution 
definition. 

Created Date 

This field shows the date and time when the planogram substitution definition was first 
saved. 

Last Modified By 
This field shows the name of the MSM User that last saved the planogram substitution 
definition. 

Last Modified Date 

This field shows the date and time when the planogram substitution definition was last 
saved. 

Last Run By 

This field shows the name of the MSM User that last ran the planogram substitution 
definition. This could be a User running a substitution from within a store plan, an 
Administrator manually running an entire batch of substitutions, or an Administrator 
running substitutions via a batch process. 

Last Run Date 

This field shows the date and time when the planogram substitution definition was last 
run. 

Status Tab 
The Status tab is used to select File Statuses that floor plans must be at in order for 
planograms to be substituted. 

Description of the Status Tab 
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The Status tab is used to select the statuses of the floor plans that will have planogram 
substitutions carried out on them. 

 

 The menus contain all options available to the User. 

 The toolbars contain a more restricted list of options available to the User. 

 The Definition Details give the Name and Description of the Planogram 
Substitution Definition. 

 The Status check boxes enable the user to specify the statuses for floor plans the 
planogram substitution is to be carried out in. 

Using the Status Tab 

The Status tab contains a list of statuses for files. These are read from the database and 
may be different for specific implementations of Macro Space Management. 

   Historical Status is not shown as this represents store plans that have been 
taken out of service. 

   Authorized Status will be checked by default. 
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   Current status will only be visible if the 
PLANOGRAM_SUBSTITUTION_COPY_FILE System Variable is set to on. If this 
system variable is set to On, files will be cloned as required. 

Statuses can be selected by means of the check boxes. A minimum of one status must be 
selected. 

Stores Tab 
The Stores Tab can be used to refine the list of stores that the substitution will be carried 
out in. 

Description of the Stores Tab 
The Stores tab contains two panes. On the left is the store hierarchy showing all possible 
stores that the substitution can take place in. On the right are the stores that have been 
excluded from the substitution. 

 

 The menus contain all options available to the User. 
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 The toolbars contain a more restricted list of options available to the User. 

 The Definition Details give the Name and Description of the Planogram 

 The Validation Rules enable the user to set how the planogram substitution is to 
be tested when it is saved and when it is carried out. 

 The Notifications give the options for writing messages to the error log. 

Using the Stores Tab 

The Stores tab initially populates with a list of all stores that the planogram substitutions 
are to be carried out in. This list is determined by the settings in the Status Tab. It may be 
necessary to make the Planogram Substitution store specific. This is because not all stores 
have the same arrangement of planograms. When the tab is opened, the All Stores check 
box can be checked to ensure that the planogram substitution is carried out in all selected 
stores. Alternatively, the check box can be unchecked, allowing users to make the 
planogram substitution store specific. Initially all stores are selected and are in the 
hierarchy on the left. Moving stores to the pane on the right deselects them from the list 
of stores the substitution will be carried out in. There are several ways of achieving this: 

 Stores can be deselected by dragging a store or a cluster from the hierarchy and 
dropping it to the list view on the right-hand side of the store specific group. 
When a cluster is selected from the hierarchy then all of the stores that are 
descendants of the cluster will be deselected. 

 Stores can be deselected by highlighting an item in the hierarchy and pressing 
the store toolbar button. When a cluster is selected from the hierarchy then all of 
the stores that are descendants of the cluster will be deselected. 

 Using the Find option to deselect stores. 

Bays Tab 
The Bay Numbers tab allows Users to specify bay numbers as a further filter for 
planogram substitutions. 

Note: For the bay tab to be operative, bay numbers must first 
have been assigned to fixtures in the Planner Module. 

Description of the Bays Tab 
The Bays Tab consists of the tab itself, and the Bays dialog box that can be called from it. 
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 The menus contain all options available to the User. 

 The toolbars contain a more restricted list of options available to the User. 

 The Definition Details give the Name and Description of the Planogram 
Substitution Definition. 

 The Bays dialog box enables users to call the Bays dialog box. 

 The selected Bay Numbers is a list of bay numbers that the planogram must 
occupy. 

Bays Dialog Box 

The Bays dialog box enables users to select from the list of available bays. 
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Note: Users should be aware that bay numbers may differ 
from drawing to drawing. Depending on how Bay 
Numbering has been implemented, Bay A1 in one drawing 
may not be in the same location in another drawing. 

Using the Bays Tab 

How the Bays tab operates will depend on the setting of the All/Bay Numbers/Fixture 
Identifier radio button. Only one method can be used within a specific planogram 
definition. 

1. If the Radio Button is set to All, planograms will be substituted irrelevant of which 
bay they are placed on in a floor plan. 

2. If the Bay Numbers radio button has been selected then existing planograms will 
only be substituted if they are placed on an appropriately bay numbered fixture in a 
floor plan. 

3. If the Fixture Identifier radio button has been selected then existing planograms will 
only be substituted if they are placed on an appropriately numbered fixture in a floor 
plan. 

Note: Fixture Numbers can be seen in the Merchandiser 
module, or in In-Store Space collaboration. Alternatively 
they could be identified from a report. 
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All Bays 

If the All  Bays radio button is selected, the Bay Numbers and Fixture Identifier options 
will be grayed out and unavailable. 

Bay Numbering 

If the Bay Numbers radio button is selected, the Fixture Identifier option will be grayed 
out and unavailable, while the Bay Numbers option will be available. There are two ways 
to add Bay Numbers to the list of bay numbers: 

1. By typing in the required Group Name and Numbers into the Group Name and 
Number text boxes and clicking the Add icon. (Numbers can be entered as a range 
separated by a hyphen: for example 5 -23). 

2. By clicking on the button with ellipses to open the Bays dialog box, highlighting a 
row and clicking the OK button. 

Fixture Identifiers 

If the Fixture Identifier radio button is selected, the Bay Numbers option will be grayed 
out and unavailable, while the Fixture Identifiers option will be available. Fixture 
identifiers must be added manually - the identifiers text box will accept a list of comma 
separated numbers and number ranges where number ranges are connected by a 
hyphen, e.g. 5012-5211. 

Planogram Substitution Assistant 

Overview of Planogram Substitution Assistant 
The Planogram Substitution Assistant aids users to set up Planogram Substitution 
Definitions. It can be accessed from: 

 The Substitution Assistant option on the tools menu or the toolbar of the 
Planogram Substitution dialog box. If selected in this manner, the Assistant will 
be blank and all information will have to be entered. 

 The Substitution Assistant option on the tools menu or the toolbar of the 
Planogram Substitution Definition dialog box. If selected in this manner, the 
Assistant may be partially populated with data. 

The Planogram Substitution Assistant works in three broad stages. 
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1. The initial stage is to select a planogram (or planogram) as the basis for the 
substitution. This is done using the Existing Planograms page of the Assistant. 

In the above example, the 8 foot planogram 'A'  has been selected. 

2. The second stage is to select any adjacent planograms it is desired to include in the 
substitution. This is done using the Adjacent Planograms page of the Assistant. In the 
above example, the 12 foot planogram 'B' and the 4 foot planogram C have been 
selected as suitable for replacement and adjacent to planogram 'A'. The purpose of 
this is to allow the user to expand the area available to substitute planograms in. If 
adjacent planograms have a low Planogram Financial Weighting score, i t may be 
sensible to include those in the list of planograms to be substituted. 

3. The final stage is to select the replacement planograms. This is done using the New 
Planograms page of the Assistant. 

In the above example the 8 foot planogram 'D', the 4 foot planogram 'E' and the 12 
foot planogram 'F' have been selected to replace the original planograms 'A' , 'B' and 
'C'. 

Note: The Assistant also enables users to select the floor plan 
statuses and stores the substitutions will be valid for. 

On completion of the steps within the Planogram Substitution Assistant the user will be 
taken to the Planogram Substitution Definition dialog box, which will have been 
populated with information from the Planogram Substitution Assistant. 

Planogram Substitution Assistant Pages 

The Planogram Substitution assistant consists of three pages. Users can move through 
these pages using the next or back buttons in the lower right corner. Each successive page 
assists users with one or more aspects of defining a planogram substitution. 

First Page - Existing Planograms 
The Existing Planogram page allows users to manually select the planograms that will 
substituted. 
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Users can select or deselect planograms for substitution and change the order in which 
they will be substituted. Clicking the Next button takes users onto the next page where 
the Assistant will open in the Status tab. 

Second Page - Status Tab 

The Status Tab enables the user to select the file statuses that the planogram substitution 
will operate on. Current status will only be visible if the 
PLANOGRAM_ SUBSTITUTION_COPY_FILE System Variable is set to On. 

 

Clicking the Next button will take the user onto the Adjacent Planograms tab. 

Second Page - Adjacent Planogram Tab 

The Adjacent Planogram page enables users to select planograms that are to the left, right 
or sharing the same fixture as the planograms selected in the Existing Planogram page. 
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Clicking the next button will take the user onto the New Planogram page - to go to the 
stores tab, click manually on it. 

Second Page - Stores Tab 

The stores tab enables users to select the stores that the planogram substitutions will be 
carried out in. 

 

Note: This dialog box works in the reverse sense from the 
Planogram Substitution Definition dialog box. The stores the 
planogram substitution will be carried out are in the left 
hand pane. 

Click manually on the Adjacent Planograms tab and then click the Next button to go to 
the New Planograms page. 

New Planogram Page 
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The New Planogram page enables the user to select the planograms that will replace the 
planograms to be substituted. 

 

After the required new planograms have been selected, clicking the Finish button will 
take the user to the Planogram Substitution Definition dialog box. 

Opening Status of Planogram Substitution Assistant 
The Planogram Substitution Assistant can be opened from either the Planogram 
Substitution dialog box or the Planogram Substitution Definition dialog box. Which page 
the Assistant opens in will be determined by the information already defined in the 
Planogram Substitution. 

1. If no existing planograms have been selected then the Existing Planograms window 
will be displayed. 

2. If existing planograms have been set but no new planograms have been defined then 
the adjacent planograms window will be displayed. 

3. If both existing planograms and new planograms have been set then the new 
planograms window will be displayed. 

Adjacency Calculations 

Prior to using the Planogram Substitution Assistant, two forms of Adjacency calculation 
should have been run: 

1. Fixture Adjacencies  

2. Product Adjacencies  

If planogram substitutions are only to be carried out in a few drawings, Fixture and 
Product Adjacencies can be run manually using the options from the Calculation menu 
or toolbar. If a large number of drawings are to have planogram substitutions made, then 
running the Fixture and Product Adjacencies as a batch process may be the most effective 
may of preparing to use the Planogram Substitution Assistant. 
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Note: If Fixture and Product Adjacencies are not run, the 
results displayed in the Adjacent Planograms tab of the 
Planogram Substitution Assistant may not be accurate. 

Existing Planogram Page 
The Existing Planogram enables users to add or remove planograms from the list of those 
to be substituted. 

 

Description of the Existing Planogram Page 

The New Planogram Page consists of a number of parts. 

 The Toolbar contains the options available to the User 

 The Planogram Hierarchy contains the list of planograms available for selection 
for substitution 

 The Planogram Properties window shows properties for the planogram currently 
highlighted in the Planogram Hierarchy. 

 The Planograms for Substitution contains the list of planograms that will be 
substituted for by fresh planograms when a planogram substitution is run. 

The toolbar contains the following options: 

Icon Option 

 

Cut 

 

Copy 

 

Paste 

 

Find 

 

Add Planogram to List 

 

Delete Planogram from List 
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Icon Option 

 

Promote Planogram in List 

 

Demote Planogram in List 

 

Help 

Using the Existing Planogram Page 

Opening status of the Existing Planogram Page 

The Planogram Substitution Assistant will open in the Existing Planogram page if no 
planograms have been defined as suitable for substitution. 

Planogram Hierarchy 

Two factors need to be taken into account when using the Planogram Hierarchy: 

 The Planogram Hierarchy will only contain the latest revision of a planogram for 
any given planogram lineage. 

 Which planograms are visible to a specific User will be governed by which User 
Groups they have been assigned to and what branches of the planogram 
hierarchy those User Groups have access to. (This is configured in the 
Administration module). 

Adding and Deleting Planograms 

There are several ways planograms can be added or deleted: 

 Planograms can be selected by dragging a planogram or a planogram group 
from the hierarchy and dropping it to the existing planograms list on the right-
hand side of the existing planograms window. 

 Planograms can be added to the existing planograms list by highlighting an item 
in the hierarchy and selecting the Add Existing Planogram option from the 
toolbar. 

 Planograms can be added to the existing planograms by using the Find… option 
on the toolbar. 

 Planograms can be added to the existing planograms by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

If a planogram group is selected from the hierarchy then all of the planograms that are 
direct descendants of the group will be added to the selection set. 

Reordering Planograms 

The list of planograms can be reordered by means of the up or down arrows on the 
toolbar. 

 The up and down toolbar options will be enabled when one or more consecutive 
rows are selected in the existing planograms list. They will be grayed out if the 
selected rows are not consecutive or no rows are selected. 

 Using the up or down arrows will promote or demote the selected rows in the 
sequence that planograms are substituted. The planogram at the top of the list 
will be substituted first, the next in the list second, etc.... 
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Cut Copy and Paste Functionality 

The cut, copy and paste functionality has two main functions: 

 To edit the list of Existing Planogram Substitutions. 

 To transfer data to and from external applications. 

Editing the list of Existing Planograms 

The list of existing planograms can be edited as follows: 

 Planograms can be added to the existing planograms by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

 Planograms can be removed from the list of existing planograms by highlighting 
rows and using the Cut option. 

Transferring Data to and from External Programs 

Data can be transferred to and from external programs (for example a spreadsheet) by: 

 Highlighting data in the Planogram Hierarchy, Properties Window or list of 
existing Planograms. Data can then be transferred to the Clipboard by means of 
the Copy command. Once the external program (for example a spreadsheet) is 
open, the Paste command can be used within that program to enter the data. 

 Highlighting data in an external program (for example a report) and using the 
Copy command to transfer it to the Clipboard. Once in the Planogram 
Substitution Assistant, the Paste command can be used to add Planogram Names 
or Planogram Codes to the list of existing planograms. 

The Next Button 

The Next button will not be enabled until there is at least one planogram in the existing 
planograms list. 
Once the Next button is enabled, clicking it will take the User to the Adjacent Planograms 
Page - the next stage in the Planogram Substitution Assistant. 

Adjacent Planogram Page 
The adjacent Planogram page is used to expand the selection of planograms. Examples of 
why the selection might need to be extended are: 

   A specific planogram is performing well and it has been decided to expand the 
amount of fixturing allocated to that type of merchandise. 

   A specific planogram is performing poorly and it has been decided to replace 
that planogram and any adjacent planograms with alternative merchandise that 
will generate more profit. 

   The store is being reorganized and it has been decided to replace one form of 
merchandise with another. 

Description of the Adjacent Planogram Page 

The Adjacent Planograms page has three tabs. These are intended to be used in sequence: 

1. Statuses - select the store plan statuses that adjacencies will be found in 

2. Adjacent Planograms - list adjacent planograms and allow the user to select them 

3. Stores - select the store plans that adjacencies may exist in. 
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The Statuses Tab 

The Status tab is used as a filter to determine which statuses floor plans will be checked 
for planograms that are adjacent to the existing planograms selected for substitution. 

 

The Status tab contains a list of statuses for files. These are read from the database and 
may be different for specific implementations of Macro Space Management. 

 Historical Status is not shown as this represent store plans that have been taken 
out of service. 

 Authorized Status will be checked by default. 

For example, if the user has selected Authorized status, only planogram adjacencies in 
store plans of that status will be reported. 

Note: Current status will only be visible if the 
PLANOGRAM_SUBSTITUTION_COPY_FILE system 
variable is set to On (1). 

Statuses can be selected by means of the check boxes. A minimum of one status must be 
selected before the Next button is enabled and the User can move on to the Adjacent 
Planograms page. When the Next button is pressed, the list of Adjacent Planograms will 
be populated in the Adjacent Planograms page using the selected statuses as a filter for 
which store plans are to be checked. 

The Adjacent Planograms Tab 

The Adjacent Planograms tab allows users to select additional planograms bordering the 
original planogram(s) selected for substitution. Adjacencies will be established for all 
store plans with file statuses selected in the Status tab. 
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Planograms are selected for substitution by means of the check boxes. 

 The Main planogram is the original planogram selected for substitution. 

 A planogram with an adjacency of Left is to the left of the main planogram. 

 A planogram with an adjacency of Right is to the right of the main planogram. 

 A planogram with an adjacency of Same shares the same fixture as the main 
planogram. 

Selecting adjacent planograms for substitution allows users to expand the area that 
planograms will be substituted into. A good way of determining whether it is 
appropriate to expand the selection is the Score (Planogram Substitution financial 
weighting). A low score indicates the products on the adjacent planograms are not selling 
well, a high score the converse. Care needs to be taken in understanding how adjacent 
planograms are generated. 

 

In the above example, the existing planogram is A. In store 1, planograms B and C are 
adjacent to it. In store 2, planograms D and E are adjacent to it. The Adjacent Planograms 
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tab will show Planogram A (the main planogram) as having Planograms B, C, D and E 
adjacent to it. 

Two separate Planogram Substitution definitions will be required to substitute these 
planograms: 

–   Planogram A, with its adjacent Planograms B and C will require one 
definition 

–   Planogram A, with its adjacent Planograms B and C will require another. 

Determining which adjacent planograms are valid to add for a substitution may require 
inspection of the data. 

 If only a single 'Existing Planogram' is selected, if all planograms are the same in 
all selected store plans, there will only be one planogram adjacent to the left and 
one to the right. (With possibly another planogram with 'Same' adjacency). More 
than this number of adjacent planograms suggests that the planograms adjacent 
to the 'Existing Planogram' may vary from store plan to store plan. 

 If multiple 'Adjacent Planograms' exist, inspection of the number of stores plans 
that a planogram is in will give information on how frequently that adjacency 
occurs. 

There are two ways further information can be obtained: 

 On completing the Planogram Substitution Assistant, the User will be taken to 
the Planogram Substitution Definition dialog box. Clicking the Dry Run option 
will produce a report showing which substitutions are successful and which 
were not. This will allow specific store plans in which this Planogram 
Substitution is valid to be identified. 

 Alternatively, the User can complete the Planogram Substitution Assistant, save 
the resulting Planogram Substitution Definition and then go to the Planogram 
Substitution dialog box. Clicking the Dry Run option will produce a global report 
showing which substitutions are successful and which were not. This will allow 
Planogram Substitutions to be refined by being made more store specific. 

Once the required adjacent planograms have been selected, the User has two options: 

 If the User clicks the Stores tab they will be taken to the stores tab to restrict the 
Planogram Substitutions to specific stores. 

 If the User clicks the Next button they will be taken to the New Planograms 
page. 

The Stores Tab 

The Stores tab is used to further restrict which stores planograms will be substituted in. 
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Stores can be deselected by dragging and dropping them from the Store hierarchy to the 
right hand pane. After the list of stores that substitutions will be carried out in has been 
modified, Users should return to the Adjacent Planograms tab to see that the selected 
planograms are still available for substitution. 

Note: This dialog box works in the reverse sense from the 
Planogram Substitution Definition dialog box. The stores the 
planogram substitution will be carried out in are in the left 
hand pane. 

The Stores tab initially populates with a list of all stores that the planogram substitutions 
are to be carried out in. This list is determined by the settings in the Status Tab. After any 
required adjacent planograms have been defined in the Adjacent Planogram tab, it may 
be necessary to make the Planogram Substitution store specific. This is because not all 
stores have the same arrangement of planograms. 

The Adjacent Planogram Page 

When the tab is opened, the 'All stores where planogram adjacency found' check box can 
be checked to ensure that the planogram substitution is carried out in all selected stores. 

Alternatively, the checkbox can be unchecked, allowing users to make the planogram 
substitution store specific. Initially all stores are selected and are in the hierarchy on the 
left. Moving stores to the pane on the right deselects them from the list of stores the 
substitution will be carried out in. There are several ways of achieving this: 

 Stores can be deselected by dragging a store or a cluster from the hierarchy and 
dropping it to the list view on the right-hand side of the store specific group. 
When a cluster is selected from the hierarchy then all of the stores that are 
descendants of the cluster will be deselected. 

 Stores can be deselected by highlighting an item in the hierarchy and pressing 
the store toolbar button. When a cluster is selected from the hierarchy then all of 
the stores that are descendants of the cluster will be deselected. 

 Using the Find option to deselect stores. 
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Stores that have been added to the selection set will be grayed out in the hierarchy. If the 
stores that have been deselected contain all examples of a particular type of adjacent 
planogram, that planogram will no longer show as adjacent when the user reverts to the 
Adjacent Planogram tab. 

When the store hierarchy has been modified as required, the user must return to the 
Planogram Adjacencies tab, where clicking the Next button will take them to the New 
Planograms tab. 

New Planograms Page 
The New Planograms Page allows Users to select the planograms that will be the 
replacement for the planograms that have been selected for substitution. 

Description of the New Planograms Page 

The New Planograms page is used to specify the planograms that will replace those 
selected for substitution. 

 

 The Toolbar contains the options available to the User 

 The Planogram Hierarchy contains the list of planograms available for selection 
for substitution 

 The Planogram Properties window shows properties for the planogram currently 
highlighted in the Planogram Hierarchy. 

 The Planograms for Substitution contains the list of planograms that will be 
substituted for by fresh planograms when a planogram substitution is run. 

 The Planograms to Be Added contains a list of the planograms that will replace 
the substituted planograms. 

The toolbar contains the following options: 
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Icon Option 

 

Cut 

 

Copy 

 

Paste 

 

Find 

 

Add Planogram to List 

 

Delete Planogram from List 

 

Promote Planogram in List 

 

Demote Planogram in List 

 

Help 

Using the New Planogram Page 

Opening status of the New Planogram Page 

The Planogram Substitution Assistant will show in the New Planogram page existing 
planograms that have been designated for substitution and any associated adjacent 
planograms. 

Planogram Hierarchy 

Two factors need to be taken into account when using the Planogram Hierarchy: 

 The Planogram Hierarchy will only contain the latest revision of a planogram for 
any given planogram lineage. 

 Which planograms are visible to a specific User will be governed by which User 
Groups they have been assigned to and what branches of the planogram 
hierarchy those User Groups have access to. 

Adding and Deleting New Planograms 

Note: Only New Planograms can be added or deleted in this 
page. To change the list of Existing Planograms, Users must 
go back to the Existing Planograms tab. 

There are several ways planograms can be added or deleted: 

 Planograms can be selected by dragging a planogram or a planogram group 
from the hierarchy and dropping it to the new planograms list on the right-hand 
side of the existing planograms window. 

 Planograms can be added to the new planograms list by highlighting an item in 
the hierarchy and selecting the Add Existing Planogram option from the toolbar 
or Tools menu. 

 Planograms can be added to the new planograms by using the Find… option on 
the toolbar or Edit menu. 
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 Planograms can be added to the new planograms by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

If a planogram group is selected from the hierarchy then all of the planograms that are 
direct descendants of the group will be added to the selection set. 

Reordering New Planograms 

The list of new planograms can be reordered by means of the up or down arrows on the 
toolbar. 

 The up and down toolbar options will be enabled when one or more consecutive 
rows are selected in the existing planograms list. They will be grayed out if the 
selected rows are not consecutive or no rows are selected. 

 Using the up or down arrows will promote or demote the selected rows in the 
sequence that planograms are substituted. The planogram at the top of the list 
will be substituted first, the next in the list second, etc.... 

Cut, Copy and Paste Functionality 
The cut, copy and paste functionality has two main functions: 

 To edit the list of New Planograms. 

 To transfer data to and from external applications. 

Editing the list of Existing Planograms 

The list of existing planograms can be edited as follows: 

 Planograms can be added to the new planograms by using the paste option to 
paste in a planogram name or planogram code. The rest of the row of data will 
populate automatically. 

 Planograms can be removed from the list of new planograms by highlighting 
rows and using the Cut option. 

Transferring Data to and from External Programs 
Data can be transferred to and from external programs (for example a spreadsheet) by: 

 Highlighting data in the Planogram Hierarchy, Properties Window or list of new 
Planograms. Data can then be transferred to the Clipboard by means of the Copy 
command. Once the external program (for example a spreadsheet) is open, the 
Paste command can be used within that program to enter the data. 

 Highlighting data in an external program (for example a report) and using the 
Copy command to transfer it to the Clipboard. Once in the Planogram 
Substitution Assistant, the Paste command can be used to add Planogram Names 
or Planogram Codes to the list of new planograms. 

The Finish Button 
The Finish button will not be enabled until there is at least one planogram in the new 
planograms list. 

Once the Finish button is enabled, clicking it will take the User to the Adjacent 
Planograms Page - the next stage in the Planogram Substitution Assistant. 
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Find Dialog Box 

Introduction to Find Dialog Box 
This section of the User Guide describes the Find dialog box. There are two variants: 

 Find dialog box in the Planogram Substitution dialog box allowing users to 
identify specific planogram substitutions. 

 Find dialog box on the Planogram Substitution Definition and Planogram 
Substitution Wizard dialog boxes enabling users to identify stores and 
planograms. 

In addition Administrators have the option of using a Custom SQL statement to set up a 
customized search. 

Note: These dialog boxes are essentially the same. When 
called in the Planogram Substitution dialog box, there is no 
results tab because results are highlighted in the list of 
available planogram substitutions. When called in the 
Planogram Substitution Definition and Planogram 
Substitution Wizard dialog boxes, a results tab allows users 
to manually select from within a result set. 

Find Dialog Box - Planogram Substitution Dialog Box 
The Find functionality in the Planogram Substitution dialog box consists of a text box for 
the search text, a Find icon to initiate the search and a Find Options drop down option to 
set the filters for the find operation. 

 

The sequence of operations is: 

1. Set the Filters in the Find dialog box (Find Options) 

2. Enter the text string in the Search text box 

3. Click the find icon 

4. The first matching result in the list of planogram substitutions will be highlighted. 

5. Successive clicks of the Find icon will step through the other matching results. 

Find Options (Filters) 

The Find Options allow the user to set filters by which to filter results obtained. There are 
two tabs: 

 Search tab - where the fields to search in and the columns to display are 
specified. 

 Filters tab - where the filters for the results can be set 
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 The check boxes in the Search frame specify whether the search should be carried 
out on the Name, Created by (User Name) or Modified by (User Name). 

 The check boxes in the display frame specify the columns that will be displayed 
in 
the results. 

 Find Options - Filters Tab 
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This tab allows the user to set filters for: 

   Planogram Substitution Name 

   Planogram Substitution Status 

   Effective and Execution Dates  

   Created by (User Name) 

   Creation Date 

   Priority 

Find dialog box - Planogram Substitution Definitions and Assistant 
The Find dialog box that is called from the Planogram Substitution Definition and 
Planogram Substitution Assistant dialog boxes operates in a similar manner to that called 
from the Planogram Substitution dialog box. The primary difference is that these dialog 
boxes have a Results tab that is used instead of populating the results into the main 
dialog boxes. 

Depending on the tab in the Planogram Substitution Definition and Planogram 
Substitution Assistant dialog boxes, the Find dialog box will automatically be set to 
search for either Stores or Planograms. 

It has four main parts: 

 The Text Box - for entering a search string. 

 The Search Type drop down list - this is automatically set to the appropriate type 
of object to search for. 
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 A check box allows the user to use a custom search 

 Tabs allow users to look at the Results, or set the required Fields or Filters. The 
fields and filters will vary depending on whether the search is for Stores or 
Planograms. 

 

To use the results tab: 

1. Enter text into the text box and press [Return]. 

2. Highlight the required result in the list of results and click OK. 

3. The check boxes in the Search frame specify whether the search should be carried out 
on the Planogram Name, Description, etc. 

4. The check boxes in the display frame specify the columns that will be displayed in 
the results. 

Using the Find Dialog Box 
The find dialog box has three tabs: Results, Fields and Filters. The Fields and Filters tabs 
will vary according to the type of object being searched for. 

Searching for Stores 

Users can search for stores when in a tab in the Planogram Substitution definition or 
Planogram Substitution Assistant dialog boxes that requires the selection of stores. In this 
case 'Stores' is pre-selected in the Look For' drop down list. The Find dialog has three 
tabs. 

Results Tab 

The Results tab will contain the results from the text string in the 'Find What' text box 
modified by the settings in the Fields and Filters tab. To search: 

1. Enter text into the text box and press {Return]. 

 

 



Planogram Substitution 

482 Oracle Retail Macro Space Management 

2. Highlight the required results in the Results pane and click OK. The highlighted 
results will be added to the list of stores the substitution will be carried out in. 

 

Fields Tab 

The Fields tab allows users to select the fields that the text string in the Find What text 
box will be checked against. 
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 The check boxes in the Search frame specify whether the search should be carried 
out on the Store Name, Store Code or Parent Cluster. 

 The check boxes in the display frame specify the columns that will be displayed 
in the results. 

The Filters Tab 
The Fields tab allows users to filter the fields that the text string in the Find What text 
box will be checked against. 
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 If the Cluster type check box is checked Users, can filter the results to restrict 
them to stores belonging to specific types of clusters in the Store Manager 
module. 

 If the Store Status check box is checked, Users can filter the results to restrict 
them to stores belonging to specific store statuses (assigned in the store manager 
module). 

Searching for Planograms 

Users can search for planograms when in a tab in the Planogram Substitution definition 
or Planogram Substitution Assistant dialog boxes that requires the selection of 
planograms. In this case 'Planograms' is pre-selected in the Look For' drop down list. The 
Find dialog has three tabs. 

Results Tab 

The Results tab will contain the results from the text string in the 'Find What' text box 
modified by the settings in the Fields and Filters tab. To search: 

1. Enter text into the text box and press {Return]. 

2. Highlight the required results in the Results pane and click OK. The highlighted 
results will be added to the list of stores the substitution will be carried out in. 
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Fields Tab 

The Fields tab allows users to select the fields that the text string in the Find What text 
box will be checked against. 

Any checked option will be tested against the text string and any matching results populated into the Results 
tab. 
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 The check boxes in the Search frame specify whether the search should be carried 
out on the Planogram Name, Planogram Description, etc. 

 The check boxes in the display frame specify the columns that will be displayed 
in the results. 

Note: Some of the fields that can be searched depend on the 
information being brought in during imports of planograms. 
Depending on how this import is configured, it is possible 
for one or more of these fields to contain null values. 

The Filters Tab 

The Filters tab allows users to filter the fields that the text string in the Find What text 
box will be checked against. 
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 If the Effective date check box is checked Users can filter the results to restrict 
them to planograms with effective dates between the specific dates. 

 If the Expiry date check box is checked Users can filter the results to restrict them 
to planograms with expiry dates between the specific dates. 

 If the revision check box is checked, users can enter revision numbers. Multiple 
revision numbers can be entered if separated by a comma. 

 If the planogram status check box is checked, users can filter the results to 
planograms of those selected statuses. 

Searching Using Custom Queries 

It is also possible to set up Custom Queries. These allow Implementers or Administrators 
to set up a search specific to a client's requirements. 

Setting up Custom Queries 

Custom Queries are set up using the Custom Query dialog box available from the 
General menu in the Administration module. 
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Implementers or Administrators can write custom search queries for: 

   Planograms 

   Planogram Substitution Definitions  

   Stores  

The query takes the form of a SQL Statement modified to allow for additional 
functionality added in Macro Space Management. This functionality is the {text} field in 
the 'Where' clause. The code will select the text entered into the Search String Text box in 
the Find dialog box and substitute the values into the {text} fields in the 'Where ' clause in 
the Custom SQL statement. 

For example, if the user entered a Store Code of ABC-123 into the Search String Text box 
the 'Where' clause would be converted to WHERE STN_NAME = 'ABC-123' OR 
STR_CODE = 'ABC-123'. The results tab of the Find dialog box would then populate with 
all results matching Store Code Search String Text box ABC-123. 

Using the Find Dialog Box with Custom SQL 

The Find dialog box behaves slightly differently if the Custom Search Query check box is 
selected. 



Tools and Logs 

Admin Merchandising 489 

 

The selection made in the Search type drop down list will determine the type of Custom 
SQL statement used. The data entered into the Text Box will then be substituted into the 
'Where' clause of the custom SQL statement. Any matches will be displayed in the results 
tab. 

Only the Results tab will be active with the Fields and Filters tabs disabled. The columns 
in the Results tab will be determined by the fields specified in the 'Select' statement of the 
Custom SQL statement. 

Dry Run and Planogram Substitution Logs 

Dry Run Log 
Dry Runs test defined planogram substitutions by reading the data from the database, 
then determining if the defined substitutions would be successful. The results enable 
administrators to determine which substitutions will error when run. Any substitutions 
that are found to error during a dry run can be corrected prior to being run for real. The 
Dry Run functionality can be invoked from the toolbar in the Planogram Substitution 
dialog box. 

 

Alternatively, it can be called from the tools menu. 

If specific planogram substitutions have been highlighted in the Planogram Substitution 
dialog box, the dry run will be restricted to those planogram substitutions. If no 
substitutions have been highlighted all the results appear in the Dry Run Log. This will 
appear automatically at the end of a Dry Run. Alternatively, it can be called from the 
View menu. Within the log Users can filter by: 
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 Log Start Date and Time 

 Planogram Substitution Event (Name) 

 User Name of person carrying out dry run 

 Status of warnings 

 

Two levels of detail can be obtained in the Dry Run Log: 

 

View Options 

Summary View 
This option gives a summary of the planogram substitutions specified in the filters, 
reporting on the total number of files and stores processed normally, with warnings and 
with errors. 

Detailed View 

This option gives a detailed view of the individual planogram substitutions that meet the 
criteria specified in the filters. Information includes: 

 Stores processed successfully, or with warnings or errors. 

 Floor plans processed successfully or with warnings or errors. 

 Number of planograms that would be substituted. 

Planogram Substitution Log 
The Planogram Substitution Log gives the results of planogram substitutions. The Log 
can be called from the Toolbar or the View menu. 



Tools and Logs 

Admin Merchandising 491 

 
This will bring up the Planogram Substitution Log: 

 

Within the log Users can filter by: 

 Log Start Date and Time 

 Planogram Substitution Event (Name) 

 User Name of person carrying out dry run 

 Status of warnings 

Two levels of detail can be obtained in the Planogram Substitution Log: 

 

View Options 

Summary View 

This option gives a summary of the planogram substitutions specified in the filters, 
reporting on the total number of files and stores processed normally, with warnings and 
with errors. 

Detailed View 
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This option gives a detailed view of the individual planogram substitutions that meet the 
criteria specified in the filters. Information includes: 

 Number of planograms substituted. 

 Whether revision (version) change has been carried out. 

 Results of substitutions and revision change. 

Batch Operations 

Batch Operations 

Capabilities of Batch Scheduling Tool 

The full capability of some of the command line switches (for example /t and /p) can 
only be used by a sophisticated batch scheduling tool. A simpler batch scheduling tool 
may have fewer capabilities. 

Syntax for Batch Operations 

The Syntax for Batch Operations will be of the format: 
BatchRunner /substitution user name/password [/t] [/p] [/e definition_name_1, 
definition_name_2, …, definition_name_n] [/c code_1,code_2, …,code_n] [/s id_1, 
id_2, …, id_n] 

Switches are not case sensitive: /t and /T will have the same effect. 

1. Batch Runner will identify the batch scheduling too used to ran the batch processes. 

2. The /Substitution switch is a compulsory switch to identify the process to be run as 
planogram substitution. 

3. The username/password is mandatory. They will be validated against user 
information defined in the Functional Security option in the Administration module. 

4. The /t switch is an optional switch and allows the external program invoking 
planogram substitution to terminate execution of any running planogram 
substitution definitions rather than waiting for the full list of substitutions to 
complete. 

5. The /p switch will be an optional switch and allows the external program invoking 
planogram substitution to pause execution of any running planogram substitution 
definitions. 

6. The /e switch will be an optional switch and will identify the planogram substitution 
definitions that are to be run. 

7. The /c switch will be an optional switch and will identify the stores filter that is to be 
applied to the planogram substitution process. 

8. The /s switch will be an optional switch and will identify the status filter that is to be 
applied to the planogram substitution process. 

Details of Syntax 

This section details the specific Syntax required for each option in the batch files used to 
call the planogram substitution functionality. 

User Name/Password  

The user name/password is mandatory. They must meet the following criteria: 

 The User must be a member of a User Group with a User Group Type of 'Admin 
User'. 
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 The User must be a member of a User Group with permissions to use planogram 
substitution. 

 The user name and password must be included within double quotes if they 
contain a space or forward slash character. 

If validation fails, then planogram substitution will terminate with the following entries 
written to the error log: 

 "Date and time when invalid username or password was supplied. 

 "The machine name used to send the invalid username or password. 

The /t Switch 

The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running planogram substitution definitions. This might be because 
there in only a three hour period  available to run planogram substitutions in and the 
process has to be terminated at a specific time. The time period planogram substitution 
will run for has to be set in the external program running planogram substitution as part 
of a batch process; the /t switch merely allows the possibility of stopping the planogram 
substitutions before they have all executed. If the external program terminates 
planogram substitution, the following entries will be written to the process log: 

 Date and time when definition stopped. 

 Name of definition stopped 

 User name used to send terminate message. 

The /p Switch 

The /p switch allows the external program invoking planogram substitution to pause 
execution of any running planogram substitution definitions. This might allow 
planogram substitution to be paused while another batch process is executed. The time 
period planogram substitution will be paused at has to be set in the external program 
running planogram substitution as part of a batch process; the /p switch merely allows 
the possibility of stopping the planogram substitutions. If planogram substitution is 
paused, the application will ensure that the store plans are in a valid state. If necessary, 
they will be checked in. The process will remain active and wait until the process is 
resumed again. 

If a planogram substitution is paused the following entries will be written to the process 
log: 

 Date and time when definition paused. 

 Name of definition paused. 

 User name used to send pause message. 

If a planogram substitution is resumed the following entries will be written to the process 
log: 

 Date and time when definition was resumed. 

 Name of the resumed definition. 

 User name used to resume the definition. 

Pause Command while Planogram Substitutions are being manually run 

The /p switch will pause all planogram substitutions currently running. As it is possible 
for as user to be manually running planogram substitutions in a store plan, while others 
are being run automatically via a batch process, the application will allow users to 
manually resume their substitutions. This will be via a confirmation dialog saying "Pause 
received from user name via the command line. Pause processing?" 
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 If the User selects OK on the confirmation dialog, the dialog will close and the 
planogram substitution process will pause. The pause button on the planogram 
substitution progress dialog will be grayed out and the play and stop buttons 
will be enabled. 

 Pressing Cancel on the confirmation dialog will close the dialog and leave the 
manually initiated process processing the planogram substitution definitions  

The /e Switch 

The /e switch is optional. It can be used to specify a list of planogram substitutions to 
run. It is of the format: 
/e definition_name_1, definition_name_2, …, definition_name_n 

The definitions will be identified by a comma separated list of definition names. The 
definition names must be included within double quotes if they contain a space or 
forward slash character.  

The /c Switch 

The /c switch is optional. It can be used to specify a list of store codes identifying the 
stores against which planogram substitutions should be run. It is of the format: 
/c code_1,code_2, …,code_n 

Store Codes can be found in the Store Code text box of the Edit Store dialog box in Store 
Manager. Alternatively, they can be identified from a report containing the STR_ CODE 
field in the Store table. 

The /s Switch 

The /s switch is optional. It can be used to specify the list of file statuses against which 
planogram substitutions should be run. It is of the format: 
/s id_1, id_2, …, id_n 

The statuses will be identified by a comma separated list of status codes. A range of 
status codes will be identified by two strings separated by a hyphen character. Status 
codes will be assumed to be in numeric and then alphabetical order allowing for possible 
leading zeros. Status codes can be found in the Status dialog box accessed from the 
General Menu of the Administration module. Alternatively, they can be identified from a 
report containing the STA_CODE field from the Status table. 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

BatchRunner Command Line Options 
Detailed descriptions of the BatchRunner command line options are given in the 
pertinent sections of this help file. A summary is given below. 

Note: Switches are not case sensitive: /t and /T will have the 
same effect. Also note that only the /t (terminate) switch is 
available for floor plan processing, floor plan publishing and 
planogram publishing. 

Floor Plan Processing 
The Syntax for Batch Operations will be of the format: 
BatchRunner /processplans username/password /t 

/substitution 
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This tells BatchRunner this set of commands is for floor plan processing. 

username/password  

The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run floor plan processing in the Functional Security dialog box). 

The /t Switch 

The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running floor plan processing operations. 

Floor Plan Publishing 

The Syntax for Batch Operations will be of the format: 
BatchRunner /publishplans username/password /t 

/publishplans 

This tells BatchRunner this set of commands is for floor plan publishing. 

username/password  

The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run floor plan publishing in the Functional Security dialog box). 

The /c Switch 

The /c switch is an optional switch. This identifies the stores filter that is to be applied to 
the Process Plans process. The stores will be identified by a comma separated list of store 
codes.  If the /c switch is included only floor plans that belong to a store listed will be 
processed. The syntax will be of the form:  
BatchRunner /processplans username/password /c 0001, 0010, “1,2”  

Note: If a store code includes a comma, it must be enclosed 
in double quotes. 

The /t Switch 

The /t switch allows the external program invoking floor plan publishing to terminate 
execution of any running floor plan publishing operations. 

Combinations of Filtering Switches 

There are three filtering switches: \c, \s and OUTOFSYNC). A floor plan must meet the 
criteria of all of the switches in order to be processed. 

Planogram Publishing 

The Syntax for Batch Operations will be of the format: 
BatchRunner /publishpogs username/password /t 

/publishpogs 

This tells BatchRunner this set of commands is for planogram publishing. 

username/password  

The MSM user name/password is mandatory. (The user must also have been assigned 
the right to run planogram publishing in the Functional Security dialog box). 
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The /t Switch 

The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running planogram publishing operations. 

Planogram Substitution 

The Syntax for Batch Operations will be of the format: 
BatchRunner /substitution user name/password [/t] [/p] [/e definition_name_1, 
definition_name_2, …, definition_name_n] [/c code_1,code_2, …,code_n] [/s id_1, 
id_2, …, id_n] 

/substitution 

This tells BatchRunner this set of commands is for planogram substitution. 

username/password  

The user name/password is mandatory. (The user must also have been assigned the 
right to run planogram substitutions in the Functional Security dialog box). 

The /t Switch 

The /t switch allows the external program invoking planogram substitution to terminate 
execution of any running planogram substitution definitions. 

The /p Switch 

The /p switch allows the external program invoking planogram substitution to pause 
execution of any running planogram substitution definitions. 

The /e Switch 

The /e switch is optional. It can be used to specify a list of planogram substitutions to 
run. 

The /c Switch 

The /c switch is an optional switch. This identifies the stores filter that is to be applied to 
the Publish Planograms process. The stores will be identified by a comma separated list 
of store codes.  If the /c switch is included only planograms that belong to a listed store 
will be processed. The syntax will be of the form:  
BatchRunner /processplans username/password /c 0001, 0010, “1,2”  

Note: If a store code includes a comma, it must be enclosed 
in double quotes. 

The /s Switch 

The /s switch is optional. It can be used to specify the list of file statuses against which 
planogram substitutions should be run. 

Note: for more detail on these switches, see the section on 
configuring planogram substitutions. 

Business Flows 

Overview of Business Flows 
Planogram Substitution needs to be integrated with the wider activities within Macro 
Space Management. The flowchart below summarizes those activities. 
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Setting up with in the Admin Module 
The first stage for preparing for planogram substitutions is carried out within the Admin 
module. Three actions are required: 

 Setting up System Variables 

 Setting up Custom Queries for the Find dialog box in Planogram Substitution  

 Setting up the Planogram Financial Weighting settings  

Setting Up System Variables 

The first stage for setting up Planogram Substitution operations is to set the system 
variables that affect the functioning of planogram substitution. These have a global effect 
and it is recommended that once the settings have been made, they are not changed 
unless strictly necessary. 

Three system variables have a significant impact on the way the functionality operates. 
Each can be set using the System Variables option on the General menu in the Admin 
Module. 

PLANOGRAM_SUBSTITUTION_COPY_FILE 

 Current status will be available for selection in the Status tabs of the Planogram 
Substitution Definition dialog box and the Planogram Substitution Assistant. 

 Files of Current s tatus are Read Only. If planogram substitutions are carried out 
in them the functionality will first attempt to make the planogram substitutions 
in an Authorized file on the same floor if one exists with a matching Effective 
Date. If a suitable Authorized file does not exist, the functionality will create one 
in the same Revision as the Current file - a process called Cloning. 
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This system variable determines whether files of Current status can be used as the basis 
for planogram substitutions. If set to 1 (On) then: 
If set to 0 (Off) then it will not be possible to select floor plans of current status for 
planogram substitution - and hence no cloning of files will take place. 

PLANOGRAM_SUBSTITUTION_RUN_CALCS 
This system variable (0 = Off, 1 = On) determines whether the Product Adjacency 
calculation will be run prior to carrying out planogram substitutions. This enables the 
functionality to ensure that planograms required to be adjacent in the Planogram 
Substitution definition are still adjacent in the drawing. Running the product adjacency 
calculation increases the accuracy of planogram substitution, but will increase the overall 
time required. 

Note: This situation could occur if the planogram 
substitution was defined some time before it was run, and 
planograms have been manually moved in a floor plan since 
that date. 

Whether this system variable should be set to On or Off also depends on the batch 
processes in use. If Automated Calculations are being run immediately before planogram 
substitution, then there will not be a need for the 
PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable to be set to On. 

PLANOGRAM_SUBSTITUTION_LOG_EXPLODED 

This system variable is not currently in use. 

PLANOGRAM_SUBSTITUTION_LENGTH_TOLERANCE 

This system variable sets the default length tolerance that appears in the Rules tab of the 
Planogram Substitution Definition dialog box. 

PLANOGRAM_SUBSTITUTION_DEPTH_TOLERANCE 

This system variable sets the default depth tolerance that appears in the Rules tab of the 
Planogram Substitution Definition dialog box. 

PLANOGRAM_SUBSTITUTION_HEIGHT_TOLERANCE 

This system variable sets the default height tolerance that appears in the Rules tab of the 
Planogram Substitution Definition dialog box. 

PLANOGRAM_SUBSTITUTION_PROCESS_EXPLODED 

This system variable determined how planograms in a different form (2D, 2.5D or 3D) to 
the planogram being brought in as a replacement are processed during the substitution 
process. 

Note: this system variable will have a significant impact on a 
number of important aspects of functionality. The setting of 
this system variable should be considered carefully. 

Setting up Custom SQL for the Find Dialog Box 

The find dialog box used in the Planogram Substitution, Planogram Substitution 
Definition and Planogram Substitution Assistant dialog boxes has the facility to carry out 
client specified searches based on Custom SQL. This Custom SQL can be configured in 
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the Admin module using the Custom Query option on the General Menu in the Admin 
Module. 

 

Note: For more information on using Custom Queries, see 
the chapter on the Find dialog box. 

Setting up Planogram Financial Weighting 

The Planogram Financial Weighting dialog box is available from the Merchandising 
module in the Administration Module. 

 

Settings in this dialog box can be used in conjunction with financial data imported with 
the planogram designs to give a score that can be used to decide between alternative 
planograms in the Planogram Substitution Assistant (New Planograms page). The 
financial weighting settings should be set up prior to beginning to set up planogram 
substitution definitions. The weighting should not be changed unless there is a clear case 
to do so, as repeatedly changing the weightings will not give a clear strategy for choosing 
one planogram over another. 

Batch Processes 
Three potential batch processes impact on the operation of planogram substitutions. 
These are: 

 Automated Calculations 

 Planogram Definition Imports 

 Planogram Substitution Schedule 
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Automated Calculations 

Automated Calculations can be run as a batch process using the 
AVT5AutomatedCalcs.exe file installed in the C:\Program Files\Oracle 
Retail\MSM\Apps directory. 

 

One of the options for Automated Calculations is Product Adjacency. If this is run 
immediately prior to running Planogram Substitutions as a batch process, then the 
PLANOGRAM_SUBSTITUTION_RUN_CALCS system variable can be set to Off (0). 

Planogram Design Imports 

Planogram Designs are often imported as part of a batch process. The import can be used 
for several purposes: 

 To import new planogram designs 

 To import updated versions of existing planograms (revisions) 

 To import updated financial information for planograms 

This import schedule should be borne in mind when designing planogram substitutions 
and deciding on the schedule to run the substitutions on. 

Planogram Substitution Schedule 

Planogram Substitutions can be run as a batch process. The timing of this needs to take 
into account a retail organizations merchandising strategy - and hence how often 
planogram substitutions will be run as a batch process. 

Planogram Substitutions 

Substitution Date Planning 

Planogram substitution is used as part of an overall business process in order to update 
the merchandise offered for sales within a retail organization. As such planogram 
substitutions should be carried out to an agreed schedule - thus resulting in a fully 
updated set of floor plans suitable for publishing to the pertinent stores for 
implementation. 

Preparing for Planogram Substitutions 

Before planogram substitutions are defined, two actions ensure that the substitutions will 
be based on the latest information: 

Planogram Design Imports 

The latest planogram information should have been imported. This information includes 
both new planogram designs and revisions of existing designs. Planogram design 
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Imports will also include the latest financial information, enabling the financial 
weightings used to chose between alternative planograms in the Planogram Substitution 
Assistant are fully up to date. 

Planogram Financial Weightings 

Planogram financial weightings are used to choose between alternative planograms in 
the Planogram Substitution Assistant. Frequent imports of Planogram data ensure they 
are fully up to date. 

Planogram Substitutions 

The planogram substitutions can then be set up. This can be accomplished by means of 
the Planogram Substitution Definition dialog box or the Planogram Substitution 
Assistant. The dates these planogram substitutions are scheduled to come into effect 
should be dovetailed with the retails organizations merchandising objectives. 

Dry Runs 

Dry runs are used to confirm that the designated planogram substitutions will run 
without problems when executed. They can be used in two different circumstances: 

On completing defining a planogram substitution 

Dry runs would be used to confirm that the recently completed planogram substitution 
will work effectively. They provide a way of confirming that the planogram substitution 
has been correctly specified by its designer. 

Prior to running planogram substitutions in a batch process 

It is possible that many planogram substitutions will have been defined some days or 
weeks before they are run as a batch process. It is possible to carry out a dry run a day 
prior to the batch process. This allows administrators to identify checked out drawings, 
drawing with exploded planograms, etc., and correct them before the batch process 
executes. 

Running Planogram Substitutions 

Planogram substitutions can be run if they match the following criteria: 

1. The planogram substitution has a status set to approved 

2. Floor plans must have a status assigned that matches the status set in the Status tab. 
Floor plans of Proposed and Published status (and any custom statuses that have 
been created) will be updated irrespective of any dates assigned to them. 

Note: If planogram substitutions are run against floor plans 
of Published status, it may be necessary to republish the 
floor plan to the store. 

3. For floor plans with a status of Authorized, the Effective date must fall within the 
range of dates set in the Floor Plan Effective date in the Properties tab of the 
Planogram Substitution Definition dialog box. 

4. For floor plans of current status, they will only be cloned if the 
PLANOGRAM_ SUBSTITUTION_COPY_FILE system variable is set to On (1). 

Note: Current Files opened Read Only in the Planner or 
Merchandiser Modules will also be cloned if substitutions 
are manually run and valid substitutions exist. 
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5. For open files, the Active date (if set) must fall within the range of dates set in the 
Floor Plan Effective date in the Properties tab of the Planogram Substitution 
Definition dialog box. 

Planogram substitutions can be run in one of three ways. 

1. Manually from within the Planner and Merchandiser modules on the current open 
store plan. 

2. Manually from within the Planogram Substitution module for single or multiple 
planogram substitutions. 

3. As a batch process. 

Planogram Substitution Log 

The Planogram Substitution Log (accessed from the Planogram Substitution dialog box) 
enables Administrators to determine the success of each planogram 
substitution. Unsuccessful substitutions can also be identified, corrected and re-run. 

Post Substitution Operations 

Synchronization in the Planner Module 

Planogram substitutions are carried out by making changes directly in the database. For 
example if the database tables show Fixture 1 as containing Planogram A before the 
substitution, they will show it as containing planogram B after the substitution. The 
Merchandiser Module and In-Store Space Collaboration read data directly from the 
database, so will show the changes directly the drawing is next opened. The Planner 
Module stores information in an AutoCAD DWG drawing. After planogram 
substitutions have been made and the information in the database changed, the 
information in the DWG drawing has to be brought into line. 

This is done by means of the Synchronization dialog box. 

 

Synchronizing 'Match the Database' will update the DWG drawing with the changes 
made in the database. 

Annotation in the Planner Module 
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After the drawing has been synchronized in the Planner Module, the drawing needs to 
be re-annotated so that each planogram has the correct text associated with it. This is 
done by selecting the Annotation option from the Retail toolbar in the Planner module. 

 

This will bring up the Annotation dialog box. 

 

This dialog box can be used to re-annotate the appropriate text for planograms. Typically 
this will be: 

 Planogram text - identifying the planograms themselves 

 Profile text - showing information on individual bays within planograms  

Managing Floor Plans 

Once the substitutions have been carried out and the floor plans synchronized and 
annotated, they need to be managed. There are three stages to this: 

Renaming Cloned Drawings 

If drawings of current status are cloned (PLANOGRAM_SUBSTITUTION_COPY_ FILE 
system variable set to On) then their names will be an autogenerated version of the 
original file name. 
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In the above example the London 3 file has been cloned - with  the clone being called 
London 3~133. It may be necessary to rename the cloned file to a more logical name - for 
example London 4. 

Running Update Status 

Update Status (installed in the C:\Program Files\Oracle Retail\MSM\Apps folder) can 
be used to change the status of files. When Publish or effective dates are exceeded, 
Authorized files will be set to either Published or Current status as appropriate. As an 
example, cloned files (at authorized status) will have their Effective Dates set to the 
earliest date in the Floor Plan Effective Date in the Properties tab of the Planogram 
substitution definition dialog box. When Update Status is run, if the current date matches 
of exceeds the Effective Date set for the floor plan, the file status will be set to Current - 
showing the cloned file is now in service. 

Publishing the Drawings 

After the drawings have reached a suitable status, they need to be published so that 
merchandise can be ordered and stores begin planning for the changes. 

Publishing can be done by sending an electronic or hard copy version of the floor plan 
together with electronic or hard copy forms of the requisite planogram designs to the 
stores that will be implementing the changes. 

Product Code Types 

Product Code Types 
Product Codes are numerical codes that enable products to be identified at SKU levels. 
They are often present in Bar code form on the actual products. 

 

Types of Product Codes 
Product Codes come in a number of formats  

UPC Codes 

UPC (Universal Product Codes) was developed for the North American Market. They are 
normally 12 digits long (although variations exist). The most common versions are the 
UPC-A and UPC-E formats, although other variants exist. UPC codes are slowly being 
superseded by EAN (European Article Number). 

EAN Codes 

EAN (European Article Number) are internationally accepted codes. They have been 
renamed 'International Article Numbers', although the EAN abbreviation is retained. 
Unlike UPC's (which are specific to North America), EAN's allow the country of the 
manufacturers of the product to be identified. The most common form of European 
Article Numbers is the EAN-13 form, which are 13 digits long. A less commonly used 
form is EAN-8 (8 digits long) which is sometimes used for smaller items, where fitting a 
longer bar code might be impractical. 

JAN Codes 
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JAN (Japanese Article Numbers) is the same as EAN codes. 

GTIN Codes   

GTIN (Global Trade Item Numbers) are a family of codes that consolidate codes in the 
UPC, EAN and JAN systems. GTINs may be 8, 12, 13 or 14 digits long. They can be 
constructed using any of four numbering structures, depending upon the exact 
application. 

 GTIN-8s will be encoded in an EAN-8 bar code. 

 GTIN-12s will be encoded in UPC-A, ITF-14, or GS1-128 bar codes. 

 GTIN-13s may be encoded in EAN-13, ITF-14, GS1-128 bar codes  

 GTIN-14s may be encoded in GS1-128 bar codes  

Product Code Types can be used to set up masks for the Product Codes to be entered 
manually within Product Studio. They have no influence on Product Code information 
imported via the Data Import module.   

 

Product Code Types are used in the SKU dialogue box in Product Studio. The type is 
selected from the UPC type drop down list. Any data entered for the UPC must then 
conform to the masks set in the Admin module. 
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Adding and Editing Product Code Types 
Product Code Types can be added, edited or deleted using the Product Code Type 
dialogue box. The add, edit or delete options can be accessed from either the menu bar or 
toolbar. 

 

The following wild card characters can be used: 

Character Meaning 

? Any letter 

# Any number 

* Any number of characters of any type 
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In addition, the following characters can be added as permanent parts of the mask. 

Option Available 

Numbers 0 1 2 3 4 5 6 7 8 9 

Separators ! " £ $ % % ( ) - + { } : ; @ ' ~ , . < > | \ 

For example, a mask could have the form 12345###-###. Any Product Code manually 
added to a Product SKU in Product Studio will have to conform to that format. Examples 
of valid inputs are: 

12345678-123 

12345123-456 

Ranges 

About Ranges and Range Groups 
Ranges and Range Groups are used to set up limits for values for specific types of data. 

 

These Ranges can then be used as filters to ensure that products are placed on compatible 
items of equipment in the Merchandiser Module. For example, if the Frozen Goods 
Range is assigned to both a shelf and a product, then the use of the Range will prevent 
(say) Ice Cream being placed into fixtures or shelves where it could melt. 

Note: Ranges have no effect in the Planner Module. 

Range Groups 
Range Groups are used to collect together Ranges sharing a common attribute - in the 
above example, the Temperature Range Group has been used to hold all the Ranges 
involving temperature. 

Ranges 
Ranges are the maximum and minimum values that can be assigned to a particular 
property of the equipment and products. In  the above example, the Frozen Goods Range 
has been defined as temperatures between -1 and -5 degrees centigrade. 

Note: Ranges are used in parallel with Styles. 

Currently only temperature ranges can be used. They can be assigned to Fixtures, Shelf 
Object and Products. 
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Where Ranges are Assigned 
Ranges can be assigned to fixtures, shelves and products. 

Assigning Ranges to Objects 

Fixtures and Shelves 

Fixtures and Shelf Objects are assigned ranges in the Styles/Ranges tab of the Block 
Details dialog box in Fixture Studio. 

 

Products 

Products are assigned Ranges at SKU level using the Physical tab. 
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Where Ranges are Used 
Ranges are used as follows: 

Using Ranges 

Products and Equipment 

If both the product and the equipment (fixture or shelf) on which it is being placed have 
been assigned a Temperature Range, a warning will be generated if an attempt is made to 
place a product on a fixture or shelf object that does not have a matching temperature 
range. 

 

Planograms and Equipment 

There is currently an option in the Configuration Module to warn if the Range assigned 
to a planogram is not compatible with the parent fixture. 
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This option is currently not active. 

About Ranges and Styles 
Ranges and Styles can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects. 

 

Styles and Ranges 

Styles 

If styles have been assigned to: 

1. Fixtures and Products  

2. Shelf Objects and Products  

and the requisite Style Relationships exist, then styles can be used to determine whether 
a product can be placed on either a fixture or a shelf object. 

Ranges 

If Ranges have been assigned to: 

1. Fixtures and Products  

2. Shelf Objects and Products  
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and the ranges are compatible, then they can be used to determine whether a product can 
be placed on either a fixture or a shelf object. 

Example 

1. It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 
styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to determine 
whether products could or could not be placed. 

2. It would also be possible to create Basic Fixture, Basic Shelf and Basic Product styles 
that could be assigned to all Fixtures, Shelf Objects and Products. The pertinent 
Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' temperature 
range. In this example, the Range would serve to determine whether products could 
or could not be placed. 

Seasons 

About Seasons 
The Seasons Option is used to set up the list of retailing Seasons. These seasons can then 
be associated with Revisions (Store Manager), Products (via the database) and 
Planograms (Planogram design - Merchandiser). Once Revisions, Products and 
planograms have been associated with Seasons, the information can be used for filtering 
and reporting purposes. 

 

Seasons are arranged in a hierarchy and must have a start and a finish date. Unlike 
Calendars, seasons can have overlapping date ranges. 
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In the above example, the year has been divided into four quarters. Seasons can nest 
within or overlap other seasons. For example the Summer Sale Phase is entirely within 
Quarter 3, while the Christmas Phase overlaps the year end. 

Importing Seasons 
Instead of manually adding seasons, it is possible to directly import them into the 
database. 

Configuring Seasons 
Seasons can be added, edited or deleted by use of the options on the menu bar or tool 
bar. 

 

Options in the Seasons Dialog Box 

Description 

The description is user configurable - any text can be used. 

Start Date and End Date 

The Start Date and End Date can be configured using the calendars. These are available 
as drop down controls. The Start Date and End Date can overlap other seasons. 

Type 

Type is selected from the drop down list. These are two options: Season and Phase. These 
are purely for user convenience and do not have any effect within the software. One way 
of using then option is to use 'Seasons' to designate regular time intervals (for example 
Months or Quarters). 'Phases' can then be used to designate irregular time intervals - for 
example the Christmas Phase might run from 1st November to 4th January. 

Assigning Seasons 
Seasons are specific time periods used to define when Revisions, Products and 
Planograms are valid for store planning purposes. If revisions, Products and Planograms 
are assigned a season, the information can then be used in the Custom SQL for filtering 
or sorting purposes. There information can also be used in Key Performance Indicators 
(KPI's). 

Where Seasons are Assigned 

Revisions 
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Revisions can be assigned a season in the Add or Edit Revision dialog box in Store 
Manager 

 

Information on which season a revision has been assigned to is held in the Revision table 
in the SSN_ID field. Only a single value can be held, so a revision can only be assigned to 
a single season. 

Products 

Products can only be assigned a season directly in the database, using during data 
import. Values are added to the Product Season Link table. This links product data in 
the Product Def table with the information in seasons in the Season table. 

 

Products can have multiple seasons assigned. 

Planograms 

Planograms can be assigned a season in the Planogram Design dialog box in the 
Merchandiser module. 
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Note: Planogram definitions will typically be imported via 
data importer. The seasons a planogram is valid for can be 
assigned during this import definition. 

Information on which seasons a planogram has been assigned to is held in the Plano 
Store Season Link  table. Planograms can have multiple seasons assigned. 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

Uses for Seasons 
Once assigned, seasons can be used for varying purposes. These include: 

 Color coding data that appears in the Object Browser 

 Filtering Data that appears in the Object Grid 

 Classifying Data that is used in KPI's 

 Reporting Purposes  

Ways of Using Seasons 

Color coding data that appears in the Object Browser 

The data that appears in the Properties and Summary windows is powered by Custom 
SQL. If seasons have been assigned to Revisions, Products and Planograms, it is possible 
to color code data. For example, if the Parent revision for the active store plan has been 
assigned a season, it would be possible to color code the properties for the products or 
planogram selected in the Object Browser hierarchies in order to show whether the 
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product or planogram selected in the Object Browser has a season compatible with that 
specified for the parent revision. 

Filtering Data that appears in the Object Grid 

Seasons can be used to filter the data that appears in the Object Grid. This can be either 
pre-filtered or filtered when in the Object Grid. 

1. Pre-filtering 

If the revision that is acting as a parent for the current store plan has had a season 
assigned, it is possible to use the custom SQL to pre-filter the data that appears in the 
Object Grid so that it only populates with products and planograms that have 
seasons that are compatible with the season set in the parent revision. 

2. Filtering  

If the season is a valid field in the Custom SQL that populates the Object Grid, it is 
possible for a user to filter the populated by the seasons assigned to it. 

Classifying Data that is used in KPI's 

Key Performance Indicators (KPI's) can be set up to meet customer requirements. It is 
possible to color code objects in the store plan based on date criteria - including seasons. 
This is done via the Date Tab of the Key Performance Indicator dialog box in both the 
Planner and Merchandiser modules. 

 

  

 



Strategies 

516 Oracle Retail Macro Space Management 

Strategies 

Overview of Strategies 
The Strategies dialog box is accessed from the Merchandising menu of the 
Administration module. It is used to assigned strategies to varying levels in the product 
hierarchy. These Strategies are then used in Category Management - software 
complementary to Macro Space Planning used to determine the range of products 
optimum for a floor plan. 

 

Strategies are used to specify how the retailer intends to treat the category. In the above 
example, a retailer has five strategies it can assign to products: 

 Strongly Grow: a category that has good potential for the future and which 
should be strongly promoted and marketed. 

 Grow: a category that is important for the future and which should be given 
reasonable resources for promotions and marketing. 

 Maintain: a category that only requires sufficient resources to hold its position in 
the market. 

 Maximize Cash: a category that is in slow decline and which the retailer will 
eventually exit. Only enough resources will be allocated to maximize the profit in 
the remaining time available to the category. 

 Exit: a category in strong decline and which the retailer is in the process of de-
listing. 

Although Strategies can be assigned manually to products in Product Studio, it is more 
likely that they will be imported. Accordingly, the Strategies entered in the 
Administration module should be similar to any that exist in the third party software 
used to maintain product information at a retail chain. Strategies can be assigned to 
products at all levels from Sub-class to SKU level in the Product hierarchy. From Sub-
Class to Item level it is assigned in the following dialog box: 
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At SKU level it is assigned in the Details Tab of the SKU dialog box. 
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Once Strategies have been assigned to a product, they can be used as filters for products 
being displayed in the Object Grid. 

Note: what appears in the Data Tab of the Object Grid is 
controlled by the Custom SQL in the Custom SQL  table. For 
more information on this table see the Oracle Retail Macro 
Space Planning Data Model. 

Strategy Menus and Toolbar 
The File Menu  allows users to add new strategies, save the changes and exit the dialog 
box. 

 

The Edit Menu allows users to cut copy and paste information, and to delete strategies. 

 

The Help Menu allows users to call this Help File. 

 

The following options are available on the toolbar: 

Icon Option 

 

Add a new Import Style 

 

Save the contents of the dialog box 

 

Cut 

 

Copy 

 

Paste 

 

Delete 
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Icon Option 

 

Move up in List 

 

Move Down in List 

 

Help 

Using the Strategies Dialog Box 
The Strategies dialog box can be used to Add, Edit and Delete strategies from the list of 
those available for use within the product hierarchy. 

Options in the Strategies Dialog Box 

Adding a Strategy 
Adding a strategy can be done by clicking the Add button on the toolbar (or the File 
menu) to create a new line in the list of Strategies. 

 

Once the line has been created, data can be entered by typing it in, or by using the copy 
and paste options on the toolbar. 

 

Editing a Strategy 

Strategies can be edited by typing the required changes in, or by using the copy and 
paste options on the toolbar (or the edit menu). 

Deleting a Strategy 

Deleting one or more strategies can be achieved by highlighting the strategies it is 
desired to delete in the list of strategies and clicking the Delete option on the toolbar (or 
the edit menu). 

 

Promoting or Demoting Strategies in the List of Strategies 

Strategies can be promoted or demoted in the sequence strategies are displayed in by 
using the Up and down icons in the toolbar. 
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 This will affect how the drop down lists display in the dialog boxes used to set strategies 
in Product Studio. 

Saving Changes 

Changes can be saved by clicking the Save icon on the toolbar (or the file menu). 

 

If users attempt to exit the dialog box without saving changes, they will be prompted as 
to whether they wish to do so. 
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Overview of Styles 

Overview of Styles 
Styles are used in the Merchandiser Module as filters, primarily to ensure that products 
are placed on the correct fixture or shelf. There are a variety of styles and style 
relationships. 

 

Types of Styles 

Fixtures and Shelf Objects 
Fixtures have to be assigned a Fixture style in Fixture Studio. Similarly Shelf Objects 
(shelves, pegs, etc) have to be assigned both a Fixture and a Shelf style in Fixture Studio. 
When shelving is placed in a fixture in Merchandiser, the Fixture Style assigned to the 
Fixture must match the Fixture Style assigned to the shelf to allow the shelf to be placed. 

Shelf Objects and Products 

Shelves have to be assigned a Shelf style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
Shelf and Product Style has been defined in the Administration Module, the Product can 
be placed on the shelf. If a relationship has not been defined, the product cannot be 
placed in the Merchandiser Module. (Display styles cannot be placed in the Planner 
Module). 

Fixtures and Products 

Fixtures have to be assigned a Fixture style in Fixture Studio. Products (at Display Style 
level only) are assigned a Product Style in Product Studio. If a relationship between the 
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Fixture and Product Style has been defined in the Administration Module, the Product 
can be placed directly onto the fixture. If a relationship has not been defined, the product 
cannot be placed in the Merchandiser Module. (Display styles cannot be placed in the 
Planner Module). 

Joints 
Some products cannot be placed directly onto fixtures, but must be placed into shelf 
objects such as pegs. There are two ways of achieving this: 

 Place the shelf object (i.e. peg) first, then place the product 

 Place the product and shelf object simultaneously - joints 

Planograms 

Fixtures have to be assigned a Fixture style in Fixture Studio. Planograms are assigned a 
Fixture Style in the Planogram Design dialog box in the Merchandiser Module. If the 
Fixture Style of the Planogram being placed does not match the Fixture Style of the first 
of the selected fixtures, a warning will be given. The user can then accept the warning, or 
override it and place the planogram. 

Other Modules 

Styles and style relationships can also be configured in the Fixture Studio and Product 
Studio Modules. 

Where Styles are Assigned 
Styles can be assigned to Fixtures, Shelf Objects, Products and Planograms. 

Fixtures 
Fixture Styles are assigned in the Fixture Studio Module in the Styles tab of the Block 
Details dialog box. 
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A Fixture is required to have a Fixture style assigned. Only Fixture Styles will be 
available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a fixture is set in 
the Categories tab. 

Shelf Objects 
Both Fixture and Shelf Styles are assigned in the Fixture Studio Module in the Styles tab 
of the Block Details dialog box. 
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A Shelf Object is required to have both Fixture and Shelf styles assigned. Both Fixture 
and Shelf Styles will be available for selection in the Styles/Ranges Tab. 

Note: Whether an object is designated as a Shelf Object is set 
in the Categories tab. 

Products 
Only Products at Display Style Level can be assigned Styles. This is done in the Styles 
Tab of the Display Style dialog box in Product Studio 
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Only Product Styles will be available for Selection. 

Planograms 
Planograms are assigned Fixture Styles in the Planogram Design dialog box in the 
Merchandiser Module. 
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Only Fixture Styles will be displayed. 

Styles and Style Relationships 
Style Relationships are set up within the Styles option in the Administration module. 
They control: 

 What products can be placed on what fixture 

 What products can be placed on what shelf 

 What products can be placed on what fixture using a specified shelf object 
(joints) 
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Style relationships must be set up before products are placed in Merchandiser. 

Preferred Styles 
Preferred Styles are used on Shelf Objects. They enable automatic switching of display 
styles for a SKU so that the preferred Display Style is placed on a shelf object. 

An example would be if electric kettles were available in two display styles: Boxed and 
Presentation. The Presentation Display Style would typically be for an electric kettle that 
has been taken out of its box and was being displayed on a shelf above the boxed electric 
kettles. The 'presentation' electric kettle would be used to show customers what the 
electric kettle looked like, the boxed' electric kettles would be purchased by customers 

An example of this would be a fixture with five shelves on it. The top shelf might contain 
examples of 'presentation' goods such as electric kettles, electric toasters, bread makers 
and toasters. The four shelves below would contain respectively boxed electric kettles, 
electric toasters, bread makers and toasters for purchase. 

By setting the preferred style of the top shelf to accept 'Presentation' Display Styles and 
the preferred styles of the shelves below to accept 'Boxed' Display Styles, the user can 
ensure that the correct form of the merchandise goes onto the shelves. If an attempt is 
made to put 'Presentation' Display Styles onto a shelf that prefers 'Boxed' Display Styles, 
then the Display Style will automatically be switched to the correct one. 

The full process for using preferred styles is 

1. Add Appropriate Styles in the Administration Module 

2. Set up Style Relationships in Administration Module 

3. Assign Styles to Shelf Objects in Fixture Studio 

4. Assign Styles to Display Style level products in Product Studio 

5. Set up Preferences for Shelves  

6. Drag and drop Display Style products onto shelf - preferred style should be chosen if 
not correct 

Setting up Preferred Styles 

Add Appropriate Styles in the Administration Module 

The appropriate styles have to exist in the Style tab of the Styles dialog box in the 
Administration module 
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Set up Style Relationships in the Administration Module 
The appropriate style relationships have to exist in the Style Relationship tab of the Styles 
dialog box in the Administration module 

 

Assign Styles to Shelf Objects in Fixture Studio 

Shelf styles have to be assigned to the shelf object in Fixture Studio. A minimum of two 
shelf styles are required for Preferred Styles to work. 
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Assign Styles to Display Style level products in Product Studio 

Product Styles are assigned in Styles Tab of the Product Display Style dialog box in 
Product Studio. 
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Set up Preferences for Shelves 
The preferences for shelves are set in the Merchandiser module. There are two ways of 
doing this: on adding the shelves to a fixture, or by editing a specific shelf. 

When adding shelves to a fixture, the preferred style can be set using the drop down list 
in the Add Shelves dialog box. 
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Once shelves have been added, the Preferred Style can be edited using the Preferred Style 
drop down list in the Edit Shelf dialog box. 

 

Drag and Drop Display Style products onto shelf - preferred style should be chosen if not 
correct. Once preferred styles have been set for a shelf, they can be used to determine 
what display style for a specific SKU is placed. If there are several alternatives, dragging 
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and dropping any display style onto a shelf from that SKU will result in the type of 
display style being checked, and if necessary changed to the preferred style. 

About Joints 
Joints are a special type of Style Relationship. They allow a product to be placed directly 
onto a compatible fixture a t the same time as the associated shelf object that the product 
will be placed on is added.   

 

In the example above products have been directly placed into a slatwall using pegs. 
Without a joint, the pegs would have to have been placed first and then merchandised 
with product in a second operation. 

Prior to products being added via joints, the following must be true: 

 The Fixture that will support the shelf objects the products are being added to 
must have a Fixture Style assigned in Fixture Studio 

 The Shelf Object the product will be added to must have a Shelf Style assigned in 
Fixture Studio 

 The Product must have a Product Style assigned in Product Studio 

 The appropriate Joint (Style Relationship) must be set up in the Styles option 
within the Admin Module 

 To add a product using joints requires the following steps: 

1. Drag the product from the Object Browser or Object Grid and drop onto the required 
Fixture. 

2. The Add Shelves dialog box will appear allowing users to specify details of the shelf 
objects to be added. 
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Note: this dialogue box will not appear if the Add Products 
Silently option is on in the Edit Menu in Merchandiser. 

3. After the Shelf Object details have been specified and the OK button clicked, the Add 
Products dialog box will appear. 

 

4. After specifying the quantity, alignment, etc, and clicking the OK button, the 
products and shelf objects will simultaneously place on the selected fixture. 
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About Styles and Ranges 
Styles and Ranges can be used interchangeably as filters to determine if products can be 
placed on Fixtures or Shelf Objects. 

 

Applications of Styles 

Styles 

If styles have been assigned to: 

 Fixtures and Products  

 Shelf Objects and Products  

and the requisite Style Relationships exist, then styles can be used to determine whether 
a product can be placed on either a fixture or a shelf object. 

Ranges 

If Ranges have been assigned to: 

 Fixtures and Products  

 Shelf Objects and Products  

and the ranges are compatible, then they can be used to determine whether a product can 
be placed on either a fixture or a shelf object. 

Example 

 It would be possible to create Chilled Fixture, Chilled Shelf and Chilled Product 
styles and assign them appropriately to Fixtures, Shelf Objects and Products. The 
appropriate style relationships could then be set up, and would serve to 
determine whether products could or could not be placed. 

 It would also be possible to create Basic Fixture, Basic Shelf and Basic Product 
styles that could be assigned to all Fixtures, Shelf Objects and Products. The 
pertinent Fixtures, Shelf Objects and Products could then be assigned the 'Frozen' 
temperature range. In this example, the Range would serve to determine whether 
products could or could not be placed. 
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Using Styles 

Adding and Deleting Styles 
Adding and Deleting Styles is done by using the Style tab in the Styles dialogue box. 

 

  

Icon Meaning 

 

Add style  

 

Delete style 

Adding a Style 
To add a style, click on the Add Style icon. A new line will be added in the styles table. 
The Style ID is a fixed, sequential number allocated when the style is created. The Name 
and Description will initially read Style11 and Description11, where the number is that of 
the style being created. These can be edited to the style name and description required. 
The Style type can be selected from a drop down list. 
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Currently only Fixture, shelf and Product styles are active. 

Deleting a Style 
Styles can be deleted by highlighting a style and clicking on the Delete Style icon. If not 
in use, the style will be deleted. If in use, a warning will appear. This indicates that the 
style has been assigned to a fixture, shelf, product or planogram. 

 

The style must then first be changed in the respective fixture, shelf, product or 
planogram before it can be deleted. 

Example of Adding a Style 
To Add a Style to the available list, open the Style option in the Admin Module. Use the 
Style Tab and click on the Add Style Icon (circled). 

 

This will add another line to the information grid (circled). 
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Edit this line until i t has the desired information. 

 

Finally, exit to save the styles. 

Note: There is a known issue with the Styles option at 
present. Information is temporarily lost if a second style is 
added immediately after the first. To overcome this close the 
Styles dialogue box after each style is added and then re-
open it to add the next. 

Adding and Deleting Style Relationships 
Style Relationships can be added and deleted by using the Style Relationships tab in the 
Styles dialogue box. 



Using Styles 

538 Oracle Retail Macro Space Management 

 

  

Icon Meaning 

 

Add style relationship 

 

Delete style relationship 

Adding a Style Relationship 
To add a style relationship, first select the style types which it is desired to set up a 
relationship with. This can be done from the drop down lists – for example it might be 
required to associate a Shelf style with a Product style. Next, select the specific types of 
styles from the lists provided – for example it might be required to associate the Pallet 
Shelf Style with the Multipack product style. Finally, click on the Add Style Relationship 
icon to add the relationship. It will then appear in the list of current relationships. Valid 
Style relationships that can be set up are: 

Style 
Relationship 

Comment 

Fixture - 
Product 

Determines which products can be placed on which fixtures 

Shelf Product Determines which products can be placed on which shelves 

Joints Joints allow products to be placed on fixtures while simultaneously placing any 
required shelf objects (i.e. pegs, etc). Joints set up the relationship between 
fixtures, certain types of shelf objects and products. 
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Deleting a Style Relationship  
Styles relationships can be deleted by highlighting a style and clicking on the Delete Style 
Relationship icon. 

Note: Style relationships in use can be deleted without any 
warning being given. This will not affect any objects placed 
before the relationship was deleted, but if further objects are 
to be placed using this relationship, it must be reinstated 
before they are. 

Example of Adding a Style Relationship 
To Add Style Relationships to the available list, open the Styles option in the Admin 
Module. Click on the Style Relationship Tab. 

 

Set the options as required. First select the required style types from the drop down list. 
Next highlight the styles it is desired to have a relationship with. 
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Finally, click on the Add Style Relationship icon. This will cause the Style to be added to 
the list of available Style relationships. 

 

Note: If we need place products directly onto a fixture, a 
Style Relationship would be required between the Fixtures 
Style and the Product Style. An example of this would be 
putting products of Boxed Style onto fixtures of Pallet Style. 
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Adding and Deleting Joints 
Adding and Deleting Joints is done by using the Style Relationships tab in the Styles 
dialogue box. 

 

  

Icon Meaning 

 

Add joint relationship 

 

Delete joint relationship 

Adding a Joint 
To add a joint, first select the style types which it is desired to set up a relationship with. 
First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Finally select Shelf Style in the right hand drop down list. Next 
highlight the required styles in each of the three lists (For example; Metal as a Fixture 
Style, Hung as a Display Style and Peg as a Shelf Style). Finally, click on the Add Joint 
Relationship icon to add the relationship. It will then appear in the list of current 
relationships. 

Deleting a Joint 
Joints can be deleted by highlighting a style and clicking on the Delete Style Relationship 
icon. 
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Note: Joints in use can be deleted without any warning 
being given. This will not a ffect any objects placed before the 
relationship was deleted, but if further objects are to be 
placed using this relationship, it must be reinstated before 
they are. 

Example of Adding a Joint 
To Add a Joint to the available list, open the Styles option in the Admin Module. Click on 
the Style Relationship Tab. 

 

First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Shelf Style will automatically appear in the right hand drop down 
list. 
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Next highlight the required styles in each of the three lists. 

 

Finally, click on the Add Joint Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 
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Testing Style Relationships 
Testing Style Relationships  is done by using the Test tab in the Styles dialogue box. 

Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment. The list of associated product styles will 
then display. 
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Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers. 

Products 
To see which equipment styles are associated with a product, click on that product in the 
list of available products. The list of associated equipment styles will then display. 
Product can be found by entering the product name or code and clicking on the search 
icon. 

 

Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers. 

Joints 
Joints can only be tested by trial placements on equipment. 
 
  





 

547 

9 
Tools and Logs 

The Update ID Tables Option 
The Update ID Table Option is called from the Tools Pull down Menu. 

 

Its function is to reset the Next ID  table in the central Macro Space Planning database in 
the event of a serious system failure. This option would normally be used by 
Administrators.  The Next ID table contains the next primary key for a number of key 
pieces of information in the database. These values are used to assign primary keys when 
new items (for example stores or planograms) are added to the database. If there is a 
serious failure and the software crashes, these primary keys may not be fully updated, 
leading to problems when the software is restarted. Similarly, if the database is updated 
by a major import of data, some of the information in the Next ID table can become 
outdated. Running the Update ID Tables option takes the latest values of the specified 
Next ID's (primary keys) from the referenced tables in the database and ensures the Next 
ID values are updated. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

The Unlock Tables Option 
The Unlock Tables option allows administrators to unlock tables that have been locked 
by (for example) a system failure or by people leaving objects such as products checked 
out. 

 

After the Unlock Tables option has been selected from the Menu Bar, the Unlock Tables 
dialogue box will appear. 
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If there are objects to be checked in, this can be done by highlighting them, right clicking 
to bring up the pop-up menu and choosing the appropriate option. 

Purge 

Purge Options 
Purge Options are available using the Purge option on the Tools pull down menu. 

 

This will bring up the Purge dialogue box. 

 

Clicking on OK will purge the selected items. 

Purge Fixtures Option 

Deleting Fixtures 
Fixtures are deleted in Fixture Studio. This is done by highlighting the selected fixture 
and selecting Delete on the right click menu. 
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The highlighted fixture can then be marked for deletion by clicking on the Delete Block 
Option. Fixtures marked for deletion will appear grey rather than black in the Fixtures 
Hierarchy. 

 

After the fixture has been marked for deletion, the information must be saved to the 
database using the Fixture Studio Save dialog box. 

Purging Fixtures 
The fixture will not be permanently deleted from the database until the Fixtures option is 
checked on the Purge dialogue and the OK button clicked. 

 

Results will be reported in the Purge Results dialogue box. If the fixture is present in any 
floor plans, it cannot be deleted until the fixture has been deleted from the floor plans or 
the floor plans themselves have been deleted. 
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Purge Products Option 

Deleting Products 
Products are deleted in Product Studio. This is done by highlighting the selected product 
and using <Ctrl> + right click to bring up the pop-up menu. 

 

  

The highlighted product can then be deleted by clicking on the Delete Block Option. 

Purging Products 
The product will not be permanently deleted from the database until the Product option 
is checked on the Purge dialogue and the OK button clicked. 
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Results will be reported in the Purge Results dialogue box. If the product is present in 
any floor plans, it cannot be deleted until the product has been deleted from the floor 
plans or the floor plans themselves have been deleted. In addition, if the product is 
present in a planogram held in the database, it cannot be deleted until the product has 
been removed from the planogram. 

 

Purge Images Option 

Deleting Images 
Images are deleted in Product Studio. This is done by highlighting the selected image 

and using <Ctrl> + 
right click to bring 
up the pop-up 
menu. 
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The highlighted image can then be deleted by clicking on the Delete Option. 

Purging Images 
The image will not be permanently deleted from the database until  the Image option is 
checked on the Purge dialogue and the OK button clicked. 

 

Images will then be deleted without further confirmation. 

Purge Planograms Option 

Deleting Planograms 
Planograms are deleted in Merchandiser. This is done by highlighting the selected 
planogram and using <Ctrl> + right click to bring up the pop-up menu. 

 

The highlighted fixture can then be marked for deletion by clicking on the Delete Block 
Option. 

Purging Planograms 
The planograms will not be permanently deleted from the database until the Planograms 
option is checked on the Purge dialogue and the OK button clicked. 
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Results will be reported in the Purge Results dialogue box. If the planogram is present in 
any floor plans, it cannot be deleted until the planogram has been deleted from the floor 
plans or the floor plans themselves have been deleted. 

 

Purge Logs Option 

Deleting Logs 
The File Log can be purged in Store Manager. 

 

This is done by selecting the Purge > Logs option from the Admin pull down menu.   

Note: The Admin pull down menu is only available to users 
with Administrator's privileges. It is toggled on and off by 
means of <Ctrl + A>. 

This will bring up the Log File Purge dialogue box. 
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Log files can then be selected and marked for purging. 

Purging Logs 
The full range of logs can be purged using the Logs option in the Purge dialogue box. 

 

Results will be reported in the Purge Results dialogue box. 

 

Purge Targets Option 
The Purge Targets Option is not enabled in this release of Macro Space Management. 
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Purge EPOS Data Option 
The Purge EPOS Data Option is not enabled in this release of Macro Space Management. 

 

Purge Users Option 
The Purge Users option can be used to remove users from the database. The first stage is 
to delete the user in the Functional Security dialog box. 
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After the user has been deleted from the Functional Security dialog box, the information 
still exists in the database. It can be permanently deleted by selecting the option in the 
Purge dialog box accessed from the Tools menu. 
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Logs 

Overview of Logs 
Logs are in two forms: Text Logs and Database Logs. 

Text Logs 
Text logs include .log, AVT5 Store Manager.log, AVT5CAD.log, AVT5Controls.log, 
AVT5Legacy.log, dbTreeControl.log, Macro Space Management.log, Store Manager.log. 
These are used mainly for debugging purposes and are not generally used in normal 
operations. 

Database Logs 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 

Log Description 

File Process Log Identifies all files that have 
been subjected to batch 
processes 

File log Identifies all files that have 
been checked in or out 

Import Error Log Identifies all errors during data 
import 

Import Log Identifies all data imports 

POG Import Log Identifies all planogram 
imports 

POG Sub Log Identifies all planogram 
substitutions 

Process Log Identifies all processes that 
have been invoked [not in use] 

Publish POG Log Identifies all planograms that 
have been published. 

Security Log Identifies all changes to 
security settings. 

User Log Identifies the times users have 
logged into MSM 

    

Error Holds errors reported by In-
Store Space Collaboration 

Note: The File Process Log Type table gives information on 
which processes are being recorded in the File Process Log 
table 

Logs can be viewed from the Logs option on the menu bar. 
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Logs can be purged using the Purge option on the tools menu. 

 

Command Log Table 
The Command Log table is not presently in use. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Error Table 
The Error Table mainly holds errors generated during the operation of In-Store Space 
Collaboration. 

 

The table can only be purged directly in the database. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

File Log Table 
The File Log table identifies the files that have been logged out and by which user. 
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The File Log table can be purged via the Purge option in the Administration module, or 
via the Purge option on the Tools menu in the Store Manager module. Purging in the 
Admin Module will remove all entries from the table. Purging in Store Manager allows 
users to remove entries for specific users or between specific dates. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

File Process Log Table 
The File Process Log table stores the results of automated processes. 

 

The Type of Process is specified by the FPT_ID (File Process Type ID). This is a foreign 
key to the AVTTB_FILE_PROCESS_LOG_TYPE table. 

File Process Type 
(FPT_ID) 

Description Comment 

0 Result of Synchronization process from 
Drawing Automation 

Not presently active 

1 Result of Save process from Drawing 
Automation 

Not presently active 

2 Result of Publish process from Drawing 
Automation 

Not presently active 

3 Store Section No longer active 

4 Bulk Planogram No longer active 

5 Update Store - Open Result of running 
UpdateStatus.exe 

6 Update Store - Close Result of running 
UpdateStatus.exe 

7 Update File - Publish Result of running 
UpdateStatus.exe 

8 Update File - Current Result of running 
UpdateStatus.exe 

9 Planograms Substitution Clone Result of Planogram 
Substitution 

11 Adjacency Calculation Result of running Automated 
Calculations 
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Note: Update Status and Automated Calculations are in the 
C:\Oracle Retail\MSM\APPS directory. 

The File Process Log table can be purged via the Purge option in the Administration 
module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Import Log Table 
The Import Log table identifies the results of imports generated by the Data Importer 
Module - including the number of records imported, updated, deleted, expired, skipped 
and failed. 

 

The contents of the table are visible in the Import Log dialog box in the Data Importer 
module. 

 

The Import Log table can be purged via the Purge option in the Administration module, 
or via the Purge option on the Edit menu in the Import Log dialog box. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Import Error Log Table 
The Import Error Log table identifies the errors that occur during imports generated by 
the Data Importer Module. 
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The contents of the table are visible in the Import Error Log dialog box in the Data 
Importer module. 

 

The Import Error Log table can be purged via the Purge option in the Administration 
module, or via the Purge option on the Edit menu in the Import Error Log dialog box. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Plano Log Table 
The Plano Log table records details of all planograms that have been Added, Edited or 
deleted in the Merchandiser Module. 

 

The Plano Log table can be purged via the Purge option in the Administration module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 



Logs 

562 Oracle Retail Macro Space Management 

POG Import Log Table 
The POG Import Log table holds information on all planograms imported into Macro 
Space Management via the Planogram Import Module. 

 

The POG Import Log table can be purged via the Purge option in the Administration 
module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

POG Publish Log Table 
The POG Publish Log table holds details of all planogram designs that have been 
published in preparation for implementation. 

 

The POG Publish Log table can be purged via the Purge option in the Administration 
module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

POG Sub Log Table 
The POG Sub Log table holds the reports of all planogram substitutions. 
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The POG Sub Log table can be purged via the Purge option in the Administration 
module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Process Log Table 
The Process Log table contains details of when files (store plans) were made Authorized 
or Current in Store Manager. 

 

The Process Log table can be purged via the Purge option in the Administration module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

Security Log Table 
The Security Log table holds details of when settings affecting the level of security for 
the Macro Space Planning application were changed and which user changed them. It 
cannot be purged except by directly in the database. 

 

Purging this table is not recommended as it shows the level of security settings selected 
and which user set them. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 

User Log Table 
The User Log table records the times users log into Macro Space Management 

 

It also records when a user has failed to log in. 
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Note: i f the Log In  ID does not match any user in the 
database, this indicates a possible unauthorized attempt to 
access the software. 

The  User Log table can be purged via the Purge option in the Administration module. 

Note: For more information on this table see the Oracle Retail 
Macro Space Planning Data Model. 
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Security 

Overview of MSM Security 
MSM Security is based on three options. 

 

1. Security Options control the form that access to the software takes: password format, 
number of log in attempts allowed, etc. 

2. Functional Security controls the access to specific modules in Macro Space 
Management. 

3. Data Security controls access to specific parts of the functionality 

 What stores and file statuses are visible in In-Store Space Collaboration 

 What planograms are available to users for Planogram Substitution  

Security Options 

Overview of Security Options 
Security Options  allows Administrators to specify the level of security provided for 
Macro Space Planning. This takes two formats: 

1. The strength of the password. 

2. The strength of the encryption algorithm for the password. 
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 If the strength of the password is changed all passwords will be expired, forcing 
users to change their password when they next log in. 

 If the strength of the encryption algorithm is changed, all passwords will be 
nullified except for the password of the user changing the strength. That user 
must then manually reset all passwords within the Administration module 
before other users can log in again. 

Default Security Options 
Some default security options are provided on the toolbar. 
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Min, Default and Max Options 
The Min, Default and Max options set the log-in options to predetermined values. These 
are: 

  Min Default Max 

Max log-in attempts before suspending 10 5 1 

Number of minutes account will be suspended 15 60 Unlimited 

Minimum password length 7 7 10 

Maximum password length 30 30 30 

Minimum number of upper case characters 0 1 2 

Minimum number of lower case characters 0 1 2 

Minimum number of numeric characters 0 1 2 

Minimum number of extended characters (!, @, etc) 0 1 2 

Password expiry period (days) Unlimited 90 30 

Lock (days past expiration) Unlimited 14 7 

Number of passwords to keep 0 4 10 

Number of days to keep passwords 0 7 360 

  

Note: See the section on security options for a more detailed 
description of these options. 

On clicking one of the Min, Default and Max buttons, a confirmatory dialog box will 
appear. 

 

On clicking OK, the changes will be saved. 

Advanced 
The Advanced button allows users to change the encryption method. On clicking the 
Advanced button, the Advanced Security Options dialog box will appear. 
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Because of the consequences of changing the password encryption method, a password is 
required to continue. On clicking the OK button, a confirmatory dialog box will appear. 
In order to proceed with the change of algorithm click No. 

 

 A confirmatory dialog box will appear. Click OK to clear it. 

 

Important Note: The change to the encryption algorithm 
method is now made. The user who made the change is now 
the sole user with  access to the application. That user must 
now manually reset all passwords for the other users in 
order for their accounts to be reactivated. 

Security Options 
The Security Options operate as follows: 
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Failed log-ins 
This section enables administrators to specify what happens in the event of failed log in 
attempts. 

Number of log-in attempts before suspending 

This option will allow an Administrator to enter a value of 1 - 10. Any number of log in 
attempts that exceeds this value will result in the account being suspended - either for a 
specified time, or until an Administrator unlocks it. Failed log in attempts will also be 
recorded in the Macro Space Planning database. 

Number of minutes account will be suspended 

This option specifies the time the user account will be suspended until further log in 
attempts will be allowed. It can be set to values of between 15 minutes to 7200 minutes 
(120 hours) by means of the drop down list. Alternatively, any value between 0 to 36000 
minutes can be typed in. 

If the value is set to Unlimited, the user will have their account suspended indefinitely 
until an Administrator resets the account. 

Password Complexity 
This section enables Administrators to specify how complex a password should be. 
Test1234? contains a minimum of one upper case, one lower case, one numeric and one 
extended character. 

Minimum Password Length 

This can be set to any whole number between 7 and 10. If the maximum password length 
is less than 10, the minimum password length will be restricted to this value. 

 Maximum Password Length 
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This can be set to any whole number between the minimum password length and 30. 

Minimum number of upper case characters 

The minimum number of upper case characters in the password can be set to any value 
between the sum of the lower case, numeric and extended characters and the maximum 
password length. For example, if the sum of the lower case, numeric and extended 
characters is 3 and the maximum password length is 10, the minimum number of upper 
case characters can be set to any value between 0 and 7. 

Minimum number of lower case characters 

The minimum number of upper case characters in the password can be set to any value 
between the sum of the upper case, numeric and extended characters and the maximum 
password length. 

Minimum number of numeric characters 

The minimum number of upper case characters in the password can be set to any value 
between the sum of the upper case, lower case and extended characters and the 
maximum password length. 

Minimum number of extended characters 

The minimum number of upper case characters in the password can be set to any value 
between the sum of the upper case, lower case and numeric characters and the maximum 
password length. 

Password Expiry 
This section enables administrators to specify when passwords should expire (and 
require resetting). 

Password Expiry Period (Days) 

This enables Administrators to specify the number of days between forced password 
changes. It can be set to any value from the drop down list. Alternatively, any positive 
whole number can be typed in. Passwords will never expire if set to UNLIMITED . 

Lock (Days Past Expiration) 
This enables administrators to specify the number of days before a users account is 
locked after their password has expired. For example, if a value of 7 is set, users have a 
week after their password expires to change it to a new one. If they fail to do so, within 
this time period, their account will be locked. The value can be set to any value from the 
drop down list. Alternatively, any positive whole number can be typed in. Passwords 
will never be locked after a set period if set to UNLIMITED. 

Password History 
This section specifies how far past passwords are taken into account when passwords are 
changed. 

Number of Passwords to Keep 

This may be set to any value between 0 and 10. The requisite number of past passwords 
will then be saved in the database. When a user changes their password with will be 
compared with the stored entries to verify they are not using a previously used 
password. This will be done in conjunction with the Number of Days to keep Passwords 
setting. 
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Number of Days to Keep Passwords 

This may be set to any value between the password expiry days and 365 days. Passwords 
retained according to the setting in the Passwords to Keep field will be compared against 
new passwords unless the Number of Days to Keep Password parameter has been 
exceeded. 

Excluded Passwords 

This section allows Administrators to exclude easy to guess passwords such as Admin 
and Password. 

 To add a password, type the password in the text box and click the Add button. 

 To delete a password, highlight it in the list of excluded passwords and click the 
Delete button. 

Functional Security 

About Functional Security 
Functional Security is used to control access to the software, and also which parts of the 
software can be accessed. 

 

Users and User Groups 
Users can be added - and their User Names and Passwords assigned. This can be used to 
control logging in to both Macro Space Management and In-Store Space Collaboration. 

Users are put into User Groups. Membership of a User Group confers the privileges of 
that User Group on the User. For example the Admin User Group will typically allow the 
User to access all parts of the software, while membership of other User Groups will give 
more restricted access. User Groups are also used in Data Security, which is currently 
used to control what stores and file (store plan) sta tuses are visible in In-Store space 
collaboration. 

The Functional Security Dialog Box 
The Functional Security dialog box has two tabs: User Groups and Group Relationships. 

User Groups Tab 
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The User Groups tab allows Administrators to create Users and User Groups. 

Note: in the default Database supplied, only users belonging 
to the Admin User Group can access the functionality within 
In-Store Space Collaboration. To give other User Groups 
access to the functionality in ISSC, changes need to be made 
directly in the database.  

Group Relationships Tab 

 

The Group Relationships Tab allows Administrators to determine which User Groups 
can access which modules. 
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The Functional Security Window 
The Functional Security Window has a series of components. 

 

The Menu Bar allows Administrators to access a limited number of options. 

The Toolbar allows Administrators to access a series of options affecting User Groups 
and Group Relationships. 

The Tabs allow operations to be switched between User Groups and Group 
Relationships. 

The Hierarchy shows the current list of User Groups or Group Relationships. 

Functional Security Menus and Toolbar 
The File menu allows users to exit this option. 
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The View menu allows users to refresh the hierarchical tree and to call the Find dialogue 

 

The Help menu  allows users to check the version of this software. 
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The Toolbar allows users to access various Functional Security options. 

 

Icon User Groups Group Relationships 

 

  

Exit  

  

Exit  

 

  

Add User Group 

  

Add Command Group 

 

  

Edit User Group 

  

Edit Command Group 
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Icon User Groups Group Relationships 

 

  

Delete User Group 

  

Delete Command Group 

 

  

Add User  

  

Not Available 

 

  

Edit User 

  

Not Available 

 

  

Delete User 

  

Not Available 

 

  

Cut 

  

Cut 

 

  

Copy 

  

Copy 

 

  

Paste 

  

Paste 

 

  

Search 

  

Search 

 

  

Refresh 

  

Refresh 

User Groups 

Overview of User Groups 
User Groups are groups of users. User Groups can be any logical grouping of users. 
Examples include: 

 Functional Groupings: Store Planners, Merchandisers, etc 

 Responsibilities: Planners, Managers, etc 

 Geographical Groupings: North America, Europe, etc  

Each User Group can be assigned specific privileges within the software. When Users as 
assigned to User Groups, they inherit the privileges of the User Group, thus enabling 
Administrators to control access the program without configuring it for each individual 
user. 

Example Ways of Setting up User Groups 

Example of 'Functional' User Groups 
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Example of 'Responsibility' User Groups 

 

Example of 'Geographic' User Groups 

 

Note: at present Geographic User Groups only find an 
application in In-Store Space Collaboration. They can be 
used in Data Security to specify which Stores users can see. 

Users can be assigned to multiple User Groups. 
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User 1 can only work in functionality assigned to the Asia User Group 

User 2 can work in functionality assigned to both the Asia and Europe User Groups  

User 3 can only work in functionality assigned to the Europe User Group 

User 4 can only work in functionality assigned to the both the Europe and America User 
Groups 

User 5 can only work in functionality assigned to the America User Group 

The User Group Hierarchy 
The User Group Hierarchy shows the relationship of User Groups and their associated 
users. 

 

Icon Meaning 

 

User Group 

 

User 

  

Users Groups can be planned in a hierarchy - for example the Store Planner User Group 
has Fixture Planner as a child. The Store Planner User Group might allow (Group 
Relationships Tab) Users to access both the Planner and Fixture Studio Modules, while 
the Store Layout User Group might only allow access to the Planner Module. Users can 
be allocated to Single or Multiple User Groups. 

Note: If users are allocated to multiple User Groups in a 
hierarchy the most restrictive permissions will apply. If a 
function is allowed in one User Group and denied in 
another, the deny permission will take precedence. 
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Before Adding, Editing or Deleting User Groups, Administrators should consider how 
access to both Macro Space Management and In-Store Space Collaboration will be 
controlled. User Groups can then be configured as required. 

Adding a User Group 
To Add a User Group  select the node in the hierarchical tree that the new User Group is 
to emanate from and click on the Add User Group Icon. 

 

This will bring up the User Groups dialogue box. 

 

1. Enter the Name of the User Group and the Description. 

2. If the mandatory check box is ticked, all new users will automatically be added to 
this group when they are created. 

3. Enter the User Group Role - some functionality (such as planogram substitution) can 
only be operated with specific user roles assigned. 

4. Click on OK and the User Group will be added to the hierarchy. 

Note: A User Group cannot be added unless a valid node 
has been selected in the hierarchical tree.   
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Editing a User Group 
To Edit a User Group select the User Group in the hierarchical tree and click on the Edit 
User Group Icon. 

 

This will bring up the User Groups dialogue box. 

 

1. Change the Name of the User Group and the Description. 

2. (If the mandatory check box is ticked, all new users will automatically be added to 
this group when they are created). 

3. Click on OK and the edited User Group will appear in the hierarchy. 

Deleting a User Group 
To Delete a User Group select the User Group in the hierarchical tree and click on the 
Delete User Group Icon. 
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This will bring up the Delete Confirmation. 

 

Click on Yes and the User Group will be removed. 

User Groups and Functionality in ISSC 
Privileges in Macro Space Management can be set using the Functional Security option 
in the Admin Module. However, privileges in In-Store Space Collaboration have to be 
assigned by a combination of actions in the Administration module and the database. 
This is because the buttons that are active in In-Store Space Collaboration are controlled 
by the Message User Group Link table. 

 

 The USG_ID is the ID of the User Group it is desired to activate buttons for. It is 
determined from the User Group table. 
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 The MSC_ID is the identity of the button or form it is desired to give a User 
Group permissions for. 

 THE MUG Permission Mask determines whether the button is active or grayed 
out. (1 = active, 0 = disabled). 

When a User Group is created in Functional Security, any users associated with that User 
group will be able to get into In-Store Space Collaboration, but will then find all the 
buttons on the toolbar grayed out and unavailable. In order for the buttons in In-Store 
Space Collaboration to become available, all the entries for USG_ID = 1 (Admin Users) 
have to be duplicated for the additional User Groups it is desired to make In-Store Space 
Collaboration available to. This can be done with a simple SQL Insert statement of the 
form: 

 

The value of the User Group ID in the User Group table (for example 9) is substituted for 
[User Group ID]. If it is necessary to disable specific functionality, the 
MUG_PERMISSION_MASK can be set to 0 (Disabled).  

Note: for more information on what is controlled by 
MSC_ID, please contact Oracle Retail Consulting. 

ISSC Select Store dialog box - District Manager Button 
The Message User Group Link  table is also used to control access to the District Manager 
button in the Select Store dialog box in In-Store Space Collaboration - this can be used by 
specific users to bulk Approve or Reject floor plans submitted to them for approval. 

 

To enable the District Manager button (MSC_ID = 7243), the MUG_PERMISSION_MASK 
must be set to 1 for the pertinent User Group (USG_ID). 

Note: For more information on these tables see the Oracle 
Retail Macro Space Planning Data Model. 
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Users 

Adding a User 
Users are Added to User Groups. The users then inherit the privileges of those User 
Groups. To Add a User select a User Group in the hierarchy then click on the Add a User 
Icon. 

 

This will bring up the User dialogue. 

 

First Name is the first name of the User. 

Last Name is the last name of the User. 
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Initials are the User's initials. 

Login ID  is what will appear in Macro Space Managements Log In dialogue box. 

Password and Password Confirmation allow the administrator to set the initial 
password. These will be required when logging in to Macro Space Management. 

Expiry Date sets the initial date at which the password will expire and require changing. 
(The interval at which the password will require further resets is determined by the 
Change Password Interval option in the Security Options option). 

Note: the expiry date can be set to a date in the past for new 
users. This will force a password change when they first log 
on. 

Language sets the default language for Macro Space Management. 

Note: For any other language than English the Message 
table must first be populated with the appropriate 
information. For more information on this table see the 
Oracle Retail Macro Space Planning Data Model. 

Activate is grayed out and unavailable when adding a new user. It becomes available 
when the user is edited. 

Note: A User cannot be added unless a valid node has been 
selected in the hierarchical tree. 

User Configuration and Logging In 
When Users are added (or User properties are Edited), Administrators can set the User 
Name and Password that will be required in the User Log in dialogue box that appears 
the first time Macro Space Management is opened. 

 

Note: the Expiry Date can be set to a date in the past. This 
will force a password change when the user first logs on. 

Thus, the 'Mark Twain' user has a user name of MT and a password set for their log in. 
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Editing a User 
To Edit a User highlight the user in the hierarchy then click on the edit user icon. 

 

This will bring up the User dialogue. 
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Edit the details as required and press OK. 

Deleting a User 
To Delete a User highlight the user in the hierarchy and click on the delete icon.   

Note: Deleting a user will remove the user from all user 
groups. Use an alternative method if it is desired to remove 
the User from a single User Group.  

 

This will bring up the Delete Confirmation. 

 

Click on Yes and the User will be removed from all User Groups. 

Adding Users to Multiple User Groups 
Adding Users to Multiple User Groups is carried out by using the Copy and Paste 
options. 
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1. Open up the hierarchical tree and highlight an instance of the user you wish to copy. 

2. Click on the Copy icon. 

3. Highlight the User group it is desired to copy the User to. 

4. Click on the Paste icon. 

The user will now be copied to the required User Group. 

Moving Users from one User Group to Another 
Moving Users to from one User Group to Another is carried out by using the Cut and 
Paste options. 
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1. Open up the hierarchical tree to find an instance of the user you wish to move. 

2. Click on the Cut icon. 

3. Highlight the User Group it is desired to move the user to. 

4. Click on the Paste icon. 

The User will now be removed from the first User Group and copied to the second User 
Group. 

Removing Users from Multiple User Groups 
Removing 'Multiple User Group' Users from some of those User Groups is not directly 
possible with the current functionality, but it can be achieved indirectly. 

Note: Do not use the Delete option to remove a User from a 
single User Group - this will result in the User being deleted 
from all User Groups. 
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1. Click on the Add Group Icon to create a Temporary Group. 

2. Name the Group Temporary or some other similar name. 

3. Open the hierarchy and select the User Group and the User it is desired to remove 
from the Group. 

4. Click on the Cut icon. 

5. Highlight the Temporary User Group. 

6. Click on the Paste icon. The User will be removed from the selected User Group and 
copied to the Temporary User Group. 

7. Delete the Temporary User Group. 

Purge Users Option 
Purge options are available using the Purge option on the Tools pull down menu. 

 

The user will not be permanently deleted from the database until the Users option is 
checked in the Purge dialogue box and the OK button clicked. 
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Note: Until the user is purged from the database, they will 
still be able to use their User Name and Password. Deleting 
a user in Functional Security alone is not enough to prevent 
them from accessing Macro Space Management. 

Group Relationships 

Overview of Group Relationships 

Group Relationships 
Group Relationships are used to define areas of functionality for which security can be 
set. These control access to the main modules of Macro Space Management - for example 
Fixture Studio. User Groups can then be assigned to these areas of functionality - 
allowing access to be controlled to the different modules. 

Adding, Editing and Deleting Command Groups 

At present Adding Command Groups has no effect as there is no method of tying the 
newly added Command Group into any functionality. The names of Command Groups 
can be edited, but this is not recommended as it may make it difficult to establish which 
functionality is having its access controlled. Command Groups can be deleted. This is not 
recommended as deleting a command group removes all control over access to the 
module it references. 

Using Group Relationships 

User Groups can be created in the User Groups Tab. Permissions to access specific parts 
of the Macro Space Management and In-Store Space Collaboration can then be granted 
by associating User Groups to the top level command groups. 
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In the above example, Planogram Substitution has been made available to users 
belonging to the Administrator and Merchandise Planner User Groups. After access to 
the module has been set up, specific access permissions have to be assigned. This is done 
by highlighting a User Group and selecting the Edit Permission  option on the right click 
menu.  This will bring up the Permission dialog box where details settings can be made. 

 

Working With User Groups and Command Groups 
There are two stages for adding permission for a user to access functionality pertinent to 
a module: adding a user group and setting the pertinent permissions for that user group.  

Adding Permissions for a Module 
There are two stages for adding permission for a user to access functionality pertinent to 
a store: adding a user group and setting the pertinent permissions for that user group.  

Adding User Groups 

Adding user groups for a module is done in three stages. 
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1. Highlight the required Command Group and select Add User Group from the right 
click menu 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 

 

3. On clicking OK, the selected User Groups will be added to the list of those that can 
access that module. 
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All Users belonging to the selected User Groups will be able to access functionality in 
Planner or access that store in In-Store Space Collaboration. 

Setting Detailed Permissions 

To set permissions for a specific user group for a module, highlight the user group for 
that module and then click the Edit option on the toolbar or Edit Permissions from the 
Edit menu. This will bring up the Permissions dialog box. Options can be set by selecting 
the pertinent check boxes. Some of these settings are mutually exclusive, meaning that 
selecting one setting will automatically select more.  

 

Option Suggested Permissions 

Read Only Access Allow Read, Deny add, Edit and Delete. 

Full Access Allow Read, Add, Edit and Delete 

Note: Not setting the Permission can result in the users in 
that User Group being unable to access those objects. 
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Deleting Permissions for Stores 
Deleting Permissions for Stores is done by highlighting the User Group it is desired to 
remove and selecting Delete from the right click menu. (Alternatively, the Delete Links 
option can be used from the toolbar). 

 

A confirmatory dialog box will appear. Click OK and the User Group will be deleted 
from having access to that module. 
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Specific Functionality Controlled by Functional Security 

Data Importer 
As well as setting general access to a module, some specific items of functionality require 
additional permissions to access. This is normally because inappropriate use can cause 
significant problems within the application. Within the Data Importer module, two 
specific items of functionality require additional permissions. 

Lookup Dialog Box 
The Import Lookups dialog box enables users to configure lookups for use when 
importing data. 

 

Selecting a lookup and choosing the edit option brings up the Edit Import Lookup dialog 
box. 

 

The Table Name/SQL field enables a user to use SQL statements in conjunction with the 
table name; for example a Where clause to be used to control how the table is to be 
updated. There are no restrictions on the SQL that could be used - unrestricted, 
customized queries can be constructed. Accordingly, permission to access this 
functionality must be assigned carefully and should be restricted to trusted power users. 

Import Defin ition Dialog Box 
The Import Definitions dialog box has the facility to run SQL on the data; either 
immediately before it is imported or immediately after it is imported. 
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 The dialog box to do this is accessed by clicking the Pre SQL or Post SQL button. 

 

There are no restrictions on the SQL that could be used - in this example a Delete 
command is being used. Accordingly, permission to access this functionality must be 
assigned carefully and should be restricted to trusted power users. 

Assigning Permissions 
Assigning Permissions is done in two stages: 

Assign User Group to Command Group 

The first stage is to assign permission for a user group to access the functionality. This is 
done by highlighting the required functionality in the Group Relationships tab and 
selecting Add User Group from the right click menu. This will bring up the Add User 
Group dialog box - enabling the required user group to be selected. 
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Separate permissions are required to access the Looks dialog box and the Pre and Post 
SQL functionality. 

Once this has been done, specific permissions are assigned. This is done by highlighting 
the recently added user group and selecting Edit Permissions from the right click menu. 
This will bring up the Permissions dialog box. Users will require the Allow permissions 
to use the functionality. 

 

KPIs in Planner and Merchandiser 
As well as setting general access to a module, some specific items of functionality require 
additional permissions to access. This is normally because inappropriate use can cause 
significant problems within the application. Within the Planner and Merchandiser 
modules, the ability to configure KPI's requires additional permissions. 

Edit KPI Dialog Box 
The Key Performance Indicators dialog box (accessed from the KPI tab of the Object 
Browser) allows anyone configuring a KPI to do two things: 
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 To execute a  SQL statement - unrestricted, customized queries can be 
constructed. 

 To invoke any stored procedure that exists in the database. 

These options could result in unintended effects in the database. Permissions to use them 
must be assigned carefully and should be restricted to trusted power users 

Assigning Permissions 
Assigning Permissions is done in two stages: 

Assign User Group to Command Group 

The first stage is to assign permission for a user group to access the functionality. This is 
done by highlighting the required functionality in the Group Relationships tab and 
selecting Add User Group from the right click menu. This will bring up the Add User 
Group dialog box - enabling the required user group to be selected. 
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Separate access rights are required to access the Key Performance Indicators dialog in the 
Planner and in the Merchandiser modules. 

Once user groups have been assigned, specific permissions have to be assigned. This is 
done by highlighting the recently added user group and selecting Edit Permissions from 
the right click menu. This will bring up the Permissions dialog box. Users will require the 
Allow permissions to use the functionality. 
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Data Security 

Overview of Data Security 
Data Security is an extension of Functional Security. It allows Administrators to further 
restrict the permissions a user may have for functionality in both Macro Space 
Management and In-Store Space Collaboration. The functionality includes: 

Option Functionality  Applications 

Stores 

When used in conjunction with statuses, this tab can be used with the 
Status tab to determine which floor plans users can access in In-Store 
space collaboration. It also determined which users can run Floor Plan 
Processing and Floor Plan Publishing as a batch process.  It also 
determines who can run the Pre-Process floor Plans, Floor Plan Print and 
Immediate Floor Plan Publishing in Planner. 

MSM and 
ISSC 

Products This can be used to restrict which products can be accessed in the 
product hierarchy in ISSC.  ISSC 

Planograms 
This can be used to restrict which planograms can be selected for 
planogram substitutions. It can also be used to restrict what planograms 
can be printed using the Print Planogram option   

MSM and 
ISSC 

Status When used in conjunction with stores, this tab can be used with the 
Status tab to determine which floor plans users can access. 

MSM and 
ISSC 

 

Option Description 

Menus The Edit, File and View menus allow users to access the data security functions. 

Toolbar The toolbar allows the user to access a slightly more restricted set of data security 
functions. 
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Option Description 

Tabs 
The Stores, Products, Planograms and Status tabs allow data security to be set for 
those types of objects. 

Hierarchy The hierarchy shows an organized list of the objects for that tab. 

Permissions 
List 

The permissions list shows the user groups that have been assigned and what 
permissions have been set. 

Menus and Toolbar 
The File menu allows users to exit this dialog box. 

 

The Edit pull down menu allows users to configure the permissions for the data. The 
options will vary slightly depending on the tab selected. 

 

The View menu allows users to access the find dialogues and to refresh the information 
in the Data Security window with the latest information in the database. 

 

The Toolbar has a number of options. These vary according to the tab selected. 

Icon Meaning 

 

Add User Group. This allows an administrator to add another user group to those with 
permissions to access the object. 

 

Edit Permissions. This allows an administrator to assign read, add, edit and delete 
permissions for a specific user group. 

 

Delete Link. This option allows administrators to remove the permission for a specific 
user group to access the specified object. 

 

Find. This option brings up the Find dialog box. It can be used to find objects in the 
currently active tab. 

 

Refresh. This option updates the dialog box with the current information stored in the 
database. 

Note: The methods for adding, editing and removing 
permissions differs slightly from tab to tab. The method for 
each is described in the pertinent section.  
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Data Security for Stores 
Data Security for Stores is intended to allow Administrators to assign permission for 
User Groups accessing: 

 Specific functionality within the Planner module 

 Specific Stores and Floor Plans within In-Store Space Collaboration. 

 

The store hierarchy that is visible is configured in the Store Manager module. This 
accessed from either the Planner or Merchandiser modules. 

Macro Space Management 
The Stores tab of the Data Security dialog box can be used to assign permissions for User 
Groups to: 

Application Option 

MSM Run Floor Plan Processing as a Batch Process. 

MSM Run Floor Plan Publishing as a Batch Processes. 

MSM Run Find and Open Floor Plans in the Planner module. 

MSM Run Pre-Process Floor Plans in the Planner module. 

MSM Run Print Floor Plans in the Planner module. 

MSM Run Immediate Floor Plan Publishing in the Planner module. 

Note: This functionality also depends on permissions set for 
Store Statuses and File (Floor Plan) Statuses. 

In-Store Space Collaboration 
The Stores tab of the Data Security dialog box can be used to assign permissions for User 
Groups to access specific stores. This functionality must be used in conjunction with the 
Status tab, for in order to see a floor plan, the user must have permissions for both the 
store and the file status the floor plan is at. For example and ISSc user may only have 
permission to set a sub-set of floor plans at a specific status. Once permissions have been 
assigned, the floor plans from the store at the specified statuses appear in the Select Store 
dialog box when In-Store Space Collaboration is opened. 
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Adding Permissions for Stores 
There are two stages for adding permission for a user to access functionality pertinent to 
a store: adding a user group and setting the pertinent permissions for that user group.  

Adding User Groups 

Adding user groups for stores is done in three stages. 

1. Highlight the required store and select Add User Group from the right click menu. 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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3. On clicking OK, the selected User Group will be added to the list of those that can 
access functionality associated with that store. 

 

All Users belonging to the selected User Groups will be able to access functionality in 
Planner or access that store in In-Store Space Collaboration. 

Setting Permissions 
To set permissions for a specific user group for a specific store, highlight the user group 
for that store and then click the Edit option on the toolbar or Edit Permissions  from the 
Edit menu. This will bring up the Permissions dialog box. Options can be set by selecting 
the pertinent check boxes. Some of these settings are mutually exclusive, meaning that 
selecting one setting will automatically select more.  
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Option Suggested Permissions 

Read Only Access Allow Read, Deny add, Edit and Delete. 

Full Access Allow Read, Add, Edit and Delete 

Note: Not setting the Permission can result in the users in 
that User Group being unable to access those objects. 

Deleting Permissions for Stores 
Deleting Permissions for Stores is done by highlighting the store it is desired to remove 
the user group from and selecting 'Delete User Group' from the right click menu (or 
using the Delete option from the toolbar). 

 

Data Security for Products 
Data Security for Products  is intended to allow Administrators to assign permission at 
Department, Class or Sub-class level for User Groups to place products. this functionality 
only applies for ISSC. 
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In order for this functionality to work, some preliminary configuration must be carried 
out directly in the database.  

Adding Permissions for Products 
There are two stages for adding permission for a user to access products in ISSC: adding 
a user group and setting the pertinent permissions for that user group.  

Adding User Groups 

Adding user groups for stores is done in three stages. 

1. Highlight the required status and select Add User Group from the toolbar. 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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3. On clicking OK, the selected User Group will be added to the list of those that can 
access that product. 

 

All Users belonging to the selected User Groups will be able to access planograms within 
those groups. 

Setting Permissions 
To set permissions for a specific user group for a specific product, highlight the user 
group for that product and then click the Edit option on the toolbar or Edit Permissions 
from the Edit menu. This will bring up the Permissions dialog box. Options can be set by 
selecting the pertinent check boxes. Some of these settings are mutually exclusive, 
meaning that selecting one setting will automatically select more.  
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Option Suggested Permissions 

Read Only Access Allow Read, Deny add, Edit and Delete. 

Full Access Allow Read, Add, Edit and Delete 

Note: Not setting the Permission can result in the users in 
that User Group being unable to access those objects. 

Deleting Permissions for Products 
Deleting Permissions for statuses is done by highlighting the store or file status it is 
desired to remove the user group from and selecting 'Delete User Group' from the 
toolbar. 

 

Data Security for Planograms 
Data Security for Planograms is used to restrict which planograms can be selected for 
planogram substitutions. It can also be used to restrict what planograms can be printed 
using the Print Planogram option.  The planogram hierarchy that is visible is either 
imported or configured in the Merchandiser module. 
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Permissions apply to all child planogram groups. Because the Food and Drink Manager 
User Group has been given access rights to the Food and Drink planogram group, 
members of that user group have rights for all planogram groups below that node. If a 
user group for more restricted access is created - for example Frozen Goods Manager - 
they could be given access rights to the Frozen Goods planogram group enabling them to 
configure planogram substitutions and so on for that sub-set of planograms, but without 
the wider rights that a member of the Food and Drink Manager User Group has. 

Functionality for which Permissions Apply 

Application Option 

MSM Run Planogram Substitution as a Batch Process. 

MSM Run Planogram Publishing as a Batch Process. 

MSM Run Immediate Planogram Publishing in the Planner or Merchandiser modules. 

MSM Run Planogram Printing in the Planner or Merchandiser modules. 

ISSC Run Planogram Printing. 

If no user groups are assigned to planograms, then they will be available to all user 
groups. Once permissions have been assigned to one or more planogram groups, then 
users will only be able to see planograms assigned to a group they have permissions for. 

Adding Permissions for Planograms 
There are two stages for adding permission for a user to access planogram groups: 
adding a user group and setting the pertinent permissions for that user group.  

Adding User Groups 

Adding user groups for planograms is done in three stages. 

1. Highlight the required planogram group and select Add User Group from the 
toolbar. 
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2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 

 

3. On clicking OK, the selected User Group will be added to the list of those that can 
access those planogram groups. 
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All Users belonging to the selected User Groups will be able to access planograms within 
those groups. 

Setting Permissions 

To set permissions for a specific user group for a specific planogram group, highlight the 
user group for that store and then click the Edit option on the toolbar or Edit 
Permissions from the Edit menu. This will bring up the Permissions dialog box. Options 
can be set by selecting the pertinent check boxes. Some of these settings are mutually 
exclusive, meaning that selecting one setting will automatically select more.  

 

Option Suggested Permissions 

Read Only Access Allow Read, Deny add, Edit and Delete. 

Full Access Allow Read, Add, Edit and Delete 

Note: Not setting the Permission can result in the users in 
that User Group being unable to access those objects. 

Deleting Permissions for Planograms 
Deleting Permissions for Stores is done by highlighting the planogram group it is desired 
to remove the user group from and selecting 'Delete User Group' from the toolbar. 
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Data Security for Statuses 
Data Security for Statuses is intended to allow Administrators to assign permissions for 
User Groups for accessing certain functionality associated with floor plans in the Planner 
Module. It also allows Administrators to assign permissions for User Groups for 
accessing floor plans of specific status in In-Store Space Collaboration. 

 

At present Data Security for Statuses only operates for File statuses. 

Macro Space Management 
The Status tab of the Data Security dialog box can be used to assign permissions for User 
Groups to: 

Application Option 

MSM 
Run Floor Plan Processing as a Batch Process for files at statuses that user group has 
permission for. 

MSM 
Run Floor Plan Publishing as a Batch Processes for files at statuses that user group has 
permission for. 
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Application Option 

MSM 
Run Find and Open Floor Plans in the Planner module for files at statuses that user 
group has permission for. 

MSM 
Run Pre-Process Floor Plans in the Planner module for files at statuses that user group 
has permission for. 

MSM 
Run Print Floor Plans in the Planner module for files at statuses that user group has 
permission for. 

MSM 
Run Immediate Floor Plan Publishing in the Planner module for files at statuses that 
user group has permission for. 

Note: This functionality also depends on permissions set for 
Store Statuses and File (Floor Plan) Statuses. 

In-Store Space Collaboration 
The Status tab of the Data Security dialog box can be used to assign permissions for User 
Groups to access floor plans at a specific status. This functionality must be used in 
conjunction with the Stores tab, for in order to see a floor plan, the user must have 
permissions for both the store and the file status the floor plan is at. For example and 
ISSC user may only have permission to set a sub-set of floor plans at a specific status. 
Once permissions have been assigned, the floor plans from the store at the specified 
statuses appear in the Select Store dialog box when In-Store Space Collaboration is 
opened. 

 

Adding Permissions for Statuses 
There are two stages for adding permission for a user to access stores and floor plans at a 
specific status: adding a user group and setting the pertinent permissions for that user 
group.  

Adding User Groups 

Adding user groups for stores is done in three stages. 

1. Highlight the required status and select Add User Group from the toolbar.  
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2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 

 

3. On clicking OK, the selected User Group will be added to the list of those that can 
access that status. 
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All Users belonging to the selected User Groups will be able to access planograms within 
those groups. 

Setting Permissions 

To set permissions for a specific user group for a specific status, highlight the user group 
for that store and then click the Edit option on the toolbar or Edit Permissions  from the 
Edit menu. This will bring up the Permissions dialog box. Options can be set by selecting 
the pertinent check boxes. Some of these settings are mutually exclusive, meaning that 
selecting one setting will automatically select more.  

 

Option Suggested Permissions 

Read Only Access Allow Read, Deny add, Edit and Delete. 

Full Access Allow Read, Add, Edit and Delete 

Note: Not setting the Permission can result in the users in 
that User Group being unable to access those objects. 

Deleting Permissions for Statuses 
Deleting Permissions for statuses is done by highlighting the store or file status it is 
desired to remove the user group from and selecting 'Delete User Group' from the 
toolbar. 
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Using Data Security 

Adding and Removing Permissions for Stores 

Adding Permissions for Stores 
Adding Permissions for Statuses is done in three stages. 

1. Highlight the required store and select the Add User Group option from the right 
click menu 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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3. On clicking OK, the selected User Group will be added to the list of those that can 
access functionality associated with that store. 
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All Users belonging to the selected User Groups will be able to access functionality in 
Planner or access that store in In-Store Space Collaboration. 

Deleting Permissions for Stores 
Deleting Permissions for Stores is done by highlighting the User Group it is desired to 
remove and selecting 'Delete User Group' from the right click menu. 

 

Alternatively, the Delete Links option can be used from the toolbar. 

Adding and Removing Permissions for Planograms 

Adding Permissions for Planograms 

Note: permissions for planograms are allocated for their 
parent groups. 

Adding Permissions for planograms is done in three stages. 

1. Highlight the required planogram group and select the Add User Group option from 
the Edit menu. 
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2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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3. On clicking OK, the selected User Groups will be added to the list of those that can 
access planograms in that Planogram Group in the Planogram Substitution 
functionality. 

 

All Users belonging to the selected User Groups will be able to access planograms 
belonging to that planogram group in the planogram substitution functionality.   

Deleting Permissions for Planograms 
Deleting Permissions for planograms is done by highlighting the User Group it is desired 
to remove and selecting 'Delete Link' from the Edit menu. 
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Permissions for Planograms 
Permissions for planograms apply to all child objects in the hierarchy for a specified 
planogram group. 

Adding and Removing Permissions for Statuses 

Adding Permissions for Statuses 
Adding Permissions for Statuses is done in three stages  

1. Highlight the required status and select the Add User Group option from the Edit 
menu 

 

2. This will bring up the Add User Group dialog box. The User Groups it is desired to 
add can be selected from the list. 
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3. On clicking OK, the selected User Group will be added to the list of those that can 
view store plans of that status in In-Store Space Collaboration. 
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All Users belonging to the selected User Groups will be able to access store plans of that 
status in In-Store Space Collaboration (providing they also have rights to access that 
store). 

Deleting Permissions for Statuses 
Deleting Permissions for Statuses is done by highlighting the User Group it is desired to 
remove and selecting 'Delete Link' from the Edit menu. 

 

Configuration 

Overview of Configuration Section 
This section contains an overview of how to configure specific aspects of the Macro Space 
Planning suite.  Current sections are: 

Macro Space Management 
This covers setting up customizable buttons. 

ISSC Mobile 
This covers how to set up access rights for ISSC mobile, together with how to configure 
object properties, annotation and KPIs. 

Customizable Buttons 

Customizable Buttons 

Overview of Functionality 
Customizable buttons are used in the Planner module. They are an optional item during 
the installation process, so not all retailers will have this functionality implemented. If 
 implemented the Planner user will see the Customizable Button toolbar. 
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This toolbar has ten buttons by default, each of which can call a stored procedure. This 
stored procedure is created by an implementer or administrator and can execute any task 
against data in the database. 

Example of Customizable Button Use 

The stored procedures called by the customizable buttons can execute any task that can 
be carried out by manipulating the data in the database. An example of this is splitting a 
floor plan up into departmental level floor plans, allowing multiple planners to work on 
a store plan simultaneously. 

 

1. A floor plan at current status (i.e. already in service)  is opened. 

2. Clicking a customizable button runs a stored procedure that creates a desires of floor 
plans for the individual departments in the floor plan. 

3. Multiple store planners work on the departments they are responsible for. 

4. Clicking on another customizable button runs a stored procedure that reassembles 
the department level floor plans into a single floor plan. 

This would allow a floor plan to be revised in a quick time scale using a team of floor 
planner, each with expertise in a particular department of the store. 

Example of Using the Functionality 
An example of how to use the customizable Button functionality works is as follows: 
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Open Floor Plan 

This functionality can only be used when a floor plan is open. Attempting to use it 
without one open will result in an error message. 

 

Click Customizable Button 

The purpose of each customizable button can be seen by hovering the mouse pointer 
over it. This will being up the button name and a tooltip. These are customized during 
implementation. The functionality is run by clicking the selected button in the toolbar. 

Note: Pressing F1 will bring up the AutoCAD help - not 
Planner help. 
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Note: Customizable buttons can also be run by typing 
AVT_CUSTOM into the command line, then entering the 
name of the command. 

Verifying Permissions 

Permission to use the functionality is assigned by an Administrator in MSMs 
Administration module.  If the user does not have permission, the functionality will not 
run and a message to this effect will appear in AutoCAD's command line.  

 

Stored Procedure Execution 

If sufficient permissions exist, the stored procedure will execute.  A stored procedure is a 
way of directly manipulating data in the database. The data can be manipulated to 
perform a large number of tasks. What is configured will be retailer specific. Ask your 
administrator for details. 

Command Line Results 

Once the stored procedure has been executed, the results will appear in the AutoCAD 
command line. 

 

In the above example the stored procedure was designed to replace outdated fixtures. 
The message indicates that this was completed successfully. 

Carry out Necessary Follow Up Actions 

After the stored procedure has executed, some follow up actions may be necessary. In the 
case of the above example where a stored procedure was used to replace outdated 
fixtures, it is necessary for the user to first synchronize the floor plan 'match the database' 
and then manually save changes to the floor plan. If they do not and merely exit the floor 
plan the changes made by the stored procedure will be rolled back and the floor plan will 
revert to the state of when the floor plan was last saved. This could be different from 
before the button was pressed because any other changes will also be rolled back. 

Configuring Customizable Buttons 
This section describes how to configure customizable buttons. The flowchart below 
shows the required actions, although some stages are optional.  

Note: For more information on the tables in this section see 
the Oracle Retail Macro Space Planning Data Model. 
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Install Customizable Button Option 
The customizable button option is not installed by default during each installation of 
Macro Space Management. Instead, it has to be selected as an option. Retailers must thus 
opt to have the functionality available. If installed, the customizable Buttons Toolbar will 
be present in the Planner module. The task of the implementer is to identify the needs of 
the retails and configure the functionality accordingly. Once the functionality is 
configured, clicking any button will result in the user running a specified stored 
procedure from the database. These stored procedures are created by the implementer to 
execute a retailer specific task.  
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Run Custom Upgrade Script 
The scripts provided with the MSP installation package include a script called X.X.X.GA-
Custom.sql where X.X.X is the number of the build.  This will install am example stored 
procedure called Custom in the MSP database. This example stored procedure serves 
two purposes: 

 It enables an implementer to see that the functionality has been configured 
correctly by running it from the Customizable Button toolbar. 

– Messages will be generated on the AutoCAD command line when the stored 
procedure is executed. 

– Entries will also be written to the Process File Log table to verify that logging 
is working correctly.  

 It gives an example of the standard inputs and outputs required from an stored 
procedure developed for a specific retailer. 

Once the custom stored procedure has been used during implementation, any reference 
to it should be deleted out of the Custom Procedure table to remove a possible entry 
point for an attacker. 

Give Permissions to Custom Commands Command Group 
The Planner Command Group has a child command group called the Custom 
Commands Command Group. In order to use the Customizable Buttons functionality, 
the user must be a member a User Group with the rights to use this command group  

 

To assign User Groups to this Command Group: 

1. Bring up the Functional Security dialog box from the Security menu in the 
Administration module. Select the Group Relationships tab. 

2. Highlight the Custom Commands Command Group and bring up the right click 
menu. 

3. This will bring up the Add User Group dialog box. 

 



  

630 Oracle Retail Macro Space Management 

4. Select the required user groups and click OK. This will add the User Group. 

5. Select the User Group and bring up the right click menu. Select Edit Permissions. 
This will bring up the Edit Permissions dialog box. 

6. For the User Group to be able to invoke the Customizable Button functionality, a 
minimum of Allow Read must be selected.  

7. Click OK to save the settings. 

If a user does not belong to a user group with permissions to this Command Group, 
when they attempt to execute a command from a customizable button, a message saying 
the users has insufficient permissions will appear on the AutoCAD command line. 

Create Command Group in Functional Security 
One option open to the implementer is to create a command group specifically for users 
of customizable buttons. This is done in the Functional Security dialog box accessed from 
the Security menu. In the example below, two command groups have been created; one 
giving access to the first five customizable buttons, the other to the second five. 

 

This will create an entry in the Command Group  table in the MSP database. User groups 
are linked to that table by the Command User Group Link table. This has the following 
fields: 

 

By referencing the User Group ID (USG_ID) and Command Group ID (CMG_ID) in this 
table in the stored procedure, it is possible to link to the permission granted to User 
Groups in Functional Security to the ability to run the stored procedure. This is done by 
referencing the CGL_PERMISSION_MASK field which holds a bitwise variable 
indicating whether the user has permission or not.  

Note: See the Oracle Retail Macro Space Planning Data Model 
for the possible values of the bitwise variable. 
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Creating Command Groups 

To create a Command Group: 

1. Highlight the required parent Command Group, bring up the right click menu and 
select Add Command Group. 

2. This will bring up the Command Group dialog box. 

3. Enter the required name and description in the Command Group dialog box and 
click OK. 

Assigning User Groups 

To assign User Groups to this Command Group: 

1. Bring up the Functional Security dialog box from the Security menu in the 
Administration module. Select the Group Relationships tab. 

2. Highlight the recently created Command Group and bring up the right click menu. 

3. This will bring up the Add User Group dialog box. 

4. Select the required user groups and click OK. This will add the User Group. 

5. Select the User Group and bring up the right click menu. Select Edit Permissions. 
This will bring up the Edit Permissions dialog box. 

6. For the User Group to be able to run a subset of the Customizable Button 
functionality, a minimum of Allow Read must be selected. Other permissions can be 
selected as required. 

7. Click OK to save the settings. 

Creating the Required Stored Procedures 
The stored procedures have to be created by an implementer. They must meet the 
following criteria: 

Note: The Custom stored procedure supplied as a script 
with the installation package gives a simple worked example 
of the requirements.  

General information 

Before starting to create a store procedure, the implementer should be familiar with: 

 The Schema 

The Oracle Retail Macro space Planning Data Model has full information on the 
tables in the database, their relationship to each other and the fields in each table. 
An implementer will need to determine the affected tables and the 
interrelationship between them. 

 The Business Processes 

Macro Space Planning has clearly defined business processes. For example 
statuses describe where an object is within its business life cycle. If the stored 
procedure affects any such business processes, the pertinent tables must be 
updated accordingly. 

 The Functionality 

Implementers should also understand how the Macro Space Planning 
functionality works. As an example, there is auto-synchronize functionality in 
the planner module. If active, this functionality reads the FIL_LAST_MODIFIED 
date in the AVTTB_FILE table and if necessary synchronizes the floor plan with 
the database.  This is an example of how the implementer might need to update 
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tables other than those directly concerned with the custom functionality they are 
implementing. 

 Other Actions 

The custom stored procedures may create changes in the database. However, 
particularly if working in a live floor plan, the user may need to carry out specified 
manual actions as a follow up. For example the changes created by a stored 
procedure may not be permanently saved to the database until the user manually 
saves the floor plan. Similarly it may be necessary to rerun things like adjacency and 
area calculations. In these cases, the implementer may need to collaborate with 
producing instructions for Macro Space Planning Users. Alternatively, certain of the 
necessary follow up actions could be carried out by means of a batch process - for 
example updating adjacency calculations. 

Inputs for the Stored Procedure 

Each stored procedure has two inputs to the stored procedure  provided by the code. 
They are: 

Order Variable 
Name 

Data 
Type 

Source 

1 FILEID Number FIL_ID from the AVTTB_FILE table. This identifies the file to be 
processed and will be the currently active floor plan. 

2 USERID Number USR_ID from the AVTTB_USER table. This identifies the user 
invoking the command and will be the current user. 

Note: Variable names are case sensitive. The variables must 
also be present in the specified order. 

Outputs from the Stored Procedure 

The outputs from the stored procedure are: 

Order Variable Name Data 
Type 

Source 

1 RETURN_VALUE Number This is a value indicating the result of the stored procedure. 0 
indicates the stored procedure has been run successfully. Any 
other value indicates that there has been a problem with the 
execution of the stored procedure.  The code will then take this 
value, and either write a Boolean value in the PFL_SUCCESS 
field of the AVTTB_PROCESS_FILE_LOG table. 0 = Failure, 1 = 
Success. 

2 RETURN_STRING Text This is any text string specified by the user. An example would 
be text selected from a Case statement depending on the outcome 
of the stored procedure. The code will then take this string and 
write it to the PFL_DETAILS fie ld of the 
AVTTB_PROCESS_FILE_LOG table.  It will also be written to 
the AutoCAD command line in Planner to inform the user of the 
result of running the stored procedure. 

Note: Variable names are case sensitive. The variables must 
also be present in the specified order. 

The stored procedure can be set to return any numerical value to the RETURN_VALUE 
field. For example these might be error codes from the database indicating why the 
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stored procedure had failed. The code will only write a Boolean value in the 
PFL_SUCCESS field of the AVTTB_PROCESS_FILE_LOG table. If it is desired to store 
this error code, there are several options available to the user. Two examples are; 

 Set the stored procedure to put an additional line into the 
AVTTB_PROCESS_FILE_LOG table to hold the error code. 

 Create a user specific table for custom logging and write the result to that.  

Body of the Stored Procedure 

The body of the stored procedure is used to implement the custom functionality required 
by the retailers. The code will pass two values into the stored procedure. These are: 

 FILEID - the FIL_ID (AVTTB_FILE table) of the currently active floor plan.  This 
is used to select data pertinent to the currently active floor plan. 

 USERID - the USR_ID (AVTTB_USER table) of the user invoking the 
functionality. This is used to validate the permissions that the user has. The code 
will automatically check that the user has permissions for the Custom 
Commands Command Group in the Functional Security. If the implementer has 
created additional command groups for granularity for which user groups can 
run which commands, the stored procedure will have to reference those 
command groups to control access to the functionality.  

The stored procedure can be used to accomplish a wide variety of tasks in the database. 
Accordingly it is only possible to give general guidelines. 

 DWG Files 

Some actions may require the creation of AutoCAD DWG files. An example would 
be to split a floor plan into its constituent zones and create a new floor plan for each 
so that multiple planners can work on a floor plan simultaneously. In this event the 
stored procedure would have to interface with functionality to create the parent 
windows folders and the associated DWG files.  

 Concurrency 

Some Macro Space Planning functionality looks floor plans against change when 
checked out to a user. Consideration would have to be given to preventing the stored 
procedure affecting information checked out to other uses. Similarly, some tables are 
check out to specific users when in use - again this should be taken into account. 

 Custom Logging and Reports  

The implementer may have to create custom logging and reports as part of the 
retailer's business processes. 

Verifying the Stored Procedure 

Any stored procedures should be initially tested against a trial database.  

Set CUSTOM_BUTTON_TIMECHECK_STEP System Variable 

The CUSTOM_BUTTON_TIMECHECK_STEP system variable determines whether the 
date and time the stored procedure was created is checked against the date and time held 
in the CPR_LAST_DDL_TIME field in the AVTTB_CUSTOM_PROCEDURE table. If set 
to On (the default) the stored procedure will not execute if the two items of data differ. 
This is intended as a security precaution to ensure it is more difficult to insert and run a 
malicious stored procedure in the database.  

0 = Off 

1 = On 
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The normal use of this system variable is to disable the check during implementation 
when stored procedures may be being regularly updated. The system variable can then 
be set back to On once all the required system variables have been created and tested and 
the functionality is ready to go live. 

Configure AVTTB_CUSTOM_PROCEDURE Table 
The next stage is to configure the AVTTB_CUSTOM_PROCEDURE table. As a result of 
running in the Custom upgrade script, this has the following initial fields. These should 
be edited as required. 

 

Field Comment 

CPR_ALIAS 

This fie ld should match the alias in the macro name. For example id the 
macro name is Ĉ̂ AVT_CUSTOM Example, this field should hold EXAMPLE. 
When the customizable button is clicked, the code will look at the alias in 
the macro and attempt to match it to the alias in this field. This in turn 
allows the code to call the stored procedure referenced  in the 
CPR_PROCEDURE_NAME field. 

CPR_PROCEDURE_NA
ME 

This fie ld should hold the name of the stored procedure to be called.   

CPR_LAST_DDL_TIME 

This fie ld holds the date and time the stored procedure was last updated 
in the database. When the customizable button is invoked, the code 
checks that the time held in this fie ld is the same as the database holds in 
the LAST_DDL_TIME field of the DBA_OBJECTS system table in the 
database for each stored procedure. If the two fields do not match, the 
code will assume that the store procedure may have been modified 
maliciously and it will not be run.  

Note: This option can be disabled by 
changing the setting of the 
CUSTOM_BUTTOM_TIMESTAMP
_CHECK system variable. 

Configure Report for AVTTB_CUSTOM_PROCEDURE_LOG Table 
The results of invoking a stored procedure via a customizable button are stored in the 
AVTTB_PROCESS_FILE_LOG table. All entries with PFL_LOGTYPE = 4 have been 
generated using the customizable buttons functionality.  
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Users in the Planner module see the result of the RETURN_STRING  field in the stored 
procedure displayed in the AutoCAD command line after running a stored procedure via 
a customizable button. However, MSP administrators without direct access to the 
database may need a report to see the results of running these stored procedures. 

Note: See the Oracle Retail Macro Space Planning Data Model 
for more information on this table. 

Configuring Customizable Buttons in Planner 
The customizable buttons in Planner need to be configured. This is done from the 
Customize User Interface dialog box in planner. This is an AutoCAD dialog box called 
by typing CUI into the AutoCAD command line. only basic details of how to configure 
this dialog box will be given below - for full details see the AutoCAD documentation. 

 

Three things require editing in this dialog box for each of the buttons. These are: 
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Option  Comment 

Name 
This should be changed to a description of the stored procedure that will be 
called 

Description This will act as the tooltip when a user hovers the mouse cursor over the button.  

Macro This should map to a name on the CPR_ALIAS field of the 
AVTTB_CUSTOM_PROCEDURE table. 

Name 

The Name field holds the name that will be displayed for the button, not the Command 
Name field. 

Description 

This field in holds text that will be used as the tooltip  

Macro 

As installed, the macro is of the form: ̂ Ĉ AVT_CUSTOM Update_Data.  

 ^C^ is used to cancel the previous command. 

 AVT_CUSTOM is the AutoCAD command invoked 

 The text following the space is a parameter passed to the code. This will call the 
stored procedure referenced by this parameter in the 
AVTTB_CUSTOM_PROCEDURE table. In this example, the parameter is the 
string Update_Data. The code will then look for the value Update_Data in the 
CPR_ALIAS field in the AVTTB_CUSTOM_PROCEDURE table. It will then look 
for the stored procedure specified in the corresponding 
CPR_PROCEDURE_NAME field and run it. 

Modifying the Appearance of the Customizable Button Toolbar 

Alternative icons can be associated with the Customizable buttons toolbar if a retailer 
wants to  associate icons more pertinent to the purpose of the stored procedure that will 
be called.  

Confirm Satisfactory Operation 
The final stage is to carry out QA testing to verify that stored procedures operate 
correctly and that the overall functionality is also correctly configured. 

Example of Use of Customizable Buttons 
The following is an example of the use of customizable buttons. It is intended as an 
illustration only. It covers general principles, but there are many more steps than can be 
described in the example below. 

Purpose of Use 
This example shows how customizable buttons could be used to let a number of floor 
planners work collaborative on a floor plan. The example involves taking a floor plan at 
Current status, using a custom button to initiate a stored procedure splitting the floor 
plan into individual departments, individually modifying the department level floor 
plans and them combining them back into a master floor plan for approval and putting 
into service. The process is as follows: 
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Stages 

Open Floor Plan at Current Status 
The first stage would be to open the Current floor plan for that store. This is the floor 
plan currently in service and will be at read only status. 

Run First Stored Procedure via Button Creating Floor Plans at Proposed Status 

One customizable button could be configured to run a stored procedure to create the data 
for department level floor plans.  This will execute a series of steps. 
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1. Identify Departments in Current Floor Plan 

The first stage for the stored procedure is to identify the departments (zones) in the 
floor plan. One new floor plan will be required for each department. This stage of the 
stored procedure identifies the name of each department and the number of 
departments involved. 

2. Write to Custom Table 

There are a number of ways to keep track of the floor plans associated with 
individual departments so that they can be reassembled into a master floor plan. One 
of the methods is to use to the stored procedure to write the information to a custom 
table. This information can be referenced at a later stage to reassemble the individual 
departmental floor plans into a master floor plan. 

3. Create Separate DB Entries for each Department 

The second stage is for the stored procedure to create entries in the database 
corresponding to a separate floor plan for each department. This can be done because 
the Fixture table contains a ZON_ID. This is a foreign key to the Zone table. This 
means each fixture in a floor plan is uniquely assigned to a specific zone.  Based on 
this information, it is possible to create a new floor plan for each department 
containing the fixtures specific for this zone. This will mean adding entries to a large 
number of tables - see the Oracle Retail Macro Space Management Data Model for 
details.  

One method of working is to create the floor plans at Proposed status. When the floor 
plan has been edited by the floor planner, it can be manually set to Authorized status 
(or some other designated status.  
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4. Create required DWG files using API 

Planner requires a DWG file to operate. Therefore an API needs to be written to 
interface with AutoCAD. When called, this API should create appropriately named 
blank DWG files in the appropriate Windows folders. The paths to and names of 
these files will need to match up with entries in the database so that the software can 
reference them. The dates the files were created should be set appropriately to trigger 
auto-synchronization. 

5. The AutoSync option will need to be turned on for users 

The AutoSync option is set by means of the AUTOSYNC system variable in the 
System Variables dialog box in the Administration module. This should be set to 1 
(On). As each blank floor plan is opened, the software will detect that changes have 
been made in the database after the DWG file was last saved. Accordingly, the 
software will write the information from the database into the floor plan. This will 
include information such as the zone, fixtures, products, aisles and other associated 
information.  

6. Floor Plan Ready for editing 

At this stage the user will have a departmental level floor plan ready for editing. 

Editing Floor Plans and Setting to Authorised Status 

With the floor plans available, the floor planners can update the individual floor plans as 
required. These will initially be at Proposed status. As each individual floor planner 
completes their task they can set their individual department floor plans to Authorized 
status. this would indicate that particular department is ready for inclusion in the 
recombined floor plan. 

Running Second Stored Procedure 

The next stage is to run the second stored procedure to reassemble the individual 
department floor plans into a master floor plan. 
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1. Read Data from Custom Table 

The first stage is to read the data from the custom table to identify all the individual 
department floor plans that will be referenced. 

2. Verify all Floor Plans are at Authorized Status 

Floor plans can be assigned a status to show where they are in the business life cycle. 
In the earlier part of the process the individual department floor plans were created 
as at Proposed status. After editing the floor planners set them to Authorized status 
as an indication the work was complete. The stored procedure would then check all 
the individual department floor plans to see they were at Authorized status before 
proceeding to the next step. 

3. Create DB Entry for Master Floor Plan 

The next state is to create an entry in the database for the reassembled floor plan. 
This can be done by taking the data from the individual department floor plans and 
writing it into a combined entry for the updated floor plan. 

4. Create required DWG files using API 

Planner requires a DWG file to operate. Therefore an API needs to be written to 
interface with AutoCAD. When called, this API should create an appropriately 
named blank DWG file in the appropriate Windows folder. The path to and name of 
this file will need to match up with the entries in the database so that the software 
can reference it. The dates the file was created should be set appropriately to trigger 
auto-synchronization. 

5. The AutoSync option will be used 

The AutoSync option should still be set to On.  As the newly created blank floor plan 
is opened, the software will detect that changes have been made in the database after 
the DWG file was last saved. Accordingly, the software will write the information 
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from the database into the floor plan. This will include all the information on zones, 
fixtures, products, aisles and other associated information.  

6. Floor Plan Ready for editing 

At this stage the user will have a departmental level floor plan ready for inspection. 
This can verified by means of KPIs and reports. When satisfactory it can bet set to 
Authorized status ready for the requisite batch processes ready to publish it and put 
it into service. 

ISSC Mobile Configuration 

Overview of ISSC Mobile Configuration 
This section of the Administration Module help gives an overview of configuring the 
ISSC mobile application. The following sections give an overview of the configuration. 
For full details of how to use specific dialog boxes, see the pertinent parts of this help file. 
The configuration actions are: 

 Configuring access privileges  

 Configuring the automated time out. 

 Configuring the KPI 

 Configuring Properties  

 Configuring Annotation 

Defaults are provided for the automated time out, KPIs, properties and annotation, so an 
implementer may choose to leave those as provided. 

Configuring Access Privileges for ISSC Mobile 
Configuring access privileges for ISSC mobile is done using the Functional Security and 
Data Security dialog boxes accessed from the Security menu. A separate login should be 
created for each user. There are two reasons for this: 

 Only one user can log in at any one time for a specific user name. If a second 
person logs in using the same user name, the first user will be logged out. 

 Many actions are logged in the database against user names. Having a separate 
log in for each user enables actions to be traced accurately. 

Setting Automatic Time Out 
Automatic time out is a security feature that automatically logs the user out if the device 
is left inactive for a specified period. This is controlled by a system variable set in the 
System Variable dialog box  accessed from the General menu. By default this is set to 
1200 seconds (20 minutes).  For convenience this system variable could be set to a large 
while implementing and configuring ISSC mobile.  

Note: This system variable should not be set to more than 
2,000,000 or the application will error.  

After implementation is complete, this system variable should be set back to a value 
consistent with the retailer's security policies. 

KPIs 
Key Performance Indicators are used to indicate changes to fixtures in floor Plan view 
and to shelves and products in Planogram View. The application comes with default 
KPI's for this purpose. These KPI's can be configured to suit specific retailer requirements 
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using the Key Performance Indicators dialog box and the Color Themes dialog box 
accessed from the General menu. 

Configuring Properties 
Users can display the properties of specified objects. These objects are zones, fixtures, 
parent fixtures for planograms, planogram shelves and planogram products. ISSC Mobile 
come with default properties for these objects. If required, these properties  can be 
configured to a retailers specific requirements using the Custom Query dialog box 
accessed from the General menu. 

Annotation 
The annotation in both Floor Plan View and Planogram View can be customized to suit 
an individual retailer's requirements.  

Floor Plan View 

The annotation in Floor Plan View is governed by a series of system variables set in the 
System Variable dialog box accessed from the General menu. 

Planogram View 

The annotation in Planogram View is set using the Text Styles dialog box accessed from 
the Planning menu. 

Configuring Access Privileges for ISSC Mobile 
This section of ISSC Mobile Help describes how access privileges for ISSC Mobile are 
configured. A separate login should be created for each user. There are two reasons for 
this: 

 Only one user can log in at any one time for a specific user name. If a second 
person logs in using the same user name, the first user will be logged out. 

 Many actions are logged in the database against user names. Having a separate 
log in for each user enables actions to be traced accurately. 

Note: For full details on working in MSMs Administration 
module see the Oracle Retail Macro Space Management 
Administration User Guide. 

Configuring Access 
The following actions are required to configure access: 
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Creating User Group 

The first stage is to create a User Group. This needs to be specific for a particular store as 
an error will result on logging in if a user has access to multiple stores. This is done in the 
User Groups tab of the Functional Security dialog box accessed from the Security menu 
in the Administration module. In this example, a User Group is being created as a child 
of the ISSC Mobile User Group. This will allow all ISSC Mobile users Groups to be 
grouped together in the User Group hierarchy. 

 

Any number of users can be created associated with this User Group - each will have the 
privileges assigned to the User Group. 

Assigning Access to ISSC Mobile 
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Once a User Group has been created, it must be granted access to the ISSC mobile 
functionality. This is done in the Group Relationships tab of the Functional Security 
dialog box. There is a Command Group called ISSC Mobile. The recently created User 
Group has to be assigned to ISSC mobile. 

 

After assigning access to the ISSC Mobile command Group, verify that the User Group 
has Read permissions in the Permissions dialog box. 

 

Assigning Users 
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The next stage is to assign Users to the User Group. It is suggested that a separate User 
be created for each person requiring access to ISSC Mobile. Thus the store manager might 
require a user to be created for them, as would the deputy store manager and so on. This 
is also done in the User Groups tab of the Functional Security dialog box. 

 

Additional users would be created as required for the different people requiring access in 
the store. 

Note: It is recommended to set the Expiry Date to a date in 
the past. This will force a password change the first time the 
user logs in. Only that specific user will then know the 
password for that account. 

Assign Access to the Store 

The next stage is to assign access to the store. This is done in the Stores Tab of the Data 
Security dialog box accessed from the Security menu in the Administration module. 
Access should only be granted to a single store or users will receive an error message 
when logging into ISSC mobile. 
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After assigning access to the store, verify that the User Group has Read permissions in 
the Permissions dialog box. 

 

Assign Access to Store Status 
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Stores are given a status. This describes where they are in the business life cycle. 
Examples include Proposed, Open and Closed. Access needs to be granted to the 
pertinent status. This is done in the Status Tab of the Data Security dialog box. 

 

After assigning access to the store status, verify that the User Group has Read 
permissions in the Permissions dialog box. 
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Configuring Access to File Statuses 

Although Data Security in the Administration module has the ability to set access 
privileges for file statuses. This is not necessary for ISSC Mobile as ISSC mobile is 
configured to only access a floor plan at Current status. 

System Variable 
One system variable that affects operation of ISSC mobile is called 
MOBILE_USER_TIMEOUT. This controls the amount of time the mobile device ISSC 
Mobile can remain inactive before the user is automatically logged out. By default this is 
set to 1200 seconds (20 minutes). This can be set to any required value in the System 
Variable dialog box accessed from the General menu in the Administration Module. 

 

Configuring KPIs 
The KPIs (Key Performance Indicators) used in ISSC Mobile are configurable. This short 
section given an overview of the process and is intended mainly for administrators. 
Normal users of ISSC Mobile will not be able to access MSMs Administration module. 

Overview 
KPIs are used to color code objects in Floor Plan View and Planogram View to highlight 
them for attention. When KPI's are configured, they reference a color theme. This color 
theme can be modified to change the color objects are changed to by the KPI. 

Configuring KPIs 
KPI's are configured using the Key Performance Indicators dialog box.  This is accessed 
from the General menu. A KPI is configured to generate a set of data from the database. 
This set of data will have a results column, the value of which is used to determine how 
objects color in a floor plan (or planogram view). 
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ISSC Mobile can only use a single KPI for floor plans. This must be called 
AVTSP_KPI_FLOOR_PLAN_CHANGES.  It references a color theme called Store 
Changes. Similarly, ISSC Mobile can only use a single KPI for planogram views. This 
must be called AVTSP_KPI_PLANOGRAM_COMPARISON . It references a color 
theme called Planogram Changes. 

Configuring Color Themes 
Color Themes are configured using the KPI Color Theme dialog box. This is accessed 
from the General menu. This determines the color objects are displayed as in the floor 
plan (or planogram view). If they meet one criteria they are colored grey; another and 
they are colored red. At need, color themes can be configured to have multiple color 
bands. 

 

Configuring Properties 

Properties that can be Configured 
ISSC mobile displays the properties of selected objects. The example below shows the 
floor plan properties. 
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The full list of configurable properties includes: 

 Floor Plans 

– Floor Plan Properties  

– Zone Properties 

– Fixtures in floor plans 

 Planogram View 

– Profile Properties. 

– Parent fixture in a planogram bay. (This uses the same query as the fixture 
properties in the floor plan view). 

– Shelf in a planogram bay 

– Product in a planogram bay 

Configuring Floor Plan and Planogram View Properties 
The precise properties that are displayed in ISSC mobile can be modified in the Custom 
Search Query dialog box in the MSM Administration module. The information 
displayed in a specific implementation of ISSC Mobile may therefore vary from that in 
this user guide. 
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The available queries are: 

Query Where Used 

ISSC Mobile File 
Properties Floor plan properties in Floor Plan View 

ISSC Mobile Zone 
Properties Zone properties in floor plan view 

ISSC Mobile Fixture 
Properties 

Fixture properties in Floor Plan view and parent fixture properties in 
Planogram View. 

ISSC Mobile Profile 
Properties 

ISSC Mobile Profile 
Properties 2 

These two queries jointly populate the profile (bay) properties in Planogram 
View. The code that references these queries knows to reference both when 
executing the SQL statement.  

ISSC Mobile Fixel 
Properties Shelf properties in Planogram View. 

ISSC Mobile POG 
Product Properties Product properties in Planogram View 

Custom SQL Placeholders 

The Custom Query functionality can use placeholders in the SQL. These are frequently 
used in where clauses. The SQL for (for example) a stored procedure can be written and 
tested using a real FIL_ID . When the SQL has been confirmed to be working correctly, it 
can be replaced by a placeholder {Fileid}. 

 The original where clause would be of the form: 
WHERE FIL_ID = 123 

 When working correctly, the where clause can be modified to: 
WHERE FIL_ID = {Fileid} 
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 When the code for annotations reads the SQL statement, it will substitute the actual 
FIL_ID for {Fileid} before executing it. This makes the SQL statement efficient as it only 
returns a sub-set of data. 

Note: See the Custom Query dialog box for more 
information on placeholders. When a particular query has 
been selected in the drop down list, the top of the dialog box 
will contain text explaining the placeholders used and their 
purpose. 

Configuring Annotation 
This section describes how annotation in ISSC mobile is configured. There are tow 
different methods in use: 

 Annotation in Floor Plan View is configured using system variables. 

 Annotation in Planogram View is configured using Text styles. 

Annotation in Floor Plan View 
The Administration module allows annotation to be configured by means of several 
system variables. These can be set using the System Variable dialog box accessed from 
the General menu. These system variables have a global effect and will affect all users of 
both ISSC and ISSC Mobile. They control how annotation appears in the floor plan view. 
A different system is used for planogram view. 

 

Note: Another system variable in use for ISSC mobile is 
MOBILE_USER_TIMEOUT.  This system variable sets the 
time period to automatically log out the user after a specified 
length of inactivity. Its units are seconds. 

Zones 

 The TEXT_ZONE_TEXTSIZE system variable controls the size of the text used to 
display zone information. 

Fixtures 

  The TEXT_FIXTURE_OPTIONS system variable controls the appearance of the 
text that is displayed. 

 The TEXT_FIXTURE_PRECISION system variable determines the number of 
decimal places if the block length, depth or height is specified in the 
TEXT_FIXTURE_OPTIONS bitwise system variable. 
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 The TEXT_FIXTURE_TEXTFONT system variable controls the font used for 
fixture annotation. 

 The TEXT_FIXTURE_TEXTSIZE system variable controls the size of the 
annotation used for fixtures and bay numbering. 

Merchandise 
 The TEXT_PRODUCT_INSERTION system variable affects how the text is 

positioned relative to the fixture. 

 The TEXT_PRODUCT_JUSTIFICATION system variable affects how text is 
justified relative to the fixture. It is used in conjunction 
with TEXT_PRODUCT_INSERTION system variable. 

 The TEXT_PRODUCT_OPTIONS system variable controls the appearance of the 
text that is displayed. 

 The TEXT_PRODUCT_TEXTFONT system variable controls the font used for 
profile annotation. 

 The TEXT_PRODUCT_TEXTSIZE system variable controls the size of the 
annotation used for product text. 

 The TEXT_PRODUCT_X_OFFSET is used to 'fine-tune'  the position of the 
product text. Positive values of X move the text to the right, negative values to 
the left. 

 The TEXT_PRODUCT_Y_OFFSET is used to 'fine-tune'  the position of the 
product text. Positive values of Y move the text up, negative values of Y move 
the text down. 

Note: All but the MOBILE_USER_TIMEOUT system 
variable affects both ISSC and ISSC Mobile. These system 
variables will generally be set at the implementation stage 
and are not normally changed thereafter. 

Annotation in Planogram View 
The Text Styles option is used to display how the text appears in Planogram view in ISSC 
mobile. It is controlled using the Text Styles Admin Tool dialog box accessed from the 
Planning menu of MSMs Administration module. 
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The Product Mobile SKU text style can be selected for editing. This will bring up the Test 
Styles dialog box. There are two tabs. 

 

The Text Style Rules tab allows the use to set up a series of rules. When the planogram 
view is annotated, the application will work through these rules in sequence until  it finds 
one that is valid. That rule will then be applied to the annotation. As an example, the 
rules might cater for the space available for annotation. A large product might be 
annotated with rule 1, a smaller product with rule 3. 

 

 The Query tab allows the SQL used to select data from the database to be customized. 
This allows administrators precise control over the text displayed. 

Custom SQL Placeholders 

The text style functionality can use placeholders in the SQL. These are frequently used in 
where clauses. The SQL for (for example) a stored procedure can be written and tested 
using a real Planogram ID. When the SQL has been confirmed to be working correctly, i t 
can be replaced by a placeholder (POG_ID}. 

 The original where clause would be of the form: 
WHERE POG_ID = 123 

 When working correctly, the where clause can be modified to: 
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WHERE POG_ID = {POG_ID} 

 When the code for annotations reads the SQL statement, it will substitute the actual 
POG_ID for {POG_ID} before executing it. This makes the SQL statement efficient as it 
only returns a sub-set of data. 

Note: See the Custom Query dialog box for more 
information on placeholders. When a particular query has 
been selected in the drop down list, the top of the dialog box 
will contain text explaining the placeholders used and their 
purpose. 
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